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Thank You for Choosing Ross

You've made a great choice. We expect you will be very happy with your purchase of Ross
Technology.

Our mission is to:

1. Provide a Superior Customer Experience

· offer the best product quality and support

2. Make Cool Practical Technology

· develop great products that customers love

Ross has become well known for the Ross Video Code of Ethics. It guides our interactions and
empowers our employees. I hope you enjoy reading it below.

If anything at all with your Ross experience does not live up to your expectations be sure to reach
out to us at solutions@rossvideo.com.

David Ross

CEO, Ross Video

dross@rossvideo.com

Ross Video Code of Ethics

Any company is the sum total of the people that make things happen. At Ross, our employees are
a special group. Our employees truly care about doing a great job and delivering a high quality
customer experience every day. This code of ethics hangs on the wall of all Ross Video locations
to guide our behavior:

1. We will always act in our customers’ best interest.

2. We will do our best to understand our customers’ requirements.

3. We will not ship crap.

4. We will be great to work with.

5. We will do something extra for our customers, as an apology, when something big goes wrong
and it's our fault.

6. We will keep our promises.

7. We will treat the competition with respect.

8. We will cooperate with and help other friendly companies.

9. We will go above and beyond in times of crisis. If there's no one to authorize the required
action in times of company or customer crisis - do what you know in your heart is right. (You
may rent helicopters if necessary.)

mailto:solutions@rossvideo.com
mailto:dross@rossvideo.com
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End User Software License Agreement

This End User Software License Agreement is a legal agreement between you (the “Licensee”) and Ross
Video Limited (“Ross Video”) specifying the terms and conditions of your installation and use of the
Software and all Documentation (as those terms are defined herein).

IMPORTANT:

BY DOWNLOADING, ACCESSING, INSTALLING OR USING THE SOFTWARE AND/OR
DOCUMENTATION AND/OR BY AUTHORIZING ANY THIRD PARTY, INCLUDING WITHOUT
LIMITATION AN INSTALLER OR COMMISSIONER ACTING ON YOUR BEHALF TO DO SO, LICENSEE
AGREES TO THE TERMS OF THIS AGREEMENT AND THE LICENSE GRANTED HEREUNDER SHALL BE
EFFECTIVE AS OF AND FROM SUCH DATE. IF YOU DO NOT WISH TO ACCEPT THE TERMS AND
CONDITIONS OF THIS AGREEMENT, DO NOT DOWNLOAD, ACCESS, INSTALL, REFER TO OR
OTHERWISE USE THE SOFTWARE AND/OR DOCUMENTATION.

1. INTERPRETATION. In this Agreement, (a) words signifying the singular number include the plural
and vice versa, and words signifying gender include all genders; (b) every use of the words "herein",
"hereof", “hereto” "hereunder" and similar words shall be construed to refer to this Agreement in its
entirety and not to any particular provision hereof; (c) reference to any agreement or other document
herein will be construed as referring to such agreement or other document as from time to time
amended, modified or supplemented (subject to any restrictions on such amendment, modification or
supplement set forth therein); (d) every use of the words “including” or “includes” is to be construed
as meaning “including, without limitation” or “includes, without limitation”, respectively; and (e)
references to an Article or a Section are to be construed as references to an Article or Section of or to
this Agreement unless otherwise specified.

2. DEFINITIONS. In this Agreement, in addition to the terms defined elsewhere in this Agreement, the
following terms have the meanings set out below:

“Affiliate” means, with respect to any Person, any other Person who directly or indirectly controls, is
controlled by, or is under direct or indirect common control with, such Person. A Person shall be
deemed to control a Person if such Person possesses, directly or indirectly, the power to direct or
cause the direction of the management and policies of such Person, whether through the ownership of
voting securities, by contract or otherwise; and the term “controlled” and “controlling” shall have a
similar meaning.

“Agreement” means this End User Software License Agreement including the recitals hereto, as the
same may be amended from time to time in accordance with the provisions hereof.

“Backup System” means the secondary piece of Designated Equipment upon which the Software is
installed and mirrored for the sole purpose of replacing a Primary System in the event such Primary
System is not available or functioning properly for any reason.

“Change of Control” means (a) the direct or indirect sale, transfer or exchange by the shareholders
of a Party of more than fifty percent (50%) of the voting securities of such Party, (b) a merger or
amalgamation or reorganization or other transaction to which a Party is party after which the
shareholders of such Party immediately prior to such transaction hold less than fifty percent (50%) of
the voting securities of the surviving entity, (c) the sale, exchange, or transfer of all or substantially
all of the assets of a Party.



“Confidential Information” means all data and information relating to the business and
management of either Party, including the Software, trade secrets and other technology to which
access is obtained or granted hereunder by the other Party, and any materials provided by Ross Video
to Licensee; provided, however, that Confidential Information shall not include any data or information
which:

(i) is or becomes publicly available through no fault of the other Party;

(ii) is already in the rightful possession of the other Party prior to its receipt from the other Party;

(iii) is already known to the receiving Party at the time of its disclosure to the receiving Party by the
disclosing Party and is not the subject of an obligation of confidence of any kind;

(iv) is independently developed by the other Party;

(v) is rightfully obtained by the other Party from a third party; or

(vi) is disclosed with the written consent of the Party whose information it is.

“Designated Equipment” shall mean (a) the hardware products sold by Ross Video to Licensee on
which the Software is installed and licensed for use, as the same may be replaced from time to time
by Ross Video; or (b) in the case of Software licensed on a stand-alone basis, the equipment of
Licensee on which the Software is to be installed and meets the minimum specifications set out in the
Documentation.

“Documentation” shall mean manuals, instruction guides, user documentation and other related
materials of any kind pertaining to the Software (whether in electronic, hard-copy or other media
format) that are furnished to Licensee by or on behalf of Ross Video in relation to the Software.

“Freeware” means Software that is available free of charge from Ross Video, and includes, without
limitation the master control system software known as "DashBoard".

"Governmental Authority" means (a) any federal, provincial, state, local, municipal, regional,
territorial, aboriginal, or other government, governmental or public department, branch, ministry, or
court, domestic or foreign, including any district, agency, commission, board, arbitration panel or
authority and any subdivision of any of them exercising or entitled to exercise any administrative,
executive, judicial, ministerial, prerogative, legislative, regulatory, or taxing authority or power of any
nature; and (b) any quasi-governmental or private body exercising any regulatory, expropriation or
taxing authority under or for the account of any of them, and any subdivision of any of them.

“Improvements” means all inventions, works, discoveries, improvements and innovations of or in
connection with the Software, including error corrections, bug fixes, patches and other updates in
Object Code form to the extent made available to Licensee in accordance with Ross Video’s release
schedule.

"License Fee" means the fee(s), if any, payable in respect of the Software in accordance with the
relevant invoice(s) or other purchase documents delivered in connection with this Agreement.

“License Period” means the period of time that Licensee will have the rights granted under this
Agreement, as may be specified in an Order.

“Modifications” means any enhancements, changes, corrections, translations, adaptations, revisions,
developments, upgrades or updates thereto; and “Modify” shall mean the creation of any of the
foregoing.

“Object Code” means the machine readable executable form of a computer software program.



"Open Source Components" means third party Open Source software, libraries or other
components.

"Open Source License" means the license that governs each Open Source Component.

"Order" means the documents provided by Ross Video to Licensee detailing the Ross Video products
contemplated for purchase, the corresponding fees and License Period that may apply to the Software,
including any and all quotations, purchase orders, acknowledgments, pro formas, invoices and other
purchase documentation.

“Parties” means both Ross Video and Licensee and “Party” means either one of them as the context
requires.

“Person” will be broadly interpreted and includes (a) a natural person, whether acting in his or her
own capacity, or in his or her capacity as executor, administrator, estate trustee, trustee or personal
or legal representative; (b) a corporation or a company of any kind, a partnership of any kind, a sole
proprietorship, a trust, a joint venture, an association, an unincorporated association, an
unincorporated syndicate, an unincorporated organization or any other association, organization or
entity of any kind; and (c) a Governmental Authority.

“Primary System” means the Designated Equipment upon which the Software is installed and
executed to deliver its intended functionality.

“Released Claims” has the meaning ascribed to it in Section 9(b). 

“Released Parties” has the meaning ascribed to it in Section 9(b). 

“Ross Video” means Ross Video Limited and its Affiliates. 

“Software” means the version of the Object Code licensed and delivered to Licensee by Ross Video
concurrently with delivery of this Agreement, including without limitation the Freeware, and any
subsequent error corrections, updates, Modifications or Improvements provided to Licensee by Ross
Video pursuant to this Agreement, but specifically excluding any features or plug-ins that may be
purchased by you directly from third parties as upgrades or enhancements to the Software.

“Source Code” means the human readable form of a computer software program, and all tools and
documentation necessary for a reasonably competent computer programmer to understand, maintain
and Modify the Software.

“Third Party Software” means those portions of the Software, if any, which are owned or controlled
by third parties and licensed to Ross Video pursuant to certain license agreements or arrangements
with such third parties, including the Open Source Components and NDI®1 software
(http://NDI.video); and

“Use” means to execute, run, display, store, merge, network, Modify, translate, host or integrate with
Licensee’s products or other third party software.

1 NDI® is a registered trademark of Vizrt NDI AB.

http://NDI.video


3. LICENSE. Subject to the terms and conditions of this Agreement, upon payment of the applicable
License Fee by Licensee, or, in the case of Freeware only, upon download of the Software by Licensee
onto its Designated Equipment, Ross Video hereby grants to Licensee a non-transferable and non-
exclusive right to Use the Software and Documentation solely for the internal use of Licensee (the
“License”), during the License Period. In the event that a License Period is not identified on the Order,
such License Period shall be deemed to be perpetual, subject to paragraph 10 (c) of this Agreement.
The Software shall only be used in connection with or installed on the Designated Equipment and,
where applicable, shall only be used on the Primary System, provided such Primary System is
operating properly."

If the Primary System is not operating properly for any reason, the Software may be used on the
designated Backup System for that Primary System until such time that the Primary System begins
operating properly. The Software and Documentation are provided to Licensee for the exclusive use by
Licensee’s organization for its ordinary business purposes and shall not be used by any third party for
any purposes. Licensee may make copies of the Software as required for internal backup and archival
purposes. To the extent permitted hereunder, Licensee may distribute copies of the Software and/or
Documentation to members of its organization, provided (a) this Agreement is included with each
copy, (b) any member of its organization who uses the Software and/or Documentation accepts and
agrees to be bound by the terms of this Agreement and by any other license agreements or other
agreement incorporated by reference into this Agreement, and (c) Licensee has paid any applicable
additional License Fees in respect of copying and redistributing of the Software. To the extent
Licensee is permitted to make copies of the Software under this Agreement, Licensee agrees to
reproduce and include on any copy made or portion merged into another work, all Ross Video
proprietary notices, including any notices with respect to copyrights, trademarks and this License.
With the exception of copying the Software for backup or archival purposes, Licensee agrees to keep a
record of the number and location of all such copies and will make such record available at Ross
Video’s request. The Software may include mechanisms to limit or inhibit copying.

4. LICENSE RESTRICTIONS. Except as otherwise provided in section 3 above, Licensee shall not: (1)
copy any Software or Documentation, or part thereof, which is provided to Licensee by Ross Video
pursuant to this Agreement, in Object Code form, Source Code form or other human or machine
readable form, including written or printed documents, without the prior written consent of Ross
Video; (2) in any way market, distribute, export, translate, transmit, merge, Modify, transfer, adapt,
loan, rent, lease, assign, share, sub-license, sell, make available for download on any website or
make available to another Person, the Software and/or Documentation, in whole or in part, provided
that Licensee shall not be prohibited from renting or leasing the Software if Ross Video has consented,
in writing, to Licensee engaging in such activities in respect of the Software; (3) reverse engineer,
decompile or disassemble the Software or electronically transfer it into another computer language; or
(4) use the Software or Documentation in a manner that is inconsistent with the License granted
hereunder or that will result in a breach of this Agreement. Licensee agrees to take all reasonable
precautions to prevent third parties from using the Software and/or Documentation in any way that
would constitute a breach of this Agreement, including such precautions Licensee would ordinarily
take to protect its own proprietary software, hardware or information.

5. DELIVERY. Ross Video shall deliver to Licensee one (1) master copy of the Software in compiled
binary (executable) form suitable for reproduction in electronic files only and Ross Video shall deliver
to Licensee a minimum of one copy of the Documentation.

6. IMPROVEMENTS. Licensee may from time to time request Ross Video to incorporate certain
Improvements into the Software. Ross Video may, in its sole discretion, undertake to incorporate and
provide such Improvements to Licensee with or without payment of a fee to be negotiated at the time
of such request. All Improvements, whether recommended and developed by Ross Video or Licensee,
shall be considered the sole property of Ross Video and shall be used by Licensee pursuant to the
terms of the License granted under this Agreement.



7. FREEWARE. Other than the obligation to pay a License Fee, which does not apply to the Freeware, all
other provisions of this End User Software License Agreement apply to the Freeware in the same way
as they apply to all other Software that is the subject of this Agreement. In addition, in connection
with the Freeware, the following provisions apply: 

a. Licensee will not Use the Freeware to engage in or allow others to engage in any illegal activity.

b. Licensee will not Use the Freeware in any way that will interfere with or damage the operation of
the services of any third parties by overburdening/disabling network resources through automated
queries, excessive usage or similar conduct.

c. Licensee will not Use the Freeware to engage in any activity that will violate the rights of others,
including, without limitation, by using it for operations that involve child labour, suppressing the
right of freedom of expression or endangering the security of person.

8. OWNERSHIP. The Parties acknowledge and agree that, as between the Parties, Ross Video shall be
the owner of all intellectual property rights in the Software, Documentation and all related
Modifications and Improvements, written materials, logos, trademarks, trade names, copyright,
patents, trade secrets and moral rights, registered or unregistered. No proprietary interest or title in
or to the intellectual property in the Software, Documentation or any Improvements or Modifications is
transferred to Licensee by this Agreement. Ross Video reserves all rights not expressly licensed to
Licensee under section 3.

9. OPEN SOURCE SOFTWARE. 

a. Software may use and/or be provided with Open Source Components, including those detailed in
the Third Party section below. To the extent stipulated by its Open Source License, each such Open
Source Component is licensed directly to Licensee from its respective licensors and not sub-
licensed to Licensee by Ross Video, and such Open Source Component is subject to its respective
Open Source License, and not to this Agreement. If, and to the extent, an Open Source Component
requires that this Agreement effectively impose, or incorporate by reference, certain disclaimers,
permissions, provisions, prohibitions or restrictions, then such disclaimers, permissions, provisions,
prohibitions or restrictions shall be deemed to be imposed, or incorporated by reference into this
Agreement, as required, and shall supersede any conflicting provision of this Agreement, solely
with respect to the corresponding Open Source Component which is governed by such Open Source
License. 

b. If Licensee, or another party on Licensee’s behalf, modifies, replaces or substitutes any Open
Source Component used in or provided with this Software, Licensee hereby fully, forever,
irrevocably and unconditionally releases and discharges Ross Video, its Affiliates and its and their
employees, officers, directors, resellers, distributors and representatives (collectively, “Released
Parties”) from any and all claims, charges, complaints, demands, actions, causes of action, suits,
rights, debts, covenants, liabilities, warranties, performance and maintenance and support
obligations (collectively, “Released Claims”), of every kind and nature, with respect to such
Software, including without limitation any such Released Claims that arise as a matter of
applicable Law. 

c. If an Open Source License requires that the source code of its corresponding Open Source
Component be made available to Licensee, and such source code was not delivered to Licensee
with the Software, then Ross Video hereby extends a written offer, valid for the period prescribed
in such Open Source License, to obtain a copy of the source code of the corresponding Open
Source Component, from Ross Video from https://www.rossvideo.com/open-source-information/.

https://www.rossvideo.com/open-source-information/


10. THIRD PARTY SOFTWARE. 

a. Licensee acknowledges that the Third Party Software is not owned by Ross Video. Notwithstanding
any other provision of this Agreement, Ross Video, to the extent permitted by applicable law,
offers no warranties (whether express, implied, statutory or by course of communication or dealing
with Licensee, or otherwise) with respect to the Third Party Software. Ross Video may pass
through to Licensee, if and to the extent permitted by applicable law, any warranties expressly
provided by such third parties to Ross Video for such Third Party Software.

b. FFmpeg Notice. The Software may utilize FFmpeg video components and their included libraries.
FFmpeg is a trademark of Fabrice Bellard (originator of the FFmpeg project). Ross Video disclaims
any ownership claim to FFmpeg. Please refer to http://ffmpeg.org (copyright is in the FFmpeg
developers). FFmpeg is licensed under the GNU Lesser General Public License v2.1 or Lesser
General Public License v3.0. GNU Lesser General Public License contact information: Free Software
Foundation, Inc., 51 Franklin Street, Fifth Floor, Boston, MA 02110-1301 USA. Licensee can
distribute it and/or modify it under the terms of such licenses. The encoding of the video media in
combination with FFmpeg or libav is licensed under the following patent portfolio licenses from
MPEG LA, LLC, 6312 S. Fiddlers Green Circle, Suite 400E, Greenwood Village, Colorado 80111
U.S.A. The MPEG-2 PATENT PORTFOLIO, The MPEG-4 VISUAL PATENT PORTFOLIO, The VC-1
PATENT PORTFOLIO, and The AVC PATENT PORTFOLIO.

11. INTELLECTUAL PROPERTY INDEMNITY. 

a. Ross Video agrees to defend, indemnify and hold harmless Licensee from final damages awarded
by a court of competent jurisdiction (hereinafter referred to as the “Losses”), which Licensee, or
any of its officers or directors, may incur, suffer or become liable for as a result of, or in
connection with, any third party claim asserted against Licensee to the extent such claim is based
on a contention that the Software, Documentation or any portion thereof, infringes any valid,
registered, enforceable patents, copyrights, trade secrets, trademarks or other intellectual property
rights of any third party, provided that (a) the allegedly infringing Software or Documentation has
been used within the scope of and in accordance with the terms of this Agreement, and (b)
Licensee notifies Ross Video in writing of such claim within ten (10) days of a responsible officer of
Licensee becoming aware of such claim. If the Software, Documentation or any portion thereof is
held to constitute an infringement of a third party’s intellectual property rights, and use thereof is
enjoined, Ross Video shall, at its election and expense, either (i) procure the right to use the
infringing element of the Software or Documentation; or (ii) replace or modify the element of the
Software or Documentation so that the infringing portion is no longer infringing and still performs
the same function without any material loss of functionality. Ross Video shall make every
reasonable effort to correct the situation with minimal effect upon the operations of Licensee.

b. Notwithstanding the above, Ross Video reserves the right to terminate this Agreement and the
License granted hereunder on immediate notice to Licensee, and without liability to Licensee, in
the event that the Software or Documentation constitutes or may, in Ross Video’s determination,
constitute, an infringement of the rights of a third party that Ross Video, in its sole discretion, does
not consider to be affordably remediable.

c. Either party may terminate this Agreement immediately should any Software become, or in either
party's opinion be likely to become, the subject of a claim of infringement of any intellectual
property right and, in such event, there shall be no claim by either Licensee or Ross Video against
the other arising out of such termination, provided that the foregoing shall not apply to a claim for
infringement by Ross Video against Licensee in the event that Licensee is alleged to have infringed
Ross Video's intellectual property rights, in which case Licensee shall remain liable for all
outstanding License Fees and other amounts owing to Ross Video.

d. Notwithstanding the foregoing, Ross Video shall have no liability for any claim of infringement
based on use of other than a current, unaltered release of the Software and/or Documentation
available from Ross Video if such infringement would have been avoided by the use of a current,
unaltered release of the Software and/or Documentation provided that such current, unaltered
release performs substantially in conformity with the specifications set out in the Documentation
and was provided, at no additional cost by Ross Video, to those subscribing for maintenance



12. CONFIDENTIALITY. Each Party shall maintain in confidence all Confidential Information of the other
Party, shall use such Confidential Information only for the purpose of exercising its rights and fulfilling
its obligations under this Agreement, and shall not disclose any Confidential Information of the
disclosing Party to any third party except as expressly permitted hereunder or make any unauthorized
use thereof. Each Party shall disclose the Confidential Information only to those of its employees,
consultants, advisors, and/or subcontractors who have a need to know the Confidential Information.
Each Party shall, prior to disclosing the Confidential Information to such employees, consultants,
advisors and/or subcontractors, obtain their agreement to receive and use the Confidential
Information on a confidential basis on the same terms and conditions contained in this Agreement.
The receiving Party shall treat the Confidential Information of the disclosing Party with the same
degree of care against disclosure and/or unauthorized use as it affords to its own information of a
similar nature, or a reasonable degree of care, whichever is greater. The receiving Party further
agrees not to remove or destroy any proprietary or confidential legends or markings placed upon any
documents or other materials of the disclosing Party. The obligations of confidence set forth in this
Agreement shall extend to any Affiliates that have received Confidential Information of the disclosing
Party and shall also cover Confidential Information disclosed by any Affiliate. The receiving Party shall
be responsible for any actions or omissions of its Affiliates as if such actions or omissions were its
own.

Either party may disclose certain Confidential Information if it is expressly required to do so pursuant
to legal, judicial, or administrative proceedings, or otherwise required by law, provided that (i) such
Party provides the other Party with reasonable written notice prior to such disclosure; (ii) such Party
seeks confidential treatment for such Confidential Information; (iii) the extent of such disclosure is
only to the extent expressly required by law or under the applicable court order; and (iv) such Party
complies with any applicable protective or equivalent order.

Each of Ross Video and Licensee (the “Indemnifying Party”, as applicable) agree to indemnify the
other (the “Indemnified Party”, as applicable) for all Losses incurred by the Indemnified Party as a
result of a failure of the Indemnifying Party to comply with its obligations under this Section 12
provided that the Indemnified Party has given prompt notice of any such claim and, to the extent that
a claim may lie against a third party for the unauthorized disclosure of such Confidential Information,
the right to control and direct the investigation, preparation, action and settlement of each such claim
and, further, provided that the Indemnified Party reasonably co-operates with the Indemnifying Party
in connection with the foregoing and provides the Indemnifying Party with all information in the
Indemnified Party’s possession related to such claim and such further assistance as reasonably
requested by the Indemnifying Party.

The Parties acknowledge and agree that any breach of the confidentiality provisions of this Agreement
by one Party may cause significant and irreparable injury to the other Party that is not compensable
monetarily, as well as damages that may be difficult to ascertain, and agrees that, in addition to such
other remedies that may be available at law or in equity, the other Party shall be entitled to seek
injunctive relief (including temporary restraining orders, interim injunctions and permanent
injunctions) in a court of competent jurisdiction in the event of the breach or threatened breach by
such party of any of the confidentiality provisions of this Agreement. The relief contemplated in this
Section shall be available to each Party without the necessity of having to prove actual damages and
without the necessity of having to post any bond or other security. Each Party further agrees to notify
the other Party in the event that it learns of or has reason to believe that any Person has breached the
confidentiality provisions of this Agreement.



13. LIMITATION OF LIABILITY. The limitation of liability provisions of this Agreement reflect an
informed voluntary allocation of the risks (known and unknown) that may exist in connection with the
licensing of the Software or Documentation hereunder by Ross Video, and that voluntary risk
allocation represents a material part of the Agreement reached between Ross Video and Licensee.
Should Ross Video be in breach of any obligation, Licensee agrees that Licensee’s remedies will be
limited to those set forth in this Agreement. No action, regardless of form, arising out of this
Agreement may be brought by Licensee more than twelve (12) months after the facts giving rise to
the cause of action have occurred, regardless of whether those facts by that time are known to, or
reasonably ought to have been discovered by, Licensee.

(A) EXCEPT AS EXPRESSLY PROVIDED IN THIS AGREEMENT, THE SOFTWARE AND DOCUMENTATION
ARE PROVIDED “AS IS” AND ROSS VIDEO (I) MAKES NO OTHER REPRESENTATIONS, AND PROVIDES
NO WARRANTIES OR CONDITIONS OF ANY KIND, EXPRESS OR IMPLIED, STATUTORY, BY USAGE OF
TRADE CUSTOM OF DEALING, OR OTHERWISE, AND (II) SPECIFICALLY DISCLAIMS ALL IMPLIED
WARRANTIES INCLUDING ANY IMPLIED WARRANTY OF UNINTERRUPTED OR ERROR FREE OPERATION,
MERCHANTABILITY, QUALITY OR FITNESS FOR A PARTICULAR PURPOSE. ROSS VIDEO DOES NOT
REPRESENT OR WARRANT THAT THE SOFTWARE WILL MEET ANY OR ALL OF LICENSEE’S PARTICULAR
REQUIREMENTS, THAT THE USE AND OPERATION OF THE SOFTWARE WILL OPERATE ERROR-FREE OR
UNINTERRUPTED, THAT ALL PROGRAMMING ERRORS IN THE SOFTWARE CAN BE FOUND IN ORDER TO
BE CORRECTED, OR THAT THE SOFTWARE WILL BE COMPATIBLE WITH OTHER PROGRAMS, SYSTEMS,
AND HARDWARE.

(B) IN NO EVENT SHALL ROSS VIDEO, ITS AFFILIATES AND LICENSORS, AND THEIR RESPECTIVE
DIRECTORS, OFFICERS, EMPLOYEES AND AGENTS, BE LIABLE FOR ANY CLAIM FOR INDIRECT,
CONSEQUENTIAL, SPECIAL, INCIDENTAL, PUNITIVE, EXEMPLARY, AGGRAVATED DAMAGES; LOST
PROFITS, OR LOST REVENUE ARISING FROM OR IN CONNECTION WITH THIS AGREEMENT,
REGARDLESS OF THE FORM OF ACTION, WHETHER IN CONTRACT, OR IN TORT, EVEN IF THE PARTY
HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

(C) IN ANY EVENT THE AGGREGATE LIABILITY OF ROSS VIDEO, ITS AFFILIATES AND LICENSORS,
AND THEIR RESPECTIVE DIRECTORS, OFFICERS, EMPLOYEES AND AGENTS, FOR ANY CLAIM FOR
DIRECT DAMAGES WITH RESPECT TO THE SUBJECT MATTER OF THIS AGREEMENT SHALL NOT EXCEED
THE AMOUNT OF THE PURCHASE PRICE PAID TO ROSS VIDEO UNDER THIS AGREEMENT.

14. TERM AND TERMINATION.

(1) Unless terminated earlier in accordance with the terms of this Agreement, the term of this
Agreement shall commence upon Licensee’s first download, access, installation, or other use of
the Software or Documentation and continues until, in the case of Software licensed with
Designated Equipment provided by Ross Video, the earliest of (a) the end of the License Period,
or (b) if the Designated Equipment is assigned or transferred in accordance with this Agreement,
the date on which the Designated Equipment is no longer owned by Licensee;

(2) Either Party shall have the right to terminate this Agreement on notice to the other Party if: 

(a) the other Party fails to pay any fees or other amounts when due hereunder or under any
other agreement between the Parties (or any Affiliates of the Parties, as applicable) in
connection with the Software and/or Designated Equipment and such breach is not cured
within thirty (30) days after written notice of such failure to pay is given to the defaulting
Party by the non-defaulting Party; 

(b) the other Party shall file a voluntary petition in bankruptcy or insolvency or shall petition for
reorganization under any bankruptcy law, consent to an involuntary petition in bankruptcy,
or if a receiving order is given against it under the Bankruptcy and Insolvency Act (Canada)
or the comparable law of any other jurisdiction (and such is not dismissed within ten (10)
days);



(c) there shall be entered an order, judgment or decree by a court of competent jurisdiction,
upon the application of a creditor, approving a petition seeking reorganization or appointing
a receiver, trustee or liquidator of all or a substantial part of the other Party’s assets and
such order, judgment or decree continues in effect for a period of thirty (30) consecutive
days; or

(d) the other Party shall fail to perform any of the other material obligations set forth in this
Agreement and such default, in the case of a default which is remediable, continues for a
period of thirty (30) days after written notice of such failure has been given by the non-
defaulting Party or, in the case of a non-remediable default, immediately upon notice.

(3) Notwithstanding anything to the contrary contained in this Agreement:

(a) Ross Video may forthwith terminate this Agreement if Licensee is in breach of any of
sections 3, 4 or 12 of this Agreement. For greater certainty, in such instances Ross Video
shall provide written notice of such termination as soon as practicable but written notice
shall not be a necessary prerequisite to such termination; and

(b)  in the event of a Change of Control of Licensee, Ross Video shall have the right to terminate
this Agreement and the License granted hereunder upon thirty (30) days’ prior written
notice to Licensee. For greater certainty, Ross Video’s right to terminate in the event of a
Change of Control of Licensee shall continue for a period of six (6) months from the date
Licensee delivers notice of such Change of Control to Ross Video.

(c) Ross Video may terminate the License immediately on the date on which it provides notice
to Licensee, if its agreements for Third Party Software are terminated.

(4) Upon the termination or expiry of this Agreement:

(a) Licensee shall immediately cease and desist all use of the Software and Documentation;

(b) Licensee shall immediately deliver to Ross Video any of Ross Video’s Confidential
Information provided hereunder (including the Software and Documentation) then in its
possession or control, if any, and shall deliver a certificate of an officer of Licensee certifying
the completeness of same;

(c) Licensee shall refrain from further use of such Confidential Information; and

(d) Licensee shall forthwith pay all amounts owing to Ross Video or any of its Affiliates
hereunder.

15. SURVIVAL. The provisions of sections 1, 2, 6, 8, 9, 10, 11, 12, 13, 14, 18, 22, 23, and 24 herein shall
survive the expiry or termination of this Agreement.

16. FORCE MAJEURE. Dates and times by which Ross Video is required to render performance under this
Agreement shall be automatically postponed to the extent and for the period that Ross Video is
prevented from meeting them by reason of events of force majeure or any cause beyond its
reasonable control provided Ross Video notifies Licensee of the commencement and nature of such
cause and uses its reasonable efforts to render performance in a timely manner.

17. ASSIGNMENT. Ross Video may assign this Agreement, or any of its rights or obligations hereunder,
in whole or in part, upon notice to Licensee. Licensee shall not assign this Agreement, or any of its
rights or obligations hereunder, in whole or in part, without the prior written consent of Ross Video,
which consent may not be unreasonably withheld. This Agreement enures to the benefit of and is
binding upon each of the Parties and their respective successors and permitted assigns.



18. GOVERNING LAW. If Licensee acquired the Ross Product(s) in the United States or Canada, the laws
of the state or province where Licensee’s principal place of business is located govern the
interpretation of this Agreement, claims for its breach, and all other claims regardless of conflict of
laws principles. If Licensee acquired the Ross Product(s) in the European Union or the United
Kingdom, then the laws of England and Wales apply. If Licensee acquired the Ross Product(s) in any
other country, then the laws of the Province of Ontario, Canada shall apply.

19. LANGUAGE. The Parties have expressly required that this Agreement and all documents relating
thereto be prepared in English. Les parties ont expressément exigé que cette convention ainsi que
tous les documents qui s’y rattachent soient rédigés en anglais.

20. GOVERNMENT CONTRACTS. If the Software and/or Documentation to be furnished to Licensee
hereunder are to be used in the performance of a government contract or subcontract, the Software
and/or Documentation shall be provided on a "restricted rights" basis only and Licensee shall place a
legend, in addition to applicable copyright notices, in the form provided under the applicable
governmental regulations. For greater certainty, Ross Video shall not be subject to any flow-down
provisions required by any customer of Licensee that is a Governmental Authority unless Ross Video
expressly agrees to be bound by such flow-down provisions in writing.

21. EXPORT AND IMPORT LAWS. Licensee acknowledges and agrees that the Software (including any
technical data and related technology) may be subject to the export control laws, rules, regulations,
restrictions and national security controls of the United States and other applicable countries (the
“Export Controls”) and agrees not to export, re-export, import or allow the export, re-export or
import of such export-controlled Software (including any technical data and related technology) or any
copy, portion or direct product of the foregoing in violation of the Export Controls. Licensee hereby
represents that it is not an entity or person to whom provision of the Software (including any technical
data and related technology) is restricted or prohibited by the Export Controls. Licensee agrees that it
has the sole responsibility to obtain any authorization to export, re-export, or import the Software
(including any technical data and related technology), as may be required. Licensee will defend,
indemnify and hold Ross Video harmless from any and all claims, losses, liabilities, damages, fines,
penalties, costs and expenses (including attorney’s fees) arising from or relating to any breach by
Licensee of its obligations under this Section.

22. AMENDMENT AND WAIVER. No amendment, discharge, modification, restatement, supplement,
termination or waiver of this Agreement or any Section of this Agreement is binding unless it is in
writing and executed by the Party to be bound. No waiver of, failure to exercise or delay in exercising,
any Section of this Agreement constitutes a waiver of any other Section (whether or not similar) nor
does any waiver constitute a continuing waiver unless otherwise expressly provided.

23. SEVERABILITY. Each Section of this Agreement is distinct and severable. If any Section of this
Agreement, in whole or in part, is or becomes illegal, invalid, void, voidable or unenforceable in any
jurisdiction by any court of competent jurisdiction, the illegality, invalidity or unenforceability of that
Section, in whole or in part, will not affect (a) the legality, validity or enforceability of the remaining
Sections of this Agreement, in whole or in part; or (b) the legality, validity or enforceability of that
Section, in whole or in part, in any other jurisdiction.

24. ENTIRE AGREEMENT. This Agreement, and any other documents referred to herein, constitutes the
entire agreement between the Parties relating to the subject matter of this Agreement and supersedes
all prior written or oral agreements, representations and other communications between the Parties.

Updated: November 1, 2023



Warranty and Repair Policy

Ross Video Limited (Ross) warrants its XPression Maps systems to be free from defects under normal use
and service for the following time periods from the date of shipment:

· XPression Maps Server — 12 months

· XPression Maps Software Upgrades — 12 months free of charge

· System and Media hard drives — 12 months

If an item becomes defective within the warranty period Ross will repair or replace the defective item, as
determined solely by Ross.

Warranty repairs will be conducted at Ross, with all shipping FOB Ross dock. If repairs are conducted at
the customer site, reasonable out-of-pocket charges will apply. At the discretion of Ross, and on a
temporary loan basis, plug in circuit boards or other replacement parts may be supplied free of charge
while defective items undergo repair. Return packing, shipping, and special handling costs are the
responsibility of the customer.

This warranty is void if products are subjected to misuse, neglect, accident, improper installation or
application, or unauthorized modification.

In no event shall Ross Video Limited be liable for direct, indirect, special, incidental, or consequential
damages (including loss of profit). Implied warranties, including that of merchantability and fitness for a
particular purpose, are expressly limited to the duration of this warranty.

This warranty is TRANSFERABLE to subsequent owners, subject to Ross’ notification of change of
ownership.

Extended Warranty

For customers that require a longer warranty period, Ross offers an extended warranty plan to extend the
standard warranty period by one year increments. For more information about an extended warranty for
your XPression Maps system, contact your regional sales manager.



Environmental Information

The equipment that you purchased required the extraction and use of natural resources for its production.
It may contain hazardous substances that could impact health and the environment.

To avoid the potential release of those substances into the environment and to diminish the need for the
extraction of natural resources, Ross Video encourages you to use the appropriate take-back systems.
These systems will reuse or recycle most of the materials from your end-of-life equipment in an
environmentally friendly and health conscious manner.

The crossed-out wheeled bin symbol invites you to use these systems.

If you need more information on the collection, reuse, and recycling systems, please contact your local or
regional waste administration.

You can also contact Ross Video for more information on the environmental performances of our products.



Company Address

Ross Video Limited 

8 John Street
Iroquois, Ontario
Canada, K0E 1K0

Ross Video Incorporated 

P.O. Box 880
Ogdensburg, New York
USA 13669-0880

General Business Office:

Fax:

(+1) 613 · 652 · 4886

(+1) 613 · 652 · 4425

Toll Free Technical Support: 1-844-652-0645 (North America)

+800 3540  3545 (International)

Alternately, you can contact:

Technical Support: (+1) 613 · 652 · 4886

After Hours Emergency: (+1) 613 · 349 · 0006

E-mail for Technical Support: techsupport@rossvideo.com

E-mail for General Information: solutions@rossvideo.com

Website: http://www.rossvideo.com

mailto:techsupport@rossvideo.com?Subject=Information Request&Body=Hi,%0D%0D
mailto:solutions@rossvideo.com?Subject=Information Request&Body=Hi,%0D%0D
http://www.rossvideo.com
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Introduction

XPression Maps is available in three configuration packages to enable video content creators to build and
deliver engaging and detailed map graphics for their live video productions. 

· XPression Maps Designer: XPression Maps Designer is a stand-alone application for creating map
graphics content using stylized vector-based imagery or aerial satellite imagery from Microsoft Bing
Maps for Enterprise, NASA's Blue Marble Project, Microsoft Azure Maps, Mapbox and OpenStreetMap.
Using the XPression Maps Designer Workflow , the design, content, and delivery of map graphics is
centralized to the Art department. Graphic designers use the XPression Maps Software to create
scenes that act as templates for producing still or animated map graphics representing global, national,
state, city, or street-level details. When requested, graphic artists modify the content of the templates
to produce finalized map graphics and output them as still images or video files for download or
integrated XPression MOS workflow tools. 

· XPression Maps Server: XPression Maps Server centralizes map graphic design and storage, enabling
teams to produce and deliver finalized map graphics. For MOS-enabled newsrooms, the XPression Maps
MOS Workflow  uses the XPression Maps Software to create scenes that act as templates for still or
animated map graphics depicting anything from global views down to street-level detail. These
templates are stored centrally on the XPression Maps Server. Through the XPression Maps HTML5
Client, authorized MOS newsroom users can remotely access and customize template content to quickly
generate story-specific map graphics. The resulting graphics can be exported as images or videos, or
directly integrated into newsroom rundowns using XPression MOS workflow tools. This MOS-specific
workflow ensures that newsrooms can deliver engaging, high-quality map-based story telling while
maintaining brand consistency. 

· XPression Maps Touch: XPression Maps Touch is a licensed extension of the XPression Maps
software that enables graphic designers to create interactive map presentation projects featuring
touch-enabled elements and user-defined macros for real-time control of content and navigation. Each
project can include up to ten destination scenes and one home scene, with scene transitions as cuts or
animated flight paths. Scenes can be designed as still or animated maps and can incorporate graphical
elements such as icons, text, and shaded regions, many of which can be dynamically updated by linking
them to external data sources or macros. During a production, presenters can operate the presentation
directly using an on-set touchscreen display, or using the XPression Maps Touch Controller
application on a tablet. Alternatively, a member of the production team can control the presentation
remotely using either the XPression Maps Touch software or the Touch Controller application. See
About the Interactive Workflow  and the XPression Maps Touch User Guide for more information.
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About This Guide

This user guide was designed to help graphic designers navigate and use the XPression Maps software to
create and deliver high-quality, detailed maps graphics for video productions. 

« This guide primarily focuses on the features and functionality of the XPression Maps software when

using the XPression Maps Designer  and XPression Maps MOS  workflows. For information related
to the Interactive  workflow, please consult the XPression Maps Touch User Guide.

To get started, we recommend reading the Introduction  and XPression Maps workflows  sections to
identify which of the three primary workflows aligns best with your creative and business needs. Once
you've chosen a workflow, use the workflow's guidelines to launch XPression Maps  and familiarize
yourself with the features and functions of the XPression Maps user interface . 

« XPression Maps offers two user interface themes: Classic and Dark. This user guide primarily features

screenshots and images captured in Dark mode. 

In the Setting Up XPression Maps  section, you'll find guidance on configuring and personalizing the
software according to your preferences. Note, however, that this guide does not cover installation or
integration of XPression Maps hardware and software with the XPression graphics system. For such
information, please refer to the XPression Maps Software Installation Guide.

Due to the unique demands of different creative and business requirements, the remaining sections of this
guide outline the features and tools within XPression Maps, breaking them down into step-by-step
instructions. Use these resources to learn how to build, control, and customize map scenes and templates
effectively.

For any further operational questions, please contact us at the numbers listed in Contacting Technical
Support . Our technical team is always available for consultations, training, and support.

6 9
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Documentation Conventions

Special text formats are used in this guide to identify parts of the user interface, text that a user must
enter, or a sequence of menus and sub-menus that must be followed to reach a particular command.

Bold text Bold text identifies a user interface element such as a dialog box, menu item, or
button.

For example:

In the Slug column, type a slug name for the story.

Italic text Italic text is used to identify the titles of referenced guides, manuals, or
documents.

For example:

For more information, refer to the DashBoard User Guide.

Courier text Courier text identifies text that a user must type.

For example:

In the Username box, type postgres.

Menu Sequences Menu arrows are used in procedures to identify a sequence of menu items that
you must follow.

For example:

If a step reads Server > Save As, you would select the Server menu and then
select Save As.

Hypertext Identifies a hyperlink to a related topic.
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Getting Help

XPression Maps documentation is available online at Product Documentation and is also accessible on the
product USB key and by selecting the Help icon in the user interface.

Contacting Technical Support

At Ross Video, we take pride in the quality of our products, but if problems occur, help is as close as the
nearest telephone.

Our 24-hour Hot Line service ensures you have access to technical expertise around the clock. After-sales
service and technical support is provided directly by Ross Video personnel. During business hours (Eastern
Time), technical support personnel are available by telephone. After hours and on weekends, a direct
emergency technical support phone line is available. If the technical support person who is on call does
not answer this line immediately, a voice message can be left and the call will be returned shortly. This
team of highly trained staff is available to react to any problem and to do whatever is necessary to ensure
customer satisfaction.

Technical Support:

· 1-844-652-0645 (North America)

· +800 3540 3545 (International)

· After Hours Emergency: (+1) 613-349-0006

· E-mail: techsupport@rossvideo.com

· Website: http://www.rossvideo.com

https://www.rossvideo.com/support/product-documentation
mailto:techsupport@rossvideo.com
http://www.rossvideo.com
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XPression Maps Workflows
XPression Maps is available in three package configurations tailored to different production use cases. Each
configuration supports unique workflows for creating, storing, and delivering map graphics and
presentations.

The following topics are discussed in this section:

About the XPression Maps Designer Workflow

About the XPression Maps MOS Workflow

About the Interactive Workflow

6
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About the XPression Maps Designer Workflow

The XPression Maps Designer Workflow centralizes the design, content, and delivery of map graphics.
Graphic designers use the XPression Maps software to create scenes that act as templates for producing
still or animated map graphics representing global, national, state, city, or street-level details. When
requested, graphic artists modify the content of the templates to produce finalized map graphics and
output them as still images or video files for download or integrated with XPression MOS workflow tools.

Given the versatility of XPression Maps software and the distinct nature of your creative and business
requirements, defining a standard usage procedure can be challenging. However, the following topics
provide a basic framework for creating and delivering map graphics using the full-service workflow. Use
the links for detailed guidance, or contact a Ross Video representative for further support.

Creating a Still Image Map Scene  

Creating an Animated Map Scene

Creating a Still Image Map Scene

The following procedure outlines how to create map scenes that can either be output as a finalized still
image file, or saved as a reusable still image template.

To create a still map scene as a reusable template or output as a finalized image file:

1. Launch XPression Maps and open a new or existing scene.

Ø Launching XPression Maps

Ø Opening a Scene

2. Select a map style. 

If the current selection of map styles does not meet your needs, edit or create a new map style.

Ø Editing Map Styles

3. Position the map on the Canvas to display the location and camera view required.

Ø Determining Map Location and Positioning

4. (Optional) Add drawings, shapes, and other objects to the scene.

Ø Types of Drawings

Ø Adding and Configuring Drawings

Ø Adding and Configuring Shapes

Ø Adding a Measured Distance Text Drawing

5. (Optional) Link a data source to a shape or drawing that has been added to the scene.

Ø Linking Data Sources to Shapes, Drawings and Container Drawings

6. (Optional) Add an overlay layer to the scene to display persistent drawings.

Ø Adding Drawings to an Overlay Layer

6

7

11

57

68

120

134

189

226

218

258

220



XPression Maps User Guide (v4.0) XPression Maps Workflows • 7

7. Save the changes to the scene. 

The saved scene can also be used later as a template for creating customized versions of the scene.

Ø Saving a Scene

8. Create an image file ( .jpg, .png or .tga) of the map scene.

Ø Creating a Static Map Image File

Creating an Animated Map Scene

The following procedure outlines how to create map scene animations that can be saved as a video file or
as single-frame still images. Alternatively, the map scene can be designed and saved as a reusable
template, allowing for the creation of customized versions with story-specific content and behaviors.

To create an animated map scene as a reusable template or output as a finalized video or still
image file:

1. Launch XPression Maps and open a new or existing scene.

Ø Launching XPression Maps

Ø Opening a Scene  

2. In the Animation Editor, set the duration for the animation.

Ø Setting the Animation Duration

3. Add a first camera Key Frame to establish the initial camera view and map style.

If the current selection of map styles does not meet your needs, edit or create a new map style.

Ø Adding Camera Parameters Key Frames

Ø Assigning an Animated Map Style

Ø Editing Map Styles

4. Add additional camera Key Frames to create flights and effects, or to change the map style during the
animation.

Ø Adding Camera Parameters Key Frames

Ø Assigning an Animated Map Style

5. Add drawings, shapes, and other objects to the scene.

Ø Types of Drawings

Ø Adding and Configuring Drawings

Ø Adding and Configuring Shapes

Ø Adding a Measured Distance Text Drawing

6. If you want to animate the object's behavior, like visibility, scale or progress, then add drawing Key
Frames that change the object's properties at different frames along the animation timeline.

Ø Adding Drawing Key Frames
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7. Link a data source to a shape or drawing that has been added to the scene.

Ø Linking Data Sources to Shapes, Drawings and Container Drawings  

8. Add a pause to the animation.

Ø Adding a Pause to an Animation

9. Add an overlay layer to the scene to display persistent drawings.

Ø Adding Drawings to an Overlay Layer

10.Save the changes to the scene.

The saved scene can also be used later as a template for creating customized versions of the scene.

Ø Saving a Scene

11.Preview the playback of the animation.

Ø Previewing Animation Playback

12.Create a video file of the animation or an image file of a specific frame in the animation.

Ø Creating an Animated Map Video

Ø Creating a Static Map Image File

258
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About the XPression Maps MOS Workflow

The XPression Maps MOS Workflow centralizes map graphic design and storage, while allowing multiple
users to remotely produce and deliver finalized map graphics for download or integration with XPression
MOS workflow tools.

The workflow begins with graphic designers in the Art department using the XPression Maps software to
create map scene templates. The scene templates lock down design elements by assigning a map style
and an initial camera view. If the scene template is intended to be used to create animated map graphics,
then it may also include one or more flight points to produce an initial flight animation. The scene
templates are then organized into template groups, where designers can again control design standards by
adding pre-approved location labels, drawings, shape styles, and user predefined objects for use with the
scene templates in the group. The scene templates are centrally stored on an XPression Maps server
where authorized MOS newsroom users can remotely access them through the XPression Maps HTML5
Client. 

When newsroom users need to create a story-specific still map graphic, they can load a scene template in
the XPression Maps HTML5 Client and complete the scene by positioning the map to a specific camera
view and adding objects from the template group. Or, they can create a story-specific animated map
graphic by editing, adding or removing flight points, as well as adding objects from the template group.
The modified scenes are stored in the system and can be output as image or video files that can be
downloaded or integrated with XPression MOS workflow tools.

The following sections provide information about creating scene templates and scenes:

· Creating and Managing Scene Templates  - Discusses how graphic designers use the XPression Maps
software to create and store scene templates that define the map style, flight points, and pre-approved
objects for still or animated map graphics.

· Creating and Managing Scenes in the HTML5 Client  - Discusses how MOS newsroom users load and
edit scene templates in the XPression Maps HTML5 Client to create scenes that produce story-specific
still or animated map graphics, which can be rendered and downloaded as image files, video files, or
transferred for integration with a MOS News graphics system.

314

345
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About the Interactive Workflow

The XPression Maps Interactive Workflow enables graphic designers to create projects to produce
interactive map presentations featuring touch-enabled elements, user-defined macros, and dynamic data
sourcing for real-time control of content and navigation.

The workflow begins in the Art Department, where graphic designers use the XPression Maps Touch
software in Interactive Mode to build an interactive map project. This involves designing the following
scene types:

· Main Overlay Scene – A persistent, transparent top-layer scene that includes touch-enabled controls
linked to user-defined macros. These controls typically allow presenters to navigate the presentation
(e.g., return to the Home Position), adjust visual settings (e.g., zoom level), or toggle tools and features
(e.g., telestration). This scene may also include branding graphics that remain visible throughout the
presentation.

· Home Position Scene – A predefined starting or reset scene that applies an animated flight transition
to return the map to a specific reference location. This provides a consistent entry point for the
presentation.

· Destination Scenes – Up to ten destination scenes can be created with scene transitions animated as
cuts or flight paths. These scenes can be designed as still or animated maps and can incorporate
graphical elements such as icons, labels, and shaded regions, many of which can be dynamically
updated by linking them to external data sources or macros. 

During a production, the presentation can be operated directly by the presenter using an on-set
touchscreen display or a tablet running the XPression Maps Touch Controller application. Alternatively,
a member of the production team can manage the presentation remotely using the Touch Controller
application.

Since the XPression Maps interactive workflow introduces specialized tools, concepts, and procedures
for creating and controlling interactive map presentations, we recommend referring to the XPression
Maps Touch User Guide for detailed instructions and best practices.
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Launching XPression Maps

To launch XPression Maps, double-click on the XPression Maps desktop icon  or right-click on the
XPression Maps desktop icon and select Open.

« By default, the last loaded layout appears when you launch XPression Maps.
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XPression Maps User Interface
The XPression Maps user interface offers intuitive access to all of the software's features and functions.
Key elements include menus, toolbars, and the Canvas, along with various dialogs and floating windows
for tools and editors that support building and managing map scenes and animations.

« XPression Maps offers two user interface themes: Classic and Dark. This user guide primarily features

screenshots and images captured in Dark mode. For instructions on switching between UI styles, refer
to Changing the UI Style - Classic or Dark . 

While XPression Maps provides a default interface layout, you can customize it to fit your workflow by
showing, hiding, and rearranging elements as needed. Your personalized layout can then be saved and
used as your preferred interface setup.

The following topics describe the main elements of the XPression Maps user interface: 

Overview of the User Interface

Menus

Toolbars

Editors and Panels

The Canvas

Changing the UI Style - Classic or Dark

Managing User Interface Layouts
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Overview of the User Interface

The following screen capture displays the main elements of the XPression Maps user interface.
Descriptions of individual elements are contained in the table below the diagram, and elaborated upon in
separate topics below.

XPression Maps User Interface 

1. Menus: Used to access the File, Edit, Style, Custom,
Output, Animation, Interactive, View and Help menus.

2. Toolbar: Used to access XPression Maps tools and
some operational functions.

3. Shape Editor, Drawing Editor and Search Editor:
Used to create shapes, edit drawings, and search for
map locations.

4. Canvas: Acts as the main workspace/canvas and
displays the map scene for output. Also includes
controls for selecting and configuring the camera
view.

5. Animation Editor: Used to build and control map
scene animations.

6. Drawings Overview, Bookmark Editor: Used to
organize, and edit drawings in a map scene, and
create bookmarks.

7. Drawing Toolbox, User Predefined Objects, OSM
(OpenStreetMap) Style Editor, Flight Points and
Log Information: Used to customize OpenStreetMaps,
create, edit and add drawings and flight points and to
view log information.

8. Map Styles and Download Information: Used to
select map styles and view map download
information. 

9. Scene Comments and Area Line Edit Options: Used
to add a description or usage instructions for the scene.
Used to lock OSM Layers to OSM Map Styles. 

10. Camera Control Editor: Provides access to camera
parameters, overlay parameters, and the Safe Area
setting. 
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Menus

The menus in XPression Maps are organized by function, providing access to a wide range of features and
tools within the application. As with many software programs, there are multiple ways to access a
particular tool or function in XPression Maps—whether through menu commands, toolbar buttons, or
keyboard shortcuts.

The following summarizes the primary functions of each menu:

· File

The File menu contains options for opening new or existing scenes or interactive project files on the
Canvas, as well as exporting or saving these files. It also includes the Preferences option, which
allows you to configure the application's output, data, connectivity, and other operational settings.

· Edit

The Edit menu gathers many of the standard editing tasks like undo/redo the most recent changes,
copy/cut/paste or arranging drawings and editing tasks like adding, deleting and moving from one Key
Frame to another. The DataLinq Setup option allows you to add data sources and configure how data is
displayed on the scene. The Edit menu also includes options for reloading the active map and selecting
disputed borders.

· Style

The Style menu provides access to tools used for managing the map styles and shape styles and
overwriting scene properties. 

· Custom

The Custom menu provides access to editors that allow you to import and manage a limited set of asset
files to be used as a custom area, line shapes, or map data.

· Output

The Output menu offers several options for creating and managing the output of your map scenes
including creating a still image file or an animated clip file. Additionally, the Export Map option allows
you to export the map scene file to another system. If you are creating scene templates and scenes for
the server workflow, the Manage Templates and Edit Saved Templates options allow you to manage
the scenes and templates used in the XPression Maps HTML5 Client application.   

· Animation

The Animation menu contains the playback controls for previewing and playing map animations on
Canvas.

· Interactive

The Interactive menu only appears when XPression Maps is running in Interactive Mode. It contains
options to switch to the project's overlay layer, home position scene and destination scenes when
designing an interactive project. Other options allow you to edit your projects, manage your interactive
scenes, or execute a project for presentation.

When XPression Maps is running in Interactive Mode, the File menu includes options to create, load,
and save Interactive projects. 

· View

The View menu contains options for changing the Canvas to fullscreen mode and for showing or hiding
the various editors, controls and toolbars. You can also reset the XPression Maps User Interface to its
default screen.

· Help

The Help menu contains the About screen which provides version, copyright and licensing information
for the XPression Maps application.
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Toolbars

The toolbars in XPression Maps are grouped by function, providing quick access to frequently used features
and tools for building and controlling map scenes and interactive projects. By default, the toolbars are
docked at the top of the interface, but you can also drag them out to create floating toolbars. You can
control which toolbars are visible by right-clicking the upper toolbar panel and selecting or deselecting
options in the context menu, or by using the View menu options. See Showing or Hiding an Editor,
Control, or Toolbar  for more information.

The following list summarizes the primary functions of each toolbar and its buttons:

· File Toolbar

The File toolbar contains buttons for creating a new scene or loading an existing scene file onto the
Canvas. The Save button allows you to save the latest changes made to the scene currently loaded on
the Canvas.

File Toolbar - New, Open Scene, Save

· Edit Toolbar

The File toolbar contains buttons for undoing and redoing the most recent changes.

Edit Toolbar - Undo, Redo

· Map Styles Toolbar

The Map Styles toolbar contains a single button that opens the Map Style Manager, which is used for
managing the system's map styles, as well as editing the properties of map styles.

Map Styles Toolbar - Map Styles

· Output Toolbar

The first three buttons in the Output toolbar are used to create an output file of the scene as either a
still image or an animated clip file. The last two buttons are used to manage and edit the scenes and
templates that are used in the XPression Maps HTML5 Client application. 

Output Toolbar - Snapshot, Record Animation, Stop Animation Recording, Manage Templates, Edit Saved
Templates

· Drawing Layer Toolbar

The Drawing Layer toolbar contains buttons for arranging drawings on the various layers of the map
scene. The last button opens the Measurement Tool, which allows you to calculate the distance
between two points on the map, as well as add a measurement (text and circumference) drawing.

Drawing Layer Toolbar - Move Drawing To Top, Move Drawing Up, Move Drawing Down, Move Drawing To
Bottom, Measurement Tool

34
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· Inset Toolbar

The Inset toolbar displays Not Active until an inset drawing is selected on the scene's Canvas. Once
the Inset drawing is selected, the control allows you to toggle between Enter Full Screen or Leave Full
Screen to either display the scene's main map or the inset's map. 

Inset Layer Toolbar - Inset > Not Active, Enter Fullscreen, Leave Fullscreen

· System Status Toolbar

The System Status toolbar displays progress bars for tracking the computer's main, GPU and App
memory usage. Selecting the Browse button opens the Memory Information dialog, which allows you
to enable and configure a memory log file.

System Status Toolbar - Memory > Main, App, GPU, Browse

· Interactive Toolbar

The Interactive toolbar only appears when XPression Maps is running in Interactive mode. This toolbar
provides you with a quick way to switch to the project's overlay layer, home position scene and
destination scenes when designing an interactive project. It also provides a means to manage your
interactive scenes and execute a project for presentation.

Interactive Toolbar - Manage Interactive Scenes, Execute, Main Overlay, Home Position, Scenes 1 - 10
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Editors and Panels

By default, many of the tools and editors required for building and controlling map scenes and animations
are arranged around the Canvas. These include dialogs and windows that can be shown or hidden, and
can be docked or left floating within the layout to suit your workflow and preferences. See Managing
Layouts  for more information.

The following sections summarize the location and primary functions of the main editors or panels that
normally surround the Canvas:

Animation Editor

Area Line Edit Options Panel

Bookmark Editor

Download Information Panel

Drawing Editor

Drawing Management Editor

Drawings Overview Panel

Drawing Toolbox

Flight Points Editor

Log Information Panel

Map Styles Panel

OSM Overview Panel

OSM Style Editor

Scene Comment Panel

Search Editor

Shape Editor

User Predefined Objects Panel

34
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Animation Editor

The Animation Editor is located below the Canvas. It allows you to create and control map animations.
Map animations are created by adding camera and drawing Key Frames to the timeline to change the
elements and properties of the map. When the animation is played back, the transition between the state
of the properties creates the animation effects, like location or zoom flights, transitions from one map style
to another, or the appearance and disappearance of drawings. See Creating Animations  for more
information.       

Animation Editor

Area Line Edit Options Panel

The Area Line Edit Options panel is usually located beside the lower-right corner of the Canvas. When
adding a drawing to a scene, you adjust its shape by dragging its handles and borders. Before adding a
drawing to the scene, use the Area Line Edit Options panel to set options that determine how you can
manipulate the drawing's shape and position on the map. See Adding and Editing Area Drawings  and
Adding and Editing Line Drawings  for more information.

Area Line Edit Options Panel

Bookmark Editor

The Bookmark Editor is usually located to the upper-right of the Canvas. It allows you to save map
positions as presets and organize them in folders for the easy recall of commonly used locations. See
Recalling a Bookmarked Location  for more information.

Bookmarks can also be used to add a pause to a flight when creating a scene template animation.

Bookmark Editor
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Download Information Panel

The Download Information panel is usually located to the right of the Canvas. It displays the map
download activity.

Download Information Panel

Map requests are scheduled for download and up to 30 map downloads can be active at the same time.
The progress bar in the panel displays how many map parts remain to be downloaded. The progress bar
can display the following colors:

Green — low load

Orange — all download links in use

Red — high load

Values higher than 100 on the progress bar can result when you play a camera animation for the first
time, when the quality of the map has a value greater than 0, or when the globe is tilted to a small
viewing angle.

« Zooming in from the satellite view to the street level view of a city will go through many map zoom

levels and all visible map parts need to be downloaded first.
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Drawing Editor

The Drawing Editor is usually located to the left of the Canvas. It allows you to modify the parameters of
a selected drawing that has been added to the scene on the Canvas. If a parameter is greyed out, it
doesn’t apply to the selected drawing. See Configuring Drawing Parameters  for more information.

Drawing Editor

204
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Drawing Management Editor

The Drawing Management Editor shown below, is a pop-up menu that is accessed through the Edit
menu or by selecting the button adjacent to the Drawing Tools Group selector pull-down menu. Unlike a
docked panel, this editor opens as a separate window when invoked. It is used to select, modify and
manage drawings. You can also create new drawing assets and organize them into groups for convenient
recall in the Drawing Toolbox. See Managing Drawings  for more information.

Drawing Management Editor

Drawings Overview Panel

The Drawings Overview panel contains any drawings that have been added to a scene. Each drawing is
listed with an icon that identifies which group it belongs to. See images below. Using the checkboxes and
context menu options in the Drawings Overview panel, you can show/hide the drawing in the scene, as
well as delete drawings from the scene.  See Showing or Hiding Drawings  and Deleting a Drawing from
the Scene  for more information. 

You can also change the name of a drawing that's been added to the scene. See Renaming a Drawing
for more information.

Drawings Overview Panel
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Drawing Toolbox

Use the Drawing Toolbox located to the right of the Canvas, to add drawings from the database to a
scene, to create a new drawing or to edit an existing drawing. See Adding and Configuring Drawings  for
information on the setup and management of drawings. 

You can also use the Drawing Toolbox to designate a drawing as a default drawing, to be used whenever
drawings are generated automatically. It also allows you to quickly add that default text, icon or dynamic
data drawing to a search location using the Search Editor's Add To Map options. See Adding a Default
Drawing to a Search Location  for more information. 

Drawing Toolbox

Flight Points Editor

The Flight Points Editor is usually located to the right of the Canvas and it is only used as part of the
XPression Maps Server workflow. It allows you to create a flight animation in a scene template in which
the map moves from one location to another, by adding a starting flight point. When the scene template is
opened in the XPression Maps HTML5 Client, additional destination flight points can be added according to
the story requirements. Refer to the XPression Maps Server User Guide for more information.

« These flight animations are not recorded on the Animation Editor's timeline in a regular scene

animation.

Flight Points Editor
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Log Information Panel

The Log Information panel displays information based on the Log Level selected in Preferences >
Output . 

To filter the level of information displayed, select from the Log Level drop-down the level of information
you want to see generated.

The options are:

· Critical - Logs activity that could result in unpredictable behavior.

· Error (Default) - Logs errors only.

· Warning - Logs unsuccessful operations.

· Information - For internal use only, for technical support.

· Debug - For internal use only, for technical support.

Select the Clear button to clear the log information when the information is no longer needed.

Log Information Panel

Map Styles Panel

The Map Styles panel is usually located in the lower-right of the Canvas. It allows you to select and
assign a map style to a scene from a list of system or customized map styles. Use the controls in this
panel to determine if the scene's map style assignment is either animated (changes at specific set points
during the map animation's playback), or automatic (changes at specific map zoom layers).  See
Managing and Assigning Map Styles  for more information.

 Map Styles Panel

37
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OSM Overview Panel

The OSM Overview panel lists all OSM elements currently visible on the Canvas. You can browse the
entries using the tree structure or refine your results with the Filter field. Use the Aa button to toggle
case-sensitive filtering, and the Vis button to choose whether filtering applies only to elements visible in
the current map view or to all OSM data loaded in the scene. Selecting an entry automatically centers the
map on that location, and the panel is updated with the corresponding values. 

OSM Overview Panel

OSM Style Editor

The OSM Style Editor allows you to customize scenes that use OpenStreetMaps as the map style.

Use the OSM Style Editor shown below, to change the background color of an OSM map, as well as the
visibility, colors, parameters and labels of the layers of the selected map or its overlay. The elements are
grouped into categories to make them easier to find. See Editing OpenStreet Maps  for more
information.

You can also convert the language used for the labels. 

OSM Style Editor

85
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Scene Comment Panel

The Scene Comment panel allows you to enter a text that is saved with the scene file. This can be used
to provide other users with a description of the scene or usage instructions. 

Scene Comment Panel

Search Editor

The Search Editor allows you to find maps of locations throughout the world by searching for addresses,
cities, countries and even prominent buildings. See Searching for a Location . You can also add default
names, addresses, icons or dynamic data drawings to the scene and add a shape layer to the country,
state, or region identified in the search results. See Adding a Default Drawing to a Search Location  and
Adding and Configuring Shapes .

Search Editor
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Shape Editor

XPression Maps comes with a library of national and interstate borders from around the world, allowing
you to fill in one or more countries, states or regions with color for greater emphasis. The Shape Editor
displays a list of all the shapes that have been added to the current scene. Use the Shape Editor to
modify the parameters of the shapes. See Adding and Configuring Shapes  for more information.

The upper portion of the Shape Editor displays a list of all the shapes that have been added to the

current scene. Icons indicate if the shape is a country ( ), a state ( ), or a region ( ). Each shape is
on its own layer and the order of the list corresponds to the order of the layers, where the first line is the
back (or bottom) layer and the last line is the front (or top) layer. You can rearrange the list by dragging
and dropping shapes from one position to another, however children shapes can not be rearranged.

Right-clicking on a shape in the list displays the following menu options:

· Go to Shape on Map — Adjusts the view of the camera so that the shape is centered on the Canvas.

· Load Children — Loads the children shapes (states or regions) of a country or state shape that has
already been added to the map.

· Delete — Deletes the selected shape from the current scene.

The fields below the shape list allow you to change the appearance of an individual shape by applying a
different predefined style to the shape or overwrite certain parameters, like color, opacity, or visiability.
You can also use these fields to change the appearance or behavior of the shape during an animation, link
the shape to a dynamic data source, or react to an interactive event.

Shape Editor

226
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User Predefined Objects Panel

The User Predefined Objects panel is used in the creation, management, and use of user predefined
objects — custom, reusable map objects that combine shapes with additional drawings—such as areas,
icons, lines, and text into a single object that can easily be added to a scene. 

This tool is also used to create Disputed Border alterations, which allows you to represent sensitive or
contested boundaries on a map.

For more information, see Creating User Predefined Objects .

User Predefined Objects Panel

285
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The Canvas

The Canvas is located at the center of the XPression Maps user interface and acts as the workspace in
which to build and preview the playback of map scenes.

On the Canvas, you can:

· move and zoom into any location of the world using the mouse, camera parameters, or by entering a
location in the Search Editor. See Determining Map Location and Positioning  for more information.

· add various drawings, shapes, and user predefined objects to the scene.

· preview and control the playback of animated map scenes. See Creating Animations  for more
information.

«The perspective of what is seen on the Canvas is often called the camera view, as it represents the

point of view of what will be recorded or seen on air. Similarly, the camera parameters (described
below) define the geographical location, view angle and depth of the camera view displayed on the
Canvas. 

The Canvas

«The first time you launch the application, the Canvas displays the world globe at a random location.

Subsequently, when you launch the application, the map opens and displays the map style and location
that was being used when the application was last closed.

The following controls appear below the Canvas:

· Camera Parameters - Displays and allows you to adjust the current values for the camera parameters
(Zoom Level, Longitude, Latitude, Tilt, Roll, and Pause Duration). Also, allows you to add camera
Key Frames to the scene's animation timeline based on individual camera parameter settings. The Lock
button prevents both the parameters and the Canvas from being modified or moved. See Adjusting
Camera Parameters  and Adding Camera Parameters Key Frames  for more information. 

· Safe Title and Safe Area - Configures the Canvas's boundary frames which ensure that all the map
scene's location, drawings and information remain inside the area that visible on air. See Configuring the
Safe Title and Safe Area  for more information.
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· Camera Selection and Overlay - Selects which of the five available camera views or overlay layer is
active and displayed in the Canvas. See Selecting the Camera View  for more information.

Other tasks related to the Canvas are:

Reloading the Active Map

Entering and Exiting Full Screen Mode

Selecting the Camera View

In the camera selection area you can switch between five different camera views: View Camera, Work
Camera 1, Work Camera 2, Work Camera 3 and Work Camera 4. The selected camera view is
indicated by a red outline.

Camera Selection

View Camera displays what will be recorded. You can enable the Overlay Layer only when this camera is
selected. 

The other four camera views are the working cameras. These camera views can be used to store other
views during editing. For example, if you want to extend an animation to cover a wider area than can be
seen in the View Camera, you can do that in a Work Camera. Key Frames used to animate the scene are
added in the View Camera. The Camera Key Frame button is disabled when a Work Camera is
selected. Only the view in the working camera is copied to the View Camera, not objects added in the
Work Camera.

To set a specific camera view:

1. Select one of the Work Cameras.

2. Move the map to the location you want to display in that camera view. 

3. Add drawings to the scene if required or extend a line animation.

The scene will be saved in the selected Work Camera and can be copied to the View Camera when
needed.

When you save the scene, any Work Camera views are saved as well.

To switch to a different camera view: 

· Select the corresponding button.

To copy a camera view:

· Drag and drop one camera view button to another camera. 

The destination camera becomes the active camera and has the same view as the source camera. This is
useful if you want to save the current camera view before making changes.
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Configuring the Safe Title and Safe Area

The Safe Title settings allow you to configure the position of the safe area, map attribution and logo on
Canvas.

The Safe Area is the area within the Canvas borders defined by the white rectangles. Keep all your
drawings and information inside this area for full visibility on air. Also, when Action Safe is selected, the
center of the Canvas is marked with crosshairs.  This is a useful tool for centering the area of interest in
the scene.

Safe Title / Safe Area

To configure the Safe Title / Safe Area:

1. Select the Settings icon  beside the Safe Title drop-down.

The Safe Title Management Editor opens.                                                                                   
                                                                       

Safe Title Management Editor
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2. Select New to set up a new configuration.

3. In the Name field, enter a name for the new configuration.

The default safe title, Full Screen is applied automatically when new scenes are created. 

4. Select the Image checkbox to choose a saved background image from the Image drop down. 

For more information on importing images refer to Managing Drawings . 

5. In the Action Safe section, use the arrows or enter a value in the Left, Right, Lower and Upper
fields to adjust the size of the outer rectangle.

Entering values of 0.00 in all these fields will make the entire Canvas a safe area.

6. In the Title Safe field, use the arrows or enter a value to adjust the size of the inner rectangle (the
inner rectangle in the image above). 

The map provider logo and attribution text can only be positioned within the Title Safe area.

7. The Center Cross checkbox relocates the scene's center to the middle of the Safe Area. This ensures
that search results appear at this position and aligns interactive actions, such as Fly to Shape, so that
the shape is centered neatly within the Safe Area. 

8. In the Attribution section, use the arrows or enter values in the Position X and Y fields to adjust the
location of the attribution text within the inner rectangle.

You can also left-click and drag the attribution on the Canvas (while the Safe Title Management
Editor is open) to position it. 

9. In the Map Provider Logo section, use the arrows or enter values in the Position X and Y fields to
adjust the location of the map provider's logo within the inner rectangle.

You can also left-click and drag the logo on the Canvas (while the Safe Title Management Editor is
open) to position it. 

«Some map providers require their logo to remain visible on air at all times. If the selected Map Style

does not use one of these providers, the parameters in this section are disabled.

10. When you have the configuration you want, select Done to save it.

You can create as many different Safe Title / Safe Area configurations as you need.
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Reloading the Active Map

Use the Reload Active Map menu option to refresh the current map. This is useful if your scene is
missing map tiles or displaying map tiles remaining from a previous map. 

To reload the active map:

· From the menu bar select Edit > Reload Active Map.

Entering and Exiting Full Screen Mode

In the XPression Maps interface, the Canvas typically appears as the central window, surrounded by
various editors, menus, and toolbars. However, for tasks such as previewing scene playback or controlling
an interactive project, it can be helpful to enter full-screen mode. This mode expands the Canvas's
preview pane to fill the entire screen, providing an enlarged viewing area and absent of any unnecessary
components. 

To enter fullscreen mode:

· From the menu bar select View > FullScreen or press the F11 key on the keyboard. 

To change to windowed mode:

· Press the Esc key.

« When XPression Maps is running in Interactive Mode, entering Full Screen also starts Interactive

Execution Mode. Exiting Full Screen does not stop execution. This behavior is useful when building
interactive macros.
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Changing the UI Style - Classic or Dark

XPression Maps offers two user interface styles—Classic and Dark. As both styles provide identical
functionality and feature sets, the selection is primarily determined by user preference and environmental
considerations.

User Interface Styles - Classic and Dark

To immediately change the current UI style:

1. From the File menu, select Preferences.

2. In the Preferences window, select the Output tab.

3. In the UI section, use the Style drop-down to select either Classic or Dark.

4. Select Save, and then select OK.

5. In the Restart needed dialog, select Close Now to immediately exit XPression Maps.

Preferences - Restart Needed

« You must restart XPression Maps for the style change to take effect.

6. Relaunch XPression Maps.

The XPression Maps user interface now appears in the selected style.
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Managing User Interface Layouts

To improve productivity and maintain focus, the XPression Maps user interface components (editors, tools,
and panels) can be shown/hidden or rearranged to match your preferences and then saved as custom
layouts. You can create multiple layouts as needed and load the one that best suits your current workflow.
By default, the last loaded layout will automatically appear when you launch XPression Maps.

The following topics are discussed in this section:

Show or hide an editor, control or toolbar

Save a configured layout

Load a configured layout

Delete a configured layout

Reset to the default settings

To show or hide an editor, control or toolbar:

1. From the menu bar select View.

2. In the menu, check the options you want to show and clear the options you don’t require.

To save a configured layout in the XPression Maps user interface:

1. From the menu bar, select View > UI Setup and select Save UI Layout. 

The Save UI Layout window opens.

Save UI Layout Window

2. Enter a name for the new layout and select OK.

To load a configured layout into the XPression Maps user interface: 

1. From the menu bar, select View > UI Setup and select Load UI Layout.

The Load UI Layout window opens.

Load UI Layout Window

2. From the Name drop-down select the name of the layout you want to load and select OK. 

34

34

34

35

35



XPression Maps User Guide (v4.0) XPression Maps User Interface • 35

To delete a configured layout from the XPression Maps user interface: 

1. From the menu bar, select View > UI Setup and select Delete Saved UI Layout.  

The Delete UI Layout window opens.

Delete UI Layout Window

2. From the Name drop-down select the workspace you want to delete and select OK.

The Delete UI Layout confirmation window opens. 

Delete UI Layout Confirmation Window

3. Select Yes.

To reset the XPression Maps user interface to the default setting:

1. From the menu bar, select View > UI Setup and select Reset UI to Default.

The Reset UI to default window opens.

Reset UI to Default Window

2. Select Yes to reset the layout.
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Setting Up XPression Maps
Before using the XPression Maps application, configure its settings in the Preferences window to
customize key features and functions.

The Preferences window contains multiple thematic tabs with different sets of parameters. These
parameters determine many of the features and functionality available in the software, so they should be
configured according to your creative and business needs.

To configure your preferences:

1. From the menu bar, select File > Preferences.

2. Select the tabs to edit the parameters, as described in the following sections:

Output

Map

Web Interface

Connection

Proxy

Data (Option)

Video I/O (Option)

Interactive (Option) For details on using XPression Maps in Interactive Mode please refer to the
XPression Maps Touch User Guide. 

3. Select Save to save changes you’ve made to the parameters.

4. When you are finished editing your preferences, select OK to apply the changes and close the
Preferences dialog.

« IMPORTANT - Some changes require restarting XPression Maps.

· Select Close Now to close the application immediately, then reopen it from the desktop icon to apply
the changes. 

· Alternatively, select Close Later to continue working; the changes will not take effect until the
application is restarted. 

XPression Maps Preferences - Restart Needed
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Output Preferences

In the Output tab of the Preferences window, you can select the screen resolution and recording format,
enable or disable various settings, specify the location and level of detail for the log file, and set the UI
Layout Data file.

«The Output Preferences should only be set once and match your facility's broadcast standard. Do not

change these settings after it is configured.  If you are unsure of your facility's broadcast standard, consult
your engineering or operations team before making any changes.  

Preferences - Output Tab

To edit the Output parameters:

1. Open XPression Maps and select File > Preferences.

2. Select the Output tab.

3. In the Screen section, from the Resolution drop-down, select the video resolution and frame rate
used by your facility.

4. In the Video Creation section, from the Field Render drop-down, select whether to render the Upper
Field First or Lower Field First. The drop-down is available only when the selected screen resolution
is an interlaced format.

5. In the Misc section, select Start in Interactive Mode to use the XPression Maps Touch workflow. 

For details on using XPression Maps in Interactive Mode refer to the XPression Maps Touch User
Guide.



38 • Setting Up XPression Maps XPression Maps User Guide (v4.0)

Also in the Misc section, enable the following default behaviors if desired:

· Select Start in Server Mode (Legacy setting — not recommended) — This option is retained for
backward compatibility but should not be used for new configurations. It starts the application
directly in server mode for MOS workflows and minimizes it to the Windows systems tray. 

· Select the Compact Scene on Save checkbox to remove unused map styles from the Map Styles
list and unused shape styles from the Shape style list when the scene is saved or exported. 

This is useful for scenes that are exported to the XPression Maps HTML5 Client for XPression MOS
workflows.

· Select the Enable Shape Editing checkbox to enable shape editing.

· Select the Autofit Fullscreen checkbox to scale the graphics card output for touchscreens so that
you can run HD 1920x1080 on a 1920x1200 monitor. This scales the output to fill the monitor while
maintaining the aspect ratio, with some graphics extending beyond the visible area on the left and
right. When unchecked, the screen fills horizontally, adding black bars at the top and bottom to
preserve the aspect ratio. 

· Select the Load scene using map style from Map Style Database checkbox to enable loading any
map style directly from the Map Style Database rather than from the saved scene. This ensures that
the latest map style from the database is always applied, allowing older scenes to appear with the
updated look. 

In the MOS Scene Template editor, the parameter Use Scene Styles from Database can be set to
override this behaviour if a scene should use a modified map style saved within the scene.

· Select the Limit Map View to Video Size checkbox to match the map view to the video size. 

If unchecked, the map view will be as large as possible. 

· Select the Turn Auto Zoom On for OSM Replacement Drawings checkbox if you generally prefer
to have your replacement labels stay the same size, regardless of the zoom level of the map. 

You can still disable Auto Zoom in the Drawing Editor if necessary in individual cases.

· Select the Invert Mouse Scroll Wheel checkbox to zoom into the map by scrolling forward on the
mouse scroll wheel, and to zoom out of the map by scrolling back on the mouse scroll wheel. 

If unchecked, to zoom into the map you must scroll backward on the mouse scroll wheel, and to
zoom out of the map you must scroll forward.

« If you invert the mouse scroll wheel you will need to restart the XPression Maps application for

the change to take effect. 

6. In the Logfile section, select the Browse ( ) button beside the Location field to navigate to the
location where you want to store the logfile.

The default location is C:\Program Files\XPression Maps\bin64\log\MainLog.txt.
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7. From the Log Priority drop-down, select the level of detail to be stored to the logfile.

Always - Logs a small set of specific information, such as the start time and version number of the
application.

Critical - Logs activity that could result in unpredictable behavior.

Error (Default) - Logs errors only.

Warning - Logs unsuccessful operations.

Information - For internal use only, for technical support.

Debug - For internal use only, for technical support.

Debug2 - For internal use only, for technical support.

8. In the UI Layout section, select the Browse ( ) button beside the File field to select the UI Layout
Data file.

The UI Layout Data file contains saved layout configurations, see Managing Layouts  for instructions
on configuring layouts. 

By default, the File name field will be populated with UILayoutData.json.

9. Select Save and then OK.

10.In the Restart Needed dialog, select Close Now.

11.Restart XPression Maps to apply the changes.

34



40 • Setting Up XPression Maps XPression Maps User Guide (v4.0)

Map Preferences

The Map tab in the Preferences window allows you to configure settings related to map data, including
language, default measurement units, and rendering options. It also provides options to set file paths for
the map database and OpenStreetMap server configuration.

Preferences - Map Tab

To edit the Map parameters:

1. Open XPression Maps and select File > Preferences. 

2. Select the Connection tab.

3. Select the Map tab.

4. In the Country section, from the Code drop-down, select the language/country to be used to view the
maps in. 

The maps will be downloaded in the selected language. The map provider search results will be
displayed in the selected language and the shape labels will take the translation table of the selected
language.

«Changing the language/country does not impact the user interface language.

5. Select the Include English Search Results checkbox when using a language other than English, to
get the best results. The English search results are displayed in magenta in the Search Editor.
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6. In the Rendering section, select the Use MipMap checkbox to render the map tiles with MipMapping
and select the 3D checkbox to enable rendering of maps with the 3D height model.

· MipMapping reduces aliasing artifacts but decreases rendering speed. 

· The 3D height model renders maps that visually indicate elevation.

7. In the Data Configuration section, the File field specifies the location where the information database
file (WNMDBInfo.db) is stored.

The default location is C:\ProgramData\Ross Video\XPression Maps\DB\WNMDBInfo3.0.db.

The information database file is used to resolve all database connections and is configured with the
Map Data Configurator in the subfolder C:\Program Files\XPression
Maps\MapDataConfigurator.

8. In the OSM Server section, select the Browse button ( ) beside the Config File field to navigate to
the location of the external OpenStreetMap tile server configuration file (osm-mapserver-
setup.xml).

The default location is C:\Program Files\XPression Maps\OSMStyles\osm-mapserver-setup.xml.

9. In the Measurement section, from the Default Units drop-down, select either Metric or Imperial as
the preferred system of measurement for displaying values on the maps.

10.Select Save, then select OK.

11.In the Restart Needed dialog, select Close Now.

12.Restart XPression Maps to apply the changes.
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Web Interface Preferences

In the Web Interface tab of the Preferences window, you can set up the XPression Maps web server,
which is used for the MOS newsroom HTML5 Client website. This includes configuring the XPression Maps
server details and the connection information for the XPression Maps Database and Gateway. 

Preferences - Web Interface Tab

To edit the Web Interface parameters:

1. Open XPression Maps and select File > Preferences. 

2. Select the Web Interface tab.

3. In the Web Template Database section enter the parameters for connecting to the database server.

Hostname: The IP address or host name of the computer on which the database is stored. 

Port: The port used to connect to the database server. The default for MySQL/mariaDB is 3306.

Username: Leave the default username as is.

Password: Leave the default password as is.

The Username and Password are used to access the database.

4. If you are using a remote template server, select the Access Remote Template Server checkbox and
then select the Browse button to navigate to the location of the Config File that identifies the server.
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5. In the Web Server Details section enter the parameters for communicating with the XPression Maps
Gateway web server. 

· The WS Client Port is the port on which the web server and client communicate. 

The default Client Port is 8877.

· Select the SSL checkbox to enable the Secure Socket Layer protocol (optional).

If you select the SSL checkbox, you will also need to change the Application Port in the Web
Gateway section to 443.

See Appendix B: Managing Network Security  for more information.

· Select the Browse button beside the Preview Folder field to navigate to the location where
XPression Maps will create the preview video clips and from which the web server will stream the
clips to the clients. The default location is D:\XPression Maps Data\Clips\Preview.

6. In the Web Gateway section, enter the parameters for communicating with the gateway.

· The Server Name field is the same as the Hostname in the Web Template Database section.

· The UI Port field is the port used by the HTML5 web application (80 = http, 443=https). This is
needed if the system runs in SSL mode -> https.

· The Application Port field is the port on which the server and gateway communicate.

The default Application Port is 9977.

7. In the Output section enter the parameters for the final clip generation.

a. From the Format drop-down, select the AVI or ffmpeg format and use the following guidelines to
set the Format File field:

· If AVI is already selected and is your preferred format:

Ø Set the Format File field to an existing file.

OR

Ø Select AVI Setup to open the Video Compression dialog, select a video codec, and save a new
format file.

«For integration with the XPression MOS workflow, the recommended option is to use an AVI file

with the XPression Video Codec. 

· If ffmpeg is already selected and is your preferred format, set the Format File field to an existing
file.

· If switching from AVI to ffmpeg, the Update File Format dialog appears and allows you to select
an existing format file from the Web Service Video Format File dialog.

· If switching from ffmpeg to AVI, the Update File Format dialog appears and allows you to:

Ø Select Creating AVI file to open the Video Compression dialog, select a video codec, and save
a new AVI format file.

OR

Ø Select an existing format file from the Web Service Video Format File dialog.
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b. Select the Browse button beside the Final Clip Folder field to navigate to the folder where the
video clips will be stored. 

«By default, the Final Clip Folder is set to the location used by the XPression MOS workflow (D:

\XPression Maps Data\Clips\Final). This default path allows the workflow to locate final renders
and populate templates in the newsroom workflow and playout devices. Changing this location may
prevent the MOS workflow from accessing the rendered clips. 

c. In the Max Clip Space field, enter or use the arrows to select the amount of system disk space, in
GBs, which can be used before the automatic cleanup mechanism starts to free up disk space by
erasing the loaded clips.

d. Select the Browse button ( ) beside the Download Format File field to navigate to the Video
Format folder to select the type of video format file you want.

e. Select the Clip Copy to Hotfolder checkbox, if you want to store your clips in a separate folder.

f. In the Hotfolder field, select the Browse button ( ) to navigate to the folder in which to store
your clips.

8. Select Save to save the changes made to your configuration and then select OK.

9. In the Restart Needed dialog, select Close Now.

10.Restart XPression Maps to apply the changes.
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Connection Preferences

The Connection tab in the Preferences window lets you configure how XPression Maps interacts with
external map providers that provide the geolocation search service and base maps imagery services to
XPression Maps. You can validate the connection to the map provider accounts, set the style of the map
provider's logo, and monitor transaction usage.

Preferences - Connection Tab

«XPression Maps displays a warning message on startup if the External Provider fields are set and

XPression Maps cannot validate a connection to the configured maps service provider. If this happens,
follow the instructions in the message or refer to Assigning an External Maps Service Provider  to
enter and validate the application access key.

The following topics are described in this section: 

Assigning an External Maps Service Provider

Setting the Style of the Map Provider's Logo

Monitoring Map Provider Access Details
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Assigning an External Maps Service Provider

To integrate XPression Maps with an external maps service provider, you must configure the External
Provider settings on the Preferences > Connection page. 

« Access to external map services depends on customer-supplied API keys for the specific vendor(s).

These keys must be obtained from the provider and entered into the configuration to enable the
connection.

The procedure below provides general instructions for assigning an external maps service provider. For
detailed instructions on creating a specific maps provider account and assigning it to XPression Maps, refer
to the additional documentation provided in C:\Program Files\XPression Maps\doc:

· Configuring XPression Maps to Use Bing Map Services

· Configuring XPression Maps to Use Azure Maps Services

· Configuring XPression Maps to Use Mapbox Services

Prerequisite

To use an external maps provider, you must have:

· A valid Bing Maps for Enterprise, Azure Maps, or Mapbox account

· And active payment subscription for that account

· The application access key generated in your provider's account

To configure XPression Maps to use an external maps service provider:

1. Open XPression Maps and select File > Preferences. 

2. Select the Connection tab.

3. In the External Provider section, select the corresponding maps service provider's tab (Bing Maps,
Azure Maps, or Mapbox).

Preferences - External Provider

4. In the Application Key (Bing Maps), Primary Key (Azure Maps), or Access token (Mapbox) field,
enter the application access key code to define the provider's download account.

The Account ID and Account Email fields are optional and are provided for you to keep track of the
account and email address under which the application access key is running.

5. Select the Validate Key button.

If the key is valid, the text on the button turns green and says Key is Valid.

6. In the Search field, select the corresponding provider as the location service provider used by the
Search Editor tool in XPression Maps.
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7. In the Satellite Tiles field, select the corresponding provider as a maps tiles provider for certain map
styles integrated in XPression Maps. 

Or, select None to disable the availability of satellite map styles in the Map Styles editor in XPression
Maps.

8. In the Map Provider Logo section, set the style of the logo  that will be displayed in the Canvas.

«This field is unavailable on the Azure Maps tab.

9. Select Save and then OK.

10.In the Restart Needed dialog, select Close Now.

11.Restart XPression Maps to apply the changes.

Setting the Style of the Map Provider's Logo

Use the Map Provider Logo section in the Connection tab to configure the style of the Bing or Mapbox
logo that will be displayed in the Canvas. A preview of the logo's style is provided as based on the
selection in the Type drop-down.

«This feature is not available for Azure Maps.

To set the style of the map provider's logo:

1. Open XPression Maps and select File > Preferences. 

2. Select the Connection tab.

3. In the Map Provider Logo section, enter a value or use the arrow controls to select one of the
following options:

0 = Displays the standard logo

1 = Displays Source: <map provider's name>

4. Select Save and then OK.
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Monitoring Map Provider Access Details

Some external map providers use a metered, pay-as-you-go service model, offering a limited number of
free requests or transactions before charges apply. To help you track and manage your usage, the Map
Provider Access Details section within the Connection tab displays detailed information about requests
and transactions over a defined time period.

To monitor your map provider access details:

1. Open XPression Maps and select File > Preferences.

2. Select the Connection tab.

3. In the Map Provider Access Details section, in the Provider drop-down, select the map service
provider: Bing Maps, Azure Maps, or Mapbox.

4. Define the reporting period:

a. Select a preset period: Day, Week, Month, or Year.

b. Use the arrow controls to adjust the Start Date and End Date for the custom date range.

Jessica Hempinstall
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5. To display cumulative results across all connected systems, select the Total checkbox. 

« This option collects and displays the combined results only if the ProviderRequests database is

configured to store data on the server.

If the database is configured for local storage, clear the Total checkbox to view results from only the
local system.

6. View the transaction results to see the number of successful transactions (Requests) and failed
attempts (Errors) across the following categories:

· Search —  Requests to retrieve geographic coordinates and related metadata based on a location
string entered in the XPression Maps Search Editor.

· Reverse GC — Requests to retrieve place names and location details from longitude and latitude
coordinates. This is used by the Dynamic Data extension to populate icon text fields.

· Tiles —  Requests to retrieve visual map content (e.g., road, aerial, or hybrid views) as image tiles,
allowing dynamic map rendering based on the view and zoom level in XPression Maps. The results are
based on the provider’s conversion rate of map tile downloads to transactions (e.g., Bing and Azure
Maps 15 tiles = 1 transaction, Mapbox 1 tile = 1 transaction).

« Only newly downloaded tiles are counted; cached tiles are excluded.

· Attribution — Requests to retrieve the provider credit text displayed on the map as required by
licensing terms.

7. To refresh the results, simply close and reopen the Preferences window.
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Proxy Preferences

The XPression Maps software requires access to the Internet to function properly. If your organization
uses an Internet proxy server, use the parameters in the Proxy tab of the Preferences window to enter
information about your organization's proxy server.

Consult your local IT administrator for the proxy server access information.

Preferences - Proxy Tab

To connect the XPression Maps application to the internet through a proxy server:

1. Open XPression Maps and select File > Preferences. 

2. Select the Proxy tab.

3. In the Hostname field, enter the IP address of the proxy server.

4. In the Port field, enter the port number over which the application and server will communicate.

5. In the Username field, enter a user name for the proxy server.

6. In the Password field, enter a password for the proxy server.

7. Select Save to save the changes made to your configuration and then select OK.

8. In the Restart Needed dialog, select Close Now.

9. Restart XPression Maps to apply the changes.
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Data Option Preferences

If you purchased the Data option, this tab will appear in the Preferences window.

To properly use the Data option, you must install the DataLinq Server Software. The installer should be
included in your software delivery package, or you can contact Ross Video Technical Support for
assistance. 

Additional information about the DataLinq Server Software can be found in the XPression User Guide. 

In the Data tab you can specify the location of the folder where the the following information is stored:

· Dynamic Data Query Folder: contains files with the data that will be generated when you add an
external Data drawing to your scene.

· Dynamic Data Layout Folder: contains files that specify the layout of the data that is generated.

Preferences - Data Tab

The following topics are discussed in this section:

Specifying the Query and Layout Files

Adding a DataLinq Server

Configuring a DataLinq Server

Deleting a DataLinq Server

Exporting DataLinq Server Data

Importing External Data Server Information Files

Saving Changes to the Configuration
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To specify which query and layout files to use:

1. In the Query Folder section, select the Browse button( ) beside the Folder field and navigate to
the folder from which you want to get the external data information. 

The default location is C:\ProgramData\Ross Video\XPressionMaps\DDQueries.

2. In the Layout Folder section, select the Browse button ( ) beside the Folder field and navigate to
the folder from which you want to get the external data layouts.

The default location is C:\ProgramData\Ross Video\XPressionMaps\DDLayouts.

To add a DataLinq Server:

1. Select the Add button.

The Add DataLinq Server window opens.

Add DataLinq Server Window

2. In the Name field, enter a name for the new DataLinq Server.

3. In the Host field, enter the host IP address. 

4. In the Port field, enter the port that connects to the DataLinq Server.

The default port number is 8888.

5. Select the State checkbox to view the status of the DataLinq Server Connection. 

If the connection passes the DataLinq Server will be highlighted in green. If the connection fails the
DataLinq Server will be highlighted in red. 

6. Select OK.

The DataLinq Server has been added. 

To configure a DataLinq Server:

1. Select the DataLinq Server you want to edit from the list of servers and select Configure.

The Configure DataLinq Server window opens. 

Configure DataLinq Server Window
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2. Edit the fields that require a change and select OK.

The DataLinq Server has been configured.

To delete a DataLinq Server:

1. Select the DataLinq Server you want to delete from the list of servers. 

2. Select Delete.

The Delete Server confirmation dialog opens.

Delete DataLinq Server Window

3. Select Yes to delete the server. 

To export DataLinq Server Data:

1. Select the DataLinq Server data you want to export and select Export.

The Export External Data Server Information File folder opens. 

2. In the File name field, enter a name for the exported data file.

3. Save the file to a local drive. 

A recommended location is a DataLinq folder within D:\XPression Maps Data for storing the External
Data Server Information File (*edsif).

To import External Data Server Information Files:

1. Select the Import button.

The Import External Data Server Information File window opens. 

2. Select the External Data Server Information File (*edsif) or select the DataLinq folder you created
and then select the file and select Open.

The External Data Server Information File is added to the list. 

To save your configurations:

1. At the bottom of the Data tab, select Save and then select OK.

2. In the Restart Needed dialog, select Close Now.

3. Restart XPression Maps to apply the changes.
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Video I/O Option Preferences

« Video I/O functions enabled by a variety of licensing options and may not be present in your

configuration.

If you do have this feature, you can configure the video inputs and outputs as either SDI/2110 or NDI. 

· Inputs: Up to four total, in any mix of HD-SDI/2110 or NDI sources.

· Outputs: Up to two, configurable as Video and Alpha pair. 

You can also assign any of the four video inputs to the following video input layers:

· The Background Video Input Layer is positioned behind all other elements, including maps and
drawings. For example, in an election project, this layer could display an animated live video background
behind state shapes.

· The Full Screen Video Input Layer sits above all other elements, including maps and drawings, except
for the Main Overlay and Telestrate graphics. In an election project, this layer might display features
like the top information bar and the top-left headshot statistics. To ensure XPression Maps graphics
remain visible, the video input must include an alpha channel.

Preferences - Video I/O Tab

« Configuration of video I/O settings requires the installation of the correct drivers for the video I/O card

on the host computer. For information on supported video I/O cards and their driver requirements,
contact Ross Video Technical Support. 

mailto:techsupport@rossvideo.com
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The following topics are discussed in this section:

Configuring an SDI/2110 Video Output

Configuring an NDI Video Output

Configuring Video Inputs

Configuring Video Input Layers

Saving Changes to the Configuration

To configure an SDI/2110 Video Output:

1. In the Video Output - SDI/2110 section, select the Enable checkbox, if you are using an SDI/2110
output. 

2. Select the Enable Key checkbox if you want to see the Key image in the output.

The Key image is automatically put on the next frame buffer above the one used for the output (i.e. on
frame buffer 4 if the output is on frame buffer 3).

3. Select the Show Interactive Overlay checkbox to display the interactive overlay in the output. The
overlay shows the keys that trigger interactive functions. 

«Only enable this function when you need to visually display the interactive function keys in the

output. 

4. From the Device drop-down, select the video card in your XPression Maps hardware.

5. In the Buffer field, enter a value or use the arrows to select which frame buffer to use.

6. From the Test Pattern drop-down, select from a number of different patterns if you want to see a test
pattern in the output (for testing purposes) or select OFF for an on-air viewing. 

7. From the Reference drop-down, select one of the following options:

Ø Internal — No reference, free running without using an external reference signal. 

Ø BlackBurst  — Uses the reference spigot on SDI framebuffers for timing. 

BlackBurst is a standard sync signal that carries no picture information but provides the timing
pulses needed to keep all SDI devices in step. 

Ø SMPTE2059 — Uses Precision Time Protocol (PTP) for timing for 2110 framebuffers. 

SMPTE ST 2059 defines how PTP is used in IP systems to keep devices locked to the same time base
across the network. 

8. From the Frame Rate drop-down, select the format that matches your reference source. 

If you are unsure of which format to use, check with your system engineer or technical director. 

To configure an NDI Video Output:

1. In the Video Output - NDI section, select the Enable checkbox, if you are using an NDI output.

2. Select the Enable Key checkbox if you want to see the Key image in the output. 

The Key image is automatically put on the next frame buffer above the one used for the output (i.e. on
frame buffer 4 if the output is on frame buffer 3).
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3. Select the Show Interactive Overlay checkbox to display the interactive overlay in the output. The
overlay shows the keys that trigger interactive functions. 

«Only enable this function when you need to visually display the interactive function keys in the

output. 

4. In the Stream Name field, enter the streaming service being used.

The default service is Maps NDI Stream.

To configure video inputs:

1. In the Video Input section, for each input, use the drop-down to select whether that input is Disabled
or is an SDI/2110 or NDI input.

If you select either SDI/2110 or NDI, additional parameters appear for each input.

2. For an SDI/2110 input:

· From the Device drop-down, select the video source for the input.

· In the Buffer field, enter a value or use the arrows to select which frame buffer to use.

· Select the Alpha checkbox if you want to see the Alpha image in the output. 

OR

For an NDI input:

·  Use the drop-down to select the Name of the input source.

To configure the video inputs layers:

1. In the Video Input section, set the Input 1 to Input 4 fields to either SDI/2110 or NDI (Disabled is
the default.)

2. In the Background Video Input Layer section, set the Use field to one of the video input sources
(Off is the default). 

The Background Video Input Layer will be displayed behind the map. 

3. In the Full Screen Video Input Layer section, set the Use field to one of the video input sources (Off
is the default). 

The Full Screen Video Input Layer will be displayed on top of the map. 

To save your configuration:

1. At the bottom of the Video I/O tab, select Save and then select OK.

2. In the Restart Needed dialog, select Close Now.

3. Restart XPression Maps to apply the changes.
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Opening a Scene
By default, XPression Maps launches with the scene that was last open, unless no scenes have yet been
created. In that case, a new scene is displayed on the Canvas. At any time, you can also choose to open a
new scene or load an existing one.

« In some cases, an existing scene may have been exported from another system. In this case, a slightly

different procedure is used to open the scene. See Exporting a Scene  for more information.

The following procedures provide instructions for opening a scene in XPression Maps:

Opening a New Scene

Opening an Existing Scene

Opening a Recently Opened Scene

To open a new scene:

1. From the menu bar select File > New or select the New icon in the toolbar.

XPression Maps Toolbar - New

If the current scene has unsaved changes, a confirmation dialog opens asking if you want to save it.

Save Scene Confirmation 

2. Select Yes to save the current scene or No to discard it.

To open an existing scene:

1. From the menu bar select File > Open or select the Open Scene button in the toolbar.

XPression Maps Toolbar - Open Scene

2. Select an existing scene from the XPression Maps Scenes folder (or whichever folder you’ve stored
your scenes in) and select Open.

Ø If the current scene has unsaved changes, a confirmation dialog opens asking if you want to save it.

Select Yes to save the current scene or No to discard it.

Save Scene Confirmation 
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Ø If the selected scene has a different video format, a confirmation dialog opens, asking if you want to
set the new format.

Select Yes to set the new format or No to keep the current format.

Selecting the X in the top-right corner gives the same result as selecting No.

Video Format Confirmation

To open a recently opened scene:

· Select File and select a scene from the list of recently opened scenes.

Recently Opened Scenes

Ø If the current scene has unsaved changes, a confirmation dialog opens asking if you want to save it.

Select Yes to save the current scene or No to discard it.

Save Scene Confirmation 

Ø If the selected scene has a different video format, a confirmation dialog opens, asking if you want to
set the new format.

Select Yes to set the new format or No to keep the current format.

Selecting the X in the top-right corner gives the same result as selecting No.

Video Format Confirmation
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Creating and Assigning Map Styles
Map styles in XPression Maps define the visual appearance of maps, including cartographic elements,
colors, fonts, and feature visibility. They set the overall look of map graphics and allow designers to meet
specific visual, editorial, or branding needs.

XPression Maps offers a collection of demo-ready system map styles  for exploring the software’s
features. Typically however, you will use the Map Style Manager to modify existing map styles or build
new ones from predefined map types  based on map imagery from providers, including Microsoft
Azure Maps For Enterprise, Mapbox, Microsoft Bing Maps For Enterprise, NASA’s Blue Marble
project, and OpenStreetMap. When building or modifying a map style, you can set the projection type,
adjust visual properties, and add overlays to control geographic features such as borders, roads, and water
bodies.

Once a map style is created, it is available in the Map Styles panel within the main XPression Maps
interface. When building a map scene or animation, there are 2 ways in which you can use the Map Styles
panel to assign or change the map style of a scene, without altering other scene elements:

· Animated  (change at Key Frames)

· Automatic  (change at specific map layers)

Map Styles Panel

The following topics are described in this section:

About Map Types

About System Map Styles

Adding a New Map Style

Editing a Map Style

Map Style Properties

Assigning an Animated Map Style

Assigning an Automatic Map Style

Editing OSM (OpenStreetMap) Map Styles

Displaying Disputed Borders and Adding OSM Data

Exporting a Map
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About Map Types

In XPression Maps, a Map Type refers to a predefined, non-editable map style that determines the base
appearance and behavior of a map. These styles are locked templates designed to deliver consistent, high-
quality mapping visuals from third-party map providers, including:

· Microsoft Bing Maps for Enterprise

· Microsoft Azure Maps For Enterprise

· Mapbox

· NASA’s Blue Marble project

· OpenStreetMap

Map Types may define key visual aspects such as:

· Map imagery source

· Zoom capabilities

· Labeling and data overlays

· Color format (e.g., full color, grayscale, dark mode)

· Map type (e.g., satellite, road, topographic)

While Map Types themselves cannot be directly edited, they can be assigned to user-created map styles in
the Edit Map Style editor. Once assigned, users can adjust various properties of their custom map style to
modify the appearance and behavior of the map. See Adding a New Map Style  and Editing a Map
Style .

Edit Map Style Editor - Assigning a Map Type to a Map Style

« While the system map types based on Blue Marble and OpenStreetMap always appear and require

no additional configuration, system map types based on Azure Maps, Bing Maps for Enterprise, and
Mapbox will only appear once the External Provider settings are configured for those providers. See
Assigning an External Maps Service Provider  for more information.
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The following table lists example MapStyles provided with XPression Maps, along with their availability.
These MapStyles can be selected from the Map Type drop-down in the Edit Map Style window.

Map Type
Option Description Availability

None Removes the map from the canvas. It can be used to
show freestanding colored country shapes and
drawings on a background image.

Available by default

Blue Marble
Satellite

Displays the topographic world image from the NASA
Blue Marble image gallery. The resolution of this map
is reduced to 500m/px. No logo will be shown on
canvas.

Available by default

Blue Marble
Colored

Displays a colored map generated from the Blue
Marble height model and a color table. It displays
selected elevations in different colors. See Color
Map  for more information.

Available by default

Bing Aerial Displays satellite maps from Bing Maps. You can
zoom to street level. The Bing logo appears on the
canvas.

Requires Bing Maps for Enterprise
contract from Microsoft

Bing Aerial
with Label

Displays satellite or structural maps from Bing Maps
with country, city, and road information on top of the
maps. You can zoom to street level. The Bing logo
appears on the canvas.

Requires Bing Maps for Enterprise
contract from Microsoft
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Bing Road Displays road maps from Bing Maps in color. You can
zoom to street level. The Bing logo appears on the
canvas.

Requires Bing Maps for Enterprise
contract from Microsoft

Bing Road
Dark

Displays road maps from Bing Maps on a dark canvas,
useful for highlighting data. You can zoom to street
level. The Bing logo appears on the canvas.

Requires Bing Maps for Enterprise
contract from Microsoft

Bing Road
Gray

Displays road maps from Bing Maps on a grayscale
canvas, useful for highlighting data. You can zoom to
street level. The Bing logo appears on the canvas.

Requires Bing Maps for Enterprise
contract from Microsoft

Bing Road
Light

Displays road maps from Bing Maps on a light canvas,
useful for highlighting data. You can zoom to street
level. The Bing logo appears on the canvas.

Requires Bing Maps for Enterprise
contract from Microsoft

Azure Displays satellite maps from Azure Maps. You can
zoom to street level.

Requires Azure Maps for
Enterprise contract from Microsoft

Azure Road Displays road maps from Azure Maps in color. You
can zoom to street level.

Requires Azure Maps for
Enterprise contract from Microsoft
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Azure Dark Displays road maps from Azure Maps on a dark
canvas, useful for highlighting data. You can zoom to
street level.

Requires Azure Maps for
Enterprise contract from Microsoft

Mapbox Displays satellite maps from Mapbox. You can zoom
to street level. The Mapbox logo appears on the
canvas.

Requires Mapbox license

VT OSM Basic Displays a colored map that includes OpenStreetMap
data.

Available by default

VT OSM Style
A

Displays a colored map that includes OpenStreetMap
data.

Available by default

VT OSM Style
B

Displays a colored map that includes OpenStreetMap
data.

Available by default

VT OSM Style
C

Displays a colored map that includes OpenStreetMap
data.

Available by default
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VT OSM Style
D

Displays a colored map that includes OpenStreetMap
data.

Available by default
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About System Map Styles

To help you get started, XPression Maps includes a set of built-in example map styles designed to
showcase the software’s features and capabilities. Created using the Edit Map Style editor, these styles
incorporate various map types , projection types, and other settings to produce realistic map graphics.
While primarily intended for demonstration, they can also serve as a starting point for developing your
own custom map styles .

Map Style Manager - System Map Styles

« The availability of some system map styles depends on how the External Provider settings are

configured in the Preferences > Connection page. If a specific system map style does not appear in
your Map Style Manager, there may be an error in the External Provider settings  configuration or
the map style may have been renamed.

« If Compact Scene on Save is selected in the Output  tab in File > Preferences, only the styles

used in the scene are saved into the scene. 
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Adding a New Map Style

To add a new map style in XPression Maps, use the Map Style Manager to customize an existing style
and save it under a new name. When creating a new map style, you can choose the map type, projection
type, adjust visual properties, and optionally add an OpenStreetMap (OSM) overlay for additional
geographic features. 

To add a new map style:

1. From the menu bar select Style > Map Styles or select the Map Styles button  in the toolbar.

The Map Style Manager opens.

2. Select Add to open the Add Map Style dialog.

Map Style Manager - Add Map Style

3. In the Name field, enter a name for the new map style.

4. From the Copy from drop-down, select one of the existing map styles to use as a base for the new
map style and select OK.

The Edit Map Style editor opens.

Edit Map Style Editor
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5. Modify the properties of the new map style and select OK. 

See Map Style Properties  for information about modifying the properties.

The new map style appears in the Map Style Manager, marked with the Save icon .

6. Select the Save Style icon.

The Save Map Style confirmation dialog opens.

Save Map Style Confirmation Dialog

7. Select Yes to save your new map style into the database.
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Editing a Map Style

Use the following procedure to customize an existing map style by editing its properties.

To edit an existing map style:

1. From the menu bar select Style > Map Styles to open the Map Style Manager.

2. Select the map style you want to modify and select Edit or double-click the selected map style.

The Edit Map Style editor opens.

Edit Map Style Editor

3. Modify the properties of the map style and select OK. 

See Map Style Properties  for more information.

The Edit Map Style editor closes and the Map Style Manager reopens. The edited style is highlighted,

and the Save  and Reset   icons are displayed beside it. 

4. Select the Save icon  if you want to save your changes into the default database or select the

Reset icon  to discard your changes and revert to the last saved version of the style. Then select
Done to close the Map Style Manager.

An exclamation mark at the left of the map style indicates that the style is saved in the scene but not
in the database. That style will not be available to be used in other scenes.

The Save All button  at the bottom of the dialog saves all changes made to all styles in the
database. 

The Reset All button  at the bottom of the dialog resets all styles in the database to their last
saved version.
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Deleting a Map Style

Use the following procedure to delete a custom map style from your XPression Maps system.

« XPression Maps example map styles cannot be deleted; only custom map styles can be removed. 

To delete a map style:

1. From the menu bar select Style > Map Styles to open the Map Style Manager.

2. Select the map style you want to delete and select Delete.

The Delete Map Style confirmation dialog opens.

Delete Map Style Confirmation Dialog

3. In the Delete Map Style confirmation dialog, select Yes to delete the map style.
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Map Style Properties

Many of the properties of map styles can be customized for a different look. Properties such as map type,
projection, brightness, country borders, light direction and mountain height can be edited in the Edit Map
Style editor. You can even add an OpenStreetMap overlay to display and control geographic features such
as borders, roads, and bodies of water. 

These properties and others are described in the sections below:

Main

Options

Background

Overlay

Custom Data

Light

3D

Color Map

Edit Map Style Editor

71

71

72

72

73

74

75

76



XPression Maps User Guide (v4.0) Creating and Assigning Map Styles • 71

Main

The following properties appear in the Main section of the Edit Map Style editor.

Parameter Description

Name The name assigned to the map style. System style names cannot be edited. If you’ve
created your own map style, you’ll be able to change the name if you want.

Map Type The style type of the map. System style types cannot be edited. 

See About Map Types  for a list and descriptions of the available map types.

Projection Defines the projection type of the map. 

Select one of the following options:

Sphere — uses a round shape like a globe

Mercator — uses a cylindrical map projection that displays latitude and longitude as a
rectangular grid.

Linear — uses a map with variables that change proportionally

Alpha Channel Select the Alpha Channel checkbox if you want to use the Alpha Channel in the final
output and see a checkerboard pattern in the preview. 

Options

Use the Options section to adjust the general appearance of a map style.

Parameter Description

Quality Increases or decreases the amount of image content and Zoom Level for a map style.

0: Normal

1: Increases the Zoom Level by 1 and downloads 3 times more image content than
normal.

Labels on Bing Aerial, Bing Road, Azure Road, and Mapbox map styles are
displayed at a smaller size.

The available quality range is -3 to 3.

-1: Decreases the Zoom Level by 1 and downloads 3 times less image content than
normal.

Labels on Bing Aerial, Bing Road, Azure Road, and Mapbox map styles are
displayed at a larger size.

The available quality range is -3 to 3.

Brightness Increases or decreases the brightness level for the map style.

Gamma Increases or decreases the gamma level for the map style.

Contrast Increases or decreases the contrast level for the map style.
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Background
Use the Background section to adjust the parameters of the background elements in a map/scene. 

Parameter Description

Drawing From the Drawing drop-down, select a drawing to be displayed as the map/scene
background. See Background Drawings  for more information.

Mode From the Mode drop-down, select the scaling of the drawing. 

Fullscreen — shows the background over the whole Canvas. This may distort the
drawing. 

Letterbox — makes the width fit onto the Canvas, while preserving the aspect ratio.

Pillarbox — makes the height fit onto the Canvas, while preserving the aspect ratio. 

Overlay

These properties control the appearance of geographical elements from the OpenStreetMap layers. A full
raster image (a fullscreen image that lies on top of the globe and includes a transparent section) can also
be defined.

To configure the overlay parameters: 

1. If you want to use a raster image to create a border around the map, in the Overlay section of the
Edit Map Style editor, select the checkbox for Full Raster Image and then select a background image
from the drop-down. 

The background image needs to have a transparent section in the middle for the map to show through. 

2. Select the Overlay Layer(s) you want to use from the drop-down.

A preset overlay of the layers (each using different colors, icons, etc.) is superimposed on the selected
map style. 

The options are:

VT OSM Basic Trans

VT OSM Style A Trans

VT OSM Style B Trans

VT OSM Style C Trans

VT OSM Style D Trans

3. Select More to open further configurations. 

The Edit Map Style Overlay More window opens.

Edit Map Style Overlay More Window

«These overlay functions are legacy features maintained for older scenes. For new map styles, use the

OSM Layers instead. 
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To configure more overlay parameters:

1. Select the checkbox of the geographical element(s) you want to include in the map.

2. For Country Borders, Country Names and State Borders enter or select a value for the line width or
font size using the field next to the selected element. 

Valid values are 0.10 to 10.00.

3. Select the Color button to select a color for the element. 

4. From the Name Style drop-down, select the style in which you want the names of countries, states
and regions to appear. 

The location and spelling of the country names can be set through the Shape Database Viewer . 

5. For Rivers enter or select a value for the line width or font size using the field next to Rivers. 

Valid values are 0.10 to 10.00.

6. Select the Color button to select a color for the element.

7. For Rivers and Lakes enter or select a Max-Rank and Out Level to change the density of the
waterways.

Valid values are 10 to 300.

8. For Ocean Mask, select the Color button to select a color for the element. 

If you want to use the Apply Ocean Mask feature to hide the parts of a shape that extend into the
ocean, the Ocean Mask checkbox needs to be selected.

Custom Data

In the Custom Data section, satellite and elevation maps that have been imported in the Custom >
Custom Maps editor can be selected. If enabled, they are drawn on top of the regular (Bing or Blue
Marble) maps, ensuring that there are no missing areas. The parameters in the Custom Data section are
only available when a custom map has been selected.

To configure the custom data parameters:

1. From the menu bar select Style > Map Styles, and in the Map Style Manager, select the map style
for which you want to add a custom map.

OR

Create a new map style with your custom map. 

See To add a new map style  for more information.

2. Select Edit.

3. In the Custom Data section: 

· To use a custom map, select the Map checkbox and from the corresponding drop-down, select the
custom satellite map you want to use.

· To use an elevation map, select the Elevation checkbox and from the corresponding drop-down,
select the elevation map you want to use. 

« Elevation maps provide crisper, better-defined illustrations of height data.
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Light

Use this section to edit the parameters for the lighting on the map.

Parameter Description

Light Direction
Longitude

Enter or select the longitudinal direction for the light on the map. This parameter only
takes effect if Shading or Height Shading are selected.

Light Direction
Latitude

Enter or select the latitudinal direction for the light on the map. This parameter only
takes effect if Shading or Height Shading are selected.

Shading Select this checkbox to enable shading on the map. The Shading function activates a
rendering mode that lights the globe with a spotlight from the light direction to
simulate the look of sunlight. The Intensity and Blending parameters work together
to define the spotlight:

Intensity — increases or decreases the intensity of the spotlight. With Blending set
to 100, a value of 0.05 will create a small intense spotlight, while a value of 1 or
more will create a large, more diffuse spotlight. As you lower the Blending value, the
spotlight becomes less noticeable.

Range is 0 to 10.

Blending — increases or decreases the amount of shading around the spotlight. A
value of 0 displays no shading and the globe looks the same as if Shading was
disabled. A value of 100 will provide a large amount of shade, making the spotlight
more noticeable. 

Height Shading Select this checkbox to enable Height Shading on the map. Height Shading makes
the elevated areas of the map more noticeable.

The following parameters adjust the height shading appearance:

Blending — increases or decreases the amount of relief that is displayed. A value of 0
shows no relief and a value of 100 shows complete relief.

Diffuse Factor — enter or select an amount to define how the light will affect the
parts of the relief away from the sun. A value of 0 will result in a black color for the
affected areas of the map and a value of 100 will result in a shiny white color for the
affected areas of the map.

The second parameter for the Diffuse Factor defines an offset to the relief as a
whole. For a value of 0, some parts of the relief will be totally black. A value of 100
makes the relief totally white.

Specular Factor — determines how the light will affect the parts of the relief on
which the sun shines directly. A value of 0 will result in a black color for the affected
areas of the map and a value of 100 will result in a shiny white color for the affected
areas of the map.

Min. Clamp —  enter or select an amount of shading relief used at locations where the
height is equal to or greater than the value of Min. Clamp. The value 0 corresponds to
sea level.

This parameter only applies to the Blue Marble Colored map type.    
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3D

The 3D section allows you to create a real three-dimensional surface of the world generated from the Blue
Marble map type height data.

Parameter Description

Mountain Height Enter or select a scale factor for the height data to make mountains appear higher or
lower than normal. A value of 1 corresponds to the correct height. For street level
views, the height is interpolated to 0 because the resolution of Blue Marble height
data is not sufficient.

Flatten At Street
Level

When selected (default), the map flattens and switches to a standard street view at
zoom level 120 or above.

When disabled, the 3D effect remains, showing elevation details. For better quality,
consider loading a higher-resolution height model for the area.
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Color Map

This section applies to Blue Marble Colored map types only.

Use this section to add, edit, and delete color maps for a style. A color map is a table of height values and
colors that will graphically show elevation data in a map. 

Adding a New Color Map

Saving a New Color Map

Editing the Color Map Parameters

Deleting a Color Map

To add a new color map:

1. In the menu bar select Style > Map Styles to open the Map Style Manager.

2. Select the map style you want to edit (must be a Blue Marble Colored map style) and select Edit. 

3. In the Edit Map Style editor, in the Color Map section, select the A button.

Edit Map Style Editor

4. In the New Color Map dialog, enter a name for your new color map. 

Add Color Map

5. If you want to copy an existing color map to use as a template, from the Copy from drop-down, select
the color map you want to copy. 

There are several default color maps to choose from. As you create new color maps, they will appear in
the drop-down.

The Edit Color Map dialog opens.

Edit Color Map
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6. In the Edit Color Map dialog, select a row and do any of the following:

· Double-click a value in the Height column to change the elevation. 

· Double-click within any of the color columns to open the Select Color window and change the color
of that elevation.

· Select Add to duplicate the row and then edit the duplicate row.

· Select Delete to remove the row.

Any changes will cause a reordering of the table so that the height values are sorted in descending
order.

7. When you are satisfied with how your color map looks, select OK to close the dialog.

To save a new color map:

1. In the Edit Map Style dialog, adjust the properties of the map style as described in Map Style
Properties .

2. Select OK to close the dialog.

3. In the Map Style Manager, select the Save button beside the map style you edited to save the new
color map to the database.

An exclamation mark indicates a color map that hasn't been saved.

4. In the Save Map Style confirmation dialog, select Yes and then select Done to close the Map Style
Manager.

To edit the color map parameters:

1. From the menu bar select Style > Map Styles to open the Map Style Manager.

2. Select the map style you want to edit (must be a Blue Marble Colored map style) and select Edit.

3. In the Edit Map Style dialog, in the Color Map section, from the Name drop-down, select the color
map you want to edit.

4. Select the Edit  button beside the Name drop-down to open the Edit Color Map editor and edit the
selected color map as described in To add a new color map .

5. When you have finished editing the color map, select OK.

6. In the Edit Map Style dialog, select OK to close the dialog.

7. In the Map Style Manager, select the Save button beside the edited map style to save the new color
map to the database.

8. In the Save Style confirmation dialog, select Yes and then select Done to close the Map Style
Manager.
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To delete a color map:

1. From the menu bar select Style > Map Styles to open the Map Style Manager.

2. Select any Blue Marble Colored map style and select Edit.

3. In the Edit Map Style dialog, in the Color Map section, from the Name drop-down, select the color
map you want to delete.

4. Select the D button.

Delete Color Map

«If the selected color map is a system map, it cannot be deleted; an error message appears. 

The Delete Color Map confirmation dialog appears.

Delete Color Map

5. Select Yes to delete the selected color map.

6. In the Edit Map Style dialog, select OK to close the dialog.

7. In the Map Style Manager, select the Save All button to save your change.

8. Select Done to close the Map Style Manager.

The Color Map has been deleted. 
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Assigning an Animated Map Style

Use the following procedure to create a map animation that automatically changes styles at specified
Zoom Levels.  For more details, see Creating Animations .

Assign different map styles to specific Zoom Levels. As the map zooms in or out, the style updates
automatically according to the table defined in the Automated Map Style settings.

To assign a map style change to a camera Key Frame:

1. In the Map Styles panel, select the Animated button, if it’s not already selected.

Map Styles - Animated Option

2. In the Search Editor, enter the location at which you want to animate the map and select Search or
press the Enter key.

Enter Location

3. In the Map Styles section, from the Style drop-down, select the map style for the beginning of the
animation.

4. From the camera parameters below the Canvas, select a starting Zoom Level.

Camera Parameters - Zoom Level

5. With the timeline slider at the beginning of the timeline (frame 0), select the Key Frame button to the
right of the Style drop-down to Key Frame the starting map style.

Map Style Key Frame

6. Select the Add Camera Key Frame button to Key Frame the starting zoom level.

Add Camera Key Frame

A blue camera Key Frame is added to the timeline above the scale.

293
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7. Move the timeline slider to the point in the timeline at which you want to change the map style.

Alternatively, select any point in the timeline to move the slider to that point or enter the position in
the frame counter to the left of the timeline.

Frame Counter

8. From the Style drop-down, select the next map style you want to apply to your scene.

9. From the camera parameters below the Canvas, select a Zoom Level for the new map style.

Map Style Key Frame

10. In the Map Styles section, select the Key Frame button to the right of the Style drop-down to key
frame the new map style.

Map Style Key Frame

11. Select the Add Camera Key Frame to Key Frame the new zoom level.

Add Camera Key Frame

12. Select the Play Animation button in the animation toolbar to play the animation.

Animation Editor - Play Animation

13. Save the changes to the scene.
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Assigning an Automatic Map Style

Use the following procedure to build a map animation that automatically changes styles at specific zoom
levels.

Assign different map styles to individual map layers. As the animation zooms in or out, the map style
automatically updates when it reaches a layer with an assigned style. This approach produces dynamic
zoom-level changes, such as starting with a satellite view at a distant scale and transitioning to a road
map as the animation zooms into a specific location.

To assign an automatic map style change to a map's zoom layer:

1. In the Map Styles panel, select the Automatic button.

Map Styles Tab - Automatic Option

2. Move the map on the Canvas to the location that you want to show.

Alternatively, in the Search Editor, enter a location in the Location / Address, City, Country field
and select Search.

3. Select the Editor button that appears beside the Style selector.

The Map Layer Manager opens.

Map Layer Manager

4. Select Add to add a new layer. 

Each layer represents a point at which the map style will change.

By default, the current map style will be entered for the new layer along with a default zoom level of
20.

Map Layer Manager - Add New Layer
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5. In the Name column, double-click New Layer and give the layer a meaningful name.

This could be the name of the country or the area of the map that you want to display at the selected
Zoom Level.

6. In the Style column, double-click the map style and from the drop-down, select the style of map you
want to apply to the layer.

7. In the Zoom column, double-click the default Zoom Level and enter a value or select the arrows to
select the Zoom Level to apply to the layer.

« The table is ordered by ascending Zoom levels, so a change in the Zoom value can result in a

reordering of the layers.

8. Repeat steps 2 to 7 to add additional layers and then select Done to close the Map Layer Manager.

During animation, as each Zoom Level is reached, the map style will change according to the table. 

9. Save the changes to the scene. 

To delete a map layer:

1. Select the Editor button that appears beside the Style selector to open the Map Layer Manager.

2. In the Map Layer Manager, select the layer you want to delete and select Delete.

The Delete Map Layer confirmation dialog opens.

3. In the Delete Map Layer confirmation dialog, select Yes.

4. When you have finished deleting layers, select Done to close the Map Layer Manager.
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Editing OSM (OpenStreetMap) Map Styles

The OSM Style Editor enables customization of scenes that use a map style based on OpenStreetMap as
the map type  or overlay layer . With the OSM Style Editor, you can adjust the background color,
visibility, colors, parameters, and labels of various layers in the selected map or its overlay. Elements are
organized into categories for easy navigation.

Additionally, you can change the language of labels in real time by selecting a language from the drop-
down menu.

OSM Style Editor

« All street name suffixes in OSM maps are styled the same in XPression Maps. By default, an

abbreviated suffix with no punctuation is used (ST, AVE, RD, DR, etc.). It is possible to change the
suffix style. If this is something you would like to do, contact techsupport@rossvideo.com.

The following topics are discussed in this section:

Overview of Editing OSM Map Styles

Editing OpenStreetMap Layers

Editing Individual Layer Elements on the Map

Showing and Hiding Information Layers

Real-Time Language Support

OSM Replacement Drawings
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Overview of Editing OSM Map Styles

This is an overview of the procedure for editing OpenStreetMap styles. For detailed instructions on using
the OSM Style Editor, see Editing OpenStreetMap Layers .

To edit and save a new OpenStreetMap style:

1. In the Map Styles panel, from the Style drop-down, select an OpenStreetMap Style.

It is preferable to add a new map style copied from an existing style and edit the new one.

For instructions on adding a map style see Creating and Assigning Map Styles .

Map Styles Panel - OSM Map Style

2. Use the OSM Style Editor to modify the map style's elements. 

See Editing OpenStreetMap Layers  for instructions.

3. Once you are finished editing the map style's elements, select Style > Map Styles from the menu bar
to open the Map Style Manager.

Map Style Manager

4. Select the map style you have modified.

An exclamation mark  at the left of the map style indicates that the style is not saved in the
database, or has been changed from the version saved in the database. In this case, the style version
is saved in the scene but will not be available for use in other scenes. 

5. Select the Save icon  to save your changes into the default database or select the Reset icon  to
discard your changes and revert to the last saved version of the style.

The Save All button  at the bottom of the dialog saves all changes made to all styles in the
database. 

The Reset All button  at the bottom of the dialog resets all styles in the database to their last
saved version. 

6. Select Done to close the Map Style Manager.
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Editing OpenStreetMap Layers

The following topics provide instructions for changing the background color, visibility, layer color, and
layer highlight color of an OpenStreet map. Additional guidance is provided for how to edit the layer
parameters and individual layer elements. 

Changing the Background Color of an OSM Map

Changing the Visibility of a Layer

Changing the Color of a Layer

Changing the Highlight Color of a Layer

Switching a Layer from Color to Highlight

Editing the Parameters of a Layer

To change the background color of an OSM map:

1. In the OSM Style Editor, from the layer list, expand Background and then select the Background
layer.

2. Select Color.

The Color Selector opens.

OSM Style Editor Color Selector - Background

3. Select a color swatch from the Basic colors or use the slider or RGB values to create a custom color.

If you create a custom color, select Add to Custom Colors so that it’s available for subsequent use.

4. Select OK.

The background color changes to the new color.

Background Color Change
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To change the visibility of a layer:

· In the OSM Style Editor, in the Visible column, clear the checkbox beside a layer to hide it, or select
the checkbox to show the layer.

OSM Style Editor Visibility Checkbox

OR

1. In the OSM Style Editor, select the checkbox of the Water, Roads, Signs layer.

OSM Style Editor - Layer Sliders and Visibility Controls

2. Move the sliders to set the level of detail for the layers:

· Slide right to display more water, roads, or road signs.

OR 

· Slide left to reduce the number of visible features. 

3. To control visibility levels for individual frames during animation, select the Key Frame icon . 

When left unselected, the visibility level will apply throughout the animation when the checkbox is
selected.

4. Use the layer's checkbox to apply or remove OSM layer setting for the scene's map.
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To change the color of a layer:

1. In the OSM Style Editor, expand the category containing the layer you want to edit.

2. In the Color column, select the color swatch beside the layer.

OSM Style Editor Color Swatch

The Color Selector for that layer opens.

OSM Style Editor Color Selector

3. Select a color swatch from the Basic colors or use the slider or RGB values to create a custom color.

If you create a custom color, select Add to Custom Colors so that it’s available for subsequent use.

4. Select OK.

To change the highlight color of a layer:

1. In the OSM Style Editor, expand the category containing the layer you want to edit.

2. In the High column, select the highlight color swatch beside the layer.

OSM Style Editor Highlight Swatch

The Highlight Selector for that layer opens.

OSM Style Editor Highlight Selector

3. Select a color swatch from the Basic colors or use the slider or RGB values to create a custom color.

If you create a custom color, select Add to Custom Colors so that it’s available for subsequent use.

4. Select OK.
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To switch a layer from color to highlight:

· If the layer's Allow Select  parameter is selected, do one of the following:

Double-click on the layer on the Canvas to toggle between using the configured Color or the Highlight.

Double-clicking selects all the parts of a layer that have the same reference or same name. 

Double-click to Change Color

OR

Right-click on the layer on the Canvas and from the context menu, select Set color > Color or select
Set color > Highlight.

Right-clicking selects the part of the layer that at the chosen location. In this mode, only the selected
section is highlighted. 

Right-click to Change Color
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To edit the parameters of a layer:

1. In the OSM Style Editor, expand the category containing the layer that you want to edit.

2. In the Edit column, select Edit  for the layer you want to edit.

OSM Style Editor Edit Button

The OSM Layer Parameters dialog opens. There are at least 4 editable parameters for each layer, Use
As Information, Zoom In, Zoom Out and Opacity. The other parameters depend on the type of
layer that is selected.

OSM Layer Parameters

3. Select the Use As Information checkbox if you don’t want the layer to appear in the final output but
want it showing while you edit the map.

You can also deselect the Visible checkbox for a category of layers if you don’t want any of them to
appear in the final output. For example, if you don’t want any buildings in the final output, deselect the
building layer checkbox.

4. Enter a value or use the arrows to adjust the Zoom In level at which the layer will appear. 

The adjacent field determines the amount of time, in seconds, it will take for the layer to dissolve in. 

100 = The layer is fully visible as soon as the Zoom In level is reached.

2.00 = The layer dissolves in gradually over 2 seconds once the Zoom In level is reached.

5. Enter a value or use the arrows to adjust the Zoom Out level at which the layer will disappear.

The adjacent field determines the amount of time, in seconds, it will take for the layer to dissolve out. 

100 = The layer disappears immediately after the Zoom Out level has been reached.

2.00 = The layer dissolves gradually over 2 seconds, after the Zoom Out level has been reached.

6. Enter a value or use the arrows to adjust the Opacity of a layer, making it more or less transparent.
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7. Adjust any additional parameters as described in the following table:

«The parameters in the table below are listed alphabetically, the order will vary depending on the

layer you are editing.

Parameter Description

Allow Select OSM layers support both a primary and a highlight color.

When the Allow Select checkbox is selected (default, except for the ocean layer),
double-clicking the layer switches it from the primary to the highlight color.

Clearing the Allow Select checkbox prevents this interaction, ensuring the layer
remains in its primary color.

Background
Color

Select the Color button to open the Color Selector and select the color for the Text
Background. 

Background
Opacity

Enter a value or use the arrows to adjust the opacity of the background color for the
text.
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Parameter Description

Font Use the drop-down to select a font for the text.

Icon Color Select the Color button to open the Color Selector and select a color for the icon. 

Icon Opacity Enter a value or use the arrows to adjust the opacity of the icon. The values range
from 0.00 to 1.00.

Icon Size Enter a value or use the arrows to adjust the size of the icon. The values range from
0.00 to 0.99.

Icon Text Fit Select to link the size of the icon to the text or the size of the text to the icon.

Some examples are shown below.
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Parameter Description

Ignore
Collision

When checked, all OSM Layers will be displayed, even if they overlap at the current
zoom level. 

When cleared, higher level layers will be displayed until a zoom level is reached that
allows room for other level layers to be displayed. Applies to Text layers only.

Invert When both the Use Shape Mask and Invert are selected, the OSM Layers that are
inside of the shape mask are hidden. When the Use Shape Mask is selected and
Invert is cleared, the OSM Layers that are outside of the shape mask are hidden. 

Is Mask When selected, the layer is designated as one that can be used as a mask. Whether or
not the mask is applied to the scene is controlled by the Use Shape Mask setting. If
selected for Ocean Layer, the ocean masks out water from satellite and OSM
backgrounds. 

 

Line Gap
Width

Enter a value or use the arrows to adjust the gap between the 2 lines of a casing,
such as the bridge_major_casing.
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Parameter Description

Line Stipple Select if you want to give a road a dotted line effect. 

Line Stipple
Pattern

Enter a value or use the arrows to adjust the width of the dot (1st field) and the width
of the space between the dots (2nd field).

Line Width Enter a value or use the arrows to adjust the width of the line. 

Opacity Enter a value or use the arrows to adjust the opacity of the text. 

Outline Color Select the Color button to open the Color Selector and select a new color for the
outline of buildings (applies to building layer only).
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Parameter Description

Shadow Select the checkbox to add a shadow to the layer.

Shadow Color If you’ve chosen to add a shadow, select the Color button to open the Color Selector
and select a color for the shadow.

Shadow
Offset

Use the arrows or enter a value in the Offset fields to change the position of the
shadow. The first field changes the horizontal position. The second field changes the
vertical position.

Show
Maritime

When selected, the boundaries are displayed in the water.

When cleared, the boundaries are not displayed in the water. Applies to boundary
layers only.

  

Text
Background

Select the checkbox to insert a rectangle as a background to the text. Select the
Color button to open the Color Selector and select a color for the background.

Text Halo Blur Enter a value or use the arrows to adjust the amount of blur in the text halo.
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Parameter Description

Text Halo
Color

Select the Color button to open the Color Selector and select a color that will
surround the text characters. 

This parameter only works if the value in Text Halo Width is greater than 0.

Text Halo
Width

Enter a value or use the arrows to adjust the thickness of the text halo.

Text Letter
Spacing

Enter a value or use the arrows to adjust the amount of space between the characters
of the text. 

Text Line
Height

Enter a value or use the arrows to increase or decrease the space between lines of
text.

Text Max
Width

Enter a value or use the arrows to increase or decrease the maximum number of
characters allowed in one line of text. 

Exceeding the Text Max Width will cause a line break, where possible.

Text Size Enter a value or use the arrows to adjust the size of the existing label text.
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Parameter Description

Text
Transform

Use the drop-down to select whether the text should be UPPERCASE, lower case or
none (mixed case).

Use
Abbreviation

When the Use Abbreviation checkbox is selected the text layer will display in
abbreviated text.

Use Defined
Replacement
Drawing

Check to add a user-defined replacement drawing for the layer. 

Then select the Browse button ( ) to select a replacement drawing from one of the
following Drawing Toolboxes, which contain text drawings:

· Text

· Web Examples

· OSM Replacement

· Your custom group

When unchecked, a replacement drawing that is the same as the OSM text will be
added. This could be used to add a label at a location where there isn’t one or to
change the size or the orientation of the text.
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Parameter Description

Use Ocean
Mask

When selected, the OSM Layers that are over the ocean are covered by the water
layer instead of being overlayed on top of the water. This can be used to hide
Country/State Boundaries. When Use Ocean Mask is cleared, the boundaries are
visible in the ocean and boundaries will cut at the shoreline.

Use Shape
Mask

When selected and Invert is cleared, the OSM Layers that are outside of the shape
mask are hidden, which visually emphasizes the form and content of what's inside the
shape. When both Use Shape Mask and Invert are selected, the OSM Layers that
are inside of the shape mask are hidden. 

Vignette Select the checkbox to apply a vignette to the surfaces of road, interstate, or highway
shields. Use the arrows to adjust the darkness of the vignette - lower to darken,
increase to lighten.
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« When editing an OSM Layer Parameter, changing the map style while the parameter window is open

will prevent updates from displaying. To apply changes correctly, close the parameter window and reopen
it after switching map styles. 

8. Select Done if you are satisfied with your changes.

OR

Select Reset to restore the OSM Layer Parameters to their original settings.

OR

Select Cancel to discard your changes.
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Editing Individual Layer Elements on the Map

While the OSM Style Editor allows you to customize and apply changes to map style elements, it can
sometimes be quicker to edit individual layer elements directly on the map. For each element, you can
toggle between the main and highlight colors or choose to hide it entirely. Additionally, you can overlay a
custom drawing on top of a place label.

To edit individual elements:

1. Right-click on the element in the map.

A menu opens, listing each layer that appears in that location.

OSM Editing Menu

2. To change the color of an element, select Set color and from the context menu, select either Color or
Highlight.

Alternatively, you can double-click the layer to switch between the Color and Highlight colors.

The layer changes to the color or highlight that has been selected for that layer in the OSM Style
Editor.

3. To hide the element, select Hide.

· To make the element visible again, press Alt + Right-click.

4. To add a replacement drawing on top of a text label, select Add Replacement Drawing.

If a user-defined replacement drawing has been set for that layer in the OSM Style Editor the text
label will be replaced by that replacement drawing. If no user-defined replacement drawing has been
set, a drawing that is identical to the text label will be added.

For information on defining a replacement drawing, see Adding OSM Replacement Drawings .106
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Showing and Hiding Information Layers

You may not want all the layers of a map to be displayed in your final output. Selected layers can be
hidden in the OSM Style Editor. The exception is that if you’ve highlighted a particular road, area,
building, etc., or created a replacement drawing of a text label by double-clicking, that element will
remain visible in the final output, while all other elements in the selected layer will be hidden. 

To hide a layer:

1. In the OSM Style Editor, expand the category containing the layer that you want to edit.

2. Select the Edit button beside the layer you want to hide.

The OSM Layer Parameters dialog opens.

OSM Layer Parameter

3. In the OSM Layer Parameters dialog, select the Use As Information checkbox and select Done. 

4. In the OSM Style Editor, clear the INFO Layers checkbox to view the scene with the selected layers
hidden.

By default, the INFO Layers checkbox is selected, indicating that all layers are visible. When cleared,
the layers which have been chosen to be hidden, will not be visible.

OSM Style Editor

5. Select INFO Layers again to view your scene with the layers displayed.

When the scene is recorded, those layers will not be visible.
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Real-Time Language Support

The OSM Style Editor allows you to instantly switch the language of OpenStreetMap labels in real time.
This feature is especially useful in multilingual workplaces, where map templates can be saved in one
language and exported in others. Language translations are provided by the global OpenStreetMap
community where translation for a selected language exists. 

The following topics are discussed below:

Converting the Language of an OSM Maps

Editing the Translation and/or Spelling of Languages

Adding Missing Labels to the Map

Removing Translations From a Map

Configuring Languages

To convert the language of an OSM Map:

· In the OSM Style Editor, select a Language from the drop-down. 

The default options are:

Ø Arabic

Ø English

Ø French

Ø German

Ø Spanish

OSM Style Editor - Language
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The map will display labels in the selected language. 

OSM Style Labels With Language Change

Once a language is selected, XPression Maps will continue to populate maps with that language until it is
changed. 

To edit the translation and/or spelling of languages (optional):

1. Select the text label or drawing you want to edit on the Canvas. 

2. Press Shift + right-click and select whether you want to edit or remove the text label or drawing.

3. Select edit to open the Edit OpenStreetMap Data window.

Edit OpenStreetMap Data Window

3. Edit the necessary fields and select Done. 

« Updates made to the labels are distributed and applied to every system connected to the shared

database regardless of the selected OSM Map Style. 



XPression Maps User Guide (v4.0) Creating and Assigning Map Styles • 103

To add a missing label to the map:

1. Determine the longitude and latitude coordinates of the airport, place or body of water you want to
add. 

2. In the map area where you want to add data, press Shift + Right-click to open the Add Data
window. 

Add Data Window

3. Select the data label you want to add.

The Add OpenStreetMap Data Window opens.

4. In the Layer Name drop-down, select the type of layer.

5. In the Longitude and Latitude fields, enter the coordinates. 

6. In the Rank field, use the arrows to determine which ranking the new layer name will take. 

The default Rank is 1.

7. In the Default Text field, enter the display name.

8. Use the Text drop-downs to select the languages in which to display the text. 

The default languages are: English, Chinese, Spanish, French, Arabic and Russian. 

9. Select Done to save the data. 

The data for the selected airport, place or body of water will be displayed on the map. 

To remove translations from a map: 

1. Select the text label you want to remove on the Canvas.

2. Press Shift + right-click, then choose one of the following:

· Remove — Deletes the translation.

· Reset — Restores the translation to its default value

« Labels removed from the map template are distributed and applied to all users that have access to the

map. 

Jessica Hempinstall
Sticky Note
Select
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Configuring Languages

Language translations are supplied from the OpenStreet Maps global community. To configure language
options, edit the language codes in the Country Code Text Document located in the XPression Maps
installation files.

«Country Code Text Document is a master list for all users, do not edit this list. 

To configure translation codes for XPression Maps:

1. Navigate to C:\Program Files\XPression Maps\DB folder and open the two Text Documents:

· CountryCodeText - this master list is supplied by the OpenStreetMaps global community and
contains the translation codes for each language provided. Use this list to copy language codes into
the WorkCountryCodeText document. 

« Do not make changes in this document.

CountryCodeText File

· WorkCountryCodeText - this is the local working list of language codes that can be modified as
needed. Paste codes from the CountryCodeText file into the WorkCountryCodeText file to add
them to the language drop-down in the OSM Style Editor. 

WorkCountryCodeText File
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2. Select File > Save to save configurations in the WorkCountryCodeText file and close both
windows.

3. Restart XPression Maps. 

The new language appears. 

«When changing languages, it's important to note that fonts for text drawings and labels need to be

supported for the selected languages. 



106 • Creating and Assigning Map Styles XPression Maps User Guide (v4.0)

Adding OSM Replacement Drawings

Replacement drawings are text drawings that substitute for existing map labels. These replacement labels
are positioned approximately where the original labels would appear. During production, all layers set to
Use As Information are hidden, leaving only the replacement labels and essential visible elements. This
reduces clutter and ensures clarity in the production view.

OSM Replacement Drawings (Original and Production)

This following topics provide instructions for adding, editing, and deleting replacement drawings:

Adding a Replacement Drawing

Editing and Deleting Replacement Drawings

To add a replacement drawing:

There are two ways to add a replacement drawing. 

Method 1: Using the context menu

1. Right-click on a label on the map.

2. From the context menu, select Add Replacement Drawing.

The replacement drawing that has been defined for the selected layer is added to the scene. 

Add Replacement Drawing Context Menus
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Method 2: Double-clicking a label

· On the Canvas, double-click any text label or road shield. 

A new drawing equal to the label in the map style is created.

If a replacement drawing is defined for that layer, the replacement drawing is used. 

Replacement Drawing Added

Once added to a scene, a replacement drawing becomes a regular drawing. It can be edited or deleted
using the same procedures as other drawings. 

To edit and delete replacement drawings:

· See Edit a Drawing  for steps on editing drawings. 

· See Delete a Drawing  for steps on deleting drawings. 

For information on creating and assigning custom replacement drawings, see User Predefined Objects
Panel
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Displaying Disputed Borders and Adding OSM Data

The Disputed Border option allows you to view disputed borders on any map style selected on the
Canvas and add OpenStreetMap (OSM) data to the scene. 

The following topics are discussed in this section:

Activating Disputed Borders

Selecting Disputed Borders

Deactivating Disputed Borders 

When activated, disputed borders are displayed in two colors: green (included) and red (excluded).

For information on adding OpenStreetMap (OSM) data and configuring multilingual labels, see Adding OSM
Replacement Drawings . 

To activate Disputed Borders:

· From the menu bar select Edit > Select Disputed Borders.

OR

·  Press Alt + D on the keyboard. 

The Canvas displays green and red borders in areas of the map that have disputed border lines.

Ø Green borders indicate boundaries that will be included in and displayed in the OSM Map Style.

Ø Red borders indicate boundaries that will be excluded and hidden from the OSM Map Style.

Disputed Borders
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To select Disputed Borders:

· On the Canvas, double-click the borders you want to use.

Ø Each double-click toggles a disputed border between green and red.

Ø Borders marked green are applied as the active boundaries in the map style.

Ø Borders marked in red are hidden and excluded from the map style.

In this way, the selected green borders become the new borders for the Map Style while the red borders
are hidden. 

All border selections are stored in the shared database, ensuring that changes are synchronized and
consistent across all workstations. 

To deactivate Disputed Borders:

· From the menu bar select Edit > Select Disputed Borders.

OR

· Press Alt + D on the keyboard to deactivate disputed borders. 

When deactivated, disputed borders are no longer displayed on the Canvas, but any selections you
previously made remain saved in the database. 
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Exporting a Map

The Export Map feature allows you to write an .hdr file of a selected portion of the output. An .hdr file is
a header file that stores the georeferencing information of an associated raster file.  

Four files are created: 

· a .png image containing the RGB information.

· an .igb file containing the elevation data.

· an .hdr file containing information about the boundaries of the exported map (minimum and maximum
longitude and latitude coordinates), as well as information about the .igb file. 

· an _N.png image that shows the normals that are calculated out of the elevation data.

The following topics describe how to export a newly created map or an existing one that has previously
been exported:

Exporting a New Map

Exporting an Existing Map

To export a new map:

1. With a map displayed on the Canvas, from the menu bar select Output > Export Map.

The Export Map dialog opens. 

Export Map

2. On the Canvas, select and drag the corner points of the bounding box to expand or decrease the
portion of the map to be exported. 

You can also right-click inside the bounding box and drag it to change the position of the box as a
whole. 

3. In the Export Map dialog, select the Browse button ( ) beside the Map Name field to navigate to
the location to which you want to export the map file.

4. In the Export Map File browser, enter a File name for the map and select Save.
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5. In the Image section, select the Resolution in pixels. 

The options are:

· 512

· 1024 

· 2048 

· 3072 

· 4096 

· 8192

Keep Aspect is selected by default so that the height of the exported image has the selected
resolution, and the width is calculated so that the aspect ratio is preserved. 

6. In the Height section, select the Format from the drop-down. 

The options are: 

· png

· raw (igb)

7. Select Save and navigate to the folder where you want to save the Bounding Box file (the .xml file).
Enter a name in the File name field and select Save. 

The path to the Bounding Box file is entered into the Name field. 

8. Select Export to export the files. 

This creates the export files and a bounding box file with the extension .xml. 

This might take some time. When the export is finished, the Export Map dialog closes. 

Selecting Cancel closes the Export Map dialog without creating the files.
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To export an existing map:

1. From the menu bar select Output > Export Map in the menu bar.

The Export Map dialog opens. 

Export Map

2. Select Load and in the Bounding File file explorer, select the file to load and select Open.

The associated .hdr file name appears in the Map Name field and the .xml file appears in the Name
field of the Bounding Box section.

3. Select Export.
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Importing Custom Maps
The Custom Maps workflow is designed for advanced users who need to create and manage high-
resolution and geo-referenced maps. This process is typically used when working with professional-
grade satellite imagery or other large map data sets that must align precisely with the globe. 

A geo-referenced image contains exact location data, allowing it to be mapped to its correct position on
the globe. One of the most common formats for this purpose is GeoTIFF. 

Each large image is processed, and its position among the 21 map levels is calculated. It is also cut into
small images and stored in the database with exact location reference information. This allows for taking
only the visible parts of the image.

For information on map setup, see Creating and Assigning Map Styles .

The Custom Maps editor displays all map data sources that contain imported map data or are ready to
import map data. 

The following topics are discussed in this section:

Creating a Map Data Source

Importing Map Data

Creating Levels

Using Custom Maps
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Creating a Map Data Source

XPression Maps requires a database to store imported map data. By default, an SQLite database is used
and requires no additional setup. This database works immediately with XPression Maps.

SQLite is best suited for smaller datasets. However, performance may decrease when reading or writing
large amounts of data.

If you plan to import more than 4 GB total of image data, it is recommended that you configure a MariaDB
(MYSQL) server to handle the larger dataset.

To create a map data source:

1. From the menu bar select Custom > Maps to open the Custom Maps editor.

Custom Maps Editor

2. In the Custom Maps editor, select New.

The Data Sources editor opens.

Data Sources Editor

3. In the Data Source Name field, enter a unique name.
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4. From the Type drop-down, select whether the data source will use an SQLite file or the mysql
(MariaDB) connection to the server.

· If you select Sqlite, in the Database Details section, select the Browse button ( ) beside the
Data Source File field to navigate to the Sqlite file you want to use and select Save. The file will be
created if it does not exist.

Then select OK and continue with Step 5.

Data Sources Editor - SQLite

· If you select mysql, in the Database Details section, enter the Server Name, Database Name,
User Name and User Password for the database you want to use, to establish a connection with the
server. 

Ø On this server, a separate database needs to be created and the name of the database entered into
the Database Name field. Creation of the database on the server can be done using the HeidiSQL
program. 

Ø Consult the database manual for how to create an empty database.

Then continue with Step 5.

Datasources Editor - MySQL (MariaDB)

The default Details for the XPression Maps Database are: 

Server Name: localhost

Database Name: name of the database 

User Name: your user name  

User Password: your password

5. Select the Test Connection button to open a connection to the database and check if read and write
access exists.

6. If the connection is successful, select OK.
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Importing Map Data

The map import process loads external map datasets into XPression Maps and generates the required map
levels for use in projects. The duration of the import depends on the size of the dataset, and the system is
dedicated to processing until the operation is complete.

« For best results, perform large data imports outside of live production hours, as the system is

unavailable for other tasks during import. 

To import map data:

1. From the menu bar select Custom > Maps to open the Custom Maps editor.

2. In the Satellite Maps tab, select the data source for the custom map you want to import.

3. Select Import.

The Map File explorer opens.

Map File Explorer

4. Select all geo-referenced image files (.tif) needed for the import and select Open.

The Map Import editor opens and the selected image files are listed in the Maps list.

Map Import Editor
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Below the list, you’ll see information displayed about the selected image, as follows:

· Type: the data type of the image

· Size: the image size

· Level: the calculated level where the maximal image resolution is reached

· Tile Progress: displays the progress of the imported file. 

· If you want the level creation to be started automatically at the end of the import, select the Create
Levels after Import checkbox. See Creating Levels  for details about level creation.

· Total Progress: displays the overall progress of the import

· Create Levels after Import: select this checkbox to automatically start the level creation at the end
of the import.

5. Select Start to begin the import process.

The Map Import confirmation dialog appears when the import is successfully completed.

To display a custom map:

1. From the menu bar select Style > Map Styles and in the Map Style Manager, select Edit to open the
Edit Map Style editor.

2. In the Custom Data section, select the Map checkbox.

3. From the drop-down, select your custom map.
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Creating Levels

In the map data importing procedure, the maps are cut into parts and stored in the database with
information about where in the world each map part is located and the resolution (level) of this map part.

Map Import Editor

In the Map Import editor image above, we can see that the example data will be imported into level 13.
This means that we will see the map once we zoom into the location of the imported map in a height
somewhere above street level. Without any level creation, we will only see our imported maps in this
level. The level creation process, started by selecting the Create Levels button in the Custom Maps
editor or by selecting the Create Levels after Import checkbox in the Map Import editor, calculates
map tiles for lower levels out of the imported map tiles.

The next level with higher quality provides four tiles with the same resolution for one tile. This makes the
resolution two times higher in X and Y. For the creation of a tile in the lower levels, we combine four map
tiles to one tile, scale this new tile down to the needed tile size, and write it back into the database for the
lower level. 

Once the next lower level (in our example, level 12) is created the process continues with the next lower
level based on the newly generated level, until the top level is generated. This process reads and writes
heavily from and into the database, and the process usually takes longer than the import of the images. If
you plan to import several map regions, wait until all maps are imported before creating the levels.

« If you import more groups of maps, do not select the automatic Create Levels after Import checkbox

before you start the last import.
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Using Custom Maps

Imported custom maps can be activated in an existing Blue Marble Colored or Blue Marble Satellite style.
This means that when the style is used, the custom map is drawn on top. 

To use a custom map:

1. From the menu bar select Style > Map Styles and in the Map Style Manager, add a new map style to
assign to your custom map. 

See To add a new map style  for more information.

Custom maps can only be assigned to map types using the Sphere projection.

2. Select the new map style and select Edit.

3. In the Edit Map Style editor, in the Custom Data section, select the Map checkbox.

4. From the Map drop-down, select which data source to use.

Imported Map Style

5. At the bottom of the Edit Map Style editor, select OK.

The Edit Map Style editor closes and the Map Style Manager reopens. The edited style is highlighted

and the Save icon  is displayed beside it. If you are editing an existing map style, the Reset icon 
will also be displayed. 

6. Select the Save icon  to save your changes into the default database or select the Reset icon  to
discard your changes and revert to the last saved version of the style.

The Save All button  at the bottom of the dialog saves all changes made to all styles in the
database. 

The Reset All button  at the bottom of the dialog resets all styles in the database to their last
saved version. 

7. In the Save Map Style confirmation dialog that opens, select Yes.

8. Select Done to close the Map Style Manager.
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Map Location and Positioning
When creating map scenes, you’ll need to adjust the positioning and perspective of the active map on the
Canvas to focus on a specific location or area of interest. This perspective, referred to as the camera
view, represents the vantage point from which the content will be displayed, recorded, or seen on air.

The following sections describe the various methods that allow you to make changes to the elements that
make up the camera view, including adjusting the geographic location, positioning and perspective of the
active map on the Canvas:

Manually Adjusting the Camera View

Searching for a Location

Adjusting Camera Parameters

Recalling a Bookmarked Location

« If the scene uses an OSM (OpenStreetMap) map style, you can use the OSM Overview panel  to

quickly search and reposition the map based on OSM layer elements.
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Manually Adjusting the Camera View

To quickly and easily adjust the camera view directly on the Canvas, use the mouse (or a combination of
mouse and keyboard) to zoom in or out, rotate, tilt, or drag to a new location or area of interest.

To manually adjust the positioning of the globe or map displayed in the Canvas:

· Left-click the mouse and drag to rotate the globe/map in the desired direction.

· Press Ctrl + left-click the mouse to spin the globe/map clockwise and counterclockwise (available only
in Sphere projection).

· Press Ctrl + right-click the mouse to tilt the globe vertically. 

· Use the scroll wheel of the mouse or right-click and draw a rectangle around the area of interest to
zoom in or out. 

« By default, to zoom into the map you must scroll backward on the mouse scroll wheel, and to zoom out

of the map you must scroll forward. However, you can change this behavior by selecting the Invert
Mouse Scroll Wheel checkbox in the Preferences > Output page. See Configuring Preferences -
Output  for more information. 37
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Searching for a Location

The Search Editor provides two ways to search and center the active map on the Canvas on a specific
location or area of interest.

· Search (Location/Address, City, Country): Use the Search field in the Search Editor to generate a
list of results.

· Geo Location: Use the Geo Location button to specify an exact location.

Instructions for using both methods are provided below.

« If the scene uses an OSM (OpenStreetMap) map style, you can use the OSM Overview panel  to

quickly search and reposition the map based on OSM layer elements.

To search for a location using the Search field:

1. In the Search Editor, in the Search (Location/Address, City, Country) field, enter the location for
which you want to find a map.

· Separate the different parts of the location with a comma, for example, Ottawa, Ontario, Canada.

· Enter more parameters, such as a street address, to narrow the search results.

2. If you want the map to go directly to the location you are searching, select the Go to Result
checkbox. 

3. Select the Search button.

The search results show all locations found that match the entered information.

Where multiple results are returned, the first result is shown on Canvas and lower quality results will
be highlighted in a different color in the Result pane in the editor.

In the Search Related Shapes section, a list of the available shapes for the searched location appears.
This list is dependent on the search filters selected (Country, States and/or Region).

4. In the Filter section, select the appropriate checkbox to display related shapes by country, region,
shape, or any combination of these.

5. In the Result pane, select the arrow beside the location to see details such as the country and latitude
and longitude of the location.

Search Results

If you haven’t selected the Go to Result checkbox, double-click on any result to switch to that location
on the Canvas.
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To search for a location using Geo Location:

1. Select the Geo Location button ( ) located next to the Search button.

The Geo Location dialog opens.

Geo Location Dialog

2. Enter the Longitude and Latitude coordinates of the location you want to find.

3. From the Zoom Level drop-down, select how broad a view you want. 

Options are:

· Country

· State

· City

· Street

· Address

4. Select Go To. 

Geo Location moves the map to the specified longitude and latitude. 
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Adjusting Camera Parameters

The perspective of what is seen on the Canvas is often called the camera view, as it represents the point
of view of what will be recorded or seen on air. The camera parameters, located below the Canvas, define
the geographical location, view angle and depth of the camera view displayed on the Canvas. 

Camera Parameters

There are five parameters that show the actual values for the camera view:

Zoom Level

Longitude

Latitude

Tilt

Roll

Camera Parameters

«These parameters are also commonly used when creating camera view animations. See Adding Camera

Parameters Key Frames  for more information.

Camera Control

There is one control that affects whether the camera view can be adjusted:

Lock
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Zoom Level

The Zoom Level parameter allows you to set the camera distance to the earth landscape, while the
Elevation field displays the corresponding reference point of altitude above sea level in miles.

A new scene starts with a Zoom Level value of 0. 

A higher value zooms into the map. 

· >30 country level

· >70 region level 

· >130 city level

· >180 street level 

· 250 is the maximum zoom level. However, satellite maps tend to only appear up to a zoom level of 200. 

To adjust the Zoom Level value:

· Enter a value in the Zoom field.

OR

· Select and drag the up and down arrows beside the Zoom field.

OR

· Select within the Canvas and move the scroll button on the mouse.
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Longitude

Along with the Latitude parameter, the Longitude parameter displays the global position, in degrees, of
the location at the center of the Canvas.

When no drawing is selected, rotating the globe changes this parameter.

To adjust the Longitude value:

· Enter a value in the Longitude field.

OR

· Select and drag the up and down arrows beside the Longitude field.

« Animating the Longitude and Latitude parameters with easing will provide the best results when both

parameters have the same settings. See Setting the Easing Method  for more information.

Latitude

Along with the Longitude parameter, the Latitude parameter displays the global position, in degrees, of
the location at the center of the Canvas.

To adjust the Latitude value:

· Enter a value in the Latitude field.

OR

· Select and drag the up and down arrows beside the Latitude field.

« Animating the Longitude and Latitude parameters with easing will provide the best results when both

parameters have the same settings. See Setting the Easing Method  for more information.

Tilt

The Tilt parameter of the camera rotates the globe around the point of the world that is closest to the
camera. The range is 0 to 85 degrees. 

· At 0, the camera looks down vertically onto the map.

· >0, the camera faces the direction of the horizon, giving the map a perspective angle.

To adjust the Tilt value:

· Enter a value in the Tilt field.

OR

· Select and drag the up and down arrows beside the Tilt field.

OR

· Press and hold the Ctrl key, then right-click on the Canvas and move the mouse up or down.
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Roll

The Roll parameter spins the globe clockwise and counter-clockwise along the axis visible on the Canvas.
For example, turning the globe upside down so that the north pole is at the bottom. The range is 0 to 360
degrees.

This option is available only for map styles that use the sphere projection.

To adjust the Roll value:

· Enter a value in the Roll field.

OR

· Select and drag the up and down arrows beside the Roll field.

OR

· Press and hold the Ctrl key, then left-click on the Canvas and move the mouse left or right.
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Lock

The Lock control enables or disables movement of the camera view on the Canvas. When enabled, all
camera parameters are locked, and the globe cannot be moved. 

To enable Lock:

· Select the lock icon  to the right of the camera parameters after setting the camera view as desired.

All camera parameters are disabled, and the globe on the Canvas cannot be moved. 

To disable Lock:

· Select the lock icon  to the right of the camera parameters.

The camera parameters are active, allowing the globe to be repositioned, zoomed, or rotated.  
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Bookmark Editor

The Bookmark Editor enables you to save map positions as presets for frequently used locations and
then organize them into folders for easy access later. 

Bookmarks are saved when you exit the application and automatically reloaded upon the next launch. The
Bookmark Editor saves only the map position, not any drawings added to the scene. Bookmarks always
display in the currently selected map style, regardless of the style in which they were created.
Additionally, bookmarks can be used to add a pause during a flight path.

Bookmark Editor

The following topics are discussed in this section:

Adding and Deleting Bookmark Folders

Adding and Deleting Bookmarks

Recalling and Editing Bookmarks

Saving and Loading Bookmarks
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Adding and Deleting Bookmark Folders

Organize your bookmarks for easy access by sorting them into folders. The following steps outline how to
add a new folder in the Bookmark Editor and how to delete an existing folder.

To add a bookmark folder:

a. In the Bookmark Editor, select the arrow beside the Add Bookmark button and then select Add
Folder.

Bookmark Menu

2. In the New Folder dialog, shown below, enter a name for the folder and select OK.

Add New Bookmark Folder

The new folder is added at the bottom of the Bookmark tab. 

New Bookmark Folder

To delete a folder:

1. In the Bookmark Editor, select the folder you want to delete, to make it the active folder.

2. Select the arrow beside the Add Bookmark button to open the Bookmark menu.

3. From the Bookmark menu, select Delete Folder.

The Delete Bookmark Folder confirmation dialog opens.

Delete Bookmark Folder

4. Select Yes to delete the folder.
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Adding and Deleting Bookmarks

Adding a bookmark lets you quickly return to a specific location with the same camera settings used at the
time of creation. The steps below explain how to add a new bookmark in the Bookmark Editor and how
to delete an existing one.

To add a bookmark:

1. Position the map location on the Canvas to the desired location

2. In the Bookmark Editor, select Add Bookmark.

The New Bookmark dialog opens.

Add New Bookmark

3. In the Name field, add an identifying name for the bookmark and select OK.

A thumbnail of the map is added to the Bookmark folder.

To delete a bookmark:

1. In the Bookmark Editor, select the folder containing the bookmark you want to delete.

2. Select the red X in the corner of the bookmark.

Bookmark

The Delete Bookmark confirmation dialog opens.

Delete Bookmark Confirmation Dialog

3. Select Yes to delete the bookmark.
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Recalling and Editing Bookmarks

The following procedures describe how to recall a saved bookmark to include it in your production, as well
as how to edit the bookmark's name.

To recall a bookmark:

1. In the Bookmark Editor, select the folder containing the bookmark you want, to open it.

2. Select the bookmark thumbnail.

To change a bookmark's name:

1. In the Bookmark Editor, select the folder containing the bookmark whose name you want to change.

2. Double-click the name of the bookmark.

3. In the Change Bookmark Name dialog that opens, type in the new name and select OK. 

Saving and Loading Bookmarks

Bookmarks are automatically saved in a default folder when you exit XPression Maps and are reloaded
upon relaunching the application. Alternatively, you can choose to save them in a folder of your choice for
easier organization.

To save your bookmarks:

1. In the Bookmark Editor, select the arrow beside the Add Bookmark button, to open the Bookmark
menu.

2. From the Bookmark menu, select Save Bookmarks.

3. In the Save File dialog, navigate to the folder where you want to save your bookmarks and select
Save.

The bookmarks are saved in an .xml file, which can then be loaded as needed.

To load your saved bookmarks:

1. In the Bookmark Editor, select the arrow beside the Add Bookmark button, to open the Bookmark
menu.

2. From the Bookmark menu, select Load Bookmarks.

3. In the Load File dialog, navigate to the folder containing the .xml file with your saved bookmarks.

4. Select the bookmark file and select Open.
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Managing Drawings
Over time, you’ll likely build a large collection of drawings to meet the diverse needs of your map projects.
The Drawing Management Editor, shown below, is the tool you’ll use to view and manage the drawings
in the Drawings database. It includes a set of predefined groups where you can add drawings, but you
can also create custom groups to organize them as needed. Additionally, the Drawing Management
Editor allows you to add new drawings to the collection, duplicate existing ones, and modify drawing
properties.

« Other drawing related tools, like the Drawing Toolbox and Drawings Overview panel, are used to

add and configure drawings on the scene, while the Drawing Management Editor is used to create
the design of the drawing and to manage the drawings in the Drawings database. 

Drawing Management Editor

The following sections provide information and instructions for using the Drawing Management Editor to
create, modify, organize, and manage drawings:

Types of Drawings

Opening the Drawing Management Editor

Organizing Drawings into Groups

Adding New Drawings to the Database

Creating a Copy of a Drawing

Renaming a Drawing

Deleting a Drawing

Modifying Drawing Properties

134

141

142

145

146

147

147

148



134 • Managing Drawings XPression Maps User Guide (v4.0)

Types of Drawings

The following topics provide high-level descriptions of the types of drawings that can be added to scenes
in XPression Maps:

Area Drawings

Background Drawings

Container Drawings

Dynamic Data Drawings

Icon Drawings

Inset Drawings

Line Drawings

Locator Drawings

Magnifier Drawings

Text and Replacement Drawings

Video Input Drawings

3D Object Drawings

Area Drawings

Use Area drawings to call out an area of the map to which you want to draw attention, as shown in the
example below. Area drawings can be still or animated.

Example - Area Drawing
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Background Drawings

Use a Background drawing to change the background of a map, as shown in the example below.

Background drawings are  also used for Safe Area images with transparency and for Overlay Full
Screen images in map styles. 

Example - Background Drawing

Container Drawings

Use Container drawings to manage the display of a group of Text drawings  on the map. When linked
to a DataLinq data source , the container drawing coordinates the application of data to certain Text
drawings' properties, which determine which Text drawings are displayed on the map, as well as defining
their exact location, content, and appearance.

While the container drawing can be placed anywhere on the map, it primarily serves as a symbolic
placeholder and does not appear in the final renderings of the map. 

Example - Container Drawing
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Dynamic Data Drawings

Use Dynamic Data drawings to show information about a particular location, such as weather, population,
etc., as shown in the example below. This feature is an option that needs to be selected when ordering
your system. It is not included in all systems.

For more information on options available for XPression Maps, please reach out to your Ross Video sales
professional.

 

Example - Dynamic Data Drawings

Icon Drawings

Use Icon drawings to mark a specific location, as shown in the example below. Icon drawings can be still
or animated.

Example - Icon Drawing
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Inset Drawings

Inset drawings are used to highlight specific regions while also displaying the larger geographical
location. 

You can place Inset drawings on the Overlay Layer or directly onto the map. 

Example - Inset Drawing

Line Drawings

Use Line drawings to show a route on the map, as shown in the example below. Line drawings can be still
or animated.

Example - Line Drawing
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Locator Drawings

Use Locator drawings to show where the location you’re looking at is found in the context of a larger map.
For example, if you place a locator drawing on a city and enlarge it, as shown in the example below, you’ll
see in what part of the country that city is found. Locator drawings are typically used in the Overlay
Layer. See Adding Drawings to an Overlay  for more information.

Example - Locator Drawing

Magnifier Drawings

Use Magnifier drawings to zoom in on a section of the map to get a closer look, as shown in the example
below.

Example - Magnifier Drawing
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Text and Replacement Drawings

Use Text drawings to add your own labels to a map, as shown in the example below. Labels can be Key
Framed to appear and/or disappear at specific points in the timeline during animation.

In OSM Layers, Text drawings are also used as replacement drawings to substitute existing labels on a
map. With replacement drawings, you can insert labels only for the locations of interest, while all other
labels are hidden in the production output. 

Text drawings have many editable properties. These properties are divided into tabs and are described in
Text and Replacement Drawings Properties .

Example - Text Drawing

Video Input Drawings

Use Video Input drawings to define the look and behavior of video inputs in the scene. You can add a
frame around the video input and attach a label, if desired.

You can have up to 4 video inputs in a scene.

Example - Video Input Drawing

166
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3D Object Drawings

A 3D Object drawing is a visual element that places imported 3D models onto a map scene, either on the
globe or an overlay, with optional lighting and shading effects. It is used to represent complex, scalable
objects within the scene and can be fixed in place as a landmark for consistent positioning and size.

Example - 3D Object Drawing
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Opening the Drawing Management Editor

There are two ways to open the Drawing Management Editor. Which method you use depends upon
whether you want access and manage the drawings in the Drawings database, or if you want to view and
edit the properties of a specific drawing. 

To access and manage the drawings in the Drawings database:

· From the XPression Maps menus, select Edit > Manage Drawings.

OR

· In the Drawing Toolbox, select the Browse button  beside the Group drop-down.

The Drawing Management Editor opens and displays all of the current groups and drawings. 

Drawing Management Editor - Access to the Contents of Drawing Database

To view and edit the properties of a specific drawing:

1. In the Drawing Toolbox, select the Group that contains the desired drawing.

2. Right-click the drawing's tile and select Edit Drawing.

The Drawing Management Editor opens with the drawing's properties displayed. See Modifying
Drawing Properties  for descriptions of each of the properties, which may be different depending on
the type of drawing.

Drawing Management Editor - Displays a Single Drawing's Properties

148
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Organizing Drawings into Groups

The Drawing Management Editor comes with a predefined set of groups to which you can add and
organize drawings.

The following section provides instructions for adding a new group, renaming a group, moving a drawing
from one group to another, and deleting a group.

Adding a New Group

Renaming a Group

Moving a Drawing to Another Group

Deleting a Group

Adding a New Group

While the Drawing Management Editor provides a predefined set of groups to which you can add
drawings, you can also create your own groups in which to organize your drawings.

To add a new group:

1. From the menu bar select Edit > Manage Drawings to open the Drawing Management Editor.

2. At the bottom of the Group section on the left side, select New Group.

The Add Group dialog opens.

Add Group

3. In the Group Name field, enter a name for the new group and select OK.

The new group appears in the Name drop-down at the top of the Group section. 

Because it's a new group there are no drawings in it yet.
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Renaming a Group

If you are not satisfied with the current name of a drawing group, you can rename the group at any time.

To rename a group:

1. From the menu bar select Edit > Manage Drawings to open the Drawing Management Editor.

2. In the Group section on the left side, from the Name drop-down, select the group you want to
rename.

3. At the bottom of the Group section, select Rename Group.

The Change Group Name dialog opens.

Change Group Name

4. Enter a new name for the Group and select OK.

The new group name appears in the Name drop-down. 

The new group will contain any drawings that were in the old group.

Moving a Drawing to Another Group

If a drawing appears in the wrong group, use the following procedure to move the drawing from one group
to another group. 

To move a drawing:

1. From the menu bar select Edit > Manage Drawings to open the Drawing Management Editor.

2. On the Group side of the editor, from the Name drop-down, select the Group that contains the
drawing you want to move. 

3. Select the drawing.

4. From the Group drop-down, select the folder into which you want to move the selected drawing.

5. On the Drawing side, select Move.

The drawing is removed from the original folder and moved to the selected folder.

6. Select Done to close the Drawing Management Editor.
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Deleting a Group

If a group, and its drawings, are no longer needed, use the following procedure to permanently delete it
from the system.

«Deleting a group also permanently deletes all of the drawings within that group.

To delete a group:

1. From the menu bar select Edit > Manage Drawings to open the Drawing Management Editor.

2. In the Group section on the left side, from the Name drop-down, select the group you want to delete.

3. At the bottom of the Group section, select Delete Group.

4. The Delete Group confirmation dialog opens. 

Delete Group Confirmation

5. Select the Confirm the group delete checkbox and select Yes. 

The final Delete Group dialog opens. 

Final Delete Group Dialog

6. Select Yes to delete the group.

The Group and its Drawings are deleted.
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Adding New Drawings to the Database

The following procedures outline how to create and add a new drawing to the Drawings database using
either the Drawing Management Editor or the Drawing Toolbox. Both methods produce the same
results; however, the Drawing Toolbox is more convenient when building scenes, while the Drawing
Management Editor is better suited for creating and managing an inventory of assets.

To create a new drawing using the Drawing Management Editor:

1. From the XPression Maps menus, select Edit > Manage Drawings.

OR

In the Drawing Toolbox, select the Browse button  beside the Group drop-down.

The Drawing Management Editor opens and displays all of the current groups and drawings. 

2. From the Name drop-down in the Group section, select the folder to which you want to add a new
drawing.

3. At the bottom of the Drawing section on the right side, select New.

4. In the New Drawing dialog, select the drawing type from the drop-down and select OK.

The drawing's properties appear in the Drawing section of the Drawing Management Editor.

5. In the Name field, type a name for the new drawing.

6. Define the properties of the drawing as described in Modifying Drawing Properties . 

7. When you’ve finished defining the properties, select Update at the bottom of the Drawing section to
save your changes.

The new drawing is added to the list of drawings in the selected group in the Drawing Management
Editor.

8. Select Done to close the editor and make your drawing available in the Drawing Toolbox.

To create a new drawing using the Drawing Toolbox: 

1. In the Drawing Toolbox, from the Group drop-down, select the folder to which you want to add a new
drawing.

2. Select the New Drawing thumbnail to open the Drawing Management Editor.

New Drawing Thumbnail

3. In the New Drawing dialog, select the drawing type from the drop-down and select OK.

When you select the icon or background drawing type, you will be taken to the Open Image File
dialog, from which you can select an image. If you prefer to use one of the default images, close this
dialog and select the image from the Image drop-down in the Drawing Management Editor. 

The process is similar for 3D Object drawing types: you can choose a model file from the Select File
dialog, or select Cancel to choose or add a model later in the drawing’s properties within the Drawing
Management Editor.

4. Define the properties of the drawing as described in Modifying Drawing Properties . 

5. When you’ve finished defining the properties, select Done.

The new drawing is added to the list of drawings in the preview pane of the Drawing Toolbox.
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Creating a Copy of a Drawing

At times, an existing drawing may almost meet your needs but requires slight adjustments. Or, you might
need a series of drawings that are nearly identical, differing only in characteristics like color or text.
Instead of starting from scratch for each one, you can copy an existing drawing, make the necessary
modifications, and save it as a new file.

To make a copy of a drawing:

1. From the menu bar select Edit > Manage Drawings to open the Drawing Management Editor.

2. On the Group side of the editor, from the Name drop-down, select the Group that contains the
drawing you want to copy and then select the drawing.

3. From the Group drop-down, select the folder into which you want to copy the selected drawing.

This may be the same folder that the drawing you want to copy is in.

4. On the Drawing side, change the name of the drawing and then select Duplicate.

The drawing now appears at the bottom of the list for the selected group.

5. Select the drawing from the list and make changes to its properties in the right-side panel. See
Modifying Drawing Properties  for more information.

6. Select Update.

7. Select Done to close the Drawing Management Editor.
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Renaming a Drawing

If you're not satisfied with a drawing's current name, you can rename it directly within the Drawing
Management Editor.

« Alternatively, you can rename a drawing that's been added to the scene by double-clicking the

drawing's name in the Drawing Overview panel and typing a new name.

To rename a drawing:

1. From the menu bar select Edit > Manage Drawings to open the Drawing Management Editor.

2. On the Group side of the editor, from the Name drop-down, select the Group that contains the
drawing you want to rename.

3. Select the drawing you want to rename.

4. On the Drawing side of the editor, delete the drawing Name and enter a new descriptive name for the
drawing.

5. Select Update.

6. Select Done to close the Drawing Management Editor.

The drawing is renamed.

Deleting a Drawing

If a drawing is no longer needed, use the following procedure to permanently delete it from the system.

To delete a drawing:

1. From the menu bar select Edit > Manage Drawings to open the Drawing Management Editor.

2. On the Group side of the editor, from the Name drop-down, select the Group that contains the
drawing you want to delete

3. Select the drawing you want to delete.

4. On the Drawing side of the editor, select Delete.

The Delete Drawing confirmation dialog opens.

Delete Drawing Confirmation Dialog

5. Select Yes to delete the drawing.

6. Select Done to close the Drawing Management Editor.
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Modifying Drawing Properties

Each type of drawing comes with its own set of properties that define its appearance, behavior, and, in
some cases, its content. When you add a drawing to the Drawing database, you can adjust these
properties to tailor the drawing to your specific needs and preferences.

« Later when a drawing is added to a scene, additional parameters can be set to define the drawing's

attributes and behavior within the scene. See Adding and Editing Drawings  for more information.

To modify a drawing's properties:

1. From the menu bar select Edit > Manage Drawings to open the Drawing Management Editor.

« Alternatively, you can access a specific drawing's properties by right-clicking the drawing in the

Drawing Toolbox and selecting Edit Drawing.

2. In the Group section on the left side, from the Name drop-down, select the Group that contains the
drawing you want to modify. 

3. From the Group list, select the drawing you want to modify.

The properties of the selected drawing are displayed in the Drawing section on the right side.

4. Modify the properties of the drawings as described in the section corresponding to the type of drawing. 

Area Drawings Properties

Background Drawings Properties

Container Drawings Properties

Dynamic Data Drawings Properties

Icon Drawings Properties

Inset Drawings Properties

Line Drawings Properties

Locator Drawings Properties

Magnifier Drawings Properties

Text and OSM Replacement Drawings Properties  

Video Input Drawings Properties

3D Object Drawings Properties

5. Select Update at the bottom of the Drawing section to save your changes.

6. Select Done to close the editor and make your drawing available in the Drawing Management
Editor.
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Area Drawings Properties

The Area drawing properties are described in the table below. 

Properties - Area Drawings

Property Description

Color Select an existing color using the drop-down or select the Browse button ( ) to add
a new color for the drawing.

The selected color will be applied to the image, if an image is selected.

Image Select an existing image from the drop-down or select the Browse button ( ) to add
a new image.  

If an image is selected, the area will be textured with this image.

Pause At End Enter a value or use the arrows to set the number of frames for which an image
sequence will pause at the last image before looping.

Slowdown When an animated image is selected, this is the number of frames, expressed as a
percentage, by which the movement of the animated image will be slowed.
Accordingly, a negative value will speed up the movement.

Outline Select an existing color using the drop-down or select Browse to add a new color for
the outline. 

Enter a value or use the arrows to increase or decrease the thickness of the outline. 

The default is no outline. 

Visibility 

(In and Out)

 

The transition effect used when an area drawing appears (In) and disappears (Out)
during animation.  

The Effect options are: 

None — the drawing appears/disappears instantly at the frame to which the Key
Frame is set. Use the Delay field to input the number of seconds that the drawing will
delay its animation.

Dissolve — the drawing blends in and out over the number of seconds selected in the
Time field. The drawing animates in and out at the level set in the corresponding
Zoom field. Use the Delay field to input the number of seconds that the drawing will
delay its animation.

Flight Mode — Select the Flight Mode checkbox to control the drawing's visibility at
the flight point level during flight map animations. If the checkbox is cleared, visibility

is instead managed at the scene level. When enabled, a small airplane icon 
 appears on the drawing's preview image to indicate Flight Mode is enabled. 
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Background Drawings Properties

The Background drawing properties are described in the table below. 

Properties - Background Drawings - General Tab

Property Description

Color Defines the fullscreen background color, independent of Background Mode.

Select an existing color using the drop-down or select the Browse button ( ) to add
a new color to apply to the background drawing.

If no color is selected, the background will be transparent.

Image Select an existing image using the drop-down or select the Browse button ( ) to
add a new image.

If selected, the image is used as the background when this drawing is selected in the
Scene Properties editor or from the Drawing Toolbox. 

Select the Auto checkbox to make the image size scale automatically as the map
zooms in and out. 

Select the Use on Replace checkbox to use the default scale when replacing one
drawing with another.

Pause At End Enter a value or use the arrows to set the number of frames for which an image
sequence will pause at the last image before looping.

Slowdown When an animated image is selected, this is the number of frames, expressed as a
percentage, by which the movement of the animated image will be slowed.
Accordingly, a negative value will speed up the movement.

Blend Mode The default mode is Regular.

Options are:

Regular — the area is color combined with the underlying map color. 

This is the most common blend method.

Multiply — the area color is multiplied with the underlying map color.

Add — the area color is added to the underlying map color.
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Container Drawings Properties

The properties found in the Container editor are described in the table below.

Properties - Container Drawings

Property Description

Name Enter a name for the container drawing that relates to the data source.

Type The type is populated by default and is not editable.
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Dynamic Data Drawings Properties

The Dynamic Data drawing properties are described in the table below. 

Properties - Dynamic Data Drawings

Property Description

Writing
Direction

Select the writing direction for the text that is used in the dynamic data drawing. 

Options are Left to Right or Right to Left.

Layout Select the layout file that defines the look of the dynamic data drawing.

Font Select an existing font using the drop-down or select the Browse button ( ) to add a
new font to apply to the text of the dynamic data drawing.

Color Select an existing color using the drop-down or select the Browse button ( ) to add
a new color to apply to the text of the dynamic data drawing.

If no color is selected, the text will be invisible.

Background
Color

This property only takes effect if there is no background image selected.

If a background color is selected, a rectangle in this color will be drawn behind the
text. The size of the rectangle corresponds to the text size with a small offset.

Background
Image

Select an existing image using the drop-down or select the Browse button ( ) to add
a new image.

If a background image is selected, the background color (if set) will not be applied. 

A rectangle textured with the image will be drawn behind the text. 

The size of the rectangle corresponds to the actual text size with a small offset, so the
background image grows as the text grows.

Default Scale The default value of the Scale property for the drawing.

Shadow Color Select an existing color using the drop-down or select the Browse button ( ) to add
a new color to apply to the shadow of the text.
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Property Description

Shadow Angle This image illustrates how the direction and angle of shadows vary depending on the
specified degree.

Shadow
Distance

The distance that the shadow falls from the text. A larger value moves the shadow
further away from the text. 

Visibility 

(In and Out)

How a dynamic data drawing appears (In) and disappears (Out) during animation. 

The default effect that plays as the drawing appears during animation. The effect can
only be seen when the animation is played.  

Options are:

None — the drawing appears instantly at the frame to which the Key Frame is set. 

Dissolve — the drawing animates in and out at the level set in the corresponding
Zoom fields. The drawing blends in over the number of seconds selected in the Time
field. Use the Delay field to input the number of seconds that the drawing will delay
its animation. 

Wipe Left — the drawing animates in and out at the level set in the corresponding
Zoom field. The drawing enters from the left over the number of seconds selected in
the Time field. Use the Delay field to input the number of seconds that the drawing
will delay its animation. 

Wipe Right — the drawing animates in at the level set in the corresponding Zoom
field. The drawing enters from the right over the number of seconds selected in the
Time field. Use the Delay field to input the number of seconds that the drawing will
delay its animation.

Wipe Bottom — the drawing animates in and out at the level set in the corresponding
Zoom field. The drawing enters from the bottom over the number of seconds selected
in the Time field. Use the Delay field to input the number of seconds that the drawing
will delay its animation.

Wipe Top — the drawing animates in and out at the level set in the corresponding
Zoom field. The drawing enters from the top over the number of seconds selected in
the Time field. Use the Delay field to input the number of seconds that the drawing
will delay its animation.

Flight Mode — Select the Flight Mode checkbox to control the drawing's visibility at
the flight point level during flight map animations. If the checkbox is cleared, visibility

is instead managed at the scene level. When enabled, a small airplane icon 
 appears on the drawing's preview image to indicate Flight Mode is enabled.
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Icon Drawings Properties

The Icon drawing properties are described in the following sections:

General Tab

Shadow Tab

General Tab

Properties - Icon Drawings - General Tab

The properties in the General tab are described in the following table.

Property Description

Color Select an existing color using the drop-down or select the Browse button ( ) to add a
new color for the icon drawing.

The selected color will be applied to the image, if an image is selected.

If no color is selected, the drawing will not be visible.

Image Select an existing image from the drop-down or select the Browse button ( ) to add
a new image.  

If an image is selected, the drawing will be textured with this image. 

If no image is selected, the drawing will be a rectangle of the selected color.

Pause At End Enter a value or use the arrows to set the number of frames for which an image
sequence will pause at the last image before looping.

Slowdown When an animated image or flip book animation is selected, the slowdown value
controls the playback speed as a percentage. A positive value slows down the
animation by increasing the time between frames, while a negative value speeds it up
by decreasing the frame duration. 
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Property Description

Default Scale The default value of the Scale property for the drawing. 

Select the Auto checkbox to make the icon size scale automatically as the map zooms
in and out. 

Select the Use on Replace checkbox to use the default scale when replacing one icon
drawing with another.

The effect can be changed in the Drawing Editor, when the icon drawing is selected
on the Canvas.

See Size  for more information.

Blend Mode The default mode is Regular.

Options are:

Regular — the icon color is combined with the underlying map color.

This is the most common blend method.

Multiply — the icon color is multiplied with the underlying map color.

Add — the icon color is added to the underlying map color.

Visibility  

(In and Out)

How an icon drawing appears (In) and disappears (Out) during animation.  

Options are: 

None — the drawing appears/disappears instantly at the frame to which the Key
Frame is set. Use the Delay field to input the number of seconds that the drawing will
delay its animation.

Dissolve — the drawing animates in and out at the level set in the corresponding
Zoom fields. The drawing blends in/out over the number of seconds selected in the
Time field. Use the Delay field to input the number of seconds that the drawing will
delay its animation.

Wipe Left — the drawing animates in and out at the level set in the corresponding
Zoom fields. The drawing appears/disappears from the left over the number of
seconds selected in the Time field. Use the Delay field to input the number of seconds
that the drawing will delay its animation.

Wipe Right — the drawing animates in and out at the level set in the corresponding
Zoom fields. The drawing appears/disappears from the left over the number of
seconds selected in the Time field. Use the Delay field to input the number of seconds
that the drawing will delay its animation.

Wipe Bottom — the drawing animates in and out at the level set in the corresponding
Zoom fields. The drawing appears/disappears from the bottom over the number of
seconds selected in the Time field. Use the Delay field to input the number of seconds
that the drawing will delay its animation.

Wipe Top — The drawing animates in and out at the level set in the corresponding
Zoom fields. The drawing appears/disappears from the top over the number of
seconds selected in the Time field. Use the Delay field to input the number of seconds
that the drawing will delay its animation.

Flight Mode — Select the Flight Mode checkbox to control the drawing's visibility at
the flight point level during flight map animations. If the checkbox is cleared, visibility

is instead managed at the scene level. When enabled, a small airplane icon  appears
on the drawing's preview image to indicate Flight Mode is enabled. 
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Shadow Tab

Properties - Icon Drawings - Shadow Tab

The properties in the Shadow tab are described in the following table. 

Property Description

Shadow Color Select an existing color using the drop-down or select the Browse button ( ) to add a
new color to apply to the shadow of the icon. 

Shadow Angle This image illustrates how the direction and angle of shadows vary depending on the
specified degree.

Shadow
Distance

The distance that the shadow falls from the icon. A larger value moves the shadow
further away from the icon. 

Shadow Blur Enter a value or use the arrows set to the degree by which the shadow appears out-of-
focus. 

The maximum value is 20. The minimum value is 0.



XPression Maps User Guide (v4.0) Managing Drawings • 157

Inset Drawings Properties

The properties found in the Inset editor are described in the table below.

Properties - Inset Drawings

Property Description

Visibility

(In and Out)

How an inset drawing appears (In) and disappears (Out) during animation.  

Options are: 

None — the drawing appears/disappears instantly at the frame to which the Key
Frame is set. 

Dissolve — the drawing animates in and out at the level set in the corresponding
Zoom fields. The drawing blends in/out over the number of seconds selected in the
Time field. Use the Delay field to input the number of seconds that the drawing will
delay its animation. 

Wipe Left — the drawing animates in and out at the level set in the corresponding
Zoom fields. The drawing appears/disappears from the left over the number of
seconds selected in the Time field. Use the Delay field to input the number of seconds
that the drawing will delay its animation. 

Wipe Right — the drawing animates in and out at the level set in the corresponding
Zoom fields. The drawing appears/disappears from the left over the number of
seconds selected in the Time field. Use the Delay field to input the number of seconds
that the drawing will delay its animation. 

Wipe Bottom — the drawing animates in and out at the level set in the corresponding
Zoom fields. The drawing appears/disappears from the bottom over the number of
seconds selected in the Time field. Use the Delay field to input the number of seconds
that the drawing will delay its animation. 

Wipe Top — the drawing animates in and out at the level set in the corresponding
Zoom fields. The drawing appears/disappears from the top over the number of
seconds selected in the Time field. Use the Delay field to input the number of seconds
that the drawing will delay its animation. 

Flight Mode — Select the Flight Mode checkbox to control the drawing's visibility at
the flight point level during flight map animations. If the checkbox is cleared, visibility

is instead managed at the scene level. When enabled, a small airplane icon 
 appears on the drawing's preview image to indicate Flight Mode is enabled. 
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Property Description

Locator Select a Locator Reference to display a reference point on the map on the Canvas. 

Select the browse button to open the Select Locator Reference window and select a
tool from the drop-down. 

Select the icon you want to use, double-click to select it or press Select. 

Adjust the Default Scale to increase or decrease the size of the reference icon you
selected. 

The Default Scale value is 1.00.

Shadow Color Select an existing color using the drop-down or select the Browse button ( ) to add
a new color to apply to the shadow of the icon.

Shadow Angle This image illustrates how the direction and angle of shadows vary depending on the
specified degree.

Shadow
Distance

The distance that the shadow falls from the icon. A larger value moves the shadow
further away from the icon. 

Shadow Blur Enter a value or use the arrows set to the degree by which the shadow appears out-of-
focus. 

The maximum value is 20. The minimum value is 0. 

Border Select the Border checkbox to add a border to the Locator drawing.

When enabled, the Border will have the properties configured in this section.

Color — Select an existing color using the drop-down or select the Browse button (
) to add a new color to apply to the border. 

Width — Enter a value or use the arrows to set the thickness of the border. 

Auto Scale
Content

When selected, the Text drawings inside of the Inset maintain their size. In other
words, zooming in or out does not affect the size of the Text drawings inside the Inset.
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Line Drawings Properties

The Line drawing properties are described in the table below.

Properties - Line Drawings

Property Description

Color Select an existing color using the drop-down or select the Browse button ( ) to add a
new color for the drawing.

The selected color will also be applied to the image, if an image is selected.

If no color is selected, the drawing will not be visible.

Image Select an existing image from the drop-down or select the Browse button ( ) to add
a new image.  

If an image is selected, the line will be textured with this image. 

Pause At End Enter a value or use the arrows to set the number of frames for which an image
sequence will pause at the last image before looping.

Slowdown When an animated image is selected, this is the number of frames, expressed as a
percentage, by which the movement of the animated image will be slowed. Accordingly,
a negative value will speed up the movement.

Default Scale The default value of the Scale property for the drawing. 

The default scale can be changed in the Drawing Editor. See Size  for more
information.

Visibility 

(In and Out)

 

How a line drawing appears (In) and disappears (Out) during animation.  

Options are: 

None — the drawing appears/disappears instantly at the frame to which the Key Frame
is set. Use the Delay field to input the number of seconds that the drawing will delay
its animation.

Dissolve — the drawing blends in and out over the number of seconds selected in the
Time field. The drawing animates in and out at the level set in the corresponding
Zoom field. Use the Delay field to input the number of seconds that the drawing will
delay its animation.

Flight Mode — Select the Flight Mode checkbox to control the drawing's visibility at
the flight point level during flight map animations. If the checkbox is cleared, visibility

is instead managed at the scene level. When enabled, a small airplane icon  appears
on the drawing's preview image to indicate Flight Mode is enabled. 
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Locator Drawings Properties

Use Locator drawings to show where the location you’re looking at is found in the context of a larger map.
For example, if you place a locator drawing on a city and enlarge it, as shown in the example below, you’ll
see in what part of the country that city is found. Locator drawings are typically used in the Overlay
Layer. See Adding Drawings to an Overlay Layer  for more information.

Example - Locator Drawing

Properties - Locator Drawings

The Locator drawing properties are described in the following table. 

Property Description

Color Defines the color of the border image selected in the Image property.

Select an existing color using the drop-down or select the Browse button ( ) to add
a new color for the Locator drawing.

The selected color will be applied to the border image, if one is selected.

If no color is selected, the selected border image will be invisible. 

If a color is selected but a border image is not, the Locator drawing will be filled with
the color. Also, if no color is selected, and a border image is selected, the default color
of the border image will be used.

Image Select an existing image from the drop-down or select the Browse button ( ) to add
a new image. The image provides a border for the map that is highlighted in the
drawing. 

For the locator drawing to work properly, there must be a transparent area in the
center of the image that is completely surrounded by graphics. Towards the edges of
the image, transparent areas are possible. The image defines the area where the maps
(Bing Aerial, Bing Aerial Label, or Bing Road) are shown.

The drawing will be enclosed within this image. 
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Property Description

An image must be selected for a Locator drawing.

In Effect The default effect that plays as the drawing appears during animation. The effect can
only be seen when the animation is played.  

Options are:

None — the drawing appears instantly at the frame to which the Key Frame is set. 

Dissolve —  the drawing animates in at the level set in the corresponding Zoom Level
field.

Wipe Left — the drawing animates from the left at the level set in the corresponding
Zoom Level field.

Wipe Right — the drawing animates from the right at the level set in the
corresponding Zoom Level field.

Wipe Bottom — the drawing animates from the bottom at the level set in the
corresponding Zoom Level field.

Wipe Top — the drawing animates from the top at the level set in the corresponding
Zoom Level field.

The effect can be changed in the Drawing Editor in the Effect section, when the
drawing is selected on the Canvas. 

See Effect  for more information.

Out Effect The default effect that plays as the drawing disappears during animation. The effect
can only be seen when the animation is played.  

Options are:

None — the drawing disappears instantly at the frame to which the key frame is set. 

Dissolve — the drawing blends out at the level set in the corresponding Zoom Level
field.

Wipe Left — the drawing animates out from the left at the level set in the
corresponding Zoom Level field.

Wipe Right — the drawing animates out from the right at the level set in the
corresponding Zoom Level field.

Wipe Bottom — the drawing animates out from the bottom at the level set in the
corresponding Zoom Level field.

Wipe Top — the drawing animates out from the top at the level set in the
corresponding Zoom Level field.

The effect can be changed in the Drawing Editor in the Effect section, when the
drawing is selected on the Canvas. 

See Effect  for more information.

Zoom Level The default value of the Zoom Level for this drawing.

The effect can be changed in the Drawing Editor, when the drawing is selected on the
Canvas.

See Locator Drawing Parameters  for more information.
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Property Description

Map Style Defines the default map style for this drawing.

Options are:

Bing Aerial

Bing Aerial Label

Bing Road

Bing Road Dark

Bing Road Gray

Bing Road Light

The effect can be changed in the Drawing Editor, when the drawing is selected on the
Canvas.

See Locator Drawing Parameters  for more information.

Map Zoom Defines the default map zoom value for this drawing.

The effect can be changed in the Drawing Editor, when the drawing is selected on the
Canvas.

See Locator Drawing Parameters  for more information.
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Magnifier Drawings Properties

The Magnifier drawing properties are described in the following table.

Properties - Magnifier Drawings

Property Description

Color Defines the color of the border of the image selected in the Image property.

Select an existing color using the drop-down or select the Browse button to add a new
color.

The selected color will be applied to the border of the image, if one is selected.

If a color is selected but a border image is not, the Locator drawing will be filled with
the color. Also, if no color is selected, and a border image is selected, the default color
of the border image will be used.

If no color is selected, the selected border image will be invisible. 

Image Select an existing image from the drop-down or select the Browse button ( ) to add
a new image. The image provides a border for the map that is highlighted in the
drawing. 

For the Magnifier drawing to work properly, there must be a transparent area in the
center of the image that is completely surrounded by graphics. Towards the edges of
the image, transparent areas are possible. The image defines the area where the maps
(Bing Aerial, Bing Aerial Label, or any of the Bing Road maps) are shown.

The drawing will be enclosed within this image. 

An image must be selected for a Magnifier drawing.
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Property Description

In Effect The default effect that plays as the drawing appears during animation. The effect can
only be seen when the animation is played.  

Options are:

None — the drawing appears instantly at the frame to which the Key Frame is set. 

Dissolve —  the drawing animates in at the level set in the corresponding Zoom Level
field.

Wipe Left — the drawing animates from the left at the level set in the corresponding
Zoom Level field.

Wipe Right — the drawing animates from the right at the level set in the
corresponding Zoom Level field.

Wipe Bottom — the drawing animates from the bottom at the level set in the
corresponding Zoom Level field.

Wipe Top — the drawing animates from the top at the level set in the corresponding
Zoom Level field.

The effect can be changed in the Drawing Editor in the Effect section, when the
drawing is selected on the Canvas. 

See Effect  for more information.

Out Effect The default effect that plays as the drawing disappears during animation. The effect
can only be seen when the animation is played.  

Options are:

None — the drawing disappears instantly at the frame to which the key frame is set. 

Dissolve — the drawing blends out at the level set in the corresponding Zoom Level
field.

Wipe Left — the drawing animates out from the left at the level set in the
corresponding Zoom Level field.

Wipe Right — the drawing animates out from the right at the level set in the
corresponding Zoom Level field.

Wipe Bottom — the drawing animates out from the bottom at the level set in the
corresponding Zoom Level field.

Wipe Top — the drawing animates out from the top at the level set in the
corresponding Zoom Level field.

The effect can be changed in the Drawing Editor in the Effect section, when the
drawing is selected on the Canvas. 

See Effect  for more information.

Zoom Level The default value of the Zoom Level for this drawing.

Valid values are 1 to 21.

The effect can be changed in the Drawing Editor, when the drawing is selected on the
Canvas. 

See Magnifier Drawing Parameters  for more information.
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Property Description

Map Style Defines the default map style for this drawing.

Options are:

Bing Aerial

Bing Aerial Label

Bing Road

Bing Road Dark

Bing Road Gray

Bing Road Light

The effect can be changed in the Drawing Editor, when the drawing is selected on the
Canvas. 

See Magnifier Drawing Parameters  for more information.

Map Zoom The zoom value for the area of a map.

The effect can be changed in the Drawing Editor, when the drawing is selected on the
Canvas. 

See Magnifier Drawing Parameters  for more information.
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Text and Replacement Drawings Properties

Text and Replacement Drawings have many editable properties. The properties are divided into tabs
and are described in the following sections:

General Tab

Label Tab

Decoration Tab

Background Tab

Edge Tab

Marker Tab

Callout Tab

General Tab

Drawings Properties - Text Drawings - General Tab

The properties found in the General tab are described in the following table. 

Property Description

Direction Sets the writing direction for the text that is used in the drawing. 

Options are Left to Right or Right to Left.

Default Text The example text that appears in the preview. This text also appears as the preview
icon in the group of drawings in which it is located.

166

169

171

173

176

177

179



XPression Maps User Guide (v4.0) Managing Drawings • 167

Property Description

Default Scale The default size of the text.

Select the Auto checkbox to make the text size scale automatically as the map zooms
in and out. 

This effect can be changed in the Drawing Editor, when the drawing is selected on
the Canvas. 

Select the Use on Replace checkbox to use the default scale when replacing one text
drawing with another.

See Size  for more information.

Offset X The distance that the text drawing is offset from the center of the text along the X-axis
of the map.

Set to something other than 0.0 to make the callout arrow or line visible.

Offset Y The distance that the text drawing is offset from the center of the text along the Y-axis
of the map.

Set to something other than 0.0 to make the callout arrow or line visible.

Visibility  

(In and Out)

How a text and replacement drawing appears (In) and disappears (Out) during
animation.  

Options are: 

None — the drawing appears/disappears instantly at the frame to which the Key
Frame is set. Use the Delay field to input the number of seconds that the drawing will
delay its animation.

Dissolve — the drawing animates in and out at the level set in the corresponding
Zoom fields. The drawing blends in/out over the number of seconds selected in the
Time field. Use the Delay field to input the number of seconds that the drawing will
delay its animation.

Typewriter — the drawing animates in and out at the level set in the corresponding
Zoom fields. The appears/disappears one character at a time over the number of
seconds selected in the Time field. Use the Delay field to input the number of seconds
that the drawing will delay its animation.

Alpha — the drawing animates in and out at the level set in the corresponding Zoom
fields. The drawing blends in/out one character at a time over the number of seconds
selected in the Time field. Use the Delay field to input the number of seconds that the
drawing will delay its animation.

Wipe — The drawing animates in and out at the level set in the corresponding Zoom
fields. The drawing appears from the right over the number of seconds selected in the
Time field. Use the Delay field to input the number of seconds that the drawing will
delay its animation.

Wipe Reverse — the drawing animates in and out at the level set in the corresponding
Zoom fields. The drawing appears from the left over the number of seconds selected in
the Time field. Use the Delay field to input the number of seconds that the drawing
will delay its animation.

Wipe Left — the drawing animates in and out at the level set in the corresponding
Zoom fields. The drawing appears/disappears from the left over the number of
seconds selected in the Time field. Use the Delay field to input the number of seconds
that the drawing will delay its animation.

Wipe Right — the drawing animates in and out at the level set in the corresponding
Zoom fields. The drawing appears/disappears from the left over the number of
seconds selected in the Time field. Use the Delay field to input the number of seconds
that the drawing will delay its animation.
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Property Description

Wipe Bottom — the drawing animates in and out at the level set in the corresponding
Zoom fields. The drawing appears/disappears from the bottom over the number of
seconds selected in the Time field. Use the Delay field to input the number of seconds
that the drawing will delay its animation.

Wipe Top — The drawing animates in and out at the level set in the corresponding
Zoom fields. The drawing appears/disappears from the top over the number of
seconds selected in the Time field. Use the Delay field to input the number of seconds
that the drawing will delay its animation.

Flight Mode — Select the Flight Mode checkbox to control the drawing's visibility at
the flight point level during flight map animations. If the checkbox is cleared, visibility

is instead managed at the scene level. When enabled, a small airplane icon  appears
on the drawing's preview image to indicate Flight Mode is enabled.
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Label Tab

Properties - Text Drawings - Label Tab

The properties found in the Label tab are described in the following table. 

Property Description

Text Font — Select an existing font using the drop-down or select the Browse button ( )

to add a new font to be applied to the text.

Color — Select an existing color using the drop-down or select the Browse button (
) to add a new color.

If no color is selected, the text drawing will not be visible.

Transform — Select either None, UPPERCASE or lowercase.

None: The text will be displayed exactly as entered.

UPPERCASE: The text will be displayed as all uppercase, regardless of how it is
entered.

lowercase: The text will be displayed as all lowercase, regardless of how it is entered.

Kerning — Enter a value or use the arrows to set the amount of space between letters.

This effect can be changed in the Drawing Editor in the Text section, when the
drawing is on the Canvas.

Line Spacing — Enter a value or use the arrows to set the amount of space between
multiple lines of text.

This effect can be changed in the Drawing Editor in the Text section, when the
drawing is selected on the Canvas.
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Property Description

Alignment Horizontal —  The longitude coordinate of the text drawing corresponds to the left
side of the text if this property is set to Left, to the right side of the text if this
property is set to Right and to the center of the text if this property is set to Center.

Vertical — If this property is set to Top, the latitude coordinate of the text drawing
will correspond to the highest theoretical possible character in the first line. This is to
have static baselines. If the latitude coordinate actually corresponded to the top of the
text, the baselines (and so the whole text) would change position whenever the text
changes. 

Accordingly, for Center, the latitude coordinate is not really in the center of the text
but at a position close to the center where baselines only change when the number of
lines changes.

For Bottom, the baseline of the last line in the text will correspond to the latitude
coordinate.

For Baseline, the baseline of the first line of the text will correspond to the latitude
coordinate.
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Decoration Tab

Properties - Text Drawings - Decoration Tab

The properties found in the Decoration tab are described in the following table. 

Property Description

Shadow Color Select an existing color using the drop-down or select the Browse button ( ) to add
a new color.

Shadow Angle This image illustrates how the direction and angle of shadows vary depending on the
specified degree.

Shadow
Distance

The distance that the shadow falls from the text. A larger value moves the shadow
further away from the text. 

Shadow Enlarge Enter a value or use the arrows to set an amount by which to enlarge the shadow. 

Shadow Blur Enter a value or use the arrows to set the degree by which the shadow appears out-of-
focus.
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Property Description

Border Select the Border checkbox to add a border around the outside of the text characters.

Color — Select an existing color for the border using the drop-down or select the
Browse button ( ) to add a new color.

Enlarge  — Enter a value or use the arrows to set an amount by which to enlarge the
border.

Glow Select the Glow checkbox to add a glow effect around the outside of the text
characters.

Enlarge — Enter a value or use the arrows to set an amount by which to enlarge the
glow.

Blur — Enter a value or use the arrows to set the degree by which the glow appears
out-of-focus.

Bevel Select the Bevel checkbox to add a bevel effect around the outside of the text
characters, giving them a 3D appearance.

Enlarge — Enter a value or use the arrows to set an amount by which to enlarge the
bevel.

Direction — Enter a value or use the arrows to set the degree at which the bevel will
appear on the text characters.
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Background Tab

Properties - Text Drawings - Background Tab 

The properties found in the Background tab are described in the following table.

Property Description

Scale X Enter a value or use the arrows to set the default width of the rectangle that forms the
background for the text drawing.

1.00 is the minimum size. 2.0 makes the background double the size of the text box.

This property is only available if TextFit is set to Unlinked.

Scale Y Enter a value or use the arrows to set the default height of the rectangle that forms
the background for the text drawing. 

1.00 is the minimum size. 2.0 makes the background double the size of the text box.

This property is only available if TextFit is set to BackgroundFitsText or
BackgroundFitsTextKeepAspect.

Text Scale Enter a value or use the arrows to adjust the default size of the text box in proportion
to the background image behind the text.

0.00 is the minimum size. 1.0 makes the text occupy the width or complete limits of
the background's borders.

This property is only available if TextFit is TextFitsBackground or
TextFitsBackgroundKeepAspect.

TextFit From the drop-down, select the option that looks best when modifying text within an
object:

Unlinked — the background image adjusts its width only to fit the text. 

BackgroundFitsText — the background image adjusts its width only to fit the text.

BackgroundFitsTextKeepAspect — the background image resizes to fit the text
while maintaining its original aspect ratio.

TextFitsBackground — the text box adjusts its width only to fit within the
background image.

TextFitsBackgroundKeepAspect — the text box resizes to fit within the background
image while maintaining its aspect ratio.

Jessica Hempinstall
Sticky Note
set to
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Property Description

Color Select an existing color for the background using the drop-down or select the Browse
button ( ) to add a new color.

If only a background color is selected, a rectangle in this color will be drawn behind
the text. 

If both a background color and an image are selected, they will be combined.

If no background color, image or outline color are selected, there will be no
background.

Image Select an existing image using the drop-down or select the Browse button ( ) to add
a new image.

The image will be drawn behind the text. 

If both a background color and an image are selected, they will be combined.

If no background color, image or outline color are selected, there will be no
background.

Pause At End Enter or use the arrows to set the number of frames for which an image sequence will
pause at the last image before looping.

Slowdown When an animated image is selected, this is the number of frames, expressed as a
percentage, by which the movement of the animated image will be slowed.
Accordingly, a negative value will speed up the movement.

Outline Color Adds the selected color to the outline of the background.

Select an existing color using the drop-down or select the Browse button ( ) to add
a new color.

If no background color is selected, only an outline in the color selected will be
displayed.

Outline Width Enter a value or use the arrows to set a width for the outline (border) of the
background.

If the px checkbox is selected, the width of the outline will remain the same regardless
of the zoom level of the map. 

If the px checkbox is cleared, the width of the outline will scale relative to the
background as the zoom level of the map changes.

Shadow Color Select an existing color using the drop-down or select the Browse button ( ) to add
a new color to apply to the shadow of the background.

Shadow Angle This image illustrates how the direction and angle of shadows vary depending on the
specified degree.
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Property Description

Shadow
Distance

The distance that the shadow falls from the background. A larger value moves the
shadow further away from the background. 

Shadow Blur Enter a value or use the arrows to set the degree by which the shadow appears out-of-
focus.
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Edge Tab

Properties - Text Drawings - Edge Tab

The properties found in the Edge tab are described in the following table.

Property Description

Left

Right

Top

Bottom

Select the checkbox to activate and apply Edge settings to the corresponding side of
the Text drawing.

Changes to the Edge settings are instantly reflected in the preview at the bottom of the
Drawing Management Editor.

Image Select an existing image from the drop-down to apply it to the edge of the Text
drawing. Alternatively, select the Browse button to open the Images window, where
you can preview the image collection and add new images to the system.

Keep Aspect

or

Scale

Select the Keep Aspect checkbox to maintain the image’s original width-to-height ratio
when scaling.

OR

Clear the Keep Aspect checkbox and set the Scale value to manually adjust the width
and height independently.

Slow Down When an animated image is selected, this is the number of frames, expressed as a
percentage, by which the movement of the animated image will be slowed. Accordingly,
a negative value will speed up the movement.

« This function only applies to edges that have an animated image.

Pause At End When an animated image is selected,this is the number of frames for which an image
sequence will pause at the last image before looping. 

« This function only applies to edge images that have an animated image. 
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Marker Tab

Properties - Text Drawings - Marker Tab

The properties found in the Marker tab are described in the following table.

Property Description

Image Select an existing image using the drop-down or select the Browse button ( ) to add
a new image from the Images folder.

By default, the image will be drawn behind the text. 

When the TextFit field in the Background tab is set to BackgroundFitsText or
BackgroundFitsTextKeepAspect the size of the image is relative to the text size, so
the image grows as the text grows.

To remove the image from the drawing, select the drop-down arrow and select the
blank area at the top of the drop-down list.

To delete an image, select the Browse button ( ) beside the image field and in the
Images folder, select Delete. You cannot delete an image that is currently being used
in a drawing. 

The Animated column indicates whether or not the image is part of a sequence,
creating an animated drawing.

Pause At End Enter a value or use the arrows to set the number of frames for which an image
sequence will pause at the last image before looping. 

«This function only applies to markers that have animation. 
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Property Description

Slowdown When an animated image is selected, this is the number of frames, expressed as a
percentage, by which the movement of the animated image will be slowed. Accordingly,
a negative value will speed up the movement.

«This function only applies to markers that have animation.

Scale Enter a value or use the arrows to increase or decrease the size of the marker image.

Default is 1.00. Selecting 2.00 will make the image twice as large.

Offset X The distance that the marker image is offset from the center of the text along the X-
axis of the map.

0.0 = Center

A value higher than 0.00 = Right of center

A value lower than 0.00 = Left of center

Offset Y The distance that the marker image is offset from the center of the text along the Y-
axis of the map.

0.0 = Center

A value higher than 0.00 = Above the center

A value lower than 0.00 = Below the center

Marker is in
front

Select this checkbox to place the marker in front of the text. 

Marker aligns Select this checkbox to align the marker to the text.

« In order to see the marker, the Offset X and Offset Y values in the general tab need to be

something other than 0.00. Otherwise, the marker will be hidden behind the text or background.
Changing the offset defines the default offset between the text and the point of interest.
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 Callout Tab

Text Properties - Callout Tab

The properties found in the Callout tab are described in the following table.

Property Description

Type Select the type of callout used to draw the connection between the text-background
panel and the location of the point of interest. 

A background color or an outline color must be defined in the Background tab in order
to use a callout.

Callout options are Arrow and Line. 

Arrow draws a triangle from the panel to the location on the map in the same style as
the background. The Line Width properties are not used in this type.

Line draws a line between the text-panel and the location on the map. If Line is chose,
the Line Width properties become available. 

For both arrows and lines, the starting point near the panel is calculated automatically
for optimal appearance of the callout.

Alignment Select whether the arrow or line should be aligned at center or automatically.

Color Select an existing color using the drop-down or select the Browse button ( ) to add a
new color for the callout line. Applies only to the Line type.

Marker Offset Enter a value or use the arrows to adjust the position of the arrow or line relative to the
marker. The value defines the distance between the end of the callout and the marker. 

· 0.0 — no offset

· >0.0 — moves  the callout toward the text

· <0.0 — moves the callout away from the text
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Property Description

Label Offset Enter a value or use the arrows to set an offset that defines the gap between the label
and the start of the callout. Adjust the Offset X an Offset Y parameters in the General
tab beyond the 0,0 position to view the effect in the example image below the
properties. The values describe the distance between the text and the start of the
callout. 

· 0.0 no offset

· > 0.0 offset toward the end of the callout

· < 0.0 offset away from the end of the callout

Line Width Enter a value or use the arrows to set the width of the callout line.

If the px checkbox is selected, the width of the line will remain the same regardless of
the zoom level of the map. 

If the px checkbox is cleared, the width of the line will scale relative to the background
as the zoom level of the map changes.

«This property only applies when the Line Type has been selected. 

Arrow Width Enter a value or use the arrows to set the width of the callout arrow.

«This property only applies when the Arrow Type has been selected and the

Alignment is set to Center. 

To add callout text to a scene:

1. In the Drawing Toolbox, select the Callout text drawing, then select within the scene at the exact
position to which you want the arrow or line of the Callout to point.

2. Double-click in the bounding box and enter the new text.

3. Place the cursor inside the bounding box, then left-click and drag the bounding box to adjust the
position of the Callout arrow or line.

4. To reposition a Callout, left-click and drag either the white handle at the end of the callout line or the
tip of the arrow. 
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Video Input Drawings Properties

The Video Input drawing properties are divided into three tabs and are described below.

General Tab

Transform Tab

Decoration Tab

General Tab

Properties - Video Input Drawings - General Tab

The properties found in the General tab are described in the following table.

Property Description

Input Select the input source to be displayed in the drawing. 

There are 8 possible inputs.

Visibility
(In and Out)

How a video input drawing appears (In) and disappears (Out) during animation.  

Options are: 

None — the drawing appears/disappears instantly at the frame to which the Key Frame
is set. 

Dissolve — the drawing animates in and out at the level set in the corresponding
Zoom fields. The drawing blends in/out over the number of seconds selected in the
Time field. Use the Delay field to input the number of seconds that the drawing will
delay its animation. 

Wipe Left — the drawing animates in and out at the level set in the corresponding
Zoom fields. The drawing appears/disappears from the left over the number of
seconds selected in the Time field. Use the Delay field to input the number of seconds
that the drawing will delay its animation. 

Wipe Right — the drawing animates in and out at the level set in the corresponding
Zoom fields. The drawing appears/disappears from the left over the number of
seconds selected in the Time field. Use the Delay field to input the number of seconds
that the drawing will delay its animation. 

Wipe Bottom — the drawing animates in and out at the level set in the corresponding
Zoom fields. The drawing appears/disappears from the bottom over the number of
seconds selected in the Time field. Use the Delay field to input the number of seconds
that the drawing will delay its animation. 

Wipe Top — the drawing animates in and out at the level set in the corresponding
Zoom fields. The drawing appears/disappears from the top over the number of seconds

181

182

183



182 • Managing Drawings XPression Maps User Guide (v4.0)

Property Description

selected in the Time field. Use the Delay field to input the number of seconds that the
drawing will delay its animation. 

Flight Mode — Select the Flight Mode checkbox to control the drawing's visibility at
the flight point level during flight map animations. If the checkbox is cleared, visibility

is instead managed at the scene level. When enabled, a small airplane icon  appears
on the drawing's preview image to indicate Flight Mode is enabled.

Transform Tab

Properties - Video Input Drawings - Transform Tab

The properties found in the Transform tab are described in the following table.

Property Description

Crop Enter a value or use the arrows to select a percentage by which to crop the video input.

Scale In the X and Y fields, enter a value or use the arrows to increase or decrease the size
of the video input.
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Decoration Tab

Properties - Video Input Drawings - Decoration Tab

The properties found in the Decoration tab are described in the following table.

Property Description

Color Select an existing color using the drop-down or select the Browse button ( ) to add a
new color to apply to the frame image for the video input.

Frame Image Select an existing image using the drop-down or select the Browse button ( ) to add
a new one. The image must be designed as a frame, with transparent area in the center
where the video input will appear. 

Label Select the Label checkbox to add a label to the video input drawing.

When enabled, the label will have the properties configured in this section.

Use the Browse button ( ) to open the Select Label Reference editor and select a
text drawing for the label.

Use the Position drop-down to select the location of the label: Top, Left, Right or
Bottom.
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3D Object Drawings Properties

When adding a new 3D Object drawing to the system, you’ll need to configure its properties. You can also
edit the properties of existing 3D Object drawings at any time. The following sections provide information
and instructions for how to configure a 3D Object drawing's properties.

3D Object Drawings Properties

Model Editor

Lights Editor

Drawings Properties - 3D Object Drawings
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3D Object Drawing Properties

Opening a 3D object drawing in the Drawing Management Editor allows you to configure the following
properties. 

Property Description

Visibility  

(In and Out)

Controls how the 3D Object drawing appears (In) and disappears (Out) during an
animation.

Options are: 

None — the drawing instantly appears/disappears at the set Key Frame. Use the
Delay field to set a delay, in seconds, its transition.

Dissolve — the drawing animates in and out at the level set in the corresponding
Zoom fields. The drawing blends in/out over the number of seconds selected in the
Time field. Use the Delay field to input the number of seconds that the drawing will
delay its animation.

Flight Mode — Select the Flight Mode checkbox to control the drawing's visibility at
the flight point level during flight map animations. If the checkbox is cleared, visibility

is instead managed at the scene level. When enabled, a small airplane icon 
 appears on the drawing's preview image to indicate Flight Mode is enabled. 

Model Models define the object’s vertices, materials/colors, and textures. Select an existing
model from the drop-down. If the required model is not listed, select the Browse
button to use the Models Editor  to import and manage models.

Light Select the Light checkbox to select and apply a shading profile and/or basic light
source settings to the 3D object drawing. An empty checkbox means that no light or
shading profiles are added to the 3D Object drawing. 

Shading — Select the shading profile to be used. Options are GGX (default) or
BlinnPhong.

· GGX — A physically based microfacet shading model that simulates realistic light
reflections on rough surfaces. Produces natural-looking highlights with a smooth
falloff, making it suitable for metallic, glossy, and rough materials. 

· BlinnPhong — A traditional shading model that calculates specular highlights using
a simplified formula. Faster but less physically accurate, often resulting in sharper,
less realistic highlights. 

Light — From the drop-down, select a light profile that has already been configured. If
the required light profile is not listed, use the Lights Editor  (open by using the
Browse button next to the Light drop-down) to configure or edit a light profile.

Landmark Landmarks are 3D objects with a predefined, fixed position and size on the map (not
on an overlay). To designate the 3D Object drawing as a landmark, select the
checkbox and set the Longitude, Latitude, Scale, and Zoom  parameters to
determine the exact geographical position and size of the 3D object on the map. See
Creating a Landmark from a 3D Object Drawing  for more information.

Note: Multiple landmarks at the same location will result in overlapping objects.

Zoom

Offset

Use the Zoom and Offset parameters to adjust the appearance of the preview icon
generated for the 3D object drawing.
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Model Editor

Models determine the 3D Object drawing’s vertices, materials/colors, and textures. Use the Models Editor
to import and manage models. Imported models are stored in the 3DModels database. Supported formats
(via assimp) include .glb, .dae, and .obj.

3D Object Drawing Properties - Model Editor

To add a new model to a 3D Object drawing:

1. Open a 3D Object drawing in the Drawing Management Editor.

2. Select the Browse button next to the Model drop-down. 

3. In the Model Editor, select the Add button.

4. In the Select File dialog, select and open the 3D model file. 

5. Use the following fields to name and adjust the orientation of the model.

Name — Enter a name for the model. This name will appear in the Model drop-down in the Drawing
Management Editor.

Rotation — Rotates the model around the Z-axis (in degrees).

Flip —  Rotates the model 90º around the X-axis (longitude).

6. Select Done to close the Model Editor. 

The new model appears in the Model drop-down list.

To delete a model:

1. Open a 3D Object drawing in the Drawing Management Editor.

2. Select the Browse button next to the Model drop-down.

3. In the Models Editor, select the model from the list in the left-side pane.

4. Select Delete.

5. In the Delete Model dialog, select Yes to confirm that you want to delete the selected model.

« Deleting a model permanently removes it from the 3D Object Model database. Once deleted, the

model is no longer available in any group and cannot be restored unless it is re-imported. 

6. Select Done to close the Models Editor.
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Lights Editor

The Lights editor manages light profiles, which define how light interacts with the 3D Object drawing
using settings like position, color, roughness, and ambient light. Light profiles are stored in the 3DModels
database and are applied when a 3D Object drawing is created or edited. Once a 3D Object drawing is
added to a scene,  its light parameters can be adjusted directly in the Drawing Editor. See 3D Object
Drawing Parameters  for more information.

3D Object Drawing Properties - Lights Editor

To add a new Light profile:

1. Open a 3D Object drawing in the Drawing Management Editor.

2. Select the Light checkbox.

3. Select the Browse button next to the Light drop-down. 

4. In the Lights Editor, select New.

5. In the Add Light dialog, enter a name for the new light profile and select OK.

The light profile is added and highlighted in the list of light profiles.

6. Set or make adjustments to the following fields:

Position X, Y, H — Positions the light relative to the center of the 3D Object's bounding box.

Roughness — If set to >0%, it overwrites the model's roughness. Normally, roughness should be 0%
since different parts a model normally have different roughness values (some parts shiny, others dull). 

Ambient — Adjusts the overall brightness, which improves visible areas that are not exposed to light.

Color — Choose the color of the light from the drop-down, or leave blank for White (default). Or,
select the Browse button to use the Colors tool to define and add a specific color.

Is Point Light — Select the checkbox to enable distance-based attenuation of the light.

7. Select Done to close the Lights Editor.

The new Light profile is now selected in the Light drop-down in the the Drawing Management
Editor.

215
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To delete a Lights profile:

1. Open a 3D Object drawing in the Drawing Management Editor.

2. Select the Light checkbox.

3. Select the Browse button next to the Light drop-down.

4. In the Lights Editor, select the light profile from the list in the left-side pane.

5. Select Delete.

6. In the Delete Light dialog, select Yes to confirm that you want to delete the selected light profile.

« Deleting a light profile removes it from the 3DModels database. 

7. Select Done to close the Lights Editor.
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Adding Drawings
The Drawing Toolbox, located on the right side of the Canvas, allows you to add drawings from the
Drawings database to a scene. If the drawing you need isn’t available in the toolbox, you can open the
Drawing Management Editor directly to create a new drawing or edit an existing one.

Once a drawing is added to the scene on the Canvas, it becomes a part of the scene, and a reference to
the drawing in the database is saved and loaded with it. You can further customize the drawing's
properties after adding it. For example, the Drawing Editor lets you configure both common and specific
parameters to define the drawing’s appearance and behavior. Additionally, you can adjust its size,
position, appearance, and, visibility using the bounding box and tools surrounding the drawing.

The Drawing Overview panel provides a list of all drawings in the scene and includes options to show,
hide, rename, or delete selected drawings. When multiple drawings are added, you can use the Drawing
Layer toolbar  to control their stacking order and overlap within the scene.

If you need additional versions of a drawing, you can quickly duplicate it within the scene and adjust its
parameters as needed. Unused drawings can be easily removed from the scene without affecting the
original drawing in the database.

Here are a few additional tasks you can perform with scene drawings:

· Designate a default drawing to be used whenever drawings are generated automatically. 

· Specify that a text or dynamic data drawing should be created precisely at the search location.

· Use the Measurement Tool to calculate the distance between two points on the map and add a text
drawing to display the result.

The following sections provide instructions for adding and configuring drawings within the active scene:

Adding and Editing Drawings

Configuring Drawing Parameters

Adding a Default Drawing to a Search Location

Adding a Measured Distance Text Drawing

Adding Drawings to an Overlay Layer

Adding a Copy of a Drawing

Replacing a Drawing

Setting a Drawing's Layer Order

Showing or Hiding Drawings

Deleting a Drawing from the Scene
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Adding and Editing Drawings

Drawings from the Drawing Toolbox are added directly to a scene on the Canvas, becoming part of the
scene itself. As a result, they will be saved and loaded along with the scene.

The following topics are discussed in this section:

Adding a Drawing to a Scene

Editing a Drawing Within a Scene

« For information about creating drawings, see Managing Drawings .

To add a drawing to a scene:

1. In the Drawing Toolbox, from the Group drop-down, select the group that contains the drawing you
want to add to your scene.

2. Then do one of the following:

· Select a thumbnail in the preview pane and then select within the scene where you want the drawing
to appear.

Left-clicking multiple times in the scene will add additional instances of the drawing.

OR

· Left-click and drag a thumbnail from the preview pane into the scene.

« Thumbnails containing an airplane icon  indicate that the drawing's Visibility > Flight Mode

property is enabled. These drawings are mostly used when creating flight map animations in the
XPression Maps MOS workflow .

3. After adding a drawing, right-click on the mouse to add just one instance of the drawing or continue
selecting to add multiple instances.

This method applies to text, icon, 3D Object, magnifier, container, locator, dynamic data,
background, video input and inset drawings. For information about adding and editing area and line
drawings, see the following sections: 

Adding and Editing Area Drawings

Adding and Editing Line Drawings
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When you add a drawing to a scene, it is displayed within a white bounding box with a handle attached to
the middle, as shown below:

Selected Drawing on the Canvas

The bounding box, the handle and the various icons attached to the bounding box are used to manipulate
the drawing. You can move the drawing and modify the size, visibility, orientation, and rotation using
these tools. Not all tools apply to every drawing type. Drawings display only those tools that apply to
them.

To edit a drawing from within a scene:

1. Select a drawing on the Canvas.

The bounding box and its tools are displayed around the selected drawing.

2. Use the tools to change the size, position and appearance of the drawing as described in the table
below:

Tool How to Use the Tool

Center Point Select and hold, then drag to move the drawing around
the scene.

You can also select and hold anywhere inside the
bounding box to move the drawing.

Corner Points Select and hold, then drag to scale the drawing. 

Handle Select and hold the end of the handle, then drag to
rotate the drawing. 

For line and area drawings, the handles can also be
used to adjust the path of the line or the shape of the
area.

Scale Select to enable Auto Scaling. 

In the Drawing Editor, you’ll see that in the Size
section, the Auto checkbox is selected. When selected,
the drawing remains the same size as you zoom in and
out on the map. When the Auto checkbox is cleared,
the drawing will scale larger when you zoom in and
smaller when you zoom out on the map.



192 • Adding Drawings XPression Maps User Guide (v4.0)

Tool How to Use the Tool

Eye Icon Select to toggle the visibility of the drawing at the scene
level.

Available when the drawing's Visibility > Flight Mode
property is not selected.

Airplane Icon Select to toggle the visibility of the drawing at the flight
point level of a flight map animation.

Available when the drawing's Visibility > Flight Mode
property is selected.

Face Icon When the map is tilted, select to toggle the placement
of a drawing, either angled to match the map surface or
perpendicular to the map surface and facing the
camera. 

For drawings that are created on the Overlay Layer,
this icon does not appear.

Double-Ended
Arrow

Select the double-ended arrow to flip the drawing
horizontally.

In addition to the tools described above, some types of drawings have additional ways to manipulate
them, that are specific to the drawing type. 

These additional methods are described in the following sections.

Adding and Editing Area Drawings

Editing Background Drawings

Editing Inset Drawings

Adding and Editing Line Drawings

Editing Locator Drawings

Editing Text Drawings

Creating a Landmark from a 3D Object Drawing
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Adding and Editing Area Drawings

Area drawings are a type of drawing that represent a flexible, closed shape filled with color and/or texture.
When you add an area drawing to a scene, you adjust its shape by dragging its handles and borders.
Before adding an area drawing to the scene, use the Area Line Edit Options panel to set options that
determine how you can manipulate the drawing's shape and position on the map. For example, you can
lock OSM Layers to OSM Map Styles, or enable Auto-Trace mode to draw an area by simply dragging,
without needing to select at multiple points. 

Area Line Edit Options

Once the area drawing is added to the scene, you can further modify its appearance, position, size, and
other attributes to suit your needs.  

The following topics provide instructions for adding and editing area drawings:

Adding an Area Drawing with Auto-Trace Mode Enabled

Adding an Area Drawing with Auto-Trace Mode Disabled

Deleting an Area Drawing

Editing an Area Drawing

To add an area drawing with Auto-Trace mode enabled:

1. Enable the Area Line Edit Options panel in the View menu.

2. In the Area Line Edit Options panel, select an option from the Lock OSM Layer drop-down if you
want to have the area drawing locked on to a particular section of the map so that it doesn't waver off
to other points. Select None to keep the OSM Layer unlocked. 

3. Select the Auto-Trace checkbox to enable it.

4. Use the Point Creation Mode section to select and modify which style of drawing handles you want to
use when creating area drawings. 

The styles are: 

Ø Locked Handles: Select the Locked Handles checkbox or press Ctrl+Alt+L to enable a 180 degree
connection with locked handle points when creating an area drawing. 

Ø Free Handles: Select the Free Handles checkbox or press Ctrl+Alt+F to enable an unlimited and
unlinked connection of points when creating an area drawing. 

Ø No Handles: Select the No Handles checkbox or press Ctrl+Alt+N to enable zero-length of linear
connection points when creating an area drawing.

5. In the Drawing Toolbox, left-click on the thumbnail of the area drawing you want to add to your
scene.

« Thumbnails containing an airplane icon  indicate that the drawing's Visibility > Flight Mode

property is enabled. These drawings are mostly used when creating flight map animations in the
XPression Maps MOS workflow .

193

194

194

195

9



194 • Adding Drawings XPression Maps User Guide (v4.0)

6. On the Canvas, left-click on the map where you want the area to start, then along the outline of the
area you want to display, ending up at the same point where you started. 

7. Release the mouse button when you reach the end of the area, to stop drawing.

To add an area drawing with Auto-Trace mode disabled:

1. Enable the Area Line Edit Options panel in the View menu.

2. In the Area Line Edit Options panel, select an option from the Lock OSM Layer drop-down if you
want to have the area drawing locked on to a particular section of the map so that it doesn't waver off
to other points. Select None to keep the OSM Layer unlocked. 

3. Clear the Auto-Trace checkbox to disable it.

4. Use the Point Creation Mode section to select and modify which style of drawing handles you want to
use when creating line and area drawings. 

The styles are: 

Ø Locked Handles: Select the Locked Handles checkbox or press Ctrl+Alt+L to enable a 180 degree
connection with locked handle points when creating a line or area drawing. 

Ø Free Handles: Select the Free Handles checkbox or press Ctrl+Alt+F to enable an unlimited and
unlinked connection of points when creating a line or area drawing. 

Ø No Handles: Select the No Handles checkbox or press Ctrl+Alt+N to enable zero lengths of linear
connection points when creating a line or area drawing.

5. In the Drawing Toolbox preview pane, left-click the area drawing you want to add to the scene.

« Thumbnails containing an airplane icon  indicate that the drawing's Visibility > Flight Mode

property is enabled. These drawings are mostly used when creating flight map animations in the
XPression Maps MOS workflow .

6. On the Canvas, left-click on the map where you want the area to start.

7. Move the mouse and left-click at individual points along the outline of the area you want to display
ending up at the same point where you started.

8. Right-click when you reach the end of the area, to stop drawing. 

To delete an area drawing:

1. Select the area drawing but don’t select on a location point. 

2. Press the Delete key to remove the drawing.

OR

· In the Drawings Overview list, right-click the drawing and select Delete Drawing.

9
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To edit an area drawing:

Use any of the following options:

· Add New Points: Double-click along the border of the area drawing to create new location points.

· Move Points: Select and hold a location point, then drag it to a new position to adjust the shape of the
area drawing.

· Toggle Corners and Paths: Press the CTRL key and select a location point to toggle between a sharp
corner and a smooth path. The selected point will turn blue when active. By default, location points are
linked, forming a smooth, rounded path. Unlinking a location point will create a sharp corner.

· Adjust Shape with Handles: Select the end of a handle and drag it to fine-tune the shape of the area
drawing.

· Remove Points: Select a location point, which will turn red, then press the Delete key to remove it.
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Adding and Editing Line Drawings

Line drawings are a type of drawing that display a predefined textured line. When you add a line drawing
to a scene, you adjust its length and direction by dragging its handles. However, before adding a line
drawing to the scene, use the Area Line Edit Options panel to set options that determine how you can
manipulate the drawing's length, shape and position on the map. For example, you can lock OSM Layers
to OSM Map Styles, or enable Auto-Trace mode to draw a line by simply dragging, without needing to
select at multiple points. 

Area Line Edit Options

Once the line drawing is added to the scene, you can further modify its appearance, position, size, and
other attributes to suit your needs.

The following topics provide instructions for adding and editing line drawings:

Adding a Line Drawing with Auto-Trace Mode Enabled

Adding a Line Drawing with Auto-Trace Mode Disabled

Deleting a Line Drawing

Editing a Line Drawing

Connecting an Icon or Text Drawing to a Line Drawing

Disconnecting an Icon or Text Drawing from a Line Drawing

To add a line drawing with Auto-Trace mode enabled:

1. In the Area Line Edit Options window, select an option from the Lock OSM Layer drop-down if you
want the line drawing locked on to a particular section of the map so that it doesn't waver off to other
points. Select None to keep the OSM Layer unlocked. 

2. Select the Auto-Trace checkbox to enable it.

3. Use the Point Creation Mode section to select and modify which style of drawing handles you want to
use when creating line drawings. 

The styles are: 

Ø Locked Handles: Select the Locked Handles checkbox or press Ctrl+Alt+L to enable a 180 degree
connection with locked handle points when creating a line drawing. 

Ø Free Handles: Select the Free Handles checkbox or press Ctrl+Alt+F to enable an unlimited and
unlinked connection of points when creating a line drawing. 

Ø No Handles: Select the No Handles checkbox or press Ctrl+Alt+N to enable zero-length of linear
connection points when creating a line drawing.
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4. In the Drawing Toolbox, left-click on the line drawing thumbnail you want to add to your scene.

« Thumbnails containing an airplane icon  indicate that the drawing's Visibility > Flight Mode

property is enabled. These drawings are mostly used when creating flight map animations in the
XPression Maps MOS workflow .

5. On the Canvas, left-click and hold down the mouse button on the map where you want the line to
start, then drag the line along the route you want to display.

6. Release the mouse button when you reach the end of the route, to stop drawing.

To add a line drawing with Auto-Trace mode disabled:

1. In the Area Line Edit Options window, select an option from the Lock OSM Layer drop-down if you
want the line drawing locked on to a particular section of the map so that it doesn't waver off to other
points. Select None to keep the OSM Layer unlocked.

2. Clear the Auto-Trace checkbox to disable it.

3. Use the Point Creation Mode section to select and modify which style of drawing handles you want to
use when creating line drawings. 

The styles are: 

Ø Locked Handles: Select the Locked Handles checkbox or press Ctrl+Alt+L to enable a 180 degree
connection with locked handle points when creating a line drawing. 

Ø Free Handles: Select the Free Handles checkbox or press Ctrl+Alt+F to enable an unlimited and
unlinked connection of points when creating a line drawing. 

Ø No Handles: Select the No Handles checkbox or press Ctrl+Alt+N to enable zero lengths of linear
connection points when creating a line drawing.

4. In the Drawing Toolbox, left-click on the line drawing thumbnail you want to add to your scene.

« Thumbnails containing an airplane icon  indicate that the drawing's Visibility > Flight Mode

property is enabled. These drawings are mostly used when creating flight map animations in the
XPression Maps MOS workflow .

5. On the Canvas, left-click on the map where you want the line to start.

6. Move the mouse and left-click at individual points along the route you want to display.

7. Right-click when you reach the end of the route, to stop drawing. 

9

9



198 • Adding Drawings XPression Maps User Guide (v4.0)

To delete a line drawing:

1. Select the line drawing but don’t select a location point. 

2. Then press the Delete key to remove the drawing.

OR

· In the Drawings Overview list, right-click the line drawing and select Delete Drawing.

To edit a line drawing:

Use any of the following options:

· Add Location Points: Double-click on or just ahead of the line's head to add a location point. To extend
the line, double-click after the last point to add a new line segment. Continue adding line segments as
needed, then right-click to stop adding location points.

· View and Move Points: Select the line to display the location points defining it. Select and hold a
location point, then drag it to a new location to reshape the line.

· Remove Points: Select a location point (it will turn red) and press the Delete key or Ctrl+X to remove
it.

· De-select Points: Select the line between points or anywhere outside the drawing to deselect all
location points.

· Toggle Corner Types: Select a location point to switch between a sharp corner and a smooth path. By
default, points are linked to form a smooth path, but unlinking a point creates a sharp corner at that
position.

· Adjust Line Width: Drag the white points at either end of the line to change its width.

· Line Progress: Drag the blue handle point at the line’s head to adjust the progress along the path, from
100% (fully drawn) to 0% (hidden). Alternatively, drag the white point at the top corner of the bounding
box left or right to achieve the same effect.

· Reposition the Line: Use the longitude and latitude parameters in the Location section of the
Drawing Editor to move the line to a new geographic position on the map.

To connect an icon or text drawing to a line drawing:

1. Place an icon or text drawing into the scene. 

2. Move the icon or text drawing to the head of the line until a glowing yellow box appears, indicating it’s
ready to connect. The head of the line is where the Blue point with a handle is.

Once connected, the drawing will move along with the head of the line whenever the line’s Progress
property is adjusted. If the Use Spline Rotation parameter is enabled, the connected drawing’s
rotation angle will automatically adjust as it follows the line.

To disconnect an icon or text drawing from a line drawing:

· Select and then drag a connected drawing away from the head of the line.
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Editing Background Drawings

In XPression Maps, Background drawings are images that replace the default background behind the
globe on the Canvas. By default, this background is a black and star-filled scene, creating the impression
of outer space.

Background images are automatically scaled to fit entirely within the selected video format. To achieve a
fullscreen effect, use an image that matches the video format dimensions. The background image will only
be visible when the Zoom Level camera setting allows the globe’s edges to be visible.

The following topics provide instructions for replacing the default background with a drawing of your
choice either using the Scene Properties menu, or by selecting a new image from the Drawing Toolbox.
 

Replacing the Background Drawing Using the Scene Properties Dialog

Replacing the Background Drawing Using the Drawing Toolbox

To replace the background drawing from the Scene Properties dialog:

1. Select Style > Scene Properties in the menu bar. 

Scene Properties

2. Select the Overwrite Style Properties to adjust the parameters.

3. Select the Use Alpha Channel checkbox, if you want to use the alpha channel in the final output and
see a checkerboard pattern in the preview.

4. In the Scene Properties dialog, from the Drawing drop-down, select the background drawing you
want to use.

5. From the Mode drop-down, select the scaling of the drawing.

· Fullscreen — shows the background over the whole Canvas. This may distort the drawing.

· Letterbox — makes the width fit onto the Canvas, while preserving the aspect ratio.

· Pillarbox — makes the height fit onto the Canvas, while preserving the aspect ratio.

6. Close the dialog.

To replace the background drawing from the Drawing Toolbox:

1. In the Drawing Toolbox, from the Group drop-down, select the group that contains the background
drawing you want to use.

2. Left-click and drag the background drawing onto the Canvas or select the drawing and then select in
the background of the scene.

3. Release the mouse button to replace the current background.
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Editing Inset Drawings

Inset drawings like Locator drawings display a "map within a map" showing the position of the selected
location within the world. Inset drawings can be placed on the Overlay Layer or directly onto the normal
layer. 

The appearance of the inset drawing is defined in the Drawing Management Editor. For information
about inset drawing properties, see Inset Drawings Properties . 

To edit an inset drawing:

1. Add an Inset drawing to the scene or select an Inset drawing in the scene. This enables the green
Enter Fullscreen button above the Canvas.

Inset Drawing Fullscreen

The Inset drawing is now shown in full view on the Canvas. 

If an Inset drawing has not been added to the scene, the button will show as Not Active. 

2. Right-click on the mouse button to drag and select a location you want to display with the inset
drawing, or open the Search Editor and type in a location. 

In fullscreen mode you can add drawings and shapes and change the Map Style that is displayed with
the inset drawing.

3. After creating the inset drawing select the red Leave Fullscreen button above the Canvas to return
back to your main map.

Inset Drawing Leave Fullscreen

The inset drawing will be displayed just as you created it in fullscreen.

To delete an inset drawing:

· With the main map on the Canvas, select the inset drawing and press the Delete key to delete it.

You can also use the keyboard shortcut Ctrl+X to delete an inset drawing.

OR

· In the Drawings Overview list, right-click the inset drawing and select Delete Drawing.
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Editing Locator Drawings

Locator drawings create a "map within a map," displaying the position of the searched location relative to
the world. Typically, locator drawings are placed on the Overlay Layer , although they can also be added
to the normal layer. By default, the center of the locator drawing aligns with the camera’s position unless a
Map Offset is set in the Drawing Editor. 

You can customize the appearance of the locator drawing by setting the Locator drawing's properties  in
the Drawing Management Editor. Additionally, the locator area can display different map styles—such
as Bing Aerial, Bing Aerial with Labels, or Bing Road maps—which can be selected in the Locator
section of the Drawing Editor.

To edit a locator drawing:

· Select the yellow point in the middle of the bounding box and move the mouse. 

This changes the Map Offset parameters in the Drawing Editor accordingly.

For information about Map Offset parameters in locator drawings, see Locator Drawings Parameters .
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Editing Text Drawings

Text drawings display a text in a predefined font that has been created in the Drawing Management
Editor.

See Text and Replacement Drawings  for more information.

To edit a text drawing:

· Double-click the text drawing and enter the new text directly on the Canvas or in the Drawing Editor,
in the Text pane, edit the default text.

· When the text drawing has a Callout marker:

Ø Select and hold inside the bounding box to move the label and its background without moving the
marker.

Ø Select and hold the white point at the top of the handle inside the bounding box to move the label,
background and marker together.
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Creating a Landmark from a 3D Object Drawing

Landmarks are 3D Object drawings with a predefined, fixed position and scale on the map scene (not on
an overlay). While you can configure Landmark settings when creating or editing a 3D Object drawing in
the Drawing Management Editor, we recommend the following procedure. It allows you to position and
scale the 3D Object directly within the scene, then save it as a landmark using the Drawing Editor.

« Multiple landmarks at the same location will result in overlapping objects.

To create a landmark from a 3D Object drawing:

1. Create and save a 3D Object drawing to the database. 

See Adding New Drawings to the Database  and 3D Object Drawings Properties .

Note that you do not have to enable the Landmark option at this stage.

2. Add the 3D Object drawing to the scene.

3. Position the drawing to the desired longitude and latitude and adjust its scale and zoom level settings
as needed. 

If the map style supports 3D , you may also want to adjust the drawing's Altitude setting.

4. Select the 3D Object drawing on the scene.

5. In the Drawing Editor, in the 3D section, select the Save button beneath the Landmark heading.

The drawing's current Longitude, Latitude, Scale, and Zoom values are saved and will be displayed
in the Drawing Management Editor.
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Configuring Drawing Parameters

Use the Drawing Editor, shown below, to modify the parameters of a selected drawing that has been
added to the map. If a parameter is greyed out, it doesn’t apply to the selected drawing.

Drawing Editor

The following topics are discussed in this section:

Common Parameters

Area Drawing Parameters

Dynamic Data Drawing Parameters

Inset Drawing Parameters

Line Drawing Parameters

Locator Drawing Parameters

Magnifier Drawing Parameters

Text and Replacement Drawing Parameters

3D Object Drawing Parameters
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Common Parameters

The upper part of the Drawing Editor contains parameters that are common to most drawings. Select the
drawing in the scene to adjust the parameters. 

Parameter Description

Location The Longitude and Latitude parameters (in degrees) define the position of the
selected drawing within the scene. If the drawing is placed on the Overlay layer, these
parameters are replaced by Position X and Position Y.

To add a Key Frame, select the Key Frame button   next to the Longitude / Position
X and Latitude / Position Y fields.

Right-click the Key Frame button  to choose an Easing method, which controls how
the animation transitions to and from that Key Frame.

The Altitude parameter specifies the vertical distance of a drawing from sea level. By
default, the Altitude checkbox is deselected and the value is set to 0. When the 3D
setting is enabled in the scene’s map style, selecting the Altitude checkbox allows you
to define the drawing’s altitude. The unit of measurement—Metric (m) or Imperial (ft)—
is determined by the Default Unit setting in the Map  tab of the Preferences
window.

Rotation The Angle parameter, in degrees, determines the rotation of the selected drawing. 

This parameter does not apply to Line and Area drawings.

Size The Scale, Aspect and Zoom parameters are used to resize a drawing on a scene. New
drawings are always created in the same size in pixels. When a drawing is created in
the Drawing Management Editor, the default Scale value is 1. 

Scale - Enter a value or use the arrows to increase or decrease the scale of the drawing
on the Canvas. 

For Line drawings, the Scale parameter adjusts the width of the line.

Aspect - The Value parameter increases or decreases the width of the drawing,
relative to the height.

· If the value is less than 1, the width (X) decreases relative to the height (Y). 

· If the value is greater than 1, the width increases relative to the height. 

When you make the drawing larger or smaller by selecting and dragging a corner of the
bounding box, the set Aspect ratio is maintained. 

The default is 1. 

Zoom - Enter a value or use the arrows to increase or decrease the zoom level of the
drawing on the scene.  

Adjust the camera Zoom Level of the map to the level at which you want the drawing
to appear before adding it.

Auto - when checked, the drawing remains the same size in pixels, while the camera
animates through the different zoom levels.

When unchecked, the drawing increases or decreases in size as the camera animates
through the different zoom levels.

Scale (px) X and Y - Displayed only when the drawing is on the Overlay layer, these
fields replace Zoom and Auto, and define the drawing’s width and height in pixels.
Changes to these fields or the Aspect field update each other automatically.
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Parameter Description

Opacity Enter or select a value between 0 and 1 to define the transparency of the drawing. 

A value of 1 is opaque and a value of 0 is transparent. 

Visible Select the Visible checkbox to make the drawing visible. 

It has the same effect as selecting the Eye icon ( ) on the Canvas.

Misc Frontface - Select to have the front side of the drawing face the camera. 

You can also toggle this parameter on the Canvas by selecting the Front Face icon ( )
at the bottom of the drawing’s bounding box. 

This parameter only applies when the map is tilted and does not apply to Line and
Area drawings.

Keep Orientation - Select to align a text drawing to the screen. Clear to align a text
drawing to the camera. Applies to Text drawings only.

Lock Camera - Select to lock the camera to a drawing. When enabled, the View
Camera button in the camera control area changes to indicate that this camera is

locked ( ). Only one drawing at a time can lock the camera. For a Line drawing, the
playout camera looks at the head of the line when locked.

Use Spline Rotation - Select to have the rotation angle of the drawing change
according to the direction of the line. 

This parameter is only applicable for drawings that are connected to the head of a line. 

To connect a drawing to a line, it must be dragged and dropped to the head of the line
on the Canvas. A yellow rectangle indicates that the drawing will be connected to the
line when the drawing is dropped. 

To disconnect a drawing, drag it away from the head of the line until the yellow
rectangle disappears. See Adding and Editing Line Drawings  for more information. 

Animation Slowdown - Enter or select the number of frames in which an image is
repeated in an image sequence before the next image is shown. 

The default value is 0. 

This parameter is only applicable to Icon, Area and Line Drawings. 

Image sequences loop independently of the timeline animation.

Fullscreen - Use the slider or box to scale the selected Icon, Video Input, and Inset
drawing from its original size to full screen (0-100%).
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Parameter Description

Effect

(In and Out)

These parameters define how a drawing appears (In) and disappears (Out) during
animation.

Options are: 

None - the drawing appears instantly at the frame to which the Key Frame is set. 

Dissolve - the drawing blends in/out over the number of seconds selected in the Time
field, starting at the Key Frame at which the drawing is set to appear/disappear.

Typewriter - the drawing appears/disappears one character at a time over the number
of seconds selected in the Time field. 

«Applies to Text drawings only.

Alpha - the drawing blends in/out one character at a time over the number of seconds
selected in the Time field. 

«Applies to Text drawings only.

Wipe - the drawing animates in and out at the level set in the corresponding Zoom
fields. The drawing appears from the right over the number of seconds selected in the
Time field. Use the Delay field to input the number of seconds that the drawing will
delay its animation. 

«Applies to Text drawings only.

Wipe Reverse - the drawing animates in and out at the level set in the corresponding
Zoom fields. The drawing appears from the left over the number of seconds selected in
the Time field. Use the Delay field to input the number of seconds that the drawing
will delay its animation. 

«Applies to Text drawings only.

Wipe Left - the drawing appears/disappears from the left side where the marker is
positioned, over the number of seconds selected in the Time field. The drawing also
appears or disappears from the opposite side of the marker, over the same time
interval. 

Wipe Right - the drawing appears/disappears from the right side where the marker is
positioned, over the number of seconds selecting in the Time field. The drawing also
appears or disappears from the opposite side of the marker, over the same time
interval.

Wipe Bottom - the drawing appears/disappears from the bottom over the number of
seconds selected in the Time field. The drawing animates in and out at the level set in
the corresponding Zoom levels. 

Wipe Top - the drawing appears/disappears from the top over the number of seconds
selected in the Time field. The drawing animates in and out at the level set in the
corresponding Zoom fields.

DataLinq The DataLinq section links Drawings to DataLinq Sources configured in the DataLinq
Setup window. See Configuring DataLinq Sources for XPression Maps  for
information. 

Select a DataLinq source from the drop-down menu, or select the Browse button ( )

to open the DataLinq Setup window. 

Once you have selected a DataLinq source, select the Source checkbox to view the
configured Container drawing data on the Canvas. 
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Area Drawing Parameters

Parameters specific to a particular drawing type are contained in the Specific drop-down. The Area
section contains parameters that are specific to Area drawings. Select the Area drawing in the scene to
adjust the parameters.

Area Drawing Parameters 

Parameter Description

Texture Aspect — Enter or select a value to define the appearance of the pattern in the area.

Scale — Enter or select a value to define the size of the pattern in the area.

Angle — Enter or select a value to define the angle of the pattern in the area.

Blend Mode — Use the drop-down to select how the area texture is mixed with the
underlying map.

The options are:

Regular — the area is blended with the map.

Multiply — the area color is multiplied with the map color.

Add — the area color is added to the map color. 

Point Index - enter or select a value for the active point of the line. 

A value of 0 means no active point. 

The active point is red in the output. All other points are green.

The active point can also be set by left-clicking the mouse on the point.

Longitude - enter or select a longitudinal value for the active point of the area.

Latitude - enter or select a latitudinal value for the active point of the area.
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Dynamic Data Drawing Parameters

The Dynamic Data section contains the Data Filter parameter which is specific to Dynamic Data
drawings. Select the Dynamic Data drawing in the scene before adjusting the parameters.

Dynamic Data is an optional feature for XPression Maps and the XPression Maps Server.

Dynamic Data Drawing Parameter 

Parameter Description

Data Filter Defines a filter parameter for the dynamic data query.

For example, if you place a Dynamic Data drawing on the map which draws
information about a city from an SQL database, and you want to move this
drawing away from the location of the city on the map, enter the name of the
city in the Data Filter parameter and use an SQL statement in the Dynamic
Data Query such that the SQL statement is using the ${Filter} parameter for
the selection of the data. 

The data will be updated to be specific to that city. 

Updating requires that you move the drawing slightly on the Canvas.
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Inset Drawing Parameters

The Inset section contains parameters that are specific to the Inset drawings. Select the Inset drawing
in the scene to adjust the parameters. 

Inset Drawing Parameters

Parameter Description

Edit Fullscreen Select the Edit Fullscreen button to edit the Inset drawing in fullscreen mode.
See Editing Inset Drawings  for information on editing in fullscreen mode. 

Edit Select the Edit button to edit the view of the Inset drawing as it is presented
on the Canvas. 

File Select the Browse button ( ) to open the File Explorer window to import an
external file for the Inset drawing
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Line Drawing Parameters

The Line section contains parameters that are specific to Line drawings. Select the Line drawing in the
scene to adjust the parameters.

Line Drawing Parameters 

Parameter Description

Texture Aspect — enter or select an aspect value to define how the image is mapped on
the line.

Scale — enter or select a scale value to define the size of the texture on the
line.

Angle —  enter or select an angle value to define the angle of the texture on the
line.

Progress Value - enter or use the slider to determine the starting point (typically the
beginning or end of the line) for a line animation.

Point Index — enter or select a value for the active point of the line. A value of 0
means no active point. The active point is red in the output. All other points are
green. 

Longitude — enter or select a longitudinal value for the active point of the line. 

Latitude — enter or select a latitudinal value for the active point of the line.

Close Select the Close checkbox to make the Line drawing from the loop back to the
starting point.
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Locator Drawing Parameters

The Locator section contains parameters that are specific to Locator drawings. Select the Locator
drawing in the scene before adjusting the parameters.

Locator Drawing Parameters  

Parameter Description

Zoom Level Enter or select a zoom level between 1 and 21 to define how much of the map is
displayed in the highlighted area. 

A higher zoom level value means a smaller map area is shown, but it appears
closer to the camera.

Map Style Use the drop-down to select a map style. 

The options are:

Bing Aerial 

Bing Aerial Label 

Bing Road 

Bing Road Dark

Bing Road Gray 

Bing Road Light

Map Zoom Enter or select a zoom value for the highlighted area of a map. 

0 - 1: The area appears closer to the camera.

>1: The area appears further from the camera.

The resolution of the map is not changed, so it does not show more or fewer
details when zoomed in or out.

Map Offset X Enter or select a value to move the highlighted area within the drawing along
the X coordinate.

Map Offset Y Enter or select a value to move the highlighted area within the drawing along
the Y coordinate.
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Magnifier Drawing Parameters

The Magnifier section contains parameters that are specific to Magnifier drawings. Select the Magnifier
drawing in the scene to adjust the parameters.

Magnifier Drawing Parameters 

Parameter Description

Zoom Level Enter or select a zoom level between 1 and 21 to define how much of the map is
displayed in the highlighted area. 

A higher zoom level value means a smaller map area is shown, but it appears
closer to the camera. 

Map Style Use the drop-down to select a map style. 

The options are:

Bing Aerial 

Bing Aerial Label 

Bing Road 

Bing Road Dark

Bing Road Gray 

Bing Road Light

Map Zoom Enter or select a zoom value for the highlighted area of a map. 

0 - 1: The area appears closer to the camera.

>1: The area appears further from the camera.

The resolution of the map is not changed, so it does not show more or fewer
details when zoomed in or out.

Map Offset X Enter or select a value to move the highlighted area within the drawing along the
X coordinate.

Map Offset Y Enter or select a value to move the highlighted area within the drawing along the
Y coordinate.

Map Location Displays the longitude and latitude coordinates of the highlighted area. 

This is defined by the position of the drawing at creation. 

Reload Map If you move the magnifier drawing within the scene, select Reload Map to set
the Map Location coordinates to the actual location of the drawing. This
updates the map in the highlighted area.
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Text and Replacement Drawing Parameters

The Text section contains parameters for modifying the alignment, kerning and spacing of Text and
Replacement drawings. Select the drawing in the scene to adjust the parameters.

Text Drawing Parameters 

Parameter Description

Alignment
 Left  - align the text to the left.

 Center  - center the text.

 Right  - align the text to the right.

 Justified - align the text to the left and right margins.

Kerning Enter a value or use the arrows to set the amount of space between letters.

Line Spacing Enter a value or use the arrows to set the amount of space between multiple
lines of text.

Text Box Use the text box to edit the text on one or more lines.

Press the Enter key to move text to the next line.
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3D Object Drawing Parameters

The 3D section provides options to enable lighting for the 3D Object drawing in the scene, adjust its
position, or remove it entirely. You can also save the 3D Object drawing as a landmark, preserving its
current position and scale on the map. To modify these settings, first select the drawing in the scene.

Text Drawing Parameters

Parameter Description

Light Select the Light checkbox to apply and adjust the Pos X, Pos Y and Height
positioning of lighting relative to the center of the 3D Object drawing's
bounding box.  Clearing the checkbox remove lighting from the 3D Object
drawing. See 3D Object Drawings Properties  for more information.

Landmark Once the 3D Object drawing has been placed and sized on the scene's map, it
can be designated as a landmark by selecting the Save button. See Creating a
Landmark from a 3D Object Drawing  for more information.
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Adding a Default Drawing to a Search Location

You can designate a default drawing, which is used whenever drawings are generated automatically. For
example, you can automatically create a text drawing with the name of a country or a state when the
corresponding shape is created. In this case, the settings of the default text drawing are used for the label
text drawing. You can set a default drawing for text, icon and dynamic data drawings.

Additionally, you can create a Text, Dynamic Data, or Icon drawing exactly at the search location.

This section contains the following topics:

Designating a Default Drawing

Creating a Drawing from the Search Location

Adding a Search Location's Name or Address, an Icon or Drawing Data to the Map

To designate a default drawing:

1. In the Drawing Toolbox, in the preview pane, right-click the thumbnail of the drawing that you want
to designate as the default drawing.

You can designate a default drawing for Text, Icon and Dynamic Data drawings.

2. From the context menu, select Set as Default [name of drawing].

The background of the default drawing will turn yellow.

Default Drawing

To create a drawing from the Search location:

1. In the Search Editor, enter a location and select the Search button.

2. In the Drawing Toolbox, in the preview pane, right-click the thumbnail of the drawing that you want
to create at the Search location.

This feature is only available in Text and Dynamic Data drawings.

3. From the context menu, select Create Drawing From Search.

Create Drawing From Search

The selected drawing appears at the exact coordinates of the searched location, with the corresponding
content already displayed (location name or weather data, for example).
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To add a Search location's name or address, an icon or drawing data to the map:

1. In the Search Editor, enter a location and select the Search button.

2. Right-click on a search result.

3. From the context menu that opens, select one of the following options.

· Add Name to Map: If you have identified a text drawing as the default, the name of the location will
be added to the map using the style of the default text drawing.

· Add Address to Map: If you have identified a text drawing as the default, the address of the location
will be added to the map using the style of the default text drawing.

· Add Icon to Map: If you have identified an icon drawing as the default, the default icon will be added
to the map at the corresponding location.

· Add Dynamic Data Drawing to Map: If you have identified a dynamic data drawing as the default,
the default dynamic data drawing for the corresponding location is added to the map.

Search Editor - Add Default Drawing to Map
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Adding a Measured Distance Text Drawing

The Measurement Tool calculates the distance between two points on the map and adds a text drawing
to display the result. You can also use the tool to mark an area of interest with a specific circumference—
such as the range of earthquake shock waves.

Distances can be measured in either the metric or imperial system.

To use the Measurement Tool:

1. From the menu bar select Edit > Measurement Tool.

Alternatively, you can select the Measurement Tool button in the toolbar.

XPression Maps Toolbar - Measurement Tool

The Measurement Tool opens.

Measurement Tool

2. Select the Show Circle checkbox to display a circle whose radius is determined by the distance
between two locations or by the size of the area of interest (optional).

3. From the Units drop-down, select whether to display the distance using the Metric or Imperial
system. 

4. Left-click on the starting location (represented in the Measurement Tool by the Tail coordinates) and
drag the cursor to the destination (represented by the Head coordinates).

A white circle is drawn on the map if Show Circle is selected and the measurement is calculated and
indicated along the straight line.

Measurement Tool Illustration - Calculation
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To display measurement units:

1. In the Drawing Toolbox, in the Text group, select a text drawing.

2. Select the white measurement text on the map.

The measurement is automatically displayed in the text drawing, provided the Zoom Level of the map
is within the drawing Visibility In and Out parameters.

Measurement Tool Illustrations

3. Adjust the location of the text drawing, if necessary.

4. To finish, select Done.

The white circle, line and original measurement text are removed, leaving just the text drawing with
the measurement. 

The Measurement Tool closes.

5. Add an area or custom drawing to illustrate an area if desired.

6. To start over, before selecting Done, select Reset.



220 • Adding Drawings XPression Maps User Guide (v4.0)

Adding Drawings to an Overlay Layer

The overlay layer is an editing area independent of the camera view. Drawings placed in the overlay layer
will not move together with the underlying map; they will stay on an invisible layer in front of the camera.
Drawings on the overlay layer can be animated the same way as all other drawings. The overlay layer is
useful for placing logos or text that you want to keep in the same spot regardless of the movement of the
map or drawings. 

To use the Overlay layer:

1. Select the Overlay checkbox next to the camera view buttons.

A transparent gray overlay indicates that the overlay layer is activated. 

2. Place your drawings on the map.

Drawings placed on the Overlay Layer are fixed in place and can only be selected and edited or
deleted when the Overlay Layer is activated.

In the example below, the title text U.S. ELECTION 2020 is placed on the Overlay Layer and remains
stationary while the scene animation is played.

Overlay Layer

3. Deselect the Overlay checkbox to return to your main layer and play your animation.
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Adding a Copy of a Drawing

When multiple versions of a drawing are needed within a scene, it’s more efficient to create copies and
adjust their parameters rather than recreating each drawing from new.

The following steps outline how to quickly duplicate a drawing already added to the scene and modify it as
needed.

To copy and paste a drawing:

1. On the Canvas, select a drawing in the scene.

2. From the menu bar select Edit > Copy Drawing or press Ctrl+C.

The drawing and its parameter values are stored internally.

3. From the menu bar select Edit > Paste Drawing or press Ctrl+V.

A copy of the stored drawing is placed in the middle of the Canvas.

« Using the Edit > Cut Drawing menu option or pressing Ctrl+X or pressing the Delete key copies

the drawing to the clipboard before deleting it, so if you change your mind, you can paste it back in
using  Ctrl+V.
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Replacing a Drawing

The following procedure explains how to replace an existing drawing in a scene with another drawing from
the Drawing database. Note that the position, scale, and any entered text (if applicable) will remain
unchanged during the replacement.

To replace a drawing:

1. In the Drawing Toolbox, from the Group drop-down, select the folder containing the drawing you
want to add to a scene. 

Thumbnails of the drawings contained in that folder are displayed in the preview pane.

2. Left-click and hold down the mouse button on the thumbnail and drag it on top of the drawing you want
to replace.

The position, scale and entered text (if applicable) will remain the same.
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Setting a Drawing's Layer Order

In some scenes, you may want to layer multiple drawings on top of one another. For instance, you might
have an area drawing with a line and icon drawing above it, accompanied by a text label for the icon. In
this situation, you’ll want all other drawings to appear above the area drawing, with the text drawing
positioned on top of the line drawing.

Use the drawing order commands to arrange each drawing in the desired layer for the correct visual
hierarchy.

To set a drawing's layer order:

1. Select the drawing on the Canvas.

2. Select Edit in the menu bar and select one of the following options:

a. Move Drawing To Top - moves the selected drawing to the top-most position in the scene so that
it will appear on top of all other drawings. 

You can also use the keyboard shortcut Ctrl+PgUp or select the Move Drawing To Top button in
the toolbar.

XPression Maps Toolbar - Move Drawing To Top

b. Move Drawing Up - moves the selected drawing up one layer in the scene. 

You can also use the keyboard shortcut Ctrl+Up or select the Move Drawing Up button in the
toolbar.

XPression Maps Toolbar - Move Drawing Up

c. Move Drawing Down - moves the selected drawing down one layer in the scene. 

You can also use the keyboard shortcut Ctrl+Down or select the Move Drawing Down button in
the toolbar.

XPression Maps Toolbar - Move Drawing Down

d. Move Drawing to Bottom - moves the selected drawing to the bottom-most layer in the scene, so
that it will appear beneath all other drawings.

You can also use the keyboard shortcut Ctrl+PgDown or select the Move Drawing To Bottom
button in the toolbar.

XPression Maps Toolbar - Move Drawing To Bottom

3. Select Save to store your changes to the scene.
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Showing or Hiding Drawings

The following procedure provides instructions for controlling the visibility (show or hide) of a drawing that
has been added to a scene.

To show or hide drawings from the scene: 

· Use the checkboxes beside the drawings in the Drawings Overview Panel to make a drawing visible or
invisible in the scene. 

If the boxes are unchecked the drawings will still appear in the drawings overview panel.

OR

·  Select the drawing on the Canvas and toggle the Eye Icon  or Airplane Icon  associated with
the drawing's bounding box to control the visibility of the drawing.
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Deleting a Drawing from the Scene

The following procedures identify two methods for deleting a drawing that has been added to the active
scene.

To delete a drawing that is currently visible on the Canvas:

· Select the drawing on the Canvas and press the Delete key on the keyboard or press Ctrl+x.

The drawing is deleted from the Canvas, as well as the Drawings Overview panel.

To delete a drawing from the scene that may not be currently visible on the Canvas:

· From the list of drawings in the Drawings Overview panel, select the drawing that you want to delete
and perform one of the following: 

Ø Right-click on the drawing's name and select Delete Drawing.

OR

Ø Press Ctrl+x.

OR

Ø Press the Delete key on the keyboard.

The drawing is deleted from the Drawings Overview panel, as well as on the Canvas.
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Adding Shapes
Using the XPression Maps library of national and interstate borders from around the world, you can add
shape layers to the map to provide greater emphasis by outlining and filling in the boundaries of
countries, states or regions with color. 

Example of Shapes in a Scene

Viewing, adding, and editing predefined or custom shapes involves using the following editors and tools: 

· Search Editor — Use the Search Editor  to find locations throughout the world by searching for
addresses, cities, countries and even prominent buildings. Once a location is found, use the Search
Related Shapes section to add a shape layer, with or without a label, to the country, state, or region
identified in the search results.

· Shape Database Viewer — The Shape Database Viewer  provides direct access to the shapes of all
countries and their states (and regions, where available) and allows you to quickly add a shape to the
active scene. It also provides access to the Shape Label Properties editor, which displays the label
details of each shape in the database. You can change the name of the shape label, the position, the size
and the zoom level at which it appears and you can add search terms to the search info.

· Shape Editor — The Shape Editor  displays a list of all the shapes that have been added to the
current scene. Use the Shape Editor to assign an existing shape style to a shape, or open the Shape
Style Manager to modify or create a new shape style. Select a shape in the Shape Editor's list and
modify the parameters to change the appearance and behavior of the shape without changing the style
itself. You can also use the Shape Editor to display the children shapes belonging to the parent shape
(Country > States, or States > Regions/Counties) and modify their parameters too.

· Custom Shapes Editor — Use the Custom Shapes Editor  to import custom shapes, which can be
area or line shapes, into the Shapes database. Once added to the shapes database, you are able to add
them to your scenes like other shapes.

· Animation Editor — The Animation Editor  allows you to create map animations where by changing
certain shape object properties at precise times, you can control the appearance or disappearance of a
shape layer or change the size of the shape layer or the shape's associated image. See Creating
Animations  for more information. 
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The following topics provide information and instructions for adding and configuring shapes:

Adding Shapes from Location Search Results

Adding Shapes from the Shape Database Viewer

Managing and Adding Custom Shapes

Adding and Editing Child Shapes

Creating and Editing Shape Styles

Editing Individual Shapes within the Scene

Editing Shape Label Properties

Setting the Language of Shape Labels

Relocating Shapes

Deleting a Shape from a Scene
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Adding Shapes from Location Search Results

The following procedure explains how to use the Search Related Shapes section in the Search Editor to
quickly add a country, state, or region shape to a specific map location in the active scene. 

To add a shape from the Search Related Shapes to the scene:

1. In the Search Editor, enter in the Location field the name of the location that you want to display in
the scene.

For more accurate results, be specific about the location you want to search. Enter the region, state and
country in the Location field, separated by commas, as in the example shown below:

Vancouver, British Columbia, Canada

2. If you want the map to go directly to the location you are searching, select the Go to Result checkbox.

3. Select Search.

The Result section lists all of the locations found that match the entered information.

4. If multiple results are listed, select each result until the desired one is found.

The Search Related Shapes section lists the available shapes for the searched location.

5. In the Search Related Shapes section, in the Filter section, select or clear the checkbox for Country,
States and/or Region depending on the location for which you are searching.

6. To add a label to the shape, in the Label area, select Auto Create to enable labeling.

7. Select or clear the Adjust Map to New Shape checkbox.

· When selected, the map on the Canvas moves to the location of the shape you’re adding and adds
the shape at its default zoom level, which is different for each shape.

· When cleared, you need to manually adjust the map to the area of interest but then each shape is
added to the map at the same zoom level.  

8. In the Search Related Shapes list, double-click the shape you want to add to the scene.

The shape appears on the map on the Canvas.

The default shape style is automatically applied to the shape, Country Default for a country, State
Default for a state and Region Default for a region. The shape style and the shape's parameters can
be changed later in the Shape Editor .

Search Editor - Search Related Shapes Example

9. If the selected shape isn't displayed on the map on the Canvas, open the Shape Editor, right-click on
the shape in the Name list and select Go to Shape on Map. 
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Adding Shapes from the Shape Database Viewer

The following procedure describes how to use the Shape Database Viewer to view the entire collection of
predefined country, state, or region shapes and how to add these shapes to the map in the active scene.

« The same shape can be created multiple times. This can be useful if you want to swap different views

of a single shape. In an election map, for example, you might want a state to change color to show
which party controlled the state before and after the election.

To add a shape from the Shape Database Viewer to the scene:

1. In the Search Editor, select or clear the Adjust Map to New Shape checkbox.

· When selected, the map on the Canvas moves to the location of the shape you’re adding and adds
the shape at its default zoom level, which is different for each shape.

· When cleared, you need to manually adjust the map to the area of interest but then each shape is
added to the map at the same zoom level. 

2. Select Shape Database Viewer. 

3. Do one of the following:

· Select a country from the list.

· Select the arrow beside a country to select a state or province from the list.

· Select the arrow beside a country and then the arrow beside a state or province to select a region
from the list (if regions are available for the selected state).

Shape Database Viewer - Select a Shape

4. Select Add State Shape or double-click the selected country, state or region to create a shape for the
country.

The shape appears on the map on the Canvas and in the Shape list in the Shape Editor.

The default shape style is automatically applied to the shape, Country Default for a country, State
Default for a state and Region Default for a region. The shape style and the shape's parameters can
be changed later in the Shape Editor.

5. If you want to make changes to the label of a shape, select the shape in the list and select Edit Label
Properties. See Editing Shape Label Properties  for details.

6. When you have finished adding shapes and editing shape labels, select Done to close the Shape
Database Viewer.
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Managing and Adding Custom Shapes

XPression Maps allows you to enhance your scenes by adding custom shapes that you’ve either created or
obtained from external sources and saved locally. These custom shapes can be either area shapes (such as
country or state borders) or line shapes (such as streets, rivers, or train tracks), and they support most
common projection formats.

· Area shapes can be filled with color and outlined with customizable borders.

· Line shapes can be styled with various colors to match your design needs.

To ensure your custom shapes are preserved during software updates, we recommend storing them in a
dedicated folder outside the XPression Maps installation directory.

After importing a custom shape, you should also create a corresponding custom shape style to define its
visual appearance. See Shape Styles  for more information.

The following topics are discussed in this section:

Organizing Custom Shapes into Groups

Importing and Deleting Custom Shapes

Searching for a Custom Shape

Editing a Custom Shape's Identifying Details

Adding a Custom Shape to a Scene

239

231

233

236

236

237



XPression Maps User Guide (v4.0) Adding Shapes • 231

Organizing Custom Shapes into Groups

Organizing custom shapes into groups makes it easier to manage and retrieve them when building scenes.
The following topics show how to add, rename, and delete groups in the Custom Shapes editor.

Adding a New Custom Shapes Group

Renaming a Custom Shapes Group

Deleting a Custom Shapes Group

To add a custom shapes group:

1. From the menu bar select Custom > Shapes to open the Custom Shapes editor.

Custom Shapes Editor

2. In the Custom Shapes editor, select the Browse button beside the Group drop-down.

The Custom Groups dialog opens.

Custom Groups Dialog

3. Select the Add button to open the Add Custom Group dialog.

Add Custom Group

4. In the Group Name field, enter a name for the new custom group and select OK.

5. In the Custom Groups dialog, select Done to close the dialog.

6. Select Done to close the Custom Shapes editor.

The new group will appear in the Group drop-down.
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To rename a custom shapes group:

1. From the menu bar select Custom > Shapes to open the Custom Shapes editor.

2. Select the Browse button beside the Group drop-down to open the Custom Groups dialog.

3. In the Custom Groups dialog, from the Group Name drop-down, select the Group you want to
rename.

4. Select Rename.

5. In the Change Custom Group Name dialog that opens, enter a new name in the Group Name field
and select OK.

The group's name is immediately updated in the Group Name drop-down list.

6. In the Custom Groups dialog, select Done to close the dialog.

7. Select Done to close the Custom Shapes editor.

To delete a custom shapes group:

1. From the menu bar select Custom > Shapes to open the Custom Shapes editor.

2. Select the Browse button beside the Group drop-down to open the Custom Groups dialog.

3. In the Custom Groups dialog, from the Group Name drop-down, select the Group you want to
delete.

4. Select Delete.

5. In the Delete Custom Group confirmation dialog that opens, select Yes to delete the group and all its
contents.

6. In the Custom Groups dialog, select Done to close the dialog.

7. Select Done to close the Custom Shapes editor.
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Importing and Deleting Custom Shapes

XPression Maps allows you to import custom shapes from local files. These shapes can be organized into
groups for easier access. When no longer needed, shapes can also be deleted. The following procedures
explain how to import  and delete  custom shapes in the Custom Shapes editor.

To import a custom shape:

1. From the menu bar select Custom > Shapes to open the Custom Shapes editor.

The Custom Shapes editor opens.

Custom Shapes Editor - Blank

2. From the Group drop-down, select the Group to which you want to add the imported custom shape.

If the Group already contains shapes, the table in the center of the Custom Shapes editor displays
the data for the shapes in the Group.

Custom Shapes Editor - Populated
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3. Select Import.

The Shape Import editor opens.

Shape Import Editor

If you’ve previously imported custom shapes, the Shape Folder field will display the last shape folder
that was opened. 

4. To open a different folder, select the Browse button ( ) beside the Shape Folder field, navigate to
the folder containing the custom shape you want to import and select Open.

All shape archives in the selected folder are listed in the upper table of the editor. Information for each
archive is displayed as follows:

· Name: The name of the shape archive.

· Type: The type can be 2D or 3D for Polygon (a closed shape where the beginning of each line is
connected to its end), Line String (which is simply a line), or Point (a location reference).

· Object Count: The number of shape objects in the archive.

· Bounding: The area in which the shapes are contained, expressed in longitude and latitude
coordinates.

· Attributes: The number of attribute columns with additional data for the shape, that are stored in
the archive.

5. Select the archive containing the shape you want to import. 

The layers of the selected archive appear in the bottom-half of the Shape Import editor.

6. Select the layer(s) you want to import.

Use the following controls to help you filter and select the layer(s):

· Select the Select All or Deselect All checkbox to toggle the selection of all the layers.

· Select a column heading to sort the contents in ascending/descending based on that column.

7. To combine multiple layers into one shape, select the Combine Parts checkbox.

8. From the Name Column drop-down, choose which attribute column will be used as the name for
imported shapes. 

The selected column's values are saved as shape names in the database. These names are displayed in
the Shape Editor when the custom shapes are added to a map.
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9. Select Import.

The Shape Import Report dialog opens indicating if there were any errors during the import. 

Shape Import Report Dialog

10.If there were no errors, select OK to close the dialog and then select Done.

The shapes from the selected archive appear in the table in the Custom Shapes editor.

11.Select Done to close the Custom Shapes editor or continue to add the custom shape to a scene. 

To delete custom shapes:

1. From the menu bar select Custom > Shapes  to open the Custom Shapes editor.

2. In the Custom Shapes editor, from the Group drop-down, select the group containing the custom
shape(s) you want to delete.

3. Select the shape you want to delete or press Ctrl and select several shapes if you want to delete
multiple shapes.

4. Go to the Manage tab and select Delete.

5. In the Delete Shapes confirmation dialog, select Yes to delete the selected shape(s).

6. Select Done to close the Custom Shapes editor.
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Searching for a Custom Shape

Quickly recall custom shapes by searching using shape name, layer name, or associated search
information to generate a filtered list of results.

To search for custom shapes:

1. From the menu bar select Custom > Shapes to open the Custom Shapes editor.

2. In the Custom Shapes editor, in the Filter tab, enter one or more of the Name, Layer Name or
Search Information parameters to narrow down the number of custom shapes displayed in the table.

3. Select Refresh to display the new search results.

Editing a Custom Shape's Identifying Details

You can edit a custom shape’s identifying details—such as its name, layer name, or search information
—directly within the Custom Shapes editor. This helps ensure your shapes are clearly labeled and easy to
locate when building scenes.

To edit a custom shape's identifying details:

1. From the menu bar select Custom > Shapes to open the Custom Shapes editor.

2. From the Group drop-down, select the Group to which contains the custom shape.

The table in the center of the Custom Shapes editor displays the data for the shapes in the Group.

Custom Shapes Editor 

3. Select the row of the custom shape whose identifying details you want to edit.

4. Select the Edit tab.

5. Edit the Name, Layer Name, and/or Search Information values.

6. Select Refresh to update the table with the new values.
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Adding a Custom Shape to a Scene

The following procedure describes how to add a custom shape to the active scene on the Canvas.

To add a custom shape to a scene:

1. Open the scene to which you want to add a custom shape.

2. From the menu bar select Custom > Shapes  to open the Custom Shapes editor, if it is not already
open.

3. From the Group drop-down, select the group containing the custom shape you want to add to the
scene.

The selected group opens, displaying the custom shapes in that group.

4. Double-click the shape you want to add to your scene and select Done.

The shape is added to the Shape Editor on the left.

5. Double-click the shape in the Shape Editor to display it on the Canvas. 

6. If the map on the Canvas isn’t displaying the selected shape, in the Shape Editor, right-click on the
shape and select Go to Shape on Map.

Custom shapes can be assigned as nested shapes within another shape. This allows hierarchial structures,
such as voting districts within a state. The Into Active Shape option must be used to create this
relationship. 

To add a custom shape as a nested shape:

1. In the Shape Editor, select the shape in which the new shape will be nested.

2. In the Custom Shapes editor. select the shape to be nested.

3. Next to the Use Selected button, select the Into Active Shape checkbox.

4. Select Done. 

The selected shape is added as a nested shape within the active shape in the Shape Editor. 

Jessica Hempinstall
Sticky Note
bold
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Adding and Editing Child Shapes

The following procedure describes how to load/add the child shapes (states or regions) of a country or
state shape that has already been added to the map.

To add child shapes:

1. In the Shape Editor, once a country or state shape has been added, select the shape for which you’d
like to add the states or regions.

2. Right-click the selected shape and from the context menu, select Load Children.

Add Child Shapes

· If a country shape has been selected, all the states of that country are loaded and displayed
alphabetically below the country.

· If a state shape has been selected, all the regions of that state are loaded and displayed
alphabetically below the state.

· It is possible that no children exist for a shape (for example, no regions are available for a state or
the shape is already a region).

3. In the Name list, expand the parent and double-click the child to add a shape to the map.

The shape appears on the map on the Canvas.

The default shape style is automatically applied to the shape, State Default for a state and Region
Default for a region.

4. To edit the child shape's style or parameters, select the name of the child in the Name list and modify
the settings in the Shape Editor as described in Editing Individual Shapes within the Scene .249
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Creating and Editing Shape Styles

XPression Maps comes with a set of predefined shape styles that can be applied to the shapes you add to
your scene. The styles are available through the Shape Editor, in the Style section. You can also create
your own custom shape style in the Shape Style Manager.

The following topics are discussed in this section:

Creating a New Shape Style

Editing a Shape Style

Shape Style Properties

Deleting a Shape Style
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Creating a New Shape Style

The following procedure describes how to create a new shape style whose properties can be copied in from
an existing style and then modified to meet your requirements and preferences. The new shape style can
then be saved to the shape style database for future use.

To create a new shape style:

1. Use the Search Editor  to locate and select the country, state, or region for which you want to create
a new shape style. 

2. In the Shape Editor, in the Style section, select the Browse button ( ) beside the Style drop-down.

The Shape Style Manager opens, displaying a list of predefined styles.

Shape Style Manager

3. Select Add.

The Add Shape Style dialog opens.

Shape Style Manager - Add Shape Style

4. In the Name field, enter a name for the new shape style.

122
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5. If you want to copy the properties of one of the existing styles, from the Copy from drop-down, select
the style you want to copy and select OK.

The Edit Shape Style dialog opens.

« If no other selection is made, the properties of shape style appearing in the Copy from field, will be

copied.

Edit Shape Style Dialog

6. Edit the shape style as necessary.

See Shape Style Properties  for information on editing shape style properties.

7. When you have finished editing the shape style properties, select OK

In the Shape Style Manager, your new style is added to the list and the Save icon appears beside it.

Shape Style Manager

244
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8. Select the Save icon and in the Save Shape Style confirmation dialog, select Yes to save the new
shape style into the shape style database.

If you don’t save the shape style, it will only be applied in the current scene and will not be available to
use again.

Save Shape Style Confirmation Dialog

9. Select Done to close the Shape Style Manager.
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Editing a Shape Style

The following procedure describes how to edit the properties of an existing shape style using the Shape
Style Manager. 

To edit a shape style:

1. In the Shape Editor, in the Style section, select the Browse button ( ) beside the Style drop-down.

The Shape Style Manager opens, displaying a list of predefined styles.

2. Select the shape style you want to change and select Edit or double-click the shape style.

The Edit Shape Style dialog opens.

3. Edit the properties of the new style and select OK.

See Shape Style Properties  for information on editing shape style properties. .

The Edit Shape Style dialog closes and the Shape Style Manager reopens. The edited style is

highlighted and the Save icon  and Reset icon  are displayed beside it. 

Shape Style Manager

4. Select the Save icon and in the Save Shape Style confirmation dialog, select Yes to save the shape
style into the shape style database.

An exclamation mark at the left of the shape style indicates that the style is saved in the scene but not
in the database. That style will not be available to be used in other scenes.

OR 

Select the Reset icon and in the Reset Shape Style confirmation dialog, select Yes to reset the shape
style to its previously saved state.

5. Select Done to close the Shape Style Manager.
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Shape Style Properties

Many of the properties of shape styles can be customized for a different appearance. Properties such as
border and fill area color, name visibility and style and the zoom level at which the shape style becomes
visible can be edited in the Edit Shape Style dialog. Changes in these properties are visible on the
Canvas but not saved into the Shape Style until you select OK. 

If the shape is a state rather than a country, the corresponding regions are shown, if available. Names and
borders of regions are available only for states that have region shapes defined. Check the Shape
Database Viewer to see whether region shapes are available for a state. 

See Adding Shapes from the Shape Database Viewer  for information about the Shape Database.

If the shape is a region, the settings in the Children Shape Properties section do not have any effect.

These properties and others are described in the table below. 

Properties Description

Name Enter a name for the new style

Default For Use the drop-down to select whether you want to make this style the default style for
countries, states, or select None if you do not want to make this style a default style.

Only one default style exists for each country, state or region. Setting a style to default
will over-ride any previously defined default style.

Border When enabled, the outline of the shapes using this style will be displayed in the color
that is set in the corresponding Color Selection editor to the right of the checkbox. 

Borders are drawn on top of the selected map style and therefore take precedence over
the borders of the map style. 

The border width can be adjusted by entering a value or using the arrows to increase or
decrease the value in the field beside the checkbox. 

Maximum is 10 pixels.

Fill Area When enabled, the shapes using this style will be filled with the color that is set in the
corresponding Color Selection editor to the right of the checkbox.

Shadow
Options

Access the Shadow Options by selecting the Browse button beside the Fill Area
Color editor button. When enabled, a shadow will surround the shape fill area. 

The parameters are:

Shadow — select the Shadow checkbox to enable a shadow color to surround the
shape area. 

Shadow Color — select the Color button to open the Select Color window. Select a
basic color, use the color gradient or input a custom color for the Shadow Color.  

Shadow Offset — use the arrows to adjust the Shadow Offset.

Ø The first entry field adjusts the shadow's placement from left to right, a higher
number places the shadow more on the right side of the shape. A lower number
places the shadow on the left side of the shape. 

Ø The second entry field adjusts the shadow's placement from top to bottom. A higher
number places the shadow more on top of the shape. A lower number places the
shadow more on the bottom of the shape. 
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Properties Description

Blur — use the arrows to adjust the level of blur added to the shadow. A higher number
will increase the blur level, a lower number will decrease the blur. 

Enter 0 for no blur. 

Standalone — select the Standalone checkbox to display a shadow for each shape
individually on the map. Deselect the Standalone checkbox to display a combined
shadow, where all shapes that share the same shape style cast a single shadow. 

Name When enabled, the name associated with the shape will be visible in the output and will
be the color that is set in the corresponding Color Selection editor to the right of the
checkbox.

The size of the name can be scaled by entering a value or using the arrows to increase
or decrease the value in the field beside the checkbox.

When not enabled, no name is displayed. This can be useful if you are using a map style
that includes names.

Name Style Use the drop-down to select a text drawing style to apply to the names. 

When you select a Name Style, you can preview it on the Canvas, but it is not saved
into the Shape Style until you select OK.

Use
Abbreviation
for Name

When enabled, abbreviations are used for the names of the top level shapes. Children
shapes must be configured separately.

Is Mask When selected, the shape is designated as one that can used as a mask for OSM layers.
Whether or not the mask is applied to the scene is controlled by the Use Shape Mask
setting in the OSM Layer Parameters dialog. See Editing OpenStreet Maps  for
more information.

Use Scene
Style Shading

When selected, the height shading in the scene will be displayed. In order for this to
work, the Height Shading parameter in the Edit Map Style editor must also be
enabled.

See Height Shading  for more information.
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Properties Description

Visibility These two parameters define how a shape appears and disappears during its visible
animation. This effect can be seen when the animation is played or when the zoom level
is changed.

Effect In — When set to Dissolve, the shape will blend in for the number of seconds
selected in the corresponding field, starting at the Key Frame at which the shape is set
to appear. When set to None, the shape appears at the frame to which the Key Frame
is set. 

Effect Out — When set to Dissolve, the shape will blend out for the number of seconds
selected in the corresponding field, starting at the Key Frame at which the shape is set
to disappear. When set to None, the shape disappears at the frame to which the Key
Frame is set. 

Zoom In — Enter or use the arrows to select the camera Zoom Level value at which
the shape will be visible. If the camera Zoom Level value is smaller than the Zoom In
value, the shape will not be visible. 

Zoom Out — Enter or use the arrows to select a camera Zoom Level value at which
the shape will no longer be visible. If the camera Zoom Level value is larger than the
Zoom Out value, the shape will not be visible.

Time — Enter or use the arrows to set the duration (in seconds) for the selected Effect.
The value determines how long the shape takes to appear (Effect In) or disappear
(Effect Out) during the animation. 

Blend Mode Use the drop-down to select how the Fill Area color of the shape is combined with the
underlying map. The options are:

Regular — the area color is combined with the underlying map color.

This is the most common blend method.

Multiply — the area color is multiplied with the underlying map color.

Add — the area color is added to the underlying map color.

Hue From Map — the hue (dominant color) of the shape style is discarded and the hue
of the underlying map is used instead.

Saturation From Map — the saturation (intensity) of the shape style is discarded and
the saturation of the underlying map is used instead.

Value From Map — the value (lightness or darkness) of the shape style is discarded
and the value of the underlying map is used instead.

Saturation and Value From Map — the hue (dominant color) of the shape style is
combined with the saturation (intensity) and value (lightness or darkness) from the
underlying map.

The Height Shading and 3D of the scene style is also applied to the shapes.

Child Shape
Properties

Description
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Properties Description

Borders When enabled, state or region borders will be visible in the output.

Enter or use the arrows to select a width for the child borders.

Select the Color button to open the Color Selection editor and set a color for the child
borders.

Names When enabled, the names of the states or regions will be visible in the output. Enter or
use the arrows to select a size for the name of the child.

Select the Color button to open the Color Selection editor and set a color for the child
names.

The name style is determined by the Name Style selected in the Properties section.

Database
Automation

Border Color When Database Automation is enabled and Border Color is selected, the border color
queried from the SQL database that is defined in the file selected in the File field is
applied to the shape.

Fill Area
Color

When Database Automation is enabled and Fill Area Color is selected, the fill area
color queried from the SQL database that is defined in the file selected in the File field
is applied to the shape.

File Select the Browse button ( ) beside the File field to navigate to the .xml
configuration file which contains the pointer to the Shape Color Database in which the
Border and Fill Area colors are defined.
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Deleting a Shape Style

The following procedure describes how to permanently delete a shape style from the shape style database.

To delete a shape style:

1. In the Shape Editor, in the Style section, select the Browse button ( ) button beside the Style
drop-down.

The Shape Style Manager opens, displaying the list of styles.

Shape Style Manager

2. Select the shape style you want to delete and select Delete.

3. In the Delete Shape Style confirmation dialog, select Yes to delete the style.

Delete Shape Style Confirmation

4. Select Done to close the Shape Style Manager.
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Editing Individual Shapes within the Scene

In the Shape Editor, you can apply a predefined style to a shape that has been added to the scene and
overwrite certain parameters, allowing you to change the appearance of an individual shape without
changing the style itself. This is useful if you have applied the same style to multiple shapes and don’t
want to change all of them. 

You can also change the opacity and visibility of the shape, add an image to the shape and edit the shape
boundaries.

Finally, you can create new Shape Styles to suit your production. See Creating and Editing Shape
Styles  for more information.

To edit a shape:

1. In the Shape Editor, select the shape you want to edit.

· Press Ctrl and select another shape in the list to select multiple shapes.

· Select a shape in the list, then press Shift and select another shape to select all the shapes between
the first and last selected shape to edit.

· A shape can also be selected by selecting it on the Canvas.

2. In the shape list, double-click the shape or right-click the shape and select Go to Shape on Map from
the context menu to adjust the view of the camera so that the shape is centered on the Canvas.

Go to Shape

3. From the Style drop-down, select a predefined shape style to apply to the shape. 

When a shape is selected, the Style drop-down indicates which shape style is currently applied to that
shape.

4. In the Overwrite Style section, you can adjust the following default parameters of the selected shape
style:

· Zoom In — enable this checkbox, then enter or select a value to define at which camera Zoom
Level the shape will be visible. 

· Zoom Out — enable this checkbox, then enter or select a value to define at which camera Zoom
Level the shape will be visible. 

· Border Color — enable this checkbox, then select a the Color button to open the Color Selection
editor and select a color to use as the border. 

· Fill Area Color — enable this checkbox, then select the Color button to open the Color Selection
editor and select a color to overwrite the color of the selected shape style. 

· Shadow Color — enable this checkbox, then select the Color button to open the Color Selection
editor and select a shadow color for the shape style.  If creating a map animation, select the Key
Frame button to add a camera Key Frame  on the timeline.

The color style overwrite can also be applied in tandem with the Zoom In and Zoom Out overwrite
parameters when they are enabled.
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« The Border, Fill Area, and Shadow options can only be overwritten if their corresponding parameters

are enabled in the shape style. 

5. In the Properties section of the editor:

a.  Enter a value or use the arrows to adjust the Opacity.

· A value of 1 makes the shape completely opaque (a solid color).

· A value between .99 and .01 makes the shape increasingly transparent.

· A value of 0 makes the shape invisible. 

· Select the Key Frame button to place a camera Key Frame  on the timeline.

«Opacity does not affect children associated with the shape.

b. Select the Visible checkbox to display the selected shape and its children. 

If the Visible checkbox is cleared, only the parent shape will be displayed.

· Select the Key Frame button to place a camera Key Frame  on the timeline.

Shapes will blend in or out for the number of seconds set in the Effect In and Effect Out
parameters set in the Edit Shape Style editor when animated, starting at the Key Frame that
makes the drawing visible or invisible. See Shape Style Properties  for more information.

c. In the Scale fields, enter a value or use the arrows to adjust the Scale of the shape. 

· Select the Key Frame button to place a camera Key Frame  on the timeline.

d. In the Offset fields, enter a value or use the arrows to increase or decrease the value by which the
shape will be offset from the actual boundaries. 

· The X field offsets the shape horizontally. 

· The Y field offsets the shape vertically.

· Select the Key Frame button to place a camera Key Frame  on the timeline.

e. Select the checkbox beside the Offset fields to be able to move the shape to a different location.

For details about using this feature, see Relocating Shapes .

f. In the Extrude fields, enter a value or use the arrows to increase or decrease the height of the
extruded shape.

This setting becomes more visible if the map is tilted. 

g. In the Resolution drop-down, select one of the following options to define how the shape is
displayed:

· Auto

· Low (with coastline)

· High (with coastline cut by the water layer)

6. In the Information section, you'll see information about the currently selected shape. While you
cannot edit any of the fields, this section offers a convenient way to confirm which shape is selected
and being edited.  
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7. In the Media section:

a. Select the Use checkbox, if you want to use an image file in the scene.

When the Use checkbox is selected, the settings in this section become available.

b. From the Type drop-down, select the type of media file to use. 

Currently, only the File type is supported.

c. Select the Browse button ( ) beside the File field to navigate to the media file you want to use in
the scene.

The supported media file formats are .jpg and .png.

d. In the Scale fields, enter a value or use the arrows to increase or decrease the size of the image.

· The X field adjusts the size of the image horizontally. 

· The Y field adjusts the size of the image vertically.

· Select the Key Frame button to place a camera Key Frame  on the timeline.

e. In the Translate fields, enter a value or use the arrows to move the image within the shape.

· A positive value in the X field moves the image to the right horizontally.

· A negative value in the X field moves the image to the left horizontally.

· A positive value in the Y field moves the image up vertically.

· A negative value in the Y field moves the image down vertically.

· Select the Key Frame button to place a camera Key Frame  on the timeline.

f. In the Angle field, enter a value or use the arrows to tilt the image.

· A positive value tilts the image towards the right.

· A negative value tilts the image towards the left.

· Select the Key Frame button to place a camera Key Frame  on the timeline.

g. From the Mapping drop-down, select one of the following options to define how an image is
displayed in the selected shape:

UV Relative: The image is locked to the shape and moves with the shape. When this option is
selected, the image is placed at a pre-calculated position relative to the shape center and cannot be
moved. 

UV Absolute: The image is locked to the shape and moves with the shape. When this option is
selected, you can adjust the Long. and Lat. values to position the image where you want it within
the shape. You can also adjust the Size of the image.

UV Static: The image is locked to the background, so when you move the shape, you see different
parts of the image.

h. Select the Repeat checkbox, if you want the image file to repeat to fill the selected shape or leave
it blank if you want only one instance of the image.

i. In the Long. and Lat. fields, enter a value or use the arrows to adjust the values to position the
image within the selected shape (available for the UV Absolute option only).
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j. In the Size field, enter a value or use the arrows to increase or decrease the size of the image
(available for the UV Absolute option only).

If the color of the shape style that has been applied to the shape conflicts with the colors in the
image, you can overwrite the color in the Overwrite Style section of the Shape Editor. Refer to
step 4  for further information.

8. In the DataLinq section:

a. From the Source drop-down, select the DataLinq Source. For information on adding DataLinq
Servers see Linking Data Sources to Scene Drawings and Shapes  

b. Select the Source checkbox and view the DataLinq data displayed on the Canvas.

c. For information on configuring the DataLinq Shape Data see Configuring DataLinq Sources for
XPression Maps .

9. In the Drawing Relation section, group together different drawing tools from within a selected shape
designated on the Canvas. These groupings can be added to the User Predefined Objects window
and saved as one object. 

See Creating User Predefined Objects  for information on creating groups. 
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Editing Shape Label Properties

The Shape Label Properties editor provides access to the label details of a shape and is accessed from
the Shape Database Viewer. You can change the name of the shape label, the position, the size and the
zoom level at which it appears and you can add search terms to the search info.

To edit the shape label properties:

1. In the Search Editor, select Shape Database Viewer at the bottom of the editor.

The Shape Database Viewer opens.

Shape Database Viewer

2. From the list, select the shape whose label you want to edit.

3. Select Edit Label Properties.

The Shape Label Properties editor opens.

Shape Label Properties Editor
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4. Edit the parameters in the Shape Label Properties editor, as described in the table below, to
configure the shape label. 

Parameter Description

Name The name of the label.

You might want to change the name that’s displayed if you are translating it
into a language that isn’t configurable in the Preferences, i.e. English (en-
US), Canadian French (fr-CA) or German (de-de).

See Shape Label Translation  for more information.

Longitude Enter or use the arrows to select a longitudinal coordinate for the label to
reposition it within the shape boundaries. 

On the Canvas, the labels for all the shapes associated with your selection
appear, so that you can judge how far and in what direction to move the label.
Only the label you’ve selected will be changed.

Latitude Enter or use the arrows to select a latitudinal coordinate for the label to
reposition it within the shape boundaries.

On the Canvas, the labels for all the shapes associated with your selection
appear, so that you can judge how far and in what direction to move the label.
Only the label you’ve selected will be changed.

Size Enter or use the arrows to select a size for the label. 

The value of the size parameter is equal to the zoom parameter of a drawing. 

A value of 20 will make the label readable at a zoom level of 20. 

A larger value will make the label smaller, so that it is readable at a larger
zoom value.

Valid range is 0.00 to 100.

Zoom Level Enter or select the zoom level of the map on which the shape will be created. 

The shape will become visible at this zoom level.

Search Info Enter a group of search terms which can be used to find the shape in the
database when searching for a location.

5. Select Update to save your changes.

6. Select Done to close the Shape Database Viewer.

The new labels will not yet be updated in the scene.

7. Select Save.

8. Select File and select the scene from the Recent Scenes list to re-open the same scene and apply the
label changes.
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Setting the Language of Shape Labels

The shape labels are stored by language (Country code) in the shape database. The default language is
English (en-US) but many other languages are now supported. If the language you want is not supported,
you need to change the labels manually in the Shape Label Properties editor.

See Shape Label Properties  for more information.

The language can be changed in File > Preferences in the Map  tab.
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Relocating Shapes

There are cases where you want to see all states, territories, districts, etc. of a country in your scene, but
some are far from the mainland. For example, in the United States, Alaska and Hawaii are not visible when
the camera is centered on the mainland. Fortunately, you can move the shapes of the areas that are out of
view.

You may also need to resize the shapes to make them fit in the scene and be properly visible.

« For instructions on moving the labels, see Editing Shape Label Properties .

To move the state shapes:

1. In the Search Editor , in the Location field, enter the name of the state, territory, district, etc. that
you want to move. 

Ensure that the Go to Result is selected and then select Search.

2. From the Search Related Shapes section, double-click the shape that is to be moved.

3. In the Shape editor, select the shape you want to move.

4. In the Properties section, select the checkbox beside the Offset parameters.

5. Left-click at the edge of the shape and drag the shape close to the mainland of the country.

6. If necessary, use the Scale parameters to resize the shape.

7. When the shape is positioned and sized as necessary, deselect the checkbox beside the Offset
parameters.

8. From the menu bar, select File > Save.

The image below is an example of how you might relocate Alaska and Hawaii.

Relocating Shapes
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Deleting a Shape from a Scene

The following procedure describes how to delete an individual shape from the map in the active scene. 

To delete a shape:

· Use the Delete key:

Ø Select the shape on the map on the Canvas and press the Delete key.

OR

· Use the Shape Editor's Delete or Delete Children options.

a. In the Shape Editor, from the list of shapes, select the shape(s) you want to delete.

· Select an individual shape.

· Press Ctrl and select another shape name in the list to select multiple shapes to delete.

· Select a shape in the list, then press Shift and select another shape to select all the shapes
between the first and last selected shape to delete.

b. Right-click on the selected shape and from the context menu, select Delete.

If children have been loaded, select and right-click the parent shape and from the context menu,
select Delete Children to remove all the child shapes.

Delete Shape
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Linking Objects to a Data Source
The XPression Maps Data option enables seamless integration of data sources managed by an XPression
DataLinq Server to dynamically populate and control shapes, drawings, and container drawing objects
within a map scene. This configuration allows map elements to automatically update in real time based on
external data feeds, such as weather conditions, traffic patterns, election results, or other live information.

Example of a Map Using a DataLinq Data Source with Shapes

Procedural Overview

1. Add external data sources to the XPression DataLinq Server

· Install and run the XPression DataLinq Server software on either the XPression system itself, or on
one or more other computer systems. 

· Open the XPression DataLinq Server window and add external data sources. 

See the DataLinq section of the XPression User Guide for more information. 

2. Connect XPression Maps to a DataLinq Server

· In XPression Maps, open the Data tab in the Preferences window. Add the required DataLinq
Server(s) and confirm that the connection is established.

See Connecting XPression Maps to a DataLinq Server  for more information.

3. Create and configure Sources in XPression Maps  

· In the DataLinq Setup window, create source configurations that will later be linked to shape,
drawing, or container drawing objects on the map scene.

See Creating a New Data Source for XPression Maps  for more information. 

· Configure the sources to specify how data from the DataLinq Server will be used to populate and
control the properties of shapes, drawings, or container drawings within the map scene.

See Configuring Data Sources for XPression Maps  for more information. 

4. Link Data Sources to Shapes, Drawings, or Container Drawings in the Map Scene

· Link a data source to the shapes, drawings, or container drawings in the map scene, enabling them to
dynamically reflect or respond to the incoming data from the DataLinq Server.

See Linking a Data Source to a Shape, Drawing or Container Drawing  for more information.
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Connecting XPression Maps to a DataLinq Server

To enable XPression Maps to access external data sources, it must be configured to connect to the
XPression DataLinq Server(s) in your system. The following procedure describes how to add DataLinq
Servers to the DataLinq Server section of the Data page in the XPression Maps Preferences window
and verify a successful connection.

« See Configuring Preferences > Data  for more information about importing, exporting, editing or

deleting DataLinq Server profiles from the XPression Maps Preferences window.

To add a DataLinq Server:

1. From the XPression Maps menu bar, select File > Preferences.

2. Select the Data tab.

3. In the DataLinq Servers section, select the Add button.

The Add DataLinq Server window opens.

Add DataLinq Server Window

4. In the Name field, enter a name for the new DataLinq Server.

51
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5. In the Host field, enter the IP address of the computer hosting the XPression DataLinq Server. 

6. In the Port field, enter the port that connects to the DataLinq Server.

The default port number is 8888.

7. Select the State checkbox to later view the status of the DataLinq Server connection. 

8. Select OK.

The DataLinq Server is added to the DataLinq Servers table, but it is highlighted in red to indicate
that the connection to the DataLinq Server has not yet been initialized. Selecting it again changes it to
blue.

9. Select Save and then OK to close the Preferences window.

To check the DataLinq Server connection:

1. Reopen the Preferences window to the Data page (File > Preferences > Data).

The DataLinq Server should now be highlighted in green to indicate that a connection has been
established.

2. Select OK to close the Preferences window.
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Creating a New Data Source for XPression Maps

After connecting XPression Maps to a DataLinq Server, create and add a new data source to XPression
Maps DataLinq Server. A data source serves as a configuration profile that previews incoming data from
the DataLinq Server and includes one or more data queries to define how specific data fields can be
applied to the properties of shapes, drawings, and container drawing objects.

To add a new XPression Maps DataLinq Source:

1. Select Edit > DataLinq Setup.

The DataLinq Setup window opens. 

2. Select Add New.

The New Data Source window opens.

New Data Source

3. In the Name field, enter a source name for the new data source. 

4. From the Type drop-down, select a DataLinq Type.

The types are:

DataLinq Shape 

DataLinq Drawing 

DataLinq Container Drawing 

The source is added to the DataLinq Setup window. 

DataLinq Setup Window - New Data Source Added

5. Select Add New.
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6. From the left panel of the DataLinq Setup window, select the data source.

7. From the DataLinq Server drop-down select the name of the server connected to the data source. 

A green icon indicates the DataLinq Server connection has been established. 

A red icon indicates the DataLinq Server is not connected or is unavailable.

8. In the Data tab, from the Source drop-down, select the source.

« These sources are brought in directly from the DataLinq Server. See the XPression User Guide for

information on installing and using the DataLinq Server.

The data imported from the DataLinq Server Source will populate in the preview screen. 

The preview screen displays data as either a table or a tree view.  This will depend on the style of data
being imported from the DataLinq Server. 

DataLinq Setup - Table View

DataLinq Setup - Tree View

9. In instances where there is more than one sheet of data in the source, select the correct table of data
to be shown in the Table drop-down.

10.Configure the data source's Data parameters that appear on the right-side of the DataLinq Setup
window. Since these are data type dependent, refer to Configuring Data Sources for XPression Maps
for specific instructions.
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Configuring Data Sources for XPression Maps

Use the DataLinq Setup window to configure data sources with data queries that define how specific data
fields can be applied to the shapes, drawings, and text drawing objects associated with a container
drawing.

Configuring Data Sources for Shapes and Drawings

There are two methods for configuring data sources for shape or drawing objects:

· Direct Value mode allows you to create one or more data queries within a data source configuration.
Each query is designed to select a single data item from the data source and apply it to a specific
property of a shape or drawing. When a shape or drawing object in a scene is linked to the data source,
its linked properties are automatically updated whenever the data source is refreshed.

Configuring Shape Data in Direct Value Mode

Configuring Drawing Data in Direct Value Mode

· Value Lookup mode allows you to create one or more data queries for a DataLinq source configuration.
Each query is designed to search a range of data associated with the shape or drawing object's
attributes and retrieve a corresponding value that can be applied to a property of the object. When a
shape or drawing object in a scene is linked to the DataLinq source, its linked properties are
automatically updated whenever the data source is refreshed.

Configuring Shape Data in Value Lookup Mode

Configuring Drawing Data in Value Lookup Mode

Configuring Data Sources for Container Drawings

To configure a DataLinq data source for container drawings, you must map the data source categories in
the data source to the appropriate text drawing properties. Then, you add a container drawing to the scene
and ensure that the names of the relevant Text drawings match those specified in the data source. See
Configuring Data Sources for Container Drawings  for more information.
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Configuring Shape DataLinq Sources in Direct Value Mode

Direct Value mode allows you to create data queries within a source, each configured to select a single
data item from the source and apply it to the corresponding shape property. A data source can support
multiple queries, which can be individually enabled or disabled, providing the flexibility to activate only
the queries relevant at any given time. When a shape object in a scene is linked to the data source, its
linked properties are automatically updated whenever the data source is refreshed.

The following table lists the shape properties (Result Values) that can be assigned to a data query, along
with the required format for the data source category:

Result Values Function Source Value

Shape Color Sets the Fill Area color by Hex
code.

#FFFFFF

Shape Outline Color Sets the Border color by Hex
code.

#FFFFFF

Shape Style Name Sets the Shape Style by Shape
Style Name.

Shape Style Name

Shape Extrude Sets the Shape Extrude value. 0-10

Shape Visibility Toggles the visibility of the shape. 0.0 = Hidden

1.0 = Visible

Shape Opacity Sets the shape opacity value. 0.0 (Invisible) to 1.0 (Opaque)

Shape Use Media Enables/disables the shape media. 0 = Disabled

1 = Enabled

Shape Media File Name Sets the file path for the shape
media

C:\SomeAsset.FileExtension

Shape Overlay Style Name Sets a Shape Style by name to be
layered on top of the configured
Shape Style.

Shape Style Name

Shape Opacity On White Sets the shape opacity value
with a white background.

0.0 (Invisible) to 1.0 (Opaque)

Shape Interactive Data Sets the Interactive Data value
of a shape.

String value

Shape Is Mask Toggles whether or not the shape
should be used as a mask.

0 = Disabled

1 = Enabled

To configure a shape data source in Direct Value Mode: 

1. Open the DataLinq Setup window by selecting Edit > DataLinq Setup.

2. From the left column, select your data source.

3. From the DataLinq Server drop-down, select the name of the server connected to the data source. 

4. In the Data tab, select a data source from the Source drop-down.

The imported data will appear in the preview screen, displayed as either a table or tree structure,
depending on the data format.
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5. From the Mode drop-down, select Direct Value.

6. Next, create a different data query  for each shape property that you want to assign a data item to
within this data source. 

To create a data query:

1. In the Data No field, select the data query that you want to configure. 

· Use the Data No up/down buttons to change between data queries.

OR

· Select Add to add and configure a new data query.

2. Select the Enabled checkbox to activate the query when the data source is linked to a shape. 

Clear it to keep the query in the configuration without applying its result to the shape.

3. Set the Direct parameters (Column and Row) to identify the exact data item from the data source
that you want to apply to a shape property.

· In the data table, right-click in the cell containing the data item and select Use as Direct
Parameter. 

Note: The first row is "0".

OR

· In the data tree, right-click in the row containing the data item and select Use as Direct Parameter.

4. In the Result section, identify the shape property that the direct data item will be applied to. 

You can also set a default value that will be applied to the shape's property if there is no data value
present (blank), as well as add a prefix or suffix to the query's returned value.

a. From the Value drop-down, select the shape property that the data value will be applied to.

b. (Optional) In the Default field, enter a fallback value to display if the resulting data source value is
blank (e.g., "Undecided" or "Not Available").

c. (Optional) Use the Prepend field to add a prefix (text or numbers) to the beginning of the result
value. 

This is required when a shape's property value has been customized to include a distinctive prefix,
but the data source values are generic and do not include the prefix. Leave this field blank if you
just want the value chosen in the Value drop-down.
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d. (Optional) In the Append field, enter a string (text or numbers) to be added to the end of the result
value.

This is required when a shape's property value has been customized to include a distinctive suffix,
but the data source values are generic and do not include the suffix. Leave this field blank if you
just want the value chosen in the Value drop-down. 

5. (Optional) Set conditional logic to ensure the resulting data value is used only when a specified
dependency condition is met.

a. Select the Condition checkbox.  

b. Set the column or row in the data source containing the data items to be evaluated.

· If the data in the preview screen is shown in a table, select from the Column drop-down the
column heading containing the data items to be evaluated.

OR

· If the data in the preview screen is shown in a tree, right-click in the row containing the data
items to be evaluated and select Use as Condition Row.

c. In the Value field, select a comparison operator (=, !=, <, >) and specify the operand.

6. Test the logic of your configuration.

· In the Test section, leave the Result field blank and select Test.

The Result field shows the direct value parameter you identified from the data source. 

This will be the data source value passed to the shape's property when linked to a shape object.

7. Select Save and close the DataLinq Setup window.

«You may need to exit and relaunch XPression Maps to view the updated data on the Canvas.
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Configuring Shape Data Sources in Value Lookup Mode

Value Lookup mode allows you to create one or more data queries for a data source configuration. Each
query is designed to search a range of data associated with the shape or drawing object's attributes and
retrieve a corresponding value that can be applied to a property of the object. A single data source can
contain multiple data queries, which can be individually enabled or disabled, giving you the flexibility to
activate only the profiles relevant to your current needs. When a shape object in a scene is linked to the
data source, its linked properties are automatically updated whenever the data source is refreshed. 

The following table lists the shape properties (Result Values) that can be assigned to a data query, along
with the required format for the data source category:

Result Values Function Source Value

Shape Color Sets the Fill Area color by Hex
code.

#FFFFFF

Shape Outline Color Sets the Border color by Hex
code.

#FFFFFF

Shape Style Name Sets the Shape Style by Shape
Style Name.

Shape Style Name

Shape Extrude Sets the Shape Extrude value. 0-10

Shape Visibility Toggles the visibility of the shape. 0.0 = Hidden

1.0 = Visible

Shape Opacity Sets the shape opacity value. 0.0 (Invisible) to 1.0 (Opaque)

Shape Use Media Enables/disables the shape media. 0=Disabled

1=Enabled

Shape Media File Name Sets the filepath for the shape
media

C:\SomeAsset.FileExtension

Shape Overlay Style Name Sets a Shape Style by name to be
layered on top of the configured
Shape Style.

Shape Style Name

Shape Opacity On White Sets the shape opacity value
with a white background.

0.0 (Invisible) to 1.0 (Opaque)

Shape Interactive Data Sets the Interactive Data value
of a shape.

String value

Shape Is Mask Toggles whether or not the shape
should be used as a mask.

0=Disabled

1=Enabled

To configure a shape data source in Value Lookup mode:

1. Open the DataLinq Setup window by selecting Edit > DataLinq Setup.

2. From the left column, select your data source.

3. From the DataLinq Server drop-down, select the name of the server connected to the data source. 
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4. In the Data tab, select a data source from the Source drop-down.

The imported data will appear in the preview screen, displayed as either a table or tree structure,
depending on the data format.

5. From the Mode drop-down, select Value Lookup.

6. Next, create a data query  for each shape property that you want to assign a data item to within this
data source. 

To create a data query:

1. In the Data No field, select the data query that you want to configure. 

· Use the Data No up/down buttons to change between data queries.

OR

· Select Add to add and configure a new data query.

2. Select the Enabled checkbox to activate the query when the data source is linked to a shape. Clear it
to keep the query in the configuration without applying its result to the shape.

3. Configure the Lookup parameters to specify the data source's lookup range and define the object
attribute category represented by the data.

a. Set the data source lookup range.

· In the data table, right-click anywhere in the column you want to use to look up data from and
select Use as Lookup Parameter. 

The Column field is filled in with the selected column's heading. 

OR

· In the data tree, right-click in the row containing the data item and select Use as Lookup
Parameter.

The Column and Row fields are filled in with the selected row headings. 

b. From the Value drop-down, select the shape attribute category represented that applies to the data
in the selected lookup range.

« The data and value chosen must match with the attributes listed in the shape object's Shape

Editor > Information section.

Shape Editor - Information
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4. Configure the Results parameters to identify the column/row in the data source that contains the data
that will be applied to the shape's property. 

Also, identify the shape property that the result data will be applied to. You can also set a default value
that will be applied to the shape's property if there is no data value present (blank), as well as add a
prefix or suffix to the query's returned value.

a. Set the results data source range.

· In the data table in the preview screen, right-click in the column containing the data item that
you want applied to the shape's property and select Use as Result Column. 

The Column field is filled in with the selected column's heading. 

OR

· In the data tree in the preview screen, right-click in the row containing the data item that you
want applied to the shape's property and select Use as Result Column.

The Row field is filled in with the selected row heading.

b. From the Value drop-down, select the shape property that the result value will be applied to. 

« The option you select must correspond with data that can be found in the data source.

c. (Optional) In the Default field, enter a fallback value to display if the result data source value is
blank (e.g., "Undecided" or "Not Available".)

d. (Optional) Use the Prepend field to add a prefix (text or numbers) to the beginning of the result
value. 

This is required when a shape's property value has been customized to include a distinctive prefix,
but the data source values are generic and do not include the prefix. Leave this field blank if you
just want the value chosen in the Value drop-down.

e. (Optional) In the Append field, enter a string (text or numbers) to be added to the end of the result
value. 

This is required when a shape's property value has been customized to include a distinctive suffix,
but the data source values are generic and do not include the suffix. Leave this field blank if you
just want the value chosen in the Value drop-down.
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5. (Optional) Set conditional logic to ensure the resulting data value is used only when a specified
dependency condition is met.

a. Select the Condition checkbox.

b. Set the column or row in the data source containing the data items to be evaluated.

· If the data in the preview screen is shown in a table, select from the Column drop-down the
column heading containing the data items to be evaluated.

OR

· If the data in the preview screen is shown in a tree, right-click in the row containing the data
items to be evaluated and select Use as Condition Row.

c. In the Value field, select a comparison operator (=, !=, <, >) and specify the operand.

6. Test the logic of your configuration.

a. In the Test section, in the Value field, enter the value from the data source's Lookup column/row.

b. Leave the Result field empty.

c. Select Test.

The Result field shows the value from the data source that matches the data query defined by the
Lookup and Results parameters.

This value is passed to the shape's property when linked to a shape object.

7. Select Save and close the DataLinq Setup window.

« You may need to exit and relaunch XPression Maps to view the updated data on the Canvas.
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Configuring Drawing Data Sources in Direct Value Mode

Direct Value mode allows you to create data queries within a data source, each configured to select a
single data item from the source and apply it to a specific drawing property. A source can support multiple
queries, which can be individually enabled or disabled, providing the flexibility to activate only the queries
relevant at any given time. When a drawing object in a scene is linked to the data source, its linked
properties are automatically updated whenever the data source is refreshed.

The following table lists the drawing properties (Result Values) that can be assigned to a data query, along
with the required format for the data source category:

Result Values Function Source Value

Drawing Longitude Sets the drawing Longitude. WGS84, -180.0 to 180.0

Drawing Latitude Sets the drawing Latitude. WGS84, -90.0 to 90.0

Drawing Visibility Toggles the visibility of the
drawing.

0.0 = Hidden 

1.0 = Visible

Drawing Color Sets the Font Color of the
drawing.

#000000

Drawing Text Sets the Text value of the
drawing.

Custom text string value

Drawing Interactive Data Sets the Interactive Data value
of the drawing.

String value

Drawing Icon Sets the drawing Style by
drawing style name.

Name of another drawing in the
Drawing Toolbox

Drawing Opacity Sets the drawing Opacity. 0.0 (Invisible) to 1.0 (Opaque)

To configure a drawing data source in Direct Value Mode: 

1. Open the DataLinq Setup window by selecting Edit > DataLinq Setup.

2. From the left column, select your data source.

3. From the DataLinq Server drop-down, select the name of the server connected to the data source. 

4. In the Data tab, select a data source from the Source drop-down.

The imported data will appear in the preview screen, displayed as either a table or tree structure,
depending on the data format.

5. From the Mode drop-down, select Direct Value.

6. Next, create a data query  for each drawing property that you want to assign a data item to within
this data source.
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To create a data query:

1. In the Data No field, select the data query that you want to configure. 

· Use the Data No up/down buttons to change between data queries.

OR

· Select Add to add and configure a new data query.

2. Select the Enabled checkbox to activate the query when the data source is linked to a drawing. 

Clear it to keep the query in the configuration without applying its result to the drawing.

3. Set the Direct parameters (Column and Row) to identify the exact data item from the data source
that you want to apply to a drawing property.

· In the data table, right-click in the cell containing the data item and select Use as Direct
Parameter. 

Note: The first row is "0".

OR

· In the data tree, right-click in the row containing the data item and select Use as Direct
Parameter.

4. In the Result section, identify the drawing property that the direct data item will be applied to. 

You can also set a default value that will be applied to the drawing's property if there is no data value
present (blank), as well as add a prefix or suffix to the query's returned value.

a. From the Value drop-down, select the drawing property that the data value will be applied to.

b. (Optional) In the Default field, enter a fallback value to display if the result data source value is
blank (e.g., "Undecided" or "Not Available".)

c. (Optional) Use the Prepend field to add a prefix (text or numbers) to the beginning of the result
value. 

This is required when a drawing's property value has been customized to include a distinctive prefix,
but the data source values are generic and do not include the prefix. Leave this field blank if you
just want the value chosen in the Value drop-down.

d. (Optional) In the Append field, enter a string (text or numbers) to be added to the end of the result
value. 

This is required when a drawing's property value has been customized to include a distinctive suffix,
but the data source values are generic and do not include the suffix. Leave this field blank if you
just want the value chosen in the Value drop-down.
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5. (Optional) Set conditional logic to ensure the resulting data value is used only when a specified
dependency condition is met.

a. Select the Condition checkbox.  

b. Set the column or row in the data source containing the data items to be evaluated.

· If the data in the preview screen is shown in a table, select from the Column drop-down the
column heading containing the data items to be evaluated.

OR

· If the data in the preview screen is shown in a tree, right-click in the row containing the data
items to be evaluated and select Use as Condition Row.

c. In the Value field, select a comparison operator (=, !=, <, >) and specify the operand.

6. Test the logic of your configuration.

· In the Test section, leave the Result field blank and select Test.

The Result field shows the direct value parameter you identified from the data source. 

This will be the data source value passed to the drawing's property when linked to a drawing object.

7. Select Save and close the DataLinq Setup window.

« You may need to exit and relaunch XPression Maps to view the updated data on the Canvas.
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Configuring Drawing Data Sources in Value Lookup Mode

Value Lookup mode allows you to create one or more data queries for a data source configuration. Each
query is designed to search a range of data associated with the drawing or drawing object's attributes and
retrieve a corresponding value that can be applied to a property of the object. A single data source can
contain multiple data queries, which can be individually enabled or disabled, giving you the flexibility to
activate only the profiles relevant to your current needs. When a drawing object in a scene is linked to the
data source, its linked properties are automatically updated whenever the data source is refreshed. 

The following table lists the drawing properties (Result Values) that can be assigned to a data query, along
with the required format for the data source category:

Result Values Function Source Value

Drawing Longitude Sets the drawing Longitude. WGS84, -180.0 to 180.0

Drawing Latitude Sets the drawing Latitude. WGS84, -90.0 to 90.0

Drawing Visibility Toggles the visibility of the
drawing.

0.0 = Hidden 

1.0 = Visible

Drawing Color Sets the Font Color of the
drawing.

#000000

Drawing Text Sets the Text value of the
drawing.

Custom text string value

Drawing Interactive Data Sets the Interactive Data value
of the drawing.

String value

Drawing Icon Sets the drawing Style by
drawing style name.

Name of another drawing in the
Drawing Toolbox

Drawing Opacity Sets the drawing Opacity. 0.0 (Invisible) to 1.0 (Opaque)

To configure a drawing data source in Value Lookup mode:

1. Open the DataLinq Setup window by selecting Edit > DataLinq Setup.

2. From the left column, select your data source.

3. From the DataLinq Server drop-down, select the name of the server connected to the data source. 

4. In the Data tab, select a data source from the Source drop-down.

The imported data will appear in the preview screen, displayed as either a table or tree structure,
depending on the data format.

5. From the Mode drop-down, select Value Lookup.

6. Next, create a data query  for each drawing property that you want to assign a data item to within
this data source.
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To create a data query:

1. In the Data No field, select the data query that you want to configure. 

· Use the Data No up/down buttons to change between data queries.

OR

· Select Add to add and configure a new data query.

2. Select the Enabled checkbox to activate the query when the data source is linked to a drawing. 

Clear it to keep the query in the configuration without applying its result to the drawing.

3. Configure the Lookup parameters to specify the data source's lookup range and define the object
attribute category represented by the data.

a. Set the data source lookup range.

· In the data table, right-click anywhere in the column you want to use to look up data from and
select Use as Lookup Parameter. 

The Column field is filled in with the selected column's heading. 

OR

· In the data tree, right-click in the row containing the data item and select Use as Lookup
Parameter.

The Column and Row fields are filled in with the selected row headings. 

b. From the Value drop-down, select the drawing attribute category that applies to the data in the
selected lookup range.

« The data and value chosen must match with the attributes listed in the Drawing Editor.
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4. Configure the Results parameters to identify the column/row in the data source that contains the data
that will be applied to the drawing's property. 

Also, identify the drawing property that the result data will be applied to. You can also set a default
value that will be applied to the drawing's property if there is no data value present (blank), as well as
add a prefix or suffix to the query's returned value.

a. Set the results data source range.

· In the data table in the preview screen, right-click in the column containing the data item that
you want applied to the drawing's property and select Use as Result Column. 

The Column field is filled in with the selected column's heading. 

OR

Ø In the data tree in the preview screen, right-click in the row containing the data item that you
want applied to the drawing's property and select Use as Result Column.

The Row field is filled in with the selected row heading.

b. From the Value drop-down, select the drawing property that the result value will be applied to. 

« The option you select must correspond with data that can be found in the data source.

c. (Optional) In the Default field, enter a fallback value to display if the result data source value is
blank (e.g., "Undecided" or "Not Available".)

d. (Optional) Use the Prepend field to add a prefix (text or numbers) to the beginning of the result
value. 

This is required when a drawing's property value has been customized to include a distinctive prefix,
but the data source values are generic and do not include the prefix. Leave this field blank if you
just want the value chosen in the Value drop-down.

e. (Optional) In the Append field, enter a string (text or numbers) to be added to the end of the result
value. 



XPression Maps User Guide (v4.0) Linking Objects to a Data Source • 277

This is required when a drawing's property value has been customized to include a distinctive suffix,
but the data source values are generic and do not include the suffix. Leave this field blank if you just
want the value chosen in the Value drop-down.

5. (Optional) Set conditional logic to ensure the resulting data value is used only when a specified
dependency condition is met.

a. Select the Condition checkbox.

Jessica Hempinstall
Sticky Note
page break?



278 • Linking Objects to a Data Source XPression Maps User Guide (v4.0)

b. Set the column or row in the data source containing the data items to be evaluated.

· If the data in the preview screen is shown in a table, select from the Column drop-down the
column heading containing the data items to be evaluated.

OR

· If the data in the preview screen is shown in a tree, right-click in the row containing the data
items to be evaluated and select Use as Condition Row.

c. In the Value field, select a comparison operator (=, !=, <, >) and specify the operand.

6. Test the logic of your configuration.

a. In the Test section, in the Value field, enter the value from the data source's Lookup column/row.

b. Leave the Result field empty.

c. Select Test.

The Result field shows the value from the data source that matches the data query defined by the
Lookup and Results parameters.

This value is passed to the drawing's property when linked to a drawing object.

7. Select Save and close the DataLinq Setup window.

« You may need to exit and relaunch XPression Maps to view the updated data on the Canvas.
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Configuring Data Sources for Container Drawings

Container drawings are used to collectively manage the display of a group of text drawings  on the
map. When linked to a data source, the container drawing object coordinates the application of data to
certain text drawings' properties, which determine exactly which text drawings are displayed on the map,
as well as defining their exact location, content, and appearance. Use the following procedure to configure
a data source for Container drawings in the DataLinq Setup window.

Procedural Overview

1. Open the DataLinq Setup window by selecting Edit > DataLinq Setup.

2. From the left column, select your data source.

3. From the DataLinq Server drop-down, select the name of the server connected to the data source. 

4. In the Data tab, select a data source from the Source drop-down.

5. Set the Data source as a Container.

This defines the data source for Container drawings and enables mapping of result values (longitude,
latitude, name etc.)

The imported data will appear in the preview screen, displayed as either a table or tree structure,
depending on the data format.

6. Use the appropriate method to map the drawing parameters to the data source:

· Configuring the Container Drawing Data from a Tree

· Configuring the Container Drawing Data from a Table

Result Values Function Source Value

Longitude Sets the drawing Longitude. WGS84, -180.0 to 180.0

Latitude Sets the drawing Latitude. WGS84, -90.0 to 90.0

Drawing Name Toggles the visibility of the
drawing.

0.0 = Hidden 

1.0 = Visible

Text Sets the Text value of the
drawing.

Custom text string value

Scale Sets the Scale of the drawing. 0-999.99

Angle Sets the Angle of the drawing. 0-999.99

Drawing Color Sets the Font Color of the
drawing.

#000000

7. Add a container drawing object to the scene. See Adding a Container Drawing to the Scene .

8. In the Drawing Management Editor, ensure that the names of the relevant text drawings match with
those specified in the data source. See Configuring the Text Drawings for the Container Drawing .
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Configuring the Container Drawing Data

To configure the Container Drawing data from a tree:

1. In the Data table, select a row, right-click and select Use as Row Index.

The selected row is added in the Row Index field in the Drawing Creation section. 

« A Row Index can only be selected from the top level (Name) column. The Value column represents

the remaining parameters. 

Selecting a Row Index

2. In the data tree's Value column, select the following Index Nodes, which will then be recorded in the
Drawing Creation fields.

· Longitude - Right-click and select Use as Longitude in the Index Node.

· Latitude - Right-click and select Use as Latitude in the Index Node.

· Drawing Name - Right-click and select Use as Drawing Name in the Index Node.

Ø Drawing Default - If the data source doesn't have a Drawing Name value, in the Drawing
Default field, enter the name of the text drawing you will be using to configure the data output.

· Text - Right-click and select Use as Text in the Index Node.

Ø Text Default - If you select a Text Drawing tool as an Index Node, you must input the Text tool
in the Text Default field. For example, if you choose a Callout Marker you must identify that as
your Text Default for the result to display on the Canvas.

· Size - Right-click and select Use as Scale in the Index Node.

· Angle  - Right-click and select Use as Angle in the Index Node.

· Drawing Color - Right-click and select Use as Drawing Color in the Index Node.

3. Select Save and close the DataLinq Setup window.



XPression Maps User Guide (v4.0) Linking Objects to a Data Source • 281

To configure the DataLinq Container Drawing Data from a table:

1. In the Data tab, select a data source from the Source drop-down.

The imported data will appear in the preview screen, displayed as a table structure.

2. In the Drawing Creation fields, set the following fields:

· Longitude - Select a column heading from the drop-down, or right-click in the column in the data
table and select Use Column as Longitude Parameter. 

· Latitude - Select a column heading from the drop-down, or right-click in the column in the data table
and select Use Column as Latitude Parameter. 

· Drawing Name - Select a column heading from the drop-down, or right-click in the column in the
data table and select Use Column as Drawing Name Parameter. 

Ø Drawing Default - If the data source doesn't have a column for the Drawing Name values, in the
Drawing Default field, enter the name of the text drawing you will be using to configure the data
output.

· Text - Select a column heading from the drop-down, or right-click in the column in the data table
and select Use Column as Text Parameter. 

Ø Text Default - If you select a Text Drawing tool as an Index Node, you must input the Text tool
in the Text Default field. For example, if you choose a Callout Marker you must identify that as
your Text Default for the result to display on the Canvas.

· Scale - Select a column heading from the drop-down, or right-click in the column in the data table
and select Use Column as Scale Parameter. 

· Angle  - Select a column heading from the drop-down, or right-click in the column in the data table
and select Use Column as Angle Parameter. 

· Drawing Color - Select a column heading from the drop-down, or right-click in the column in the
data table and select Use Column as Drawing Color Parameter.

· Text Color - Select a column heading from the drop-down, or right-click in the column in the data
table and select Use Column as Text Color Parameter.

Drawing Creation Parameters

3. Select Save and close the DataLinq Setup window.
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Adding a Container Drawing to the Scene

To add a Container drawing to the scene:

1. In the Drawing Toolbox, select New Drawing.

2. In the New Drawing dialog, from the Select Drawing Type drop-down, select Container. 

The Container Drawing properties sheet opens.

New Container Drawing Properties

3. In the Name field, enter the name for the container drawing and select Done. 

« The container drawing name must match the data source selected in the Source field in the

DataLinq Setup window. 

4. Place the new container drawing anywhere on the Canvas.

« The container drawing acts as a holder for the DataLinq data  set up in the DataLinq Setup

window. The container drawings placement on the map is not important. The image of the container
drawing will not be shown in the final render. 
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Configuring the Text Drawings for the Container Drawing

To configure the text drawing(s) that will display the data:

1. From the menu bar select Edit > Manage Drawings.

2. In the Drawing Management Editor, from the Name drop-down, select Text.

3. From the list of text drawings, select the drawing you want to use to display the data in your map. 

4. In the Drawing panel, in the Name field, enter the name that appears in the Drawing column of your
data source.

If there is no Drawing Name value in your data source, enter any name and in the DataLinq Setup
window, enter the same name in the Drawing Default field.

5. Select a group in which to save the newly named text drawing and select Duplicate.

6. If you want to change any of the properties in the text drawing, you can do so now or you can select
the text drawing in the Drawing Toolbox later and edit the properties.

7. Select Done to close the Drawing Management Editor.



284 • Linking Objects to a Data Source XPression Maps User Guide (v4.0)

Linking a Data Source to a Shape, Drawing or Container
Drawing

After defining the data sources in the DataLinq Setup window, you can link them to specific shapes,
drawings, or container elements within your map scene. This enables these objects to dynamically update
and respond to the data supplied by the connected DataLinq Servers.

To link a data source to a shape in the map scene:

1. In the Shape Editor, select the shapes you want to display with the DataLinq configuration.

Press Shift and left-click on the first and last shapes in the list to select all shapes at once. 

2. Expand the DataLinq section, select a DataLinq Data Source from the drop-down and select the
Source checkbox.

If the desired DataLinq source is not available in the drop-down options or if you need to edit a
DataLinq source's settings, select the browse button to open the DataLinq Setup window.

Shape Editor - DataLinq

The map on the Canvas reflects the results of the DataLinq data source configuration.

To link a data source to a drawing or container drawing in the map scene:

1. In the Drawing Overview panel or directly on the Canvas, select the drawing you want to display
with the DataLinq configuration.

2. In the Drawing Editor, expand the DataLinq section, select the corresponding DataLinq Data
Source from the drop-down and select the Source checkbox.

If the desired DataLinq source is not available in the drop-down options or if you need to edit a
DataLinq source's settings, select the browse button to open the DataLinq Setup window.

Drawing Editor - DataLinq

The map on the Canvas reflects the results of the DataLinq data source configuration.
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Creating User Predefined Objects
A User Predefined Object is a custom, reusable map object that combines a shape with other individual
drawings—such as areas, icons, lines, and text—into a single object that can easily be added to a scene.
This is especially useful for creating complex or frequently used map elements like custom country
borders, disputed territories, or specialized region graphics to depict current war zones, pandemic data, or
wildfire activity. User predefined objects ensure consistency and improve efficiency by reducing the need
to manually recreate complex map components for each use.

While tools such as the Search Editor , Shape Editor , and Drawing Toolbox  are used to create and
modify the shapes and drawings that make up a User Predefined Object, the User Predefined Objects
panel  is used to save, manage, and apply these objects within a scene.

User Predefined Object Panel - Adds Shapes and Drawings to the Scene as a Single Object

The following topics are discussed in this section:

Managing User Predefined Objects

Creating User Predefined Objects  

Adding a User Predefined Object to a Scene
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Managing User Predefined Objects

To ensure quick and easy identification and retrieval, user predefined objects are organized in the User
Predefined Objects panel using a group-and-folder system. To save a User Predefined Object, you must
first create a group, then add a folder within that group.

Later if a User Predefined Object is no longer needed, you can delete it from its folder in the User
Predefined Objects panel.

The following topic described how to manage User Predefined Objects using the User Predefined Objects
panel: 

Adding a Group to the User Predefined Objects Panel

Adding a Folder to a Group

Deleting a Group

Deleting a Folder

Deleting a User Predefined Object from a folder

To add a new group:

1. Enable the User Predefined Objects panel in the View menu.

2. In the User Predefined Objects panel, select the Browse button ( ) beside the Group drop-down. 

The Groups Management window opens. 

Groups Management Window

3. Select Add.

The Add Group window opens.

Add Group Window

4. In the Name field, enter a name for the new group.

5. In the Description field, enter a description for the new group.

6. Select Add and the group is immediately added to the list.

« You can rearrange groups in the Groups Management window by dragging them into position.
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To add a folder to a group:

1. In the User Predefined Objects panel, from the Group drop-down, select the group to which you
want to add a folder.

2. Right-click in a blank area of the Name or Description box and select Add Folder.

The Add Folder window opens.

 

Add Folder Window

3. In the Name field, enter a name for the folder.

4. In the Description field, enter a description for the folder.

5. Select Add.

The folder is added to the group. 

To delete a group:

1. Enable the User Predefined Objects panel in the View menu.

2. From the User Predefined Objects panel, select the Browse button ( ) beside the Group drop-
down. 

3. Select the group you want to delete and select Delete. 

The Delete Group window opens.

Delete Group Window

4. Select the checkbox to confirm the group delete and select Yes. 

The red highlighted Delete Group confirmation dialog opens.

Highlighted Delete Group Window 

5. Select Yes to delete the group. 

The group and its containing folders are now deleted.
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To delete a folder from a group:

1. From the User Predefined Objects panel select the group containing the folder you want to delete
from the Group drop-down.

2. Right-click on the folder and select Delete.

The Delete Folder window opens.

Delete Folder Window

3. Select the checkbox to confirm the folder delete and select Yes.

The red highlighted Delete Folder window opens. 

Highlighted Delete Folder Window

4. Select Yes to delete the folder.

« Deleting a folder will delete the objects as well.

To delete User Predefined Objects from a folder:

1. In the User Predefined Objects panel, select the group containing the object(s) you want to delete
from the Group drop-down.

2. Expand the folder and right-click the object you want to delete.

3. Select Delete.

The Delete Object window opens.

Delete Object Window

3. Select the checkbox to confirm and select Yes to delete the object. 
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Creating User Predefined Objects

User Predefined Objects are created by building a map scene that includes shapes and other individual
drawings—such as areas, icons, lines, and text. Once the scene is complete, it is added to a group and
folder in the User Predefined Objects panel, where all of the scene's elements are combined and saved
to the database as a single, reusable object that can easily be added to other scenes.

This tool is also used to create Disputed Border alterations, allowing contested boundaries to be
represented directly on a map.

This section discusses the following topics:

Building a Scene for a User Predefined Object

Adding a User Predefined Object

To build a scene for a User Predefined Object:

1. Open a new scene on the Canvas.

2. In the Search Editor , in the Location field, enter the name of the state, territory, district, etc. that
you want to display on the map on the Canvas. 

Ensure that the Go to Result is selected and then select Search.

3. In the Search Related Shapes section, double-click the shape that you want to add to the scene.

4. Adjust the camera view on the Canvas, as needed.

5. Add drawings to the map, as needed.

These drawings are automatically added to the Drawings Overview panel.

6. In the Shape Editor, select the shape's name from the upper panel and then expand the Drawing
Relation section.

7. Drag each drawing from the Drawings Overview panel into the Drawing Relation panel to link them
to the selected shape.

Shape Editor - Drawing Relation 

8. If you added any Area drawings to the Drawing Relation panel, use the checkboxes in the Shape

Masked by Area  or Area masked by Shape  columns to apply  a mask.  

Instructions are provided in the following topics:

Masking a shape by the area

Masking an area with a shape  

Masking is also the method used to represent Disputed Borders. By applying masks, you can control
which regions of a map are displayed or hidden to reflect contested boundaries. 

9. Save the scene.

« If in the future you want create a similar User Predefined Object, you can open the scene and

make edits without having to recreate everything.
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10. Use the completed scene to add a new User Predefined Object to the database. 

See Adding a User Predefined Object .

To add a User Predefined Object:

1. Select the shape from the top of the Shape Editor panel and drag it into the selected group folder
created in the User Predefined Objects panel. 

The Add User Predefined Objects window opens.

Add User Predefined Objects Window

« To add a completed scene to the User Predefined Objects panel, you must first create a group and

folder within the group. 

2. In the Name field, enter a name for the object. 

3. In the Search Tags field, enter any identifying terms for the object. 

4. In the Description field, enter a description of the scene and its intended purposes. 

5. Select the Create Thumbnail button beside the Preview image to snap thumbnail of the User
Predefined Object.

To adjust the thumbnail image, move the map or zoom in or out to your preferred position. Double-click
the User Predefined Object to open the Edit User Predefined Object window and select Create
Thumbnail to preview a new thumbnail image. 

6. Select Add to add the User Predefined Object to your folder.

7. From the menu bar select File > Save to save your project. 

290
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To mask an area with a shape:

1. Add an Area drawing to the map.

2. Drag and drop the Area drawing from the Drawings Overview panel to the Drawing Relation panel. 

3. In the Drawing Relation panel, select the checkbox in the Area masked by Shape  column to the
right of the Area drawing to apply a mask to the part of the Area drawing that falls outside of the
shape. 

Image Displays The Difference Between Drawing Tools Unmasked And Masking By An Area

«This method can also be used to define disputed borders, where part of a region is selectively hidden or

revealed.

To mask a shape by the area: 

· Select the checkbox in the Shape Masked by Area   beside the shape that you want to have the
area masked by.

Notice the background and borders of the area showing through the drawing tools. 

The shape is masked by the area. 

Image Displays The Difference Between Drawing Tools Being Masked And Unmasked By An Area

«This technique is commonly applied to disputed borders, ensuring that only the defined portion of

the map is visible.
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Adding a User Predefined Object to a Scene

User Predefined Objects are stored and accessed in a user-defined group-folder structure in the User
Predefined Objects panel. Use the following procedure to add a User Predefined Object to a map scene
on the Canvas.

To add a User Predefined Object to a scene:

1. On the Canvas, position the map to the general location where the User Predefined Object is to be
added.

2. From the View menu, enable the User Predefined Objects panel.

3. In the User Predefined Objects panel, navigate to the desired user predefined object:

· In the Group drop-down, select the group in which the User Predefined Object is stored.

· Expand the folder in which the user predefined object is stored.

4. Select and drag the User Predefined Object's thumbnail from the User Predefined Objects panel to
the map on the Canvas.

The selected User Predefined Object—along with its associated shapes and drawings—will appear on the
map and be listed in the Drawing Overview panel.
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Creating Animations
Use the Animation Editor in XPression Maps to create dynamic map animations by setting camera and
drawing Key Frames along the animation timeline. Camera Key Frames control the animation of camera
view properties and can also define pause durations, map style transitions, and lock camera settings.
Meanwhile, drawing Key Frames animate the properties of shapes and drawing objects within the scene,
allowing for intricate and engaging visual effects.

In most cases, Key Frames mark the start and end of changes to camera views or the properties of
drawing and shape objects. When the animation plays, smooth transitions enhance your maps with
dynamic camera effects like panning between locations, zooming in and out, or changing map styles.
Additionally, drawing and shape objects can be animated to appear, disappear, resize, change color, or
move seamlessly across the map with precise timing and control.

Animation Editor

The following topics provide information about how to use the Animation Editor:

Overview of the Animation Editor

Animation Editor - Common Tasks and Actions

Adding Camera Parameters Key Frames

Changing the Map Style During an Animation

Adding a Pause to an Animation

Adding Drawing Key Frames

The following topics provide examples of how to create various types of map animations:

Creating a Location and View Animation

Creating a Drawing Visibility Animation

Creating a Line Progression Animation

Creating a Zoom Animation

Creating a Shape Animation

294

296

301

302

303

304

306

307

308

310

311



294 • Creating Animations XPression Maps User Guide (v4.0)

Overview of the Animation Editor

The Animation Editor, located below the Canvas, lets you create map animations by adding camera and
drawing Key Frames to the timeline, marking the start and end of changes to camera views and object
properties.

Use the following diagram and table to familiarize yourself with the main components of the Animation
Editor.

# Description

1 Animation Playback Controls

· Rewind Animation - rewind the animation to the beginning. Alternatively, you can select the
Animation > Rewind menu option or press Ctrl+B. 

· Play Animation - play the animation from the beginning. Alternatively, you can select the
Animation > Play menu option or you can press Ctrl+Space.

· Continue Animation - continue playing the animation from the position on the timeline.
Alternatively, you can select the Animation > Continue menu option or you can press Ctrl+G.

· Stop Animation - stop playing the animation. Alternatively, you can select the Animation > Stop
menu option or you can press Ctrl+H.

· Forward Animation - fast-forward the animation to the end. Alternatively, you can select the
Animation > Forward menu option or you can press Ctrl+M.

2 · Add Camera Key Frame - creates and adds a camera Key Frame to the animation timeline at the
current location of the animation position slider.

· Add Drawing Key Frame - creates and adds a drawing Key Frame to the animation timeline at the
current location of the animation position slider.

· Delete Selected Key Frames - deletes the Key Frame(s) that are currently selected on the
animation timeline.

3 · Frame Counter - displays the current position of the animation position slider on the animation
timeline. Use this field to immediately move the animated scene displayed on the Canvas and the
position slider to a precise location on the animation timeline. 

4 · Animation Step Back - moves the current animation position one frame towards the beginning of
the animation. Also, holding the Ctrl key while selecting Animation Step Back moves the current
animation position to the previous Key Frame position.

· Animation Step Forward - moves the current animation position one frame towards the end of
the animation. Also, holding the Ctrl key while selecting Animation Step Forward moves the
current animation position to the next Key Frame position.
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# Description

5 · Minimum Frame - displays and lets you set the starting frame number for the animation. The
animation's duration is determined by the difference between the maximum frame number and the
minimum frame number. The timeline scale adjusts automatically whenever either of these values
changes. The starting frame cannot be set below zero.

· Maximum Frame - displays and lets you set the ending frame number for the animation. The
animation's duration is determined by the difference between this value and the minimum frame
number. The timeline scale adjusts automatically whenever either of these values changes. 

6 · Drawing Key Frame - indicates the frame at which a drawing Key Frame is applied. Drawing Key
Frames are represented by blue rectangles (or green when selected) on the scale below the
timeline. If no drawing or shape is selected on the Canvas, then all drawing Key Frames are
displayed below the timeline. However, if a drawing or shape is selected on the Canvas, only the
Key Frames associated with the drawing or shape are shown.

· Animation Position Slider - indicates the current frame position within the animation. Select and
drag the handle of the slider to move the position of the animation within the displayed range.

· Camera Key Frame - indicates the frame at which a camera Key Frame is applied. Camera Key
Frames (for camera parameters, map style, and camera lock) are represented by blue rectangles
(or red when selected) on the scale above the timeline. Interactive Event Key Frames are shown as
white circles on the scale above the timeline.
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Animation Editor - Common Tasks and Actions

The following topics describe tasks and actions that are typically performed when using the Animation
Editor to create map animations:

Setting the Animation Duration

Identifying and Moving the Current Position to Specific Frames

Adding Key Frames to the Timeline

Setting the Easing Method

Selecting Key Frames on the Timeline

Repositioning Key Frames

Navigating Between Key Frames

Deleting Key Frames From the Timeline

Scrubbing Through the Animation

Previewing Animation Playback

Setting the Animation Duration

The total duration of the map animation is determined by assigning a frame range using the Minimum
Frame and Maximum Frame fields.

« The scale of the timeline adjusts automatically with changes to these fields.

To set the duration of an animation:

1. In the Minimum Frame field, enter the frame value for the starting frame in the animation.

2. In the Maximum Frame field, enter the frame value for the ending frame in the animation.
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Identifying and Moving the Current Position to Specific Frames

The Frame Counter on the left of the timeline shows the current frame of the map animation that is being
displayed on the Canvas.

To move the current position in the animation to a specific frame:

· Enter a frame number in the Frame Counter field.

OR

· Left-click your mouse on a point on the timeline to immediately move to that frame.

OR

· Drag the slider handle to navigate within the range.

OR

· Use Animation Step Back or Animation Step Forward buttons to shift one frame backward or
forward.

Adding Camera Key Frames or Drawing Key Frames to the Timeline

There are two methods for adding a camera Key Frame or drawing Key Frame to the Animation Editor's
timeline:

· Collective Parameters Settings — The Add Camera Key Frame and Drawing Key Frame buttons in
the Animation Editor captures all the current settings for the camera parameters (Zoom Level,
Longitude, Latitude, Tilt and Roll), or the drawing or shape parameters (Location, Rotation, and
Size parameters) and adds a Key Frame to the current location of the animation position slider on the
animation timeline.

· Selected Parameters Only: Selecting the Key Frame button  beside an individual camera, drawing,
shape, or map style parameter, adds a Key Frame for the selected settings (but keep all other non-
selected Key Frame settings unaffected). An easing method can be assigned to each individual Key
Frame, which may change the look of the Key Frame button (see Setting the Easing Method) .

Camera Parameters - Key Frame Buttons to the Right of Each Parameter

Full instructions and information for adding Key Frames to an animation are provided in Adding Camera
Parameters Key Frames  and Adding Drawing Key Frames .
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Setting the Easing Method

The easing method of a Key Frame defines the progressive movement or transition over time, creating
natural-looking motion by controlling the speed at which it moves between Key Frames. Using these
easing methods gives a sense of realistic weight and timing to animations, which enhances the viewer's
perception of the motion.

To set the easing method of a parameter Key Frame:

1. Right-click the Key Frame button  beside the parameter. 

2. From the context menu, select Easing. 

3. Select one of the following easing methods:

Ø None: the animation from one Key Frame to the next is linear and the animation maintains the same
speed from beginning to end.

Ø Out: the animation from the previous Key Frame is linear but the animation from this Key Frame to
the next Key Frame is accelerated.

Ø In: the animation from the previous Key Frame to this one is decelerated, but the animation to the
next Key Frame is linear or constant.

Ø In/Out: the animation from the previous Key Frame to this one is decelerated and the starting
animation of this Key Frame is accelerated.

Ø Automatic: the animation from one Key Frame to the next starts slow, then gets faster, and slows
again before reaching its final position.

Selecting Key Frames on the Timeline

To select an individual Key Frame on the timeline:

· Left-click on the Key Frame to select it.

Selected camera Key Frames appear red; drawing Key Frames appear green.

To select multiple Key Frames on the timeline:

· Hold Ctrl and click multiple Key Frames.

Selected camera Key Frames appear red; drawing Key Frames appear green.

OR

· Left-click and drag to draw a box around the desired Key Frames.

Selected camera Key Frames appear red; drawing Key Frames appear green.
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Repositioning Key Frames

Key Frames are added to the timeline at the frame where the current position slider is located. You can
move a Key Frame to a different point on the timeline at any time.

To move a Key Frame to another position on the timeline:

1. Select the Key Frame on the timeline. See Selecting Key Frames on the Timeline .

Selected camera Key Frames appear red; drawing Key Frames appear green.

2. Drag the Key Frame to a new point on the timeline.

To help you reposition it accurately, the Key Frame's frame number is displayed as you drag it along
the timeline.  

Navigating Between Key Frames

When editing Key Frame settings, it's helpful to quickly jump between Key Frames by moving the current
position slider along the timeline.

To move to the current position slider to an adjacent Key Frame on the timeline: 

· Press the Ctrl key while selecting the Right Arrow button ( ) or the Left Arrow button ( ) located
beside the timeline.

OR

· Press the Ctrl + right arrow key or the Ctrl + left arrow key.

OR

· Select Edit > Jump to Next Key Frame or Jump to Previous Key Frame.

Deleting Key Frames From the Timeline

To prevent Key Frames from being accidentally deleted from the timeline, only the Delete Selected Key
Frames button can be used to delete a Key Frame.

To delete Key Frames from the timeline:

1. On the timeline, select the Key Frame(s) you want to delete (see Selecting Key Frames on the
Timeline) .

The selected Key Frames change from blue to green (drawing Key Frames) or red (camera Key
Frames). 

2. In the Animation Editor, select the Delete Selected Key Frames button.
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Scrubbing Through the Animation

You can scrub through the animation, frame-by-frame, to see the resulting changes in the map at each
frame of the animation on the Canvas. 

To scrub through the animation:

· Drag the position slider to scrub through frames in the displayed range to see the animation on the
Canvas.

OR

· Use the arrow buttons ( , ) next to the minimum and maximum fields to shift one frame forward or
backward.

Previewing Animation Playback

Use the playback controls in the Animation Editor to preview the playback of the current animation, from
start to finish, on the Canvas.

To view the complete playback of the animation:

· Select Play Animation in the Animation Editor's playback controls to preview the animation on the
Canvas. 
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Adding Camera Parameters Keyframes

XPression Maps uses camera Key Frames to control how the scene's camera view behaves over time,
allowing for dynamic perspectives, pans, zooms, rotations, and more. The camera parameters below the
Canvas define the camera's perspective within the scene. 

Camera Parameters

When creating an animation, adjusting individual or multiple camera parameters allows you to set a
specific location, position, or orientation for the camera at a given frame. By interpolating between two
Key Frames, XPression Maps generates smooth transitions that seamlessly shift the camera view from one
perspective to another. When a camera Key Frame is added to the timeline, it is represented by a blue
rectangle (or red when selected) on the scale above the timeline.

Animation Editor

Using the Key Frame buttons beside each parameter, you can add a Key Frame for the individual
parameter to the current position on the timeline.

Alternatively, you can select the Animation Editor's Add Camera Key Frame button to collectively capture
all the current values of the camera parameters (Zoom Level, Longitude, Latitude, Tilt and Roll) in a
single action.

Setting different values for the camera parameters at two different Key Frames creates the following
animations:

· Location change: Setting different Longitude and Latitude values at two camera Key Frames along
the timeline produces a flight that moves the camera view from one geographic location to another
geographic location. See Creating a Location and View Animation  for more information.

· Zoom Level: Setting different Zoom Level values at two camera Key Frames along the timeline
produces an animation where the camera zooms in or zooms out of the map. See Creating a Zoom
Animation  for more information.

· Viewing Angle: Setting different Tilt and Roll values at two camera Key Frames along the timeline
produces an animation that rotates the camera view around the map's horizontal axis or spins the map
clockwise or counterclockwise.  See Creating a Location and View Animation  for more information.
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Changing the Map Style During an Animation

When building an animation, the Map Style  panel allows you to add a camera Key Frame to the
timeline, enabling a smooth transition to a new map style at a precise frame. This is particularly useful in
zoom-level animations, where you can transition between map styles to reveal more or less detail at a
specific zoom level. See Assigning an Animated Map Style  for more information.

Map Style Panel - Camera Key Frame
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Adding a Pause to an Animation

The Pause Dur. field, found to the right of the camera parameters below the Canvas, includes a Key
Frame button. This field allows you to insert a pause in the animation, holding the camera view steady for
a specified number of frames. When this Key Frame is encountered during playback, the camera view
remains static until the set frame count elapses, after which the animation continues.

Pause Duration

Alternatively, you can use a bookmark to create a pause during a flight animation, allowing you to
provide additional information at a specific point in the sequence.

The following topics are discussed in this section:

Adding a Pause Duration to an Animation

Adding a Bookmark Pause to a Flight Animation

To add a pause duration camera Key Frame:

1. Move the timeline slider to the point in the animation where you want to pause. 

2. In the Pause Dur. field, enter the number of frames for which you want the pause to last.

3. Select the Key Frame button beside the field to add a camera Key Frame at this point.

The Pause Dur. Key Frame button changes to solid grey and the camera Key Frame is added to the
current position on the timeline.

To use a bookmark to add a pause to a flight animation:

1. Select File > Open to open a flight animation scene in which the flight goes from point A to B to C
without stopping.

Alternatively, you can create a new flight animation. 

For information on creating a flight animation, see Flight Points .

2. If necessary, move the Key Frames following flight point B towards the end of the timeline to leave
space for the pause. 

3. Move the timeline handle to point B and in the Bookmark Editor, select Add Bookmark. 

4. Now move the timeline handle to a position after flight point B, where you want the pause to end and
select the bookmark you created in the previous step.

5. Add a camera Key Frame at that position.

6. Select the green Play button in the animation toolbar to play the animation.
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Adding Drawing Keyframes

XPression Maps uses drawing Key Frames in the Animation Editor to control drawing and shape objects
within map animations. In most cases, these drawing Key Frames identify the start or end points of
changes to the position, rotation, size, visibility and other parameters of the drawing and shape objects
within the scene. For example, setting the visibility parameter at specific Key Frames on the timeline
allows you to manage and synchronize a drawing or shape's appearance or disappearance with other
objects or events. Changes to a drawing's Location parameters can enable objects to travel seamlessly
across the scene, and in the case of line drawings, changes to the object's Progress parameter creates a
smooth effect where the line progressively moves from one point to another.

« Which properties can be animated may differ depending on whether the object is a shape or drawing,

as well as the type of drawing. 

To add a drawing Key Frame to the timeline in Animation Editor:

1. Move the slider to the frame on the timeline where the changes to the parameter(s) are to be begin or
end. See Repositioining Key Frames .

2. On the Canvas, select the drawing or shape in the scene. 

3. Use the Drawing Editor or Shape Editor to adjust and set the object's parameters. 

If the parameters have a Key Frame button beside it, you can add a Key Frame for the individual
parameter with that setting to the current position on the timeline. 

    

Drawing Editor & Shape Editor - Drawing Key Frames

· When the Key Frame button is solid grey, it indicates that a Key Frame exists in the timeline for this
parameter.

· When the Key Frame button is cleared, no Key Frame exists in the timeline for this parameter.
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When a drawing Key Frame is added to the timeline, it is represented by a blue rectangle (or green when
selected) on the scale below the timeline.

« Alternatively for drawing objects, you can select the Animation Editor's Add Drawing Key Frame

button to capture the drawing's current Location, Rotation, and Size parameters in a single action
and add them to a drawing Key Frame on the timeline.

The following topics provide examples of the types of animation that can be created using drawing Key
Frames for drawing and shape objects: 

Creating a Drawing Visibility Animation

Creating a Line Progression Animation

Creating a Shape Animation
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Creating a Location and View Animation

Use a location and view animation to draw attention to multiple locations and different map views. This
type of animation involves setting different Longitude and Latitude values at two or more camera Key
Frames along the timeline to produce flights that move the camera view from one geographic location to
another geographic location. Additionally, setting different Tilt and Roll values at the camera Key Frames
adds a rotation of the camera view around the map's horizontal axis and spins the map clockwise or
counterclockwise during the animation's playback. 

To create a location and view angle animation:

1. Create the starting point for the animation by moving the slider to the beginning of the animation
timeline.

2. In the Search Editor, enter the location at which you want to begin your animation.

The location you enter is immediately displayed in the center of the map.

Alternatively, you can left-click on the map and move it to the location you want.

3. Adjust the Zoom Level, Tilt and Roll values to change the viewpoint of the map, if desired.

4. Select the Add Camera Key Frame button.

Add Camera Key Frame

A camera Key Frame is added to the timeline.

5. Drag the slider in the timeline to a different position that will be the next location in the animation. 

Alternatively, you can select any point in the timeline to move the slider to that point or enter the
position in the frame counter to the left of the timeline.

Frame Counter

6. Repeat steps 2 to 4 for each location you want to show.

7. Select the green Play Animation button in the Animation Control toolbar to view your animation.

Play Animation

8. When you are satisfied with the animation, save it with the scene (File > Save).
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Creating a Drawing Visibility Animation

You can make drawings appear and/or disappear at specific points in an animation. Some of the common
applications for this type of animation are to coordinate the appearance or disappearance of a drawing
with other objects or events. For example, a drawing might appear or disappear when a specific zoom
level or location is reached in an animation. 

To create a drawing visibility animation:

1. With the map positioned where you want to start your animation and the timeline slider at 0, select the
Add Camera Key Frame button to add a starting camera Key Frame.

2. Drag the timeline slider to the point in the timeline where you want a drawing to appear.

Alternatively, you can select any point in the timeline to move the slider to that point or enter the
position in the frame counter to the left of the timeline.

Frame Counter

3. Add a drawing to your scene and keep it selected.

4. In the Drawing Editor, in the General section, select the Visible checkbox (or clear the checkbox if
you want the drawing to disappear) and select the Key Frame button beside the checkbox to Key Frame
the visibility.

5. Select the Add Drawing Key Frame button.

6. Repeat steps 2 to 5 for each additional drawing you want to include in your scene.

7. Select the green Play Animation button in the Animation Control toolbar to view your animation.

Play Animation

8. When you are satisfied with the animation, save it with the scene (File > Save).
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Creating a Line Progression Animation

You can use a line animation to show the progression of a route across a map, for example the route to
take to get from point A to point B, or the route that will be followed for a race.

To animate a line:

1. Add a line drawing to your scene to mark a route. See Adding and Editing Line Drawings  for
instructions on adding a line drawing. 

2. On the Canvas, select the line drawing you want to animate.

3. In the Maximum Frame field to the right of the timeline slider enter the number of frames you want to
have in your animation.

The timeline will display up to 9999 frames. The speed of the animation playback depends on the
screen resolution selected in File > Preferences > Output. For example, HD 1080 50i will play 25
frames per second and HD 1080 60p will play 60 frames per second.

4. Move the timeline slider to the last frame.

Alternatively, you can select any point in the timeline to move the slider to that point or enter the
position in the frame counter to the left of the timeline.

Frame Counter

5. In the Drawing Editor, in the Progress section, select the Key Frame button beside the Value field.

This creates a Key Frame on the timeline at the slider position. 

6. Select the Close checkbox to connect and close both ends of the Line animation. 

Leave unchecked if you want to have an open ended Line animation. 

Drawing Editor - Progress Section

7. Move the timeline slider to the left to the 0 position.

This marks the point on the timeline as the ending Key Frame (100.0000) of the animation.

8. In the Drawing Editor, in the Progress section, move the Value slider all the way to the left to the 0
position and select the Key Frame button beside the Value field.

This creates the starting Key Frame of the animation.

If your animation covers a large area of the map and you want the map to move with the line, in the
Drawing Editor, in the Misc section, select the Lock Camera checkbox.
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9. Select the green Play Animation button in the Animation Control toolbar to view your animation.

Play Animation

10.When you are satisfied with the animation, save it with the scene (File > Save).
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Creating a Zoom Animation

You can use a zoom animation to draw the viewer’s attention to a specific location, beginning from a
distant camera view and zooming in to a close-up view or starting close-up and zooming out.

To animate a zoom into a location:

1. In the Maximum Frame field to the right of the timeline slider enter the number of frames you want to
have in your animation.

The timeline will display up to 9999 frames. The speed of the animation playback depends on the video
format and on the screen resolution selected in File > Preferences > Output. For example, HD 1080
50i will play 25 frames per second and HD 1080 60p will play 60 frames per second.

2. In the Search Editor, in the Location field, enter the name of the city, the area of the city or the
landmark that you want to zoom into and select Search.

The map on the Canvas will move to the specified location.

3. In the camera parameters beneath the Canvas, adjust the Zoom Level parameter to a level that gives
you the desired starting view of the country or area of your location.

Alternatively, you can scroll with your mouse to the desired zoom level.

4. With the timeline slider at the beginning of the timeline, select the Add Camera Key Frame button.

Add Camera Key Frame

5. Drag the timeline slider to the right as many frames as you want the animation to take to zoom into or
out of the location.

Alternatively, you can select any point in the timeline to move the slider to that point or enter the
position in the frame counter to the left of the timeline.

Frame Counter

6. Select the Add Camera Key Frame button.

7. Adjust the Zoom Level parameter to a level that gives you the desired final view of the target location
and add another camera Key Frame at this position.

The animation will automatically move through the levels to the final zoom level.

7. Select the green Play Animation button in the Animation Control toolbar to view your animation.

Play Animation

8. When you are satisfied with the animation, save it with the scene (File > Save).
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Creating a Shape Animation

Use a shape animation to draw the viewer’s attention to specific related locations, by having each location
appear in the scene individually. An example would be a map showing election results. Each location is
represented by a shape that appears at a specific point in the animation.

To animate a shape:

1. In the Maximum Frame field to the right of the timeline slider, enter the number of frames you want
to have in your animation.

The timeline will display up to 9999 frames. The speed of the animation playback depends on the
screen resolution selected in File > Preferences > Output. For example, HD 1080 50i will play 25
frames per second and HD 1080 60p will play 60 frames per second.

2. With the map positioned where you want to create your animation and the timeline slider at the
beginning of the timeline, select the Add Camera Key Frame button.

3. Drag the timeline slider to the point on the timeline where you want to display the shape.

Alternatively, you can select any point on the timeline to move the slider to that point or enter the
position in the frame counter to the left of the timeline.

Frame Counter

4. In the Search Editor , in the Location field, enter the name of the geographic location where the
shape is to be added. 

Ensure that the Go to Result is selected and then select Search.

5. In the Search Related Shapes section, double-click the shape that is to be moved.

The shape appears on the map, using the default shape style defined in the Shape Editor.

6. In the Shape Editor , select the new shape you just added from the list and in the Properties
section, make sure the Visible checkbox is selected and select the Key Frame button beside the
Visible checkbox to add a Key Frame. 

This will make the shape become visible at this point in the timeline.

7. Select the Add Camera Key Frame button.

To add additional shapes to the scene:

· Repeat steps 3 to 7 to add additional shapes to the scene.

To view animation playback and save:

1. Select the green Play Animation button in the Animation Control toolbar to view your animation.

Play Animation

2. When you are satisfied with the animation, save it with the scene (File > Save).
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Saving a Scene
Saving a scene preserves all details, including camera movements and drawings, along with their
references in the database. Saved files are stored with the *.wnm extension.

Scenes can be reopened in XPression Maps. When a scene is loaded, it uses references from the drawing
database to recreate the drawings. Any changes made to the drawings in the database will automatically
update all scenes that use them—unless the scene has been exported. See Exporting a Scene  for more
information.

« If Compact Scene on Save is selected in Preferences > Output , all unused styles in the map style

list and in the shape style list are removed.

To save a new scene:

1. Select File > Save in the menu bar or select the Save button in the toolbar.

XPression Maps Toolbar - Save

The file browser opens.

Save File

2. Select a folder or destination where the scene is to be saved.

3. In the File name field, enter a name for the scene.

4. Select Save.

To save an existing scene with a new name:

1. Select File > Save As in the menu bar or select the Save button in the toolbar.

XPression Maps Toolbar - Save

2. In the Save As window, in the File name field, enter a new name for the scene and select Save.
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Exporting a Scene
Exporting a scene saves both the scene itself and all associated drawings, ensuring it can be opened in
any XPression Maps application—regardless of changes made to the original drawings in the database.
When an exported scene is opened, the included drawings appear in the Drawing Toolbox under the
Imported Scene Drawings section, where they can be reused within the scene. Exported scenes are
saved with the .wnm_exp file extension. If the scene is edited and saved again, it will automatically
retain this exported format.

« If Compact Scene on save is selected in Preferences > Output , all unused styles in the map style

list and in the shape style list are removed.

The following topics are discussed in this section:

Exporting a Scene

Opening an Exported Scene

Using an Imported Scene Drawing

To export a scene:

1. Select File > Export in the menu bar.

The file browser opens.

2. Select a folder or destination where the scene is to be exported.

3. Select Save.

The file browser closes and the scene is exported to the selected location, with the extension
.wnm_exp.

« Export the scene for use in different XPression Maps applications and for archiving a scene. This

ensures that changes in the drawing database will not affect the scene.

To open an exported scene:

1. Select File > Open.

2. In the file browser, from the File Type drop-down, select XPression Maps export files
(*.wnm_exp).

The browser will be populated with a list of exported files.

3. From the list of files, select the exported file you want and select Open.

To use imported scene drawings:

1. Open an exported scene.

2. In the Drawing Toolbox in the Imported Scene Drawings section, select a drawing and then select
the scene on the Canvas to add the drawing to the scene.

The Imported Scene Drawings section is hidden, unless there is an exported scene open on the
Canvas.

37

313

313

313



314 • Creating and Managing Scene Templates XPression Maps User Guide (v4.0)

Creating and Managing Scene
Templates
As part of the XPression Maps MOS workflow , graphic designers create scenes that define key design
elements by assigning a map style and an initial camera view. If the scene template is intended to be used
to create animated map graphics, then they may also include one or more flight points to produce an
initial flight animation. These scenes become scene templates when they are added to a template
group in the Scene Templates editor, where designers also include pre-approved location labels,
drawings, shape styles, and user predefined objects. All scene templates and associated objects are
centrally stored on the XPression Maps server so that MOS newsroom users can remotely access them to
create customized scenes using the XPression Maps HTML5 Client.

The following topics are discussed in this section:

Procedural Overview for Creating Scene Templates

Adding and Managing Flights Points

Managing Scene Templates Groups

Loading and Editing a Scene Template

Editing Scenes Created in the HTML5 Client
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Procedural Overview for Creating Scene Templates

Given the versatility of XPression Maps software and the distinct nature of your creative and business
requirements, defining a standard usage procedure can be challenging. However, the following procedures
provide basic guidance for how to create scene templates for still or animated map graphics.

Creating a Scene Template for a Still Map Graphic

Creating a Scene Template for an Animated Flight Map Graphic

To create a scene template for a still map graphic:

1. Launch XPression Maps from the desktop icon and select File > New to open a new scene.

2. In the Map Styles panel, from the Styles drop-down, select a map style. 

If the selection of map styles does not meet your needs, edit or create a new map style. 

3. Position the map on the Canvas to display the required location and camera view.

4. (Optional) Add drawings, shapes, and other objects to the scene.

5. Select File > Save to save the scene to your scenes folder.

6. Select Output > Manage Templates to open the Scene Templates editor and add the scene to a
group to create a scene template.

7. Configure the template's details (the Still As Default checkbox must be selected) and select Update.

8. Add the drawings, shapes, labels, and user predefined objects that you want to have accessible in the
HTML5 Client to the corresponding tabs.

See the following topics for complete instructions:

· Adding Locations Labels to a Scene Templates Group

· Adding Drawings to a Scene Templates Group

· Adding Shape Styles to a Scene Templates Group

· Adding User Predefined Objects to a Scene Templates Group  

9. When you are satisfied with your template, select Done to close the Scene Templates editor.
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To create a scene template for a flight animation map graphic:

1. Launch XPression Maps from the desktop icon and select File > New to open a new scene.

2. In the Map Styles panel, from the Styles drop-down, select a map style. 

If the selection of map styles does not meet your needs, edit or create a new map style. 

3. Create Key Frames for the animation by adding flight points to the Flight Points editor in the desired
playback order (e.g., starting, next, ending).

a. Position the map on the Canvas to display the required location and camera view for the starting
flight point.

 Alternatively, in the Search Editor, in the Location field, enter the location for the first flight point.

b. (Optional) Add drawings, shapes, and other objects to the map.

c. In the Flight Points editor, select New and enter a name for the flight point.

d. Repeat steps a to c above for each flight point.

Each new flight point is appended to the end of the list in the Flight Points editor. 

4. Preview the playback of the animation on the Canvas by selecting the Start button in the Flight
Points editor. 

5. Select File > Save to save the scene to your scenes folder.

6. Select Output > Manage Templates to open the Scene Templates editor and add the scene to a
group to create a scene template.

7.  Configure the template's details (the Still As Default checkbox must be cleared) and select Update.

8. Add the drawings, shapes, labels, and user predefined objects that you want to have accessible in the
HTML5 Client to the corresponding tabs.

See the following topics for complete instructions:

· Adding Location Labels to a Scene Templates Group

· Adding Drawings to a Scene Templates Group

· Adding Shape Styles to a Scene Templates Group

· Adding User Predefined Objects to a Scene Templates Group  

9. When you are satisfied with your template, select Done to close the Scene Templates editor.
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Adding and Managing Flight Points

Flight points are animation Key Frames that use the Longitude, Latitude, Tilt, Zoom, and Wait values to
define a location and camera view. Typically, graphic designers build a scene template by adding a
starting flight point to the Flight Points editor, which defines the initial map location and camera view.
Additional flight points are then added to Flight Points editor to define the number of transitions and
destinations in the flight animation. When newsroom users want to create story-specific map animations,
they use the HTML5 Client to access the scene template and are permitted to add, change, or remove the
flight points defined in the scene template. 

Flight Points Editor - Starting Flight Point

When multiple flight points are added to the Flight Points editor, the first flight point in the list is
automatically assigned as the starting flight point and the remaining flight points are assigned to the
scene template and played back in the order in which they appear in this list.

Example - Order of Flight Points in the Flight Points Editor

The following topics are discussed in this section:

Adding a Flight Point

Editing a Flight Point

Deleting a Flight Point

Previewing the Flight Points Animation
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Adding a Flight Point

A new flight point captures the current map location and camera view parameters values from the
Canvas. Once you provide a name for the flight point, it is appended to the bottom of the list in the Flight
Point editor. Expanding the flight point's name displays the flight point's camera parameters. These
parameters are read-only, except for the Wait parameter. See Editing a Flight Point  for instructions on
how to change a flight point's parameters. 

« The order of the flight points listed in the Flight Point editor determines the order of execution during

playback (e.g,. start, next, end). See Managing Flight Points  for more information.

To add a new flight point:

1. Position the map on the Canvas to the location where you want the flight point to begin and adjust the
camera view parameters (Zoom Level, Tilt and Roll), if necessary.

2. In the Flight Points editor, select New to create a flight point with the displayed camera values.

3. In the Add Flight Point dialog, enter the name of the flight point and select OK.

Add Flight Point

The flight point is appended to the list in the Flight Points editor. 

4. Expand the flight point name to see the camera parameters for the point.

Flight Points editor - Starting Flight Point Added

5. If you want the animation to pause for a duration at the start flight point before continuing to the next
flight point, double-click the Wait value and enter a new time in seconds.
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Editing a Flight Point

When you select a flight point in the Flight Point editor, the map on the Canvas immediately updates to
its set location and camera view. Expanding the flight point's name in the Flight Points editor reveals its
current values. These parameters are read-only, except for the Wait parameter, which can be directly
edited to change the duration of the pause at the start of a flight point before continuing to the next flight
point. 

Flight Points Editor - Flight Point Parameters

To edit a flight point's location and camera view:

1. In the Flight Points editor, select the flight point you want to edit.

2. On the Canvas, reposition the map and/or edit the camera view parameters to the desired location and
perspective.

3. Press Update to save the new flight point values to the Flight Point editor.

To edit a flight point's Wait value:

1. In the Flight Points editor, expand the name of the flight point to reveal its parameters.

2. Double-click the value for the Wait parameter.

3. Type a new time in seconds that the animation will pause at the start of the flight point.

4. Press Enter.
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Deleting a Flight Point

A flight point that is no longer needed can be deleted from the Flight Points editor. 

« Since the order of the flight points in the Flight Point editor determines the order of execution during

playback (e.g. start, next, end) and flight points cannot be reordered directly, we recommend deleting
flight points from the Flight Point editor and then adding new flight points in the required order. See
Managing Flight Points  for more information.

To delete a flight point:

1. In the Flight Points editor, select the flight point.

2. Press Delete.
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Previewing the Flight Points Animation

Once flight points have been added to the Flight Points editor, a preview of the animation's playback can
be viewed on the Canvas.

To preview the playback of the flight animation:

1. In the Flight Points editor, select the first flight point.

The map on the Canvas immediately updates to its set location and camera view.

2. Select Start.

The map on the Canvas transitions from one flight point to another using to the list order and applying
any Wait durations.
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Managing Scene Templates Groups

Graphic designers use the Scene Templates editor to create templates groups, which are folders that
store scene templates and their associated objects in an organized file structure. While this file structure is
built and used in the XPression Maps software, it is also replicated and used to provide easy access to
scene templates in the HTML5 Client.

Scene Templates Editor and HTML5 Client

To create a scene template, add the scene to a group's Scene page and configure its identity and
attributes in the Details section. The Scene Templates editor also contains tabbed pages for adding
location labels, drawings, shapes and user predefined objects to a template group. These objects are also
made available to MOS newsroom users in the HTML5 Client.

Finally, the Scene Templates editor provides a way to load a scene template back onto the XPression
Maps application's Canvas, where the scene's flight point parameters, map style, and included objects
can be edited.       

The following topics are discussed in this section:

Adding, Renaming, and Deleting Scene Templates Groups

Adding a Scene Template to a Group

Editing Scene Template Details

Deleting a Scene Template

Adding Location Labels to a Scene Templates Group

Adding Drawings to a Scene Templates Group

Adding Shape Styles to a Scene Templates Group

Adding User Predefined Objects to a Scene Templates Group
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Adding, Renaming, and Deleting Scene Templates Groups

A template group is a user-defined folder that allows graphic designers to organize scene templates and
their associated object files into a logical file structure. Use the Scene Templates editor to add, rename
and delete template groups.

The following topics are discussed in this section:

Adding a New Group

Renaming a Group

Deleting a Group

To add a scene template group:

1. From the menu bar, select Output > Manage Templates to open the Scene Templates editor.

2. In the Scene Templates editor, select the Browse button ( ) beside the Group drop-down.

The Template Groups dialog opens.

3. In the Template Groups dialog, in the Name field, enter a name for the new template group.

4. In the Description field, enter a description of the type of maps that will be saved in this group.

5. Select Add.

Template Groups Dialog

6. Select Done to close the Scene Templates editor.

To rename a scene template group:

1. From the menu bar, select Output > Manage Templates to open the Scene Templates editor.

2. From the Group drop-down, select the group you want to edit.

3. Select the Browse button ( ) beside the Group drop-down to open the Template Groups dialog.

4. In the Template Groups dialog, enter a new name for the group.

5. Select Update.

6. Select Done to close the Scene Templates editor.
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To delete a scene template group:

1. From the menu bar, select Output > Manage Templates to open the Scene Templates editor.

2. In the Scene Templates editor, from the Group drop-down, select the scene template group you want
to delete.

3. Select the Browse button ( ) beside the Group drop-down to open the Template Groups dialog.

4. In the Template Groups dialog, select Delete.

5. In the Delete Group confirmation dialog, select Yes to delete the group and all templates in it.

6. Select Done to close the Scene Templates editor.
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Adding a Scene Template to a Group

The Scene Templates editor provides two ways to add a new scene template to a group:

· Add  - Uses a scene file ( .wmn) that was previously saved to the database to create and add a new
scene template to the selected group.

· Add Actual  - Uses the active scene from the Canvas to create and add a new scene template to the
selected group.

Scene Templates Editor - Adding a Scene

To create and add a scene template to a group based on a previously saved scene file:

1. Build a scene that includes the required elements and characteristics of a scene template (map style,
camera view parameters, and flight points, etc.) and save the scene as a .wmn file. 

See Saving a Scene .

2. From the menu bar, select Output > Manage Templates to open the Scene Templates editor.

Scene Templates Editor

3. In the Scene Templates editor, from the Group drop-down, select the group to which you want to add
a new scene template.
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4. Select the Scene tab, and then select the Add button to navigate to a saved scene.

The WNM Scene File browser opens. 

WNM Scene File Selection Dialog

5. In the WNM Scene File browser, navigate to the folder where you have saved your scenes.

By default, the WNM Scene File window opens to the C:\XPression Maps\Scene folder, where
scenes are saved. If you are saving your scenes to a different folder, navigate to that location.

6. Select the scene from which you want to create a template and select Open.

The scene is added to the top of the list in the Scenes tab and a thumbnail is displayed, along with the
name and the Type. 

By default, the scene is added as a Video type. To switch to a Still type, in the Details section to the
right of the Scenes list, select the Still As Default checkbox and select Update.

You can reorder the list by selecting and dragging an item to another spot in the list.

7. Now you can edit the scene template details, add location labels, drawings, shapes styles, or user
predefined objects to the template group or select Done to close the Scene Templates editor.
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To create and add a scene template to a group based on the scene that is currently open on the
Canvas:

1. Build a scene that includes the required elements and characteristics of a scene template (map style,
camera view parameters, drawings, flight points, etc.).

2. From the menu bar, select Output > Manage Templates to open the Scene Templates editor.

Scene Templates Editor

3. In the Scene Templates editor, from the Group drop-down, select the group to which you want to add
a new scene template.

4. Select the Scene tab, and then select the Add Actual button to add the currently displayed scene.

The scene is added to the top of the list in the Scenes tab and a thumbnail is displayed, along with a
default name and the default Type. 

You can reorder the list by selecting and dragging an item to another spot in the list.

5. In the Details section, enter a name for the scene template and configure the other parameters.

By default, the scene is added as a Video type. To switch to a Still type, in the Details section to the
right of the Scenes list, select the Still As Default checkbox and select Update.

6. Now you can add location labels, drawings, shapes styles, or user predefined objects to the template
group or select Done to close the Scene Templates editor.
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Editing Scene Template Details

A scene template is created by adding a scene to the Scene Templates editor and configuring its
parameters, which appear in the Details section of the Scene tab. These details, which define the
template's identity and attributes, can be edited anytime.

Scene Templates Editor - Details

To edit the scene template details:

1. From the menu bar, select Output > Manage Templates to open the Scene Templates editor.

2. On the Scenes tab, select the scene template you want to edit. 

3. In the Details section, edit the information as necessary:

· In the Name field, enter a new name for the scene.

· From the drop-down beside the Name field, select one of the following flight types:

Ø User Defined - The template is animated. It must have a starting flight point. A flight point is
automatically created if one does not exist. The duration of the flight is determined by the Flight
End parameter and played out accordingly in the HTML5 Client application, when this template
is used.

Ø Automatic - The template is animated. It must have a starting flight point. A flight point is
automatically created if one does not exist. The duration of the flight is the shortest possible time
that the application can reasonably complete the flight during playout. The Flight Start and Clip
Length parameters are respected, allowing for a set time for a static image to be displayed
before and after the flight.

· In the Flight Start field, enter a value or use the arrows to select a time, in seconds that the clip will
wait before the flight starts. By default this value is set to 1.00.

· In the Max Flight End field, enter a value or use the arrows to select the point in the clip by which
the flight needs to end.

· In the Clip Length field, enter a value or use the arrows to select the length of the clip, in seconds.

The Clip Length value needs to be the same as or greater than the Flight End value.
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· Select the Still As Default checkbox to create a still image in the XPression Maps HTML5 Client
application.

OR

Deselect the Still As Default checkbox, to create a video (clip) in the XPression Maps HTML5
Client application.

In Automatic videos, the animation will have the duration set in the Clip Length parameter. The
flight to the location defined in the Client app will start after the number of seconds set in the
Flight Start parameter and will end at latest after the number of seconds set in the Max. Flight
End parameter. If the distance between the start and end flight points is short, the flight may
finish earlier. The flight end location will be displayed for the duration set in the Clip Length
parameter.

In User Defined videos, the animation will have the duration set in the Clip Length parameter.
The flight to the location defined in the Client app will start after the number of seconds set in
the Flight Start parameter and will end after the number of seconds set in the Flight End
parameter. The flight end location will be displayed for the duration set in the Clip Length
parameter.

4. Select the Use Scene Styles from Database checkbox, if you want the map style that’s currently
saved in the database to be used, instead of the map style in the selected scene. 

This parameter is only available if you have selected the Load Scene using map style from Map Style
Database checkbox in File > Preferences > Output.

5. In the Description field, enter a description of the template.

6. Select Update to save the changes.

7. Select Done to close the Scene Templates editor.
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Deleting a Scene Template

As part of good resource management, you may want to delete a scene template that is no longer
required. This removes the scene template from both the group in the Scene Templates editor, as well as
the HTML5 Client.

« Deleting a scene template does not delete the scene file  (.wmn) from which the scene template

originated.

To delete a scene:

1. From the menu bar, select Output > Manage Templates to open the Scene Templates editor.

2. From the Group drop-down, select the group that contains the scene template you want to delete.

3. In the Scenes tab of the selected group, select the scene template you want to delete.

Scene Templates - Scenes Tab

4. Select Remove and in the Remove Scene confirmation dialog, select Yes.

Remove Scene Confirmation Dialog

5. Select Done to close the Scene Templates editor.



XPression Maps User Guide (v4.0) Creating and Managing Scene Templates • 331

Adding Location Labels to a Scene Templates Group

A Location Label is a text drawing—optionally accompanied by a marker image—that already exists in the
Drawing Management Editor (1). It can be added to a scene template group in the Scene Templates
editor (2), enabling newsroom users to access it through the HTML5 Client (3) and include it in story-
specific map scenes to identify or label a location.

Scene Templates Editor - Adding Location Labels to a Scene Templates Group

Text drawings are added to the Location Labels tab in the Scene Templates editor, where they are

listed by preview image, name, and type. If a drawing's preview image includes an  airplane icon , it
indicates that the drawing's Flight Mode property is enabled, which allows the drawing’s visibility to be
controlled at the flight point level when creating flight map animations (see Adding, Editing or Deleting
Flight Points) .

The following topics are discussed in this section:

Adding a New Location Label to a Scene Template Group

Renaming a Location Label

Deleting a Location Label from a Scene Template Group

To add a new location label to a scene templates group:

1. From the menu bar, select Output > Manage Templates to open the Scene Templates editor.

2. From the Group drop-down, select the group to which you want to add a location label.

3. In the Location Labels tab, select the Add button.

The Add Location Label editor opens.

Add Location Label Editor
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4. In the Add Location Label editor, select the Toolbox drop-down and select the group that contains
the drawing you want to use as a location label. 

Typically, text, icon and dynamic data drawings are used for location labels.

5. From the Location Label list, select the label (or hold Shift and select multiple labels) that you want
to add to the group and select Add.

The new location label drawing is added to the list in the Location Labels tab and a thumbnail is
displayed, along with the name and Type. This label will now be available for all scene templates in
the current group.

You can reorder the list by selecting and dragging an item to another spot in the list. 

6. Select Done to close the Scene Templates editor.

To rename the location label in a scene templates group:

1. From the menu bar, select Output > Manage Templates to open the Scene Templates editor.

2. In the Scene Templates editor, from the Group drop-down, select the group that contains the location
label you want to edit.

3. In the Location Labels tab, select the location label you want to edit.

4. In the Details section, edit the name or enter a new name for the location label.

5. Select Update to save the changes.

6. Select Done to close the Scene Templates editor.

To delete a location label from a scene template group:

1. From the menu bar, select Output > Manage Templates to open the Scene Templates editor.

2. From the Group drop-down, select the group that contains the location label you want to delete.

3. In the Location Labels tab, select the location label you want to delete.

4. Select Remove and in the Remove Location Label confirmation dialog, select Yes.

5. Select Done to close the Scene Templates editor.
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Adding Drawings to a Scene Templates Group

A drawing that already exists in the Drawing Management Editor (1) can be added to a scene template
group in the Scene Templates editor (2). This allows newsroom users to access it through the HTML5
Client (3) and include it in story-specific map scenes.

Scene Templates Editor - Adding Drawings to a Scene Templates Group

Drawings are added to the Drawings tab in the Scene Templates editor, where they are listed by

preview image, name, and type. If a drawing's preview image includes an  airplane icon , it indicates
that the drawing's Flight Mode property is enabled, which allows the drawing’s visibility to be controlled
at the flight point level when creating flight map animations (see Adding, Editing or Deleting Flight
Points) .

The topics discussed in this section are:

Adding a Drawing to a Scene Template Group

Renaming a Drawing

Deleting a Drawing from a Scene Template Group

To add a new drawing to a scene templates group:

1. From the menu bar, select Output > Manage Templates to open the Scene Templates editor.

2. From the Group drop-down, select the group to which you want to add a drawing. 

3. In the Drawings tab, select the Add button.  

The Add Drawing editor opens. 

Add Drawing Editor

4. Select the Toolbox drop-down and select a drawing group.
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5. From the Drawing list, select the drawing (or hold Shift and select multiple drawings) that you want
to add to the group and select Add.

The new drawing is added to the list in the Drawings tab and a thumbnail is displayed, along with the
name and Type. This drawing will now be available for all scene templates in the current group.

You can reorder the list by selecting and dragging an item to another spot in the list. 

6. Select Done to close the Scene Templates editor.

To rename a drawing in a scene templates group:

1. From the menu bar, select Output > Manage Templates to open the Scene Templates editor.

2. From the Group drop-down, select the group that contains the drawing you want to edit. 

3. In the Drawings tab, select the drawing you want to edit.

4. In the Details section, in the Name field, edit the name or enter a new name for the drawing.

5. Select Update to save the changes.

6. Select Done to close the Scene Templates editor.

To delete a drawing from a scene templates group:

1. From the menu bar, select Output > Manage Templates to open the Scene Templates editor.

2. From the Group drop-down, select the group that contains the drawing you want to delete.

3. In the Drawings tab, select the drawing you want to delete.

4. Select Remove and in the Remove Drawing confirmation dialog, select Yes.

Remove Drawing Confirmation Dialog

5. Select Done to close the Scene Templates editor.
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Adding Shape Styles to a Scene Template Group

A shape style that already exists in the Shape Styles Manager (1) can be added to a scene template
group in the Scene Templates editor (2). This allows newsroom users to access it through the HTML5
Client (3) and include it in story-specific map scenes.

Scene Templates Editor - Adding Shape Styles to a Scene Templates Group

The following topics are discussed in this section:

Adding a Shape Style to a Scene Template Group

Renaming a Shape Style

Deleting a Shape Styles from a Scene Template Group

To add a new shape style to a Scene Template Group:

1. From the menu bar, select Output > Manage Templates to open the Scene Templates editor.

2. From the Group drop-down, select the group to which you want to add a shape style. 

3. In the Shape Styles tab, select the Add button.  

The Add Shape Style editor opens. 

Add Shape Style Editor

4. In the Add Shape Style editor, select the shape style (or hold Shift and select multiple shape styles)
you want to add and select Add.

The new shape style is added to the list in the Shape Styles tab. This shape will now be available for
all scene templates in the current group.

You can reorder the list by selecting and dragging an item to another spot in the list.

5. Select Update to save the changes.

6. Select Done to close the Scene Templates editor.
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To rename a shape style in a Scene Template Group:

1. From the menu bar, select Output > Manage Templates to open the Scene Templates editor.

2. From the Group drop-down, select the group that contains the shape style you want to edit.

3. In the Shape Styles tab, select the shape style you want to edit.

4. In the Details section, in the Name field, edit the name or enter a new name for the shape style.

5. Select Update to save the changes.

6. Select Done to close the Scene Templates editor.

To delete a shape style from a Scene Template Group:

1. From the menu bar, select Output > Manage Templates to open the Scene Templates editor.

2. From the Group drop-down, select the group that contains the shape style you want to delete.

3. In the Scene Templates editor, in the Shape Styles tab, select the shape style you want to delete.

4. Select Remove and in the Remove Shape Style confirmation dialog, select Yes.

Remove Shape Style Confirmation Dialog

5. Select Done to close the Scene Templates editor.
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Adding User Predefined Objects to a Scene Templates Group

User Predefined Objects that already exists in the User Predefined Objects panel (1) can be added to a
scene template group in the Scene Templates editor (2). This allows newsroom users to access them
through the HTML5 Client (3) and include them in story-specific map scenes.

Scene Templates Editor - User Predefined Objects are Made Available to the HTML5 Client

« For information on creating User Predefined Object Groups and Folders, see Creating User

Predefined Objects . 

The following topics are discussed in this section:

Adding a new folder

Adding User Predefined Objects to a folder

Removing User Predefined Objects from a folder

Deleting a Folder from a Scene Templates Group
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To create a new folder of User Predefined Objects for a scene templates group:

1. From the menu bar, select Output > Manage Templates to open the Scene Templates editor.

2. From the Group drop-down, select the templates group to which you want to add the new folder. 

Scene Templates - Select the Group

3. Select the User Predefined Objects tab.

4. Select the Add button  beside the Folder drop-down to add a new folder.

The Add Folder window opens. 

Scene Templates - User Predefined Objects - Add Folder

5. In the Name field, enter a name for the User Predefined Object folder.

6. In the Description field, enter a description for the User Predefined Object folder. 

7. Select Add to add the folder to the template group.

8. Next, add user predefined objects to the folder.
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To add user predefined objects to a folder:

1. From the menu bar, select Output > Manage Templates to open the Scene Templates editor.

2. From the Group drop-down, select the templates group to which you want to add the user predefined
objects. 

Scene Templates - User Predefined Objects Tab

3. Select the User Predefined Objects tab.

4. From the Folder drop-down, select the folder to which you want to add the user predefined objects.

5. Select the Add button to open the Add User Predefined Object window.

The Add User Predefined Object window is populated with the groups, folders, and user predefined
objects that were created using the User Predefined Objects Panel. For more information, see
Creating User Predefined Objects .

Scene Templates - Add User Predefined Object
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6. From the Group drop-down, select the group (originating from the User Predefined Object panel)
that contains the folder that contains the user predefined object you want to add.

Add User Predefined Object - Select a Group

7. If the group (originating from the User Predefined Object panel) has multiple folders, from the
Folder drop-down, select the folder that contains the user predefined objects that you want to add. 

Add User Predefined Object - Select a Folder

8. Add one or more user predefined objects by performing one of the following tasks:

· To add a single user predefined object, select the object from the list and select Add at the bottom of
the window.

OR 

· To add multiple user predefined objects, hold CTRL and select the user predefined objects from the
list and select Add at the bottom of the window.

OR 

· To add the folder and all of its user predefined objects, select Add to the right of the Folder drop-
down.

Then, select OK in the Folder Added dialog and then select Done.

Scene Templates - User Predefined Objects Added

9. For each user predefined object, select the object from the list and use the Details section to view, edit
or update the Name, Search Tags and Description. 

10.When finished, select Done to close the Scene Templates editor. 
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To remove User Predefined Objects from a User Predefined Object folder:

1. From the menu bar, select Output > Manage Templates to open the Scene Templates editor.

2. From the Group drop-down, select the scene template group containing the user predefined objects
you want to remove.

3. Select the User Predefined Objects tab.

4. From the Folder drop-down, select the folder containing the user predefined objects that you want to
remove from the scene template group.

5. Select a single object from the list, or hold CTRL and select multiple objects from the list.

6. Select Remove.

7. In the Remove User Predefined Object dialog, select Yes. 

Scene Templates Editor - Remove User Predefined Object

8. When finished, select Done to close the Scene Templates editor. 

To delete a User Predefined Object folder and its contents from a scene templates group:

1. In the Scene Templates editor, from the Group drop-down, select the template group containing the
folder you want to delete.

2. Select the User Predefined Objects tab.

3. In the User Predefined Objects tab, from the Folder drop-down, select the folder you want to

remove and select the Delete button . 

The Delete Folder window dialog opens. 

Scene Templates - User Predefined Objects - Delete Folder Dialog

4. Check the Confirm the folder delete checkbox and select Yes to delete the folder and its objects. 

The final red Delete Folder dialog opens. 

Scene Templates - User Predefined Objects - Final Delete Folder Dialog

5. Select Yes to delete the folder and its objects. 

6. When finished, select Done to close the Scene Templates editor. 
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Loading and Editing a Scene Template

Use the Scene Templates editor to load an existing scene template back onto the Canvas and edit the
scene's camera view parameters, flight points, and map style.

To load a template:

1. From the menu bar, select Output > Manage Templates to open the Scene Templates editor.

2. From the Group drop-down, select the group containing the scene template you want to load.

3. In the Scenes tab of the selected group, select the scene template you want to load.

4. Select Load. 

The scene template is retrieved from the database, the Scene Templates editor closes and the scene
is visible on the Canvas. The icon in the menu bar is highlighted, indicating that the template can be
edited.

Manage Templates Icon Highlighted

· If the selected scene has a different video format, a confirmation dialog opens, asking if you want to
set the new format.

Ø Select Yes to set the new format or No to keep the current format.

Ø Selecting the X in the top-right corner gives the same result as selecting No.

Video Format Confirmation

5. Make edits to the scene.

6. Save the changes made to the scene by selecting the Save icon from the menu bar.

A confirmation dialog opens asking if you want to save the edited scene back into the database as a
template.

Save Scene Back as Template Confirmation Dialog

7. Select Yes to save it.

8. In the Save window, navigate to the folder where you want to save the template and enter a name for
the template.

· Entering the original name will automatically overwrite the template in the Scene Templates editor.

· Entering a different name will save it as a new scene, but you will then have to add it to the Scene
Templates editor if you want it available for use in the HTML5 Client. See To add a new scene
template  for more information.

9. Select Save.

The scene is added to the database as a template. The icon in the menu bar is no longer highlighted, as
the scene can no longer be edited. 
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Editing Scenes Created in the HTML5 Client

Scenes created from templates in the XPression Maps HTML5 Client can be opened in the Saved Scene
Templates editor for editing and then saved back to the XPression Maps Server database.

To load and edit a saved scene in XPression Maps:

1. From the menu bar, select Output > Edit Saved Templates to open the Saved Scene Templates
editor.

Saved Scene Templates Editor

2. Select the group containing the scene you want to edit, then select the scene and select Load.

When the template is loaded, the Edit Saved Templates button turns blue, indicating that it can be
edited.

XPression Maps Toolbar - Edit Saved Templates Active

· If the selected scene has a different video format, a confirmation dialog opens, asking if you want to
set the new format.

Ø Select Yes to set the new format or No to keep the current format.

Ø Selecting the X in the top-right corner gives the same result as selecting No.

Video Format Confirmation

3. Make any necessary changes to the template.

4. Select the Save button in the menu bar.

A confirmation dialog opens asking if you want to save the scene back to the HTML5 Client. 

Save Scene in HTML5 Client
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5. If you want to make the edited template available in the the HTML5 Client, select Yes.

OR

Select No to only save the template into your Scenes folder.
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Creating and Managing Scenes in the
HTML5 Client
The XPression Maps HTML5 Client is a web-based application that allows authorized MOS newsroom users
to remotely access and edit scene templates  stored on the XPression Maps Server. These templates are
designed to enforce branding and style guidelines, so that newsroom users can focus on content when
creating story-specific still or animated map graphics. The modified scene templates are stored on the
XPression Maps Server as scenes that can be rendered as image or video files, or integrated directly into
the XPression MOS workflow.

The following topics are discussed in this section:

Launching and Signing In/Out of the HTML5 Client

Procedural Overview for Creating or Editing Scenes

Opening a Scene Template

Opening a Scene

Duplicating a Scene

Deleting a Scene

Changing OpenStreetMap (OSM) Layer Settings

Changing the Language of a Scene

Modifying the Safe Title Area

Adding, Editing or Deleting Flight Points

Positioning the Map in the HTML5 Client

Adding, Editing and Deleting Shapes

Adding, Editing, and Deleting Labels

Adding, Editing, Deleting and Ordering Drawings

Adding User Predefined Objects

Saving a Scene

Previewing and Downloading an Animated Map Graphic File

Previewing and Downloading a Still Map Graphic File

User Management in the HTML5 Client

Folder Management in the HTML5 Client
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Launching and Signing In/Out of the HTML5 Client

The XPression Maps HTML5 Client is a web-based application that can be opened in a web browser on a
workstation that's connected to the same network as the computer hosting the main XPression Maps
software and XPression Maps Server. Once opened, the HTML5 Client enables authorized MOS newsroom
users to remotely access, edit, and manage scene templates and scenes stored in the XPression Maps
Server database. 

« To use the HTML5 Client, XPression Maps must be running in Server mode on the host computer, with

the Preferences > Web Interface settings properly configured. 

XPression Maps HTML5 Client - Log In

If communication with the XPression Maps Server is interrupted during an HTML5 Client session, a
Communication Error dialog appears, prompting you to verify that the server is running. Select OK to
close the dialog. Once communication is restored, the HTML5 Client automatically resumes operation—no
need to log in again or refresh your browser.

HTML5 Client - Communication Error

If the HTML5 Client is idle for an extended period, a Logout Warning dialog appears. To stay logged in,
select OK within 60 seconds. If no action is taken, the HTML5 Client will automatically log the current user
out and return to the Log In page.

HTML5 Client - Logout Warning

The following topics are discussed in this section:

Launching the HTML5 Client

Logging in to the HTML5 Client

Logging out of the HTML5 Client
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To launch the HTML5 Client:

1. Open your web browser and in the address field, enter “computername/maps/” (without the quotation
marks).

Instead of “computername” you can also enter the IP address of the computer on which you want to
run the HTML5 Client.

2. Press Enter.

The XPression Maps HTML5 Client opens to the Login page.

XPression Maps HTML5 Client Application - Login

« If the HTML5 Client does not open, check your network connection or contact your XPression Maps

administrator to verify that XPression Maps software is currently running in Server mode on your
network and that its Web Interface  settings are properly configured.

To log in to the HTML5 Client:

1. In the HTML5 Client Login page, enter your Username and Password.

2. Select Log in.

The HTML5 Client Home page is displayed.

XPression Maps HTML5 Client - Home Page

« If you are unable to log in to the HTML5 Client, contact your XPression Maps administrator to

ensure that your user account is activated in the user management system.
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To log out of the HTML5 Client:

·  From the User Management Menu located at the top-right corner of the window, select Log Out.
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Procedural Overview for Creating or Editing Scenes

Given the versatility of XPression Maps software and the unique nature of your creative and business
needs, establishing a standard usage procedure can be challenging. However, the following procedures
provide basic guidance for how to use a scene template to create a scene for a still or animated map
graphic, as well as how to create a new scene from an existing scene.

Creating a scene for a still map graphic

Creating a scene for an animated flight map graphic

Creating a new scene from an existing scene

« Scenes can be edited in both the HTML5 Client and the main XPression Maps application, but scene

templates can only be created and edited in the main application. See Loading and Editing a Scene
Template  and Editing Scenes Created in the HTML5 Client  for more information about editing
template or scenes in the main XPression Maps application.

To create a scene for a still map graphic:

1. With the XPression Maps application in Server mode, open the XPression Maps HTML5 Client in a
web browser and sign in to the application.

2. From the New tab, select a template group folder.

3. From the Results panel, select the tile of the scene template from which you want to build a still map
graphic.

« Scene templates for creating still map graphics are marked with the Still icon .

The scene template opens on the Canvas.

4. Position the map on the Canvas to display the required location and camera view.

5. (Optional) Modify the content or characteristics of the scene: 

· Add or edit the labels, drawings, shapes or user predefined objects in the scene.

· Change the language of the scene's map layers.

· Change the level of detail of the map's OSM layers.

· Change the size of the scene Safe Title Area.

6. Save the changes to the scene.

7. (Optional) Preview an image of the still map scene in the HTML5 Client. 

8. (Optional) Download an image file of the map scene.

9. (Optional) Transfer the scene to your host graphics system.
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To create a scene for an animated flight map graphic:

1. With the XPression Maps application in Server mode, open the XPression Maps HTML5 Client in a
web browser and sign in to the application.

2. From the New tab, select a template group folder.

3. From the Results panel, select the tile of the scene template from which you want to build an animated
flight map graphic.

« Scene templates for creating animated flight map graphics are marked with the Clip icon .

The scene template opens on the Canvas.

4. Modify, if necessary, characteristics of the map.

· Change the language of the scene's map layers.

· Change the level of detail of the map's OSM layers.

· Change the size of the scene Safe Title Area. 

5. View and, if necessary, edit the starting flight point (Point 1).

6. View and, if necessary, edit the second flight point (Point 2).

7. Add and configure additional flight points (Point 3+).

8. Save the changes to the scene.

9. (Optional) Preview the playback of the animated map scene in the HTML5 Client.

10.(Optional) Download a video file of the animated map scene.

11.(Optional) Transfer the scene to your host graphics system.

To create a new scene from an existing saved scene:

1. With the XPression Maps application in Server mode, open the XPression Maps HTML5 Client in a
web browser and sign in to the application.

2. From the Saved tab, select the folder containing the scene that you want to create the new scene
from.

3. In the Results panel, locate the tile of the scene that you want to create the new scene from.

4. On the scene's tile, hover over the 3 dots and select Duplicate Scene to create a new copy of the
scene. 

5. Make changes to the scene, as needed.

6. (Optional) Preview the rendered map scene in the HTML5 Client.

7. Save the new scene by entering a new name and description, choosing a folder, and selecting Save

 icon.

8. (Optional) Download a video or image file of the map scene.

9. (Optional) Transfer the scene to your host graphics system.
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Opening a Scene Template

When the HTML5 Client is open to the Home page, selecting the New tab displays a list of template
group folders . Selecting a folder reveals its templates in the Results pane on the right. Each template
appears as a tile with fields and icons that indicate its type and key characteristics. Selecting a tile opens
the template, allowing you to view and edit it to create a customized map scene.

« The HTML5 Client supports role-based folder access, so only the folders associated with the current

user's profile permissions are displayed. If you do not see the required folder listed, contact your
XPression Maps administrator to verify that your user account is part of the proper user group based on
the folder's attributes.

# Description

1 Preview — A thumbnail image of the map scene to help visually identify the template.

2 Type — Identifies the type of scene template: 

 Still for creating static image map scenes

 Clip for creating animated flight map scenes

3
 Name — The name of the scene template.

4
 Duration — The amount of time (in seconds) of the scene's playback from the first frame to the

last frame.

5
 Timestamp — The date and time at which the scene template was last saved in the XPression

Maps Server database.

6
 Description — An optional note from the scene template creator that often explains its content

or purpose.

To open a scene template in the HTML5 Client:

1. From the Home page, select the New tab.

2. Select the folder containing the template you want to open.

« If you do not see the required folder listed, contact your XPression Maps administrator to verify that

your user account is part of the proper user group based on the folder's attributes.  

3. In the Results window, select the template you want to open.

The Results pane is replaced on the Canvas, which now displays the template, which can be edited,
saved and rendered. 
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Opening a Scene

When the HTML5 Client is open to the Home page, selecting the Saved tab displays a list of scene
folders. Selecting a folder reveals its scenes in the Results pane on the right. Each scene appears as a tile
with fields and icons that indicate its type and key characteristics. Selecting a tile opens the scene,
allowing you to view, edit or render it into a map graphic.

« The HTML5 Client supports role-based folder access, so only the folders associated with the current

user's profile permissions are displayed. If you do not see the required folder listed, contact your
XPression Maps administrator to verify that your user account is part of the proper user group based on
the folder's attributes.

# Description

1
 Media ID — Drag the Media ID icon directly into an XPression scene to import the saved scene

into an XPression project.

2 Preview — A thumbnail image of the map scene to help visually identify it.

3 Type — Identifies the type of scene: 

 Still for static image map scenes

 Clip for animated flight map scenes

4
 Name — The name of the scene.

5
 Menu Options — Exposes the following commands that can be performed to the scene:

· Duplicate Scene — Creates a copy of the scene and opens it for editing and saving as a new scene
without affecting the original scene.

· Delete Scene — Permanently deletes the scene from the XPression Maps Server database.

6 Scene Icon — Indicates the rendering status of the scene. The following icons show the current
state:

Folder Add — A final rendering is in progress.

 Folder Check —  A final rendering exists.

Folder Close —  The final rendering was removed; a new rendering is required.

Folder Empty — No final rendering exists; a rendering is required. 

7
 Duration — The amount of time (in seconds) of the scene's playback from the first frame to the

last frame.
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# Description

8
 Timestamp — The date and time at which the scene was last saved in the XPression Maps

Server database.

9
 Description — An optional note from the scene's creator that often explains its content or

purpose.

10
 User — The user profile name of the last person to save changes to the scene.

To open a scene:

1. From the Home page, select the Saved tab.

2. Select the folder containing the scene you want to open.

« If you do not see the required folder listed, contact your XPression Maps administrator to verify that

your user account is part of the proper user group based on the folder's attributes.  

3. In the Results window, select the scene you want to open.

The Results pane is replaced on the Canvas, which now displays the scene, which can be edited,
saved, and rendered. 
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Duplicating a Scene

Duplicating a scene allows you to make a copy of an existing scene, make edits and then save it under a
different name. This creates a new scene, while keeping the original unchanged. It is an effective way to
quickly make variations of a scene map graphic without having to invest the time to create from new each
time.

Duplicating a scene is also required when changing the OSM Language of a map. If you modify the original
scene instead of duplicating it first, the changes will affect the original drawing and may impact MOS
workflow publishing. 

To duplicate a scene and save it as a new scene:

1. From the Home page, select the Saved tab.

2. Select the folder containing the scene you want to duplicate.

3. In the Results pane, locate the tile of the scene and hover over the 3 Dots menu to expose the menu
options. 

4. Select Duplicate Scene.

 

5. Make changes to the scene, as needed.

6. Save the new scene with a new name.

a. Select the Save tab.

b. In the Name field, enter a new name for the scene.

c. In the Description field, enter a description of the scene (optional).

d. In the Folder field, select the folder icon at the right of the field and select the folder to which you
want to save the scene. 

e. Select the Save  icon.
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Deleting a Scene

When the HTML5 Client is on the Home page, selecting the Saved tab displays a list of Scene folders
along with the scenes they contain. If the current user has the Delete Saved Scenes privilege, they can
remove  scenes from the XPression Maps Server database.

To delete a scene:

1. From the Home page, select the Saved tab.

2. Select the folder containing the scene you want to delete.

3. In the Results pane, locate the tile of the scene and hover over the 3 Dots menu to expose the menu
options. 

4. Select Delete Scene.

HTML5 Client - Delete Scene

3. In the confirmation dialog that opens, select Yes to delete the scene.
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Changing OpenStreetMap (OSM) Layer Settings

When a scene template or scene uses an OSM map style, the OSM section in the Scene tab allows you to
control the level of detail for OSM layer elements, like Information, Water, Roads, and Road Signs.
These settings help simplify the map by adjusting the visibility of specific features.

« OSM settings activation is managed at the scene level using checkboxes. For animated flight map

graphics, the level of detail (slider position) for each enabled layer can be adjusted individually for
each flight point.

HTML5 Client - OSM Layer Settings

To adjust and control the OSM layer settings:

1. Open a template or scene that uses an OSM-styled map.

2. For an animated flight graphic, select the desired flight point from the Flight Point toolbar.

3. Select the Scene tab.

4. In the OSM section, select the checkbox of the layer for which you want to adjust the level of detail.

5. Move the sliders to set the level of detail for the layers:

· Slide right to display more water, roads, or road signs.

OR 

· Slide left to reduce the number of visible features.

« The INFO Layers option does not include a slider. Its checkbox simply toggles the visibility of the

map’s Information layer.

6. For animated flights, select a different flight point from the Flight Point toolbar and repeat step 5 to
customize detail levels as needed.

« As shown in the image above, the activation of the OSM settings (checkboxes) must remain

consistent across all flight points. However, slider positions (level of detail) can vary per flight point.

7. After adjusting the sliders, use the checkboxes to apply or remove OSM layer setting for the scene's
map.
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Changing the Language of a Scene

In the XPression Maps HTML5 Client, you can change the language of OpenStreetMap labels in a scene by
selecting a language from a predefined list of country code translations. See Configuring Languages  for
information on translation codes.

«The language setting is applied to the map at the scene level. When building an animated flight map,

the language setting will be identical at all flight points.

Important: Duplicate the saved map before changing its language. If you edit the original scene, it will
be overwritten with the new language setting. See Duplicating a Scene  for more information. 

To change the language of a scene:

1. Open the template or scene on the Canvas.

2. In the Scene tab, in the Language section, select a language from the Country drop-down. 

The language on the Canvas is updated. 

3. In the Save tab, save the new language setting to the scene.
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Modifying the Safe Title Area

The Safe Title Area is the area inside of the Canvas defined by the white rectangles. Content inside this
area will be fully visible on air. The Safe Title Area is defined in the main application but you can decide
whether or not to use it in the HTML5 Client. You can also select the style of the safe title area.

«The Safe Title Area settings are applied at the scene level. When building an animated flight map, these

settings will be the same at each flight point.

To modify the Safe Title Area:

1. Open the template or scene onto the Canvas.

2. In the Scene tab, in the Safe Title area, do one of the following:

Select the checkbox to use the configured safe title area.

OR

Deselect the checkbox to use the entire Canvas.

3. From the Style drop-down, select how the safe title area should be displayed. 

The options are:

· Fullscreen — the map credits appear in the bottom corners of the scene

· OTS (Over the shoulder) — the map credits appear centered in the scene 

4. In the Save tab, save the changes made to the scene.
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Adding, Editing or Deleting Flight Points

XPression Maps generates multi-flight point animations by moving the map from one flight point to the
next. In the HTML5 Client, authorized newsroom users can create story-specific animated flight map
scenes by loading a Clip scene template and editing, adding, or deleting flight points as needed.

When a Clip scene template  is loaded in the HTML5 Client, the Flight Point toolbar appears above
the Canvas, which contains the following controls and settings for editing, adding and deleting flight
points from the current animated map scene. 

# Description

1 Flight — This read-only value shows the total duration (in seconds) of the flight map animation. By
default, it's based on the scene template's Clip Length plus the total Pause time for all flight points.
Adding or deleting flight points or making changes to a flight point's Pause value automatically
updates this duration without altering the original template.

2 Point — This read-only value indicates the index of the currently selected flight point in the
animation, where the starting point is 1, the second is 2, etc.). Use the arrow buttons to step forward
or backward between flight points on the Canvas and Flight Point toolbar settings.

3 Name — This field lets you assign a descriptive name to the flight point, making it easier to identify
or distinguish from others in the animation.

4 Pause — This value shows the duration (in seconds) of the pause at the start of a flight point before
continuing to the next flight point. Enter a value directly or use the arrows to increment/decrement
the value. Changes to a flight point's Pause value automatically updates this Flight duration without
altering the original template.

5 Set — Selecting the Set button   applies the current flight point's settings to the scene, including
updates to the Name, Pause duration, and any adjustments made on the Canvas (e.g., map
position, camera view, or flight mode drawings). Note that all changes to a flight point must also be
saved to the scene.

6 Add — Selecting the Add button  appends a new flight point to the end of the animation. Flight
points cannot be directly inserted or reordered; instead, you must delete and re-add them in the
desired sequence. Adding a flight point automatically updates the Flight duration without affecting
the original template.

7 Delete — Selecting the Delete button  deletes the currently selected flight point from the
animation. Since flight points cannot be directly inserted or reordered; you must delete and re-add
them in the desired sequence. Deleting a flight point automatically updates the Flight duration
without affecting the original template.



360 • Creating and Managing Scenes in the HTML5 Client XPression Maps User Guide (v4.0)

The following topics are discussed in this section:

Editing an existing flight point

Adding a new flight point

Deleting a flight point

« See Creating a scene for an animated flight map graphic  for an overview of how to use multiple

flight points to build an animated flight map graphic. 

To edit an existing flight point:

1. Open the clip template or scene onto the Canvas.

2. In the Flight Point toolbar, use the Point field to select the index number of the flight point to be
edited.

3. Make changes, if necessary, to the selected flight point.

Possible edits may include: 

· changing the flight point's name

· adjusting the flight point's Pause duration

· repositioning the map location or changing the camera view settings

· adding or removing Flight Mode labels or drawings

4. Select the Set button   to apply the changes to the flight point.

5. When you've finished editing the scene, go to the Save tab and save your changes.

To add a new flight point:

1. Open the clip template or scene onto the Canvas.

2. In the Flight Point toolbar, select the Add button  to append a new flight point to the end of the
animation.

The Point field indicates the number of the new flight point, with the first flight point being 0.

3. Make changes to the new flight point.

Possible edits may include: 

· changing the flight point's name

· adjusting the flight point's Pause duration

· repositioning the map location or changing the camera view settings

· adding or removing Flight Mode labels or drawings

4. Select the Set button   to apply the changes to the flight point.

5. When you've finished editing the scene, go to the Save tab and save your changes.
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To delete a flight point:

1. Open the clip template or scene onto the Canvas.

2. In the Flight Point toolbar, use the Point field to select the index number of the flight point to be
deleted.

3. Select the Delete button .

The flight point is immediately deleted from the scene and the number of flight points in the Point field
is updated.

4. When you've finished editing the scene, go to the Save tab and save your changes.
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Positioning the Map in the HTML5 Client

When creating a still map graphic or flight points for an animated map graphic, you’ll want to adjust the
position and perspective of the active map on the Canvas to focus on a specific location or area of
interest. 

The following topics describe the various methods for adjusting the geographic location, positioning and
perspective of the active map on the Canvas:

Manually adjusting the positioning of the map

Repositioning to a Searched location

Repositioning using OSM Elements

Repositioning using the Camera settings

To manually adjust the positioning of the map:

· With the template or scene loaded onto the Canvas, use your mouse to reposition the map:

Ø Rotate: Left-click and drag to rotate the globe or map in the desired direction. 

Ø Zoom: Use the mouse scroll wheel, or right-click and drag a rectangle around the area of interest. 

Ø Tilt: Hold Ctrl and drag left or right with the mouse to tilt the map.

Ø Roll (sphere projection only): Hold Ctrl and drag left or right with the mouse to roll the globe. Roll is
not available when using Mercator or Linear projections. 

To use Search to position the map to a specific location:

1. With the template or scene loaded onto the Canvas, select the Search tab.

2. In the Location section, enter the name of the geographic location (e.g., address, city, state, or
country) or a landmark.

3. If you want the map to go directly to the location you are searching, select the Go to Result checkbox.

4. Select the Search button  to run the search query.

The search results are displayed in an expandable list in the Results section. 

5. From the Results section, select the desired location.
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To position the map using an OSM element:

1. With an OpenStreetMap (OSM) style map open on the Canvas, select the Search tab.

2. In the OSM Information section, use the tree structure—populated with OSM elements currently
visible on the Canvas —to locate the desired element.

3. To narrow down the results, type the name of the OSM element in the filter box. 

Use the Aa checkbox to toggle case-sensitive filtering.

4. Select the desired OSM element from the tree.

 The map will immediately center on the selected location.

To use the Camera settings to position the map:

1. With the template or scene loaded onto the Canvas, select the Scene tab.

2. In the Camera section, edit one or more of the following fields to reposition the map to the desired
geographic location and camera perspective.

« The map on the Canvas updates instantly with any changes to the Camera settings.

Longitude The geographic longitudinal value, in degrees, of the location at the center of
the Canvas.

Latitude The geographic latitudinal value, in degrees, of the location at the center of the
Canvas.

GPS The precise GPS latitude and longitude coordinates (DMS format) of the map's
center location on the Canvas.

Tilt Rotates the globe around the point of the world that is closest to the camera.

Roll Spins the globe clockwise and counter-clockwise along the axis visible on the
Canvas.

Zoom Level Sets the camera distance to the earth landscape. The furthest (zoom out) value
is 0 and the closest (zoom in) value is 240.
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Adding, Editing and Deleting Shapes

In the XPression Maps HTML5 Client, you can add a shape to any location that exists in the shape
database. You can also edit the shape by changing the shape's opacity level or applying a different shape
style from among the styles included in the template group.

The following topics are discussed in this section:

Adding a shape to a scene

Editing a shape that has been added to a scene

Deleting a shape from a scene

To add a shape to a scene:

1. Open the template or scene to which you want to add a shape.

2. In the Search tab, enter the location for which you want to add a shape and select the Search button

 or press Enter.

3. In the Shapes section, select the location for which you want to add a shape and then select the +
sign to the right of the location to add the default shape to the scene.

The new shape appears on the map. The shape appears at the Zoom level set in the shape style, so
you may have to zoom in or out (using the scroll wheel on your mouse) in order to see the new shape. 

4. In the Save tab, save the changes made to the scene.

To edit a shape that has been added to a scene:

1. Open the template or scene you want to edit.

2. On the Canvas, select the shape.

3. In the Edit tab, from the Style drop-down, select a different shape style.

« Only shape styles that were added to the template group appear in the drop-down list.

HTML5 Client - Edit Shape

4. In the Opacity field, enter a value or use the up and down arrows to change the transparency of the
shape.

5. In the Save tab, save the changes made to the scene. 
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To delete a shape from a scene:

1. Open the template or scene you want to edit.

2. On the Canvas, select the shape you want to delete.

3. In the Edit tab, in the Action parameter, select the Delete Shape button .

HTML5 Client - Delete Shape Button

Alternatively, with the shape selected, press the Delete key.
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Adding, Editing and Deleting Labels

In the XPression Maps HTML5 Client, newsroom users can add labels within a scene to identify or highlight
specific locations or landmarks. These labels are text drawings that include an editable text element, and
some may also feature a graphical marker such as a pin or dot.

HTML5 Client - Label Menu and Edit Label Properties

The available label styles are determined by those added to the template group and can be accessed
within the Label menu when a template or scene is loaded in the HTML5 Client. While a label's style
cannot be changed, its text, position, size, and visibility can be modified. You can also set a default label
for the current scene, which overrides the template’s default label.

Thumbnails in the Label menu that display an airplane icon  indicate that the Flight Mode property is
enabled. These labels are intended for use in flight map animations and allow visibility to be toggled at the
individual flight point level. Labels without the airplane icon are controlled at the scene level.  

The following topics are discussed in this section:

Adding a label to a scene

Adding a default label to a scene

Overriding a default label on the scene

Editing a label's text, position and visibility properties

Adjusting a label's position, size or visibility from within the scene

Deleting a label from a scene
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To add a label to a scene:

1. Open the template or scene to which you want to add a label.

2. Reposition the map on the Canvas to the location where you want to add a label.

3. Select the arrow beside the XPression Maps title to open the Label and Drawing menus.

HTML5 Client - Labels and Drawings Menus

4. From the Labels list, select the label style you want to use and drag it to the desired location.

Thumbnails containing an airplane icon   indicate that the label's Flight Mode property is enabled.
These labels should only be added to flight points when creating scenes for flight map animations.

The label appears at the Zoom level set in the label style, so you may have to zoom in or out (using
the scroll wheel on your mouse) in order to see the new label.

Alternatively, you can set a default label style to use in any scene in the current folder. See To add a
default label  for more information. 

5. After adding a label to the map on the Canvas, you can adjust its properties—such as text content,
position, size, and visibility—to suit your needs. See Editing a label's text, position and visibility
properties  and Adjusting a label's position, size or visibility from within the scene .

To add a default label to a scene:

1. Open the template or scene to which you want to add a label.

2. In the Search tab, in the Location field, enter the location to which you want to add a label and select
the Search icon to generate results.

3. Select the arrow beside the XPression Maps title to open the Label and Drawing menus.

4. Select the Label tab and locate the label that you want to use.

5. Select the three dots in the top-right corner of the label and select Set Default.

HTML5 Client - Set Default Drawing
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6. In the Result section, select the + sign beside the location for which you want to add a label.

To override a default label on the scene:

· Select a different label style and drag it on top of the default label, to change only that instance of the
label. 

To edit a label's text, position and visibility properties:

1. Open the template or scene you want to edit.

2. On the Canvas, select the label you want to edit.

3. In the Edit tab, in the Drawing section, adjust the following properties as necessary.

Property Description

Action Place the label on top of or behind other text in the scene or
delete the label.

Zoom Enter a value or use the arrows to adjust the size of the label
in relation to the map.

Longitude, Latitude
and Rotation

Enter a value or use the arrows to adjust the position of the
label.

GPS The GPS coordinates of the label.

Size Enter a value or use the arrows to adjust the absolute size of
the label.

Frontface Select to have the front side of the label face the camera. 

Auto Zoom Select to have the label stay the same size, regardless of the
Zoom Level.

Visible Select if you want the label to be visible or deselect to hide
the label.

Zoom In

Zoom Out

Enter or use the arrows to select a camera Zoom value at
which the label will be visible or hidden.

If the camera Zoom value is larger than the Zoom Out
value, the label will not be visible.

If the camera Zoom value is smaller than the Zoom In
value, the label will not be visible.

Visible In Delay

Visible Out Delay

When the label's Flight Mode property is enabled (indicated

by an airplane icon  ), these values determine how long
after the start or before the end of the flight point the label
will be shown or hidden.

4. In the Text section, you can change the text of the label.

5. When you’ve finished modifying the label, save your new scene. 
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To adjust a label's position, size or visibility from within the scene:

1. Select a label on the Canvas.

The bounding box and its tools are displayed around the selected label.

 

HTML5 Client — Label Examples - Bounding Box and Tools

2. Use the tools to change the size, position and appearance of the label as described in the table below:

Tool How to Use the Tool

Center Point Select and hold, then drag to move the label around the
scene.

You can also select and hold anywhere inside the
bounding box to move the label.

Corner Points

and

Lower
Boundary

Select and hold a corner point, then drag to scale the
label.

If the label includes an image (e.g., a pin), select and
hold the lower boundary to adjust the distance between
the label's image and its text. 

Handle Select and hold the lower end of the handle, then drag
to rotate the label.

Scale Select to toggle the Auto Zoom property, which is
located in the Edit tab's Text Drawing section. When
selected, the label remains the same size as you zoom
in and out on the map. When the Auto Zoom checkbox
is cleared, the label will scale larger when you zoom in
and smaller when you zoom out on the map.

Eye Icon Select to toggle the visibility of the label at the scene
level.

Shown when the label's Visibility > Flight Mode
property is not selected.

Airplane Icon Select to toggle the visibility of the label at the flight
point level of a flight map animation.

Available when the label's Visibility > Flight Mode
property is selected.
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Tool How to Use the Tool

Face Icon When the map is tilted, select to toggle the placement
of a label, either angled to match the map surface or
perpendicular to the map surface and facing the
camera. 

For labels that are created on the Overlay Layer, this
icon does not appear.

To delete a label from a scene:

1. Open the template or scene you want to edit.

2. On the Canvas, select the label you want to delete.

3. In the Edit tab, select the Delete Drawing button.

HTML5 Client - Delete Drawing Button

Alternatively, with the label selected, press the Delete key.
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Adding, Editing, Deleting and Ordering Drawings

In the XPression Maps HTML5 Client, newsroom users can enhance the visual and informational quality of a
map graphic by adding drawings anywhere within a scene. The available drawing options are dictated by
those included in the template group and appear in the Drawing menu when a template or scene is
loaded.

Once a drawing is added, users can adjust various properties—such as position, size, and visibility—either
through the drawing settings in the Edit tab or by using controls directly on the Canvas. Additionally,
users can specify a default drawing for the current scene, which will override the template’s default
drawing.

HTML5 Client - Edit Tab and Drawing Menu

Thumbnails in the Drawing menu that display an airplane icon  indicate that the Flight Mode property
is enabled. These drawings are intended for use in flight map animations and allow visibility to be toggled
at the individual flight point level. Drawings without the airplane icon are controlled at the scene level.  

The following topics are discussed in this section:

Adding a drawing to a scene

Editing a drawing's properties

Adjusting a drawing's position, size or visibility from within the scene

Replacing a drawing on the scene

Setting a default text drawing

Deleting a drawing from the scene

Changing the order of drawings on the scene
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To add a drawing to a scene:

1. Open the template or scene to which you want to add a drawing.

2. Select the arrow beside the XPression Maps title to open the Label and Drawing menus.

HTML5 Client - Drawing List

3. In the Drawing list, select the drawing that you want to add to the scene and then select the point on
the map where you want to place the drawing.

For Line and Area drawings, select and drag the mouse on the map until the line or area is complete.

Thumbnails containing an airplane icon   indicate that the drawing's Flight Mode property is
enabled. These drawings should only be added to flight points when creating scenes for flight map
animations.

Alternatively, you can set a default label style to use in any scene in the current folder. See To add a
default label  for more information. 

4. After adding a drawing to the map on the Canvas, you can adjust its properties—such as text content,
position, size, and visibility—to suit your needs. See Editing a drawing's properties  and Adjusting a
drawing's position, size or visibility from within the scene .

To edit a drawing's properties:

1. Open the template or scene you want to edit.

2. On the Canvas, select the drawing you want to edit.

3. In the Edit tab, in the Drawing section, adjust the following properties as required.

Property Description

Action Place the drawing on top of or behind other drawings in the scene or delete the
drawing.

Zoom Enter a value or use the arrows to adjust the size of the drawing in relation to
the map.

Longitude

Latitude

Enter a value or use the arrows to adjust the geographic location of the drawing.

GPS Enter the GPS coordinates of the drawing.
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Property Description

Rotation Enter a value or use the arrows to adjust the rotation position of the drawing.

Size Enter a value or use the arrows to adjust the absolute size of the drawing.

Frontface Select to have the front side of the drawing face the camera.

Auto Zoom When checked, the drawing remains the same size in pixels, while the camera
animates through the different zoom levels.

When unchecked, the drawing increases or decreases in size as the camera
animates through the different zoom levels.

Visible Select if you want the drawing to be visible or deselect to hide the drawing.

Zoom In

Zoom Out

Enter or use the arrows to select a camera Zoom value at which the drawing
will be visible or hidden.

If the camera Zoom value is larger than the Zoom Out value, the drawing will
not be visible.

If the camera Zoom value is smaller than the Zoom In value, the drawing will
not be visible.

Visible In Delay

Visible Out Delay

When the drawing's Flight Mode property is enabled (indicated by an airplane

icon  ), these values determine how long after the start or before the end of
the flight point the drawing will be shown or hidden.

Locator Applies to Locator drawings only.

Zoom Level — Enter or select a zoom level between 1 and 21 to define how
much of the map is displayed in the highlighted area. A higher zoom level value
means a smaller map area is shown, but it appears closer to the camera.

Zoom — Enter or select a zoom value for the highlighted area of a map.

0 - 1: The area appears closer to the camera.

>1: The area appears further from the camera.

The resolution of the map is not changed, so it does not show more or fewer
details when zoomed in or out.

Offset X — Enter or select a value to move the highlighted area within the
drawing along the X coordinate.

Offset Y — Enter or select a value move the highlighted area within the drawing
along the Y coordinate.

Magnifier Applies to Magnifier drawings only.

Zoom Level — Enter or select a zoom level between 1 and 21 to define how
much of the map is displayed in the highlighted area. A higher zoom level value
means a smaller map area is shown, but it appears closer to the camera.

Zoom — Enter or select a zoom value for the highlighted area of a map.

0 - 1: The area appears closer to the camera.

>1: The area appears further from the camera.

The resolution of the map is not changed, so it does not show more or fewer
details when zoomed in or out.

Offset X — Enter or select a value to move the highlighted area within the
drawing along the X coordinate.

Offset Y — Enter or select a value move the highlighted area within the drawing
along the Y coordinate.
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Property Description

Mirrored Applies to Icon drawings only. 

Flips the image horizontally creating a reflection or mirroring effect.

Point Applies to Area drawings only.

Index — identifies each point in the drawing based on the order in which it was
added. The selected point turns red.

Longitude — Enter a value or use the arrow to adjust the longitudinal position
of the selected Index point.

Latitude — Enter a value or use the arrow to adjust the latitudinal position of
the selected Index point.

Progress Applies to Line drawings only. 

Visualizes the progression of the line being drawn on the map. Use the up and
down arrows to view the placement of the drawing at different intervals. 

Text Applies to Text drawings only.

Use the text box to edit the text on one or more lines. Press the Enter key to
move text to the next line.

Texture Applies to Line and Area drawings that have an image or pattern.

Scale — Multiplies the scale of the drawing. For example, a line drawing of a
road with a scale of 1, will be a single 2-lane road, while a road with a scale of 2
will be a 4-lane road.

Rotation — Increases the rotation of the drawing, making it appear spiraled.

Aspect — Increases or decreases the width of the drawing, relative to the
height.

· If the value is less than 1, the width (X) decreases relative to the height (Y). 

· If the value is greater than 1, the width increases relative to the height. 

4. When you’ve finished modifying the drawing, save your new scene. 
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To adjust a drawing's position, size or visibility from within the scene:

1. Select a drawing on the Canvas.

The bounding box and its tools are displayed around the selected label.

HTML5 Client — Drawing Example - Bounding Box and Tools

2. Use the tools to change the size, position and appearance of the drawing as described in the table
below:

Tool How to Use the Tool

Center Point Select and hold, then drag to move the drawing around
the scene.

You can also select and hold anywhere inside the
bounding box to move the drawing.

Corner Points

and

Lower
Boundary

Select and hold a corner point, then drag to scale the
drawing.

If the drawing includes text and an image (e.g. a pin),
select and hold the lower boundary to adjust the
distance between the image and its text. 

Handle Select and hold the lower end of the handle, then drag
to rotate the drawing.

Scale Select to toggle the Auto Zoom property, which is
located in the Edit tab's Text Drawing section. When
selected, the label remains the same size as you zoom
in and out on the map. When the Auto Zoom checkbox
is cleared, the label will scale larger when you zoom in
and smaller when you zoom out on the map.

Eye Icon Select to toggle the visibility of the drawing at the scene
level.

Available when the drawing's Visibility > Flight Mode
property is not selected.

Airplane Icon Select to toggle the visibility of the drawing at the flight
point level of a flight map animation.

Shown when the drawing's Visibility > Flight Mode
property is selected.
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Tool How to Use the Tool

Face Icon When the map is tilted, select to toggle the placement
of a drawing, either angled to match the map surface or
perpendicular to the map surface and facing the
camera. 

For drawings that are created on the Overlay Layer,
this icon does not appear.

Double-Ended
Arrow

Select the double-ended arrow to flip the drawing
horizontally.

To replace a drawing that's already in the scene:

1. Open the template or scene you want to edit.

2. From the Drawings list, select a different drawing of the same type (line, area, text, etc.) and drag it
on top of the drawing you want to replace. 

To set a default text drawing:

1. Open the template or scene you want to edit.

2. From the Drawings list, select the text drawing you want to set as a default for all scenes in the
current folder.

3. Select the three dots in the top-right corner of the text drawing you want to use and select Set
Default.

To delete a drawing from a scene:

1. Open the template or scene from which you want to delete a drawing.

2. Select the drawing you want to delete.

3. In the Edit tab, select the Delete Drawing button.

HTML5 Client - Delete Drawing Button

Alternatively, you can select the drawing you want to delete and then press the Delete key.

To order drawings on the scene:

1. Open the template or scene in which you want to reorder the drawings.

2. Select the drawing you want to move.

3. In the Edit tab, select the Move Drawing to Front button to move the drawing to the front.

HTML5 Client - Move Drawing to Front Button

OR

Select the Move Drawing to Back button to move the drawing to the back.

HTML5 Client - Move Drawing to Back Button
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Adding User Predefined Objects

User Predefined Objects that already exists in the User Predefined Objects panel (1) can be added to a
scene template group in the Scene Templates editor (2). This allows newsroom users to access them
through the HTML5 Client (3) and include them in story-specific map scenes. For more information about
User Predefined Objects, see Creating User Predefined Objects  and Adding User Predefined Objects to a
Scene Templates Group .

Access User Predefined Objects from the Predefined Tab in HTML5 Client

To add a user predefined object to a scene:

1. Open the template or scene to which you want to add a user predefined object.

2. Select the Predefined tab.

3. In the User Predefined Objects list, expand the folders to navigate to the desired User Predefined
Object.

4. Add one or all of the User Predefined Objects from the folder to the scene:

· Select the folder's Add button   to add all of the User Predefined Objects in the folder to the
scene.

OR

· Select the Add button   beside an individual User Predefined Objects to only add it to the scene.
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Saving a Scene

Follow the procedure below to save a scene, whether you are saving a new scene based on a template or
working with an existing scene that you’ve edited.

« For instructions on copying an existing scene, see Duplicating a Scene . This process lets you edit

the duplicated scene and save it with a new name, while keeping the original unchanged.

To save a scene:

1. In the Save tab, in the Name field, enter a name for your scene.

HTML5 Client - Save Scene

2. (Optional) In the Description field, enter a description of the scene.

3. In the Folder field, select the folder icon at the right of the field and select the folder to which you
want to save the scene. 

You can only save into an existing folder. Creating new folders requires the Manage Saved Folders
privilege. 

Once you’ve saved a scene, the first time the folder will be selected automatically if you edit the scene
and save it again.

4. Select the Save  icon.

After a scene has been saved, the Media ID icon becomes active and you can drag it into a host
project such as XPression, to play. 

For more information, see Transferring Scenes to a Host Application.
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Previewing and Downloading an Animated Map Graphic
File

During the creation process or after saving a scene, newsroom users can preview a rendered version of the
animated map graphic directly in a video player within the HTML5 Client. If the download option has been
purchased, the scene can also be rendered and the animated map graphic downloaded as a video file.

The following topics are discussed in this section:

Previewing an Animated Map Graphic File

Downloading an Animated Map Graphic File

To preview an animated map graphic file:

1. Load a clip  scene onto the Canvas.

2. Select the Scene tab and in the Scene section, ensure that Type is Clip.

HTML5 Client - Scene - Clip Type

3. Select the Preview button .

The preview clip is rendered and a video player window opens.

4. When you are finished, select Close to close the video player window.

To download an animated map graphic file:

1. Load a clip  scene onto the Canvas.

2. Select the Scene tab and in the Scene section, ensure that Type is Clip.

HTML5 Client - Scene - Clip Type

3. Select the Download button .

4. In the file browser, navigate to the location where you want to save the video file.

5. Give the video file a name and select Save.
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Previewing and Downloading a Still Map Graphic File

During the creation process or after saving a scene, newsroom users can preview a rendered version of the
still map graphic directly within the HTML5 Client. If the download option has been purchased, the scene
can also be rendered and the still map graphic downloaded as an image file.

The following topics are discussed in this section:

Previewing a Still Map Graphic File

Downloading a Still Map Graphic File

To render and preview a still map graphic:

1. Load a still   scene onto the Canvas.

2. Select the Scene tab and in the Scene section, ensure that Type is Still.

HTML5 Client - Scene - Clip Type

3. Select the Preview button .

The image is rendered and displayed in a preview window.

4. Select Close to exit from the Preview window.

To render and download an image file of the still map graphic:

1. Load a still   scene onto the Canvas.

2. Select the Scene tab and in the Scene section, ensure that Type is Still.

HTML5 Client - Scene - Clip Type

3. Select the Preview button .

The image is rendered and displayed in a Preview window.

4. In the Preview window, select Download.

5. In the file browser, navigate to the location where you want to save the image file.

6. Give the image file a name and select Save.

7. Select Close to exit from the Preview window.
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User Management in the HTML5 Client

The XPression Maps HTML5 Client allows administrators to create and manage user accounts by assigning
user privileges and controlling scene folder access based on user group profiles and folder attributes.

The User Management Menu is located in the top-right corner of the HTML5 Client. When the current
user has administrator privileges, the full menu is displayed and offers options to create and manage user
profiles. An administrator can perform the following tasks: 

· View and edit their own user account details.

· Add, configure or delete other user profiles.

· View the performance and capacity status of the XPression Maps Servers on the network.

· Create web user groups that can be assigned to user profiles.

· Create folder attributes and use them to control user access to template and scene folders.

User Management Menu (Users with Administrator Privileges)

A different version of the User Management Menu is available to other users which limits them to
verifying their own user account details, the ability to log out of the HTML5 Client, or to change their user
account password.

User Management Menu (All Other Users)

The following topics are discussed in this section:

Managing Users

Managing Web User Groups

Managing Attributes

Monitoring XPression Maps Servers

Changing your Password
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Managing Users

The Manage Users option in the User Management Menu allows users with administrative privileges to:

Add users and assigning them to a user group

Delete users

Edit user details

To add a user and assign them to a Web Client Group:

1. From the User Management Menu, select Manage Users.

2. In the Manage Users window, select Add User.

The New User form opens.

User Management - New User Form

3. Enter the Username, Password, Repeat Password, First Name and Last Name of the new user.

4. If the user will be an administrator, select the Is Administrator checkbox.

5. From the Web Client Group drop-down, assign the user to a user group.

By default, a set of Web User Groups is already created with the following privileges: 

Artist — Delete Saved Scenes

Journalist — None

Producer — Manage Saved Folders / Delete Saved Scenes

Production — None

Superuser — Manage Saved Folders / Delete Saved Scenes

For more information on user privileges, see Managing Web User Groups .

6. In the E-Mail field, enter an e-mail address for the user (required).

7. In the Phone Number field, enter a phone number for the user (optional).

8. Select Submit to add the user.
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To delete a user:

1. From the User Management Menu, select Manage Users.

The Manage Users window is displayed.

User Management - Manage Users

2. In the Users list, select the user you want to delete.

User Management - User Details

3. In the Details panel, select Delete User. 

4. In the confirmation dialog that opens, select OK to confirm that you want to delete the user.

5. Select Exit to close the Manage Users window.
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To edit user details:

1. From the User Management Menu, select Manage Users.

The Manage Users window is displayed.

User Management - Manage Users

2. From the Users list, select the user whose information you want to edit.

The Details panel is populated with the user’s information.

User Management - User Details

3. Edit the user details as necessary and select Update.

A message appears above the Update button, indicating that the update was successful.

4. Select Exit to close the Manage Users window.
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Managing Web User Groups

A Web User Group is a thematic, often role-based, classification that uses group membership to
determine user privileges and access control.   

By default, a set of Web User Groups is already created with the following privileges: 

· Artist — Delete Saved Scenes

· Journalist — None

· Producer — Manage Saved Folders / Delete Saved Scenes

· Production — None

· Superuser — Manage Saved Folders / Delete Saved Scenes

Only users with administrator privileges can create, edit or delete Web User Groups, as well as enable or
disable privileges for a user group. 

Once a Web User Group is added to the system, users with administrator privileges can also assign a
specific user group to the group. See Managing Users  for more information.

The following topics are discussed in this section:

Editing a Web User Group's details

Adding a new Web User Group

Deleting a Web User Group
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To edit an existing Web User Group:

1. From the User Management Menu, select Web User Groups.

The Manage Web User Groups window for that group is displayed.

User Management - Manage Web User Groups

2. In the Group section, select the group you want to edit.

The Details panel is populated with the group’s details.

User Management - Web User Group Details

3. In the Details panel, in the Group Name field, edit the name of the group or leave it unchanged.

4. Select or deselect the checkboxes to assign privileges to the group.

In the Web User Groups, the options are: 

· Manage Saved Folders — The user will be able to add and delete Group folders and Sub-folders
and edit the folder names.

· Delete Saved Scenes — The user will be able to delete scenes from the Saved tab.

· Folder Attributes — The user will have access to template and scene folders associated with these
folder attributes.

5. Select Update to save your changes.

6. Select Exit to close the Manage Web User Groups screen.
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To add a new Web User Group:

1. From the User Management Menu, select Web User Groups.

The Manage Web User Groups window for that group is displayed.

User Management - Manage Web User Groups 

2. Select Add User Group.

The Details panel is ready to be populated with the group’s details.

User Management - Web User Group Details

3. In the Details panel, in the Group Name field, enter a name for the group.

4. In the Details panel, select or deselect the checkboxes to assign privileges to the group.

The options are: 

· Manage Saved Folders — The user will be able to add and delete Group folders and Sub-folders
and edit the folder names.

· Delete Saved Scenes — The user will be able to delete scenes from the Saved tab.

· Folder Attributes — The user will have access to template and scene folders associated with these
folder attributes.
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5. Select Update to save your changes.

The user group is immediately added to the list in the Group section.

6. Select Exit to close the Manage Web User Groups window.

To delete a user group:

1. From the User Management Menu, select Web User Groups.

The Manage User Groups window for that group is displayed.

User Management - Manage Web User Groups

2. In the Group section, select the group you want to delete.

User Management - Web User Group Details

3. Select Delete. 

The user group is immediately removed from the list.

4. Select Exit to close the Manage Web User Groups window.
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Managing Attributes

An attribute is a user-defined label (e.g., Evening News) that can be assigned to one or more template or
scene folders as the condition for whether a user group is granted access to the folder and its contents. 

« Only users who have administrator privileges can add or delete attributes from the system.

The following sections describe how to create, delete and edit folder attributes:

Adding a new attribute

Deleting an attribute

Editing an attribute

Once an attribute is added to the system, see Folder Management  for instructions on how to assign
folder attributes to user groups.

To add a new attribute:

1. From the User Management Menu, select Manage Attributes.

The Manage Attributes window is displayed and lists all of the existing attributes, including the
Default attribute.

User Management - Manage Attributes

2. In the Manage Attributes window, select Add Attribute.

3. In the Details section, enter the Name and Description for the new attribute.

4. Select Update to add the attribute.

A message appears above the Update button, indicating that the update was successful.

5. Select Exit to close the Manage Attributes screen.

The new attribute can now be assigned to various Web User Groups, as necessary. See Managing Web
User Groups  for more information.  
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To delete an attribute:

1. From the User Management Menu, select Manage Attributes.

The Manage Attributes window is displayed.

2. In the Attributes section, select the name of the attribute to be deleted.

3. In the Details section, select Delete.

4. In the confirmation dialog that opens, select OK to confirm that you want to delete the attribute.

The attribute is immediately removed from the Attributes list. It is also no longer available to be
assigned to any user groups and is removed from any user profiles where it was already assigned.

5. Select Exit to close the Manage Attributes screen.

To edit the name and/or description of an attribute:

1. From the User Management Menu, select Manage Attributes.

The Manage Attributes window is displayed.

2. In the Attributes section, select the name of attribute that is to be edited.

3. In the Details section, edit the Name and/or Description.

4. Select Update to apply the changes to the attribute.

A message appears above the Update button, indicating that the update was successful.

5. Select Exit to close the Manage Attributes screen.
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Monitoring the Status of XPression Maps Servers

Users with administrator privileges can access the Server State window to view the collective
performance statistics of the XPression Maps Servers on the network. Additionally, individual XPression
Maps Servers can be monitored to view their current capacity, performance and user activity.

The following topics are described in this section:

Viewing the collective status of all XPression Maps Servers on the network

Viewing the status of a specific XPression Maps Server

HTML5 Client - Server State Window

To view the collective performance and capacity of all active XPression Maps Servers on the
network:

1. From the User Management Menu, select Server State.

2. In the upper table of the Server State window, review the following statistics that represent the
overall status of all active XPression Maps Servers on your network.

· Avg. Load — The average processing load across all active servers.

· Total Load — The combined processing load of all active servers.

· Total Free Edit Slots (FES) — The total number of available edit slots across all active servers.

· Total Free Clip Slots — The total number of available clip slots across all active servers. 

3. Select Refresh (lower-left) to update the table with the latest data.

4. Select Exit to close the Server State window.
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To view the current status of a specific XPression Maps Server on the network:

1. From the User Management Menu, select Server State.

2. In the Server section of the Server State window, review the list of XPression Maps Servers (active or
inactive) that are on the network.

Server State Window

The following information is displayed for each server listed in the table:

· Name — The computer name of the XPression Maps Server.

· ID — Displays the row number used to reference server data in the Server table.

· Active — Displays Yes if the server is connected/active, or No if the server is disconnected/down.

· Load — The total load of the server calculated from the FES and FCS.

· FES — (Free Edit Slots) — The number of free slot user can use to edit a map.

· FCS — (Free Clip Slots) — The number of slots which can be used by the XPression Maps Gateway to
render final clips.

· Instance — The name of the specific XPression Maps Server instance, which is useful when multiple
instances are running in the same location.
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3. In the Server section, select an active server to display a list of details. 

Server State Details

The following information is displayed in the Details table:

· ID — Displays the row number used to reference user data in the Details table.

· Active — Displays Yes if a user is actively logged in on the slot, or No if a user is not actively logged
in on the slot.

· User — The user name of the user that is currently logged in. 

· Host — The IP address of the host computer from where the user is logging in.

· Edit Start — The timestamp (date and time) of when the user logged in.

« All data is visible in the table until a new user logs in to a slot and overwrites the values.

4. Select Refresh (lower-left) to update the window the latest data.

5. Select Exit to close the Server State window.
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Changing your Password

Any user can change their own password.

To change your password:

1. From the User Management Menu in the upper-right corner, select Account.

The User Details window opens.

User Management - Change Password

2. In the Change Password section, in the Old Password field, enter your current password and then
enter your new password twice. 

3. Select Save and then select Exit to close the User Details window.
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Folder Management in the HTML5 Client

In the HTML5 Client, scene templates are organized in a folder structure in the New tab on the Home
page, while scenes are organized in folders in the Saved tab. 

When the logged in user has the Manage Saved Folders privilege, the Folder Management toolbar
appears below the tabs and allows the user to add, edit, delete and rename folders and sub-folders.

HTML5 Client - New and Saved Folder Management

The HTML5 Client can also be configured to use a role-based folder access system to control user access
to the template and scene folders using folder attributes and user group conditions.

The following topics are discussed in this section:

Managing Folders

Folder Access Control
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Managing Folders

Users who have been assigned the privilege of Manage Saved Folders can add, edit or delete folders and
sub-folders using the Folder Management toolbar.

HTML5 Client - Folder Management Toolbar

· Add New Folder — Adds a new folder.

· Add New Sub-Folder — Adds a sub-folder to the selected folder. This button only appears when the
Saved tab is selected. 

· Delete Folder — Deletes the selected folder from the system.

· Edit Folder — Allows you to rename the folder, edit its description, and edit the folder's attributes
assignment.

« The Folder Management menu options are also accessible by right-clicking on a folder. 

The following topics are discussed in this section:

Adding a new folder

Adding a sub-folder

Deleting a folder

Editing an existing folder
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To add a folder and assign folder attributes:

1. Select the New or Saved tab.

2. Select the Add New Folder icon.

HTML5 Client - Add New Folder Icon

3. In the New Folder dialog, enter a Name for the folder and a brief Description of the folder.

HTML5 Client - Add New Folder

4. In the Folder Attributes section, enable the attributes that will determine whether the folder will be
accessible to certain user groups. 

5. Select OK.

To add a sub-folder to a Saved scene folder:

1. In the Saved tab, select the folder to which you want to add a sub-folder.

2. Select the Add New Sub-Folder icon.

HTML5 Client - Add New Sub-Folder Icon

3. In the New Sub-Folder dialog, enter a Name and Description for the sub-folder.

HTML5 Client - Add New Sub-Folder

4. Select OK.
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To delete a folder:

1. Select the New or Saved tab.

2. Select the folder or sub-folder you want to delete and select the Delete Folder icon.

HTML5 Client - Delete Folder Icon

3. In the Delete Folder dialog, select the checkbox to confirm that you want to delete the folder and all
its contents and then select Delete.

HTML5 Client - Delete Folder

To edit a folder's name, description and/or attribute assignments:

1. Select the New or Saved tab.

2. Select the folder or sub-folder you want to edit and select the Edit Folder icon.

HTML5 Client - Edit Folder icon

3. In the Edit Folder dialog, enter a new Name and/or Description for the folder.

HTML5 Client - Edit Folder

4. In the Folder Attributes section, enable or clear the attributes that determine whether the folder will
be accessible to certain user groups.

5. Select OK.
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Folder Access Control

The XPression Maps HTML5 Client uses a folder access system to control template and scene folder
access to users assigned to particular user groups. More specifically, it's the association of attributes
assigned to folders and user group membership that determines which folders are visible or hidden from
the logged in user. 

For example, you could configure the system so that users associated with the 'Journalist' user group have
access to folders with the 'Evening News' attribute, but 'Production' user group members won't have
access since their user group doesn't include the 'Evening News' attribute.

Setting up the role-based folder access control system involves:

1. Create a folder attribute. 

See Managing Attributes  for more information. 

Manage Attributes - Attribute Details

2. Assign attributes to the folder. 

See Managing Folders  for more information. 

New Folder - Folder Attributes
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3. Assign attributes to the Web User Groups.

See Managing Groups  for more information. 

Manage User Groups - Folder Attributes

385
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Creating a Static Map Image File
During the creation process or after completing a scene, the Snapshot tool allows you to capture and
render a static image—either of a still map graphic or a single frame from an animated map graphic. The
image can be saved in .jpg, .png, or .tga format.

To render a still map graphic and create an image file:

1. Display the map content on the Canvas.

If the active scene contains an animation, use the animation slider in the Animation Editor to scrub
through the animation until you locate the frame that contains the map content that you want to
capture as an image.

2. From the menu bar select Output > Snapshot  or select the Snapshot button in the toolbar.

XPression Maps Toolbar - Snapshot

3. In the Save dialog, navigate to the folder in which you want to save the image file.

4. In the File name field, enter a name for the image file.

5. From the File Type drop-down, select the file format for your image.

The options are .jpg, .png and .tga.

6. Select Save.
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Creating an Animated Map Video File
During the creation process or after completing a scene, the Record Animation function allows you to
capture and render the full animation of a scene. The recorded animated map graphic can be saved in
either .avi or .ffmpeg format.

The following topics are discussed in this section:

Recording an Animation as an AVI File

Recording an Animation in ffmpeg Format
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Recording an Animation as an AVI File

Record the animation of your scene as an AVI (Audio Video Interleaved) file using the Record Animation
function.

The following topics are discussed in this section:

Recording an Animation as an AVI File

Stopping the Recording of the Animation

Playing Back the Recorded Animation File

To record an animation as an AVI file:

1. Select Output > Record Animation in the menu bar or select Record Animation in the toolbar.

XPression Maps Toolbar - Record Animation

The Animation Recording dialog opens.

Animation Recording - AVI

2. Select the AVI tab if it is not already selected.

3. In the Output section, select Browse ( ) beside the File field, to navigate to the location where you
want to save the video file.

The Save Video dialog opens.

4. In the Save Video dialog, in the File name field, enter a name for the video file and select Save.

In the Animation Recording dialog, in the Output section, the File field is populated with the path to
the video file.

5. Select the Overwrite File checkbox if you want to overwrite an existing copy of the animation or clear
the checkbox if you want to keep existing copies and create a new video file.

If you choose not to overwrite an existing copy, you need to change the file name.
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6. In the Configuration section, select AVI Setup to open the Video Compression dialog.

AVI Video Compression

a. Select a video compressor from the drop-down and select OK.

Some options will activate the Compression Quality slider and/or the Configure button and
require further configuration. 

« Video compression options depend on system capabilities. 

b. Select OK when you have finished configuring the video compression.

7. In the Save Format File, select a video format file and select Save.

8. When you have finished configuring the output, select Record to record your animation.

The Animation Recording progress dialog opens. When the recording is complete, the dialog closes.

Animation Recording Progress Dialog - AVI

To stop recording an animation:

· In the Animation Recording dialog, select Cancel or select the Stop Animation Recording button in
the toolbar.

XPression Maps Toolbar - Stop Animation Recording

To play a recorded animation:

1. Navigate to the folder in which you’ve saved your recorded animations.

2. Double-click the recording you want to play. 
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Recording an Animation in ffmpeg Format

Record the animation of your scene into one of several ffmpeg file formats using the Record Animation
function.

The following topics are discussed in this section:

Recording an Animation as an ffmpeg File

Stopping the Recording of the Animation

Playing Back the Recorded Animation File

To record an animation in an ffmpeg file format:

1. Select Output > Record Animation in the menu bar or select the Record Animation button in the
toolbar.

Maps Toolbar Record Animation

The Animation Recording dialog opens.

Animation Recording - ffmpeg

2. Select the ffmpeg tab if it is not already selected.

3. In the Output section, select Browse ( ) beside the File field, to navigate to the location where you
want to save the video file.

The Save Video dialog opens.

4. In the Save Video dialog, in the File name field, enter a name for the video file and select Save.

Include the appropriate file extension in your file name.

In the Animation Recording dialog, in the Output section, the File field is populated with the path to
the video file.

5. Select the Overwrite File checkbox if you want to overwrite an existing copy of the animation or clear
the checkbox if you want to keep existing copies and create a new video file.

If you choose not to overwrite an existing copy, you need to change the file name.
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6. When you have finished configuring the output, select Record to record your animation.

The Animation Recording to ffmpeg progress dialog opens. When the recording is complete, the
dialog closes.

Animation Recording Progress Dialog - ffmpeg

To stop recording an animation:

· In the Animation Recording dialog, select Cancel or select the Stop Animation Recording button in
the toolbar.

XPression Maps Toolbar - Stop Animation Recording

To play a recorded animation:

1. Navigate to the folder in which you’ve saved your recorded animations.

2. Double-click the recording you want to play. 
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Appendix A: Keyboard Shortcuts
Shortcuts for the following menus and windows are included in this section:

File Menu Shortcuts

Edit Menu Shortcuts

Output Menu Shortcuts

Animation Menu Shortcuts

Interactive Menu Shortcuts

Canvas Shortcuts

File Menu Shortcuts

Command Shortcut

New CTRL+N

Open CTRL+O

Save CTRL+S

Save As CTRL+SHIFT+S

Export CTRL+E

Open Recent Used CTRL+0...4

Exit CTRL+Q
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Edit Menu Shortcuts

Command Shortcut

Undo CTRL+Z

Redo CTRL+Y

Copy Drawing CTRL+C

Cut Drawing CTRL+X

Paste Drawing CTRL+V

Move Drawing to Top CTRL+Page Up

Move Drawing Up CTRL+Up

Move Drawing Down CTRL+Down

Move Drawing to Bottom CTRL+Page Down

Next Animation Key Frame CTRL+Right Arrow

Previous Animation Key
Frame

CTRL+Left Arrow

Add Camera Key Frame CTRL+,

Add Drawing Key Frame CTRL+.

Delete Selected Key Frames CTRL+D

Output Menu Shortcuts

Command Shortcut

Snapshot CTRL+P

Record Animation CTRL+R
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Interactive Menu Shortcuts

«The Interactive menu is only available when XPression Maps is running in Interactive mode.

Command Shortcut

Execute F5

Animation Menu Shortcuts

Command Shortcut

Rewind Animation CTRL+B

Play Animation CTRL+Space Bar

Continue Animation CTRL+G

Stop Animation CTRL+H

Forward Animation CTRL+M

Canvas Shortcuts

Command Shortcut

Toggle Framerate Display F

Select Previous Point (shape,
area object, or line object)

Left Arrow

Select Next Point (shape,
area object, or line object)

Right Arrow

Delete drawing or point
(shape, area drawing, line
drawing)

Delete

To enter Full Screen Mode F11

To exit Full Screen Mode Esc
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Appendix B: Managing Network
Security
Secure Sockets Layer (SSL) protocol protects sensitive information as it travels across computer
networks. It provides privacy, critical security and data integrity.

This section describes how to enable the SSL protocol in XPression Maps.

An SSL certificate must be purchased and used with  the XPression Maps Gateway  and the XPression
Maps Designer application. Purchase an SSL certificate from a trusted root authority (our certificates are
purchased from DigiCert, so these instructions will use the steps for DigiCert as an example).

Buying an SSL Certificate

To purchase an SSL certificate, a CSR file must be generated and sent to the certificate authority. The
CSR file describes the server machine that will hold the certificate as well as your Company and
Organization details.

The CSR can usually be generated using a tool provided by the certificate authority (or they will provide
documentation on how to generate the CSR).

Using the SSL Certificate

The certificate authority will provide you with the SSL certificate files. 

To use the certificates:

Copy the certificate chain file (.crt) and the unencrypted private key (.key) into the following locations:

· C:\Program Files\XPression Maps\bin64\certs

· C:\Program Files\XPression Maps Gateway\certs
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To configure the Maps Gateway:

1. Navigate to C:\Program Files\XPression Maps Gateway\bin64\MapsGatewayConfig.xml.

MapsGatewayConfig.xml

2. In the editor, change the SSL value to 1 and the HttpServer Port to 443.

3. Select File > Save.

4. Open the Windows Computer Management application and from Services and Applications, select
Services > Maps Gateway Service.

Maps Gateway Service

5. In the Services pane, select Restart the service.
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To configure XPression Maps:

1. Launch the XPression Maps application.

2. Go to File > Preferences > Web Interface.

Preferences - Web Interface 

3. In the Web Server Details section, select the SSL checkbox.

4. In the Web Gateway section, change the UI Port from 80 to 443.

5. Select OK and relaunch the application.
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Appendix C: Third Party Licenses
XPression Maps uses software covered by one or more of the licenses described below:

As required by the GNU General Public License, and the Lesser GNU Public License (LGPL), source code can
be obtained from Ross Video for at least 3 years. Contact Ross Video Technical Support for more
information.

Name Version License

Assimp (Open Asset Import
Library)

Assimp License 

Earcut 0.12.4 ISC License

FFmpeg 3.3.3 FFmpeg License

FreeImage 1.0 FreeImage Public License

FreeType FreeType Project License

FreeType Font Engine License

GDAL/OGR GDAL/OGR License

GStreamer and Glib 2.0 GNU Library General Public License

GTS 2.0 GNU Library General Public License

ImageMagick GNU Library General Public License

Libav GNU Lesser General Public License

Noto-emoji Apache License 2.0

Poly2Tri Poly2Tri License 

ProtoZero 1.5.2 Apache License 2.0

Vector Tile 1.0.1 Copyright
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Assimp License

Copyright (c) 2006 - 2025, assimp team.

All rights reserved.

Redistribution and use of this software in source and binary forms, with or without modification, are
permitted provided that the following conditions are met:

· Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer. 

· Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution. 

· Neither the name of the assimp team, nor the names of its contributors may be used to endorse or
promote products derived from this software without specific prior written permission of the assimp
team. 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OR
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL
THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT
OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 

Exception: Applies to all files in the ./test/models-nonbsd folder. These are 3D models for testing
purposes, from various free sources on the internet. They are - unless otherwise stated - copyright of their
respective creators, which may impose additonal requirements on the use of their work. For any of these
models, see <model-name>.source.txt for more legal information. Contact us if you are a copyright holder
and believe that we credited you improperly or if you don't want your files to appear in the repository. 

Earcut License

Copyright (c) 2015, Mapbox

Permission to use, copy, modify, and/or distribute this software for any purpose with or without fee is
hereby granted, provided that the above copyright notice and this permission notice appear in all copies.

THE SOFTWARE IS PROVIDED "AS IS" AND THE AUTHOR DISCLAIMS ALL WARRANTIES WITH REGARD TO
THIS SOFTWARE INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS. IN NO
EVENT SHALL THE AUTHOR BE LIABLE FOR ANY SPECIAL, DIRECT, INDIRECT, OR CONSEQUENTIAL
DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS,
WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR
IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.
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FFmpeg License

FFmpeg is used in this work under the "GNU LESSER GENERAL PUBLIC LICENSE" Version 2.1, February
1999. The files LICENSE.md and COPYING.LGPLv2.1 distributed in Ext_License/FFmpeg contain additional
details. 

Some optional parts of FFmpeg are licensed under the GNU General Public License version 2 or later (GPL
v2+). See the file `COPYING.GPLv2` for details. None of these parts are used by default, you have to
explicitly pass `--enable-gpl` to configure to activate them. In this case, FFmpeg's license changes to GPL
v2+.

Specifically, the GPL parts of FFmpeg are:

- libpostproc

- optional x86 optimization in the files

    - `libavcodec/x86/flac_dsp_gpl.asm`

    - `libavcodec/x86/idct_mmx.c`

    - `libavfilter/x86/vf_removegrain.asm`

- the following building and testing tools

    - `compat/solaris/make_sunver.pl`

    - `doc/t2h.pm`

    - `doc/texi2pod.pl`

    - `libswresample/swresample-test.c`

    - `tests/checkasm/*`

    - `tests/tiny_ssim.c`

- the following filters in libavfilter:

    - `vf_blackframe.c`

    - `vf_boxblur.c`

    - `vf_colormatrix.c`

    - `vf_cover_rect.c`

    - `vf_cropdetect.c`

    - `vf_delogo.c`

    - `vf_eq.c`

    - `vf_find_rect.c`

    - `vf_fspp.c`

    - `vf_geq.c`

    - `vf_histeq.c`
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    - `vf_hqdn3d.c`

    - `vf_interlace.c`

    - `vf_kerndeint.c`

    - `vf_mcdeint.c`

    - `vf_mpdecimate.c`

    - `vf_owdenoise.c`

    - `vf_perspective.c`

    - `vf_phase.c`

    - `vf_pp.c`

    - `vf_pp7.c`

    - `vf_pullup.c`

    - `vf_repeatfields.c`

    - `vf_sab.c`

    - `vf_smartblur.c`

    - `vf_spp.c`

    - `vf_stereo3d.c`

    - `vf_super2xsai.c`

    - `vf_tinterlace.c`

    - `vf_uspp.c`

    - `vsrc_mptestsrc.c`

Should you, for whatever reason, prefer to use version 3 of the (L)GPL, then the configure parameter `--
enable-version3` will activate this licensing option for you. Read the file `COPYING.LGPLv3` or, if you
have enabled GPL parts, `COPYING.GPLv3` to learn the exact legal terms that apply in this case.

There are a handful of files under other licensing terms, namely:

· The files `libavcodec/jfdctfst.c`, `libavcodec/jfdctint_template.c` and `libavcodec/jrevdct.c` are taken
from libjpeg, see the top of the files for licensing details. Specifically note that you must credit the IJG
in the documentation accompanying your program if you only distribute executables.

You must also indicate any changes including additions and deletions to those three files in the
documentation.

· `tests/reference.pnm` is under the expat license.

External libraries

FFmpeg can be combined with a number of external libraries, which sometimes affect the licensing of
binaries resulting from the combination.



XPression Maps User Guide (v4.0) Appendix C: Third Party Licenses • 417

Compatible libraries

The following libraries are under GPL:

- frei0r

- libcdio

- librubberband

- libvidstab

- libx264

- libx265

- libxavs

- libxvid

When combining them with FFmpeg, FFmpeg needs to be licensed as GPL as well by passing `--enable-
gpl` to configure.

The OpenCORE and VisualOn libraries are under the Apache License 2.0. That license is incompatible with
the LGPL v2.1 and the GPL v2, but not with version 3 of those licenses. So to combine these libraries with
FFmpeg, the license version needs to be upgraded by passing `--enable-version3` to configure.

Incompatible libraries

There are certain libraries you can combine with FFmpeg whose licenses are not compatible with the GPL
and/or the LGPL. If you wish to enable these libraries, even in circumstances that their license may be
incompatible, pass `--enable-nonfree` to configure. But note that if you enable any of these libraries the
resulting binary will be under a complex license mix that is more restrictive than the LGPL and that may
result in additional obligations.

It is possible that these restrictions cause the resulting binary to be unredistributable.

The Fraunhofer FDK AAC and OpenSSL libraries are under licenses which are incompatible with the GPLv2
and v3. To the best of our knowledge, they are compatible with the LGPL.

The NVENC library, while its header file is licensed under the compatible MIT license, requires a
proprietary binary blob at run time, and is deemed to be incompatible with the GPL. We are not certain if it
is compatible with the LGPL, but we require `--enable-nonfree` even with LGPL configurations in case it is
not.
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FreeImage License

FreeImage Public License - Version 1.0

1. Definitions.

1.1  "Contributor" means each entity that creates or contributes to the creation of Modifications.

1.2  "Contributor Version" means the combination of the Original Code, prior Modifications used by a
Contributor, and the Modifications made by that particular Contributor.

1.3  "Covered Code" means the Original Code or Modifications or the combination of the Original Code
and Modifications, in each case including portions thereof.

1.4  "Electronic Distribution Mechanism" means a mechanism generally accepted in the software
development community for the electronic transfer of data.

1.5  "Executable" means Covered Code in any form other than Source Code.

1.6  "Initial Developer" means the individual or entity identified as the Initial Developer in the Source
Code notice required by Exhibit A.

1.7  "Larger Work" means a work which combines Covered Code or portions thereof with code not
governed by the terms of this License.

1.8  "License" means this document.

1.9  "Modifications" means any addition to or deletion from the substance or structure of either the
Original Code or any previous Modifications. 

When Covered Code is released as a series of files, a modification is:

  A.  Any addition to or deletion from the contents of a file containing Original Code or previous
Modifications.

  B.  Any new file that contains any part of the Original Code or previous Modifications.

1.10 "Original Code" means Source Code of computer software code which is described in the Source
Code notice required by Exhibit A as Original Code, and which, at the time of its release under this License
is not already Covered Code governed by this License.

1.11 "Source Code" means the preferred form of the Covered Code for making modifications to it,
including all modules it contains, plus any associated interface definition files, scripts used to control
compilation and installation of an Executable, or a list of source code differential comparisons against
either the Original Code or another well known, available Covered Code of the Contributor's choice. The
Source Code can be in a compressed  or archival form, provided the appropriate decompression or de-
archiving software is widely available for no charge.

1.12 "You" means an individual or a legal entity exercising rights under, and complying with all of the
terms of, this License or a future version of this License issued under Section 6.1. For legal entities, "You"
includes any entity which controls, is controlled by, or is under common control with You. For purposes of
this definition, "control" means (a) the power, direct or indirect, to cause the direction or management of
such entity, whether by contract or otherwise, or (b) ownership of fifty percent (50%) or more of the
outstanding shares or beneficial ownership of such entity.

2. Source Code License.

2.1. The Initial Developer Grant.

The Initial Developer hereby grants You a world-wide, royalty-free, non-exclusive license, subject to third
party intellectual property claims:

(a) to use, reproduce, modify, display, perform, sublicense and distribute the Original Code (or portions
thereof) with or without Modifications, or as part of a Larger Work; and
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(b) under patents now or hereafter owned or controlled by Initial Developer, to make, have made, use and
sell ("Utilize") the Original Code (or portions thereof), but solely to the extent that any such patent is
reasonably necessary to enable You to Utilize the Original Code (or portions thereof) and not to any
greater extent that may be necessary to Utilize further Modifications or combinations.

2.2. Contributor Grant.

Each Contributor hereby grants You a world-wide, royalty-free, non-exclusive license, subject to third
party intellectual property claims:

(a) to use, reproduce, modify, display, perform, sublicense and distribute the Modifications created by
such Contributor (or portions thereof) either on an unmodified basis, with other Modifications, as Covered
Code or as part of a Larger Work; and

(b) under patents now or hereafter owned or controlled by Contributor, to Utilize the Contributor Version
(or portions thereof), but solely to the extent that any such patent is reasonably necessary to enable You
to Utilize the Contributor Version (or portions thereof), and not to any greater extent that may be
necessary to Utilize further Modifications or combinations.

3. Distribution Obligations.

3.1. Application of License.

The Modifications which You create or to which You contribute are governed by the terms of this License,
including without limitation Section 2.2. The Source Code version of Covered Code may be distributed only
under the terms of this License or a future version of this License released under Section 6.1, and You
must include a copy of this License with every copy of the Source Code You distribute. You may not offer
or impose any terms on any Source Code version that alters or restricts the applicable version of this
License or the recipients' rights hereunder. However, You may include an additional document offering the
additional rights described in Section 3.5.

3.2. Availability of Source Code.

Any Modification which You create or to which You contribute must be made available in Source Code form
under the terms of this License either on the same media as an Executable version or via an accepted
Electronic Distribution Mechanism to anyone to whom you made an Executable version available; and if
made available via Electronic Distribution Mechanism, must remain available for at least twelve (12)
months after the date it initially became available, or at least six (6) months after a subsequent version of
that particular Modification has been made available to such recipients. You are responsible for ensuring
that the Source Code version remains available even if the Electronic Distribution Mechanism is maintained
by a third party.

3.3. Description of Modifications.

You must cause all Covered Code to which you contribute to contain a file documenting the changes You
made to create that Covered Code and the date of any change. You must include a prominent statement
that the Modification is derived, directly or indirectly, from Original Code provided by the Initial Developer
and including the name of the Initial Developer in (a) the Source Code, and (b) in any notice in an
Executable version or related documentation in which You describe the origin or ownership of the Covered
Code.

3.4. Intellectual Property Matters.

(a) Third Party Claims.

If You have knowledge that a party claims an intellectual property right in particular functionality or code
(or its utilization under this License), you must include a text file with the source code distribution titled
"LEGAL" which describes the claim and the party making the claim in sufficient detail that a recipient will
know whom to contact. If you obtain such knowledge after You make Your Modification available as
described in Section 3.2, You shall promptly modify the LEGAL file in all copies You make available
thereafter and shall take other steps (such as notifying appropriate mailing lists or newsgroups)
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reasonably calculated to inform those who received the Covered Code that new knowledge has been
obtained.

(b) Contributor APIs.

If Your Modification is an application programming interface and You own or control patents which are
reasonably necessary to implement that API, you must also include this information in the LEGAL file.

3.5. Required Notices.

You must duplicate the notice in Exhibit A in each file of the Source Code, and this License in any
documentation for the Source Code, where You describe recipients' rights relating to Covered Code. If You
created one or more Modification(s), You may add your name as a Contributor to the notice described in
Exhibit A. If it is not possible to put such notice in a particular Source Code file due to its structure, then
you must include such notice in a location (such as a relevant directory file) where a user would be likely
to look for such a notice. You may choose to offer, and to charge a fee for, warranty, support, indemnity or
liability obligations to one or more recipients of Covered Code. However, You may do so only on Your own
behalf, and not on behalf of the Initial Developer or any Contributor. You must make it absolutely clear
than any such warranty, support, indemnity or liability obligation is offered by You alone, and You hereby
agree to indemnify the Initial Developer and every Contributor for any liability incurred by the Initial
Developer or such Contributor as a result of warranty, support, indemnity or liability terms You offer.

3.6. Distribution of Executable Versions.

You may distribute Covered Code in Executable form only if the requirements of Section 3.1-3.5 have been
met for that Covered Code, and if You include a notice stating that the Source Code version of the Covered
Code is available under the terms of this License, including a description of how and where You have
fulfilled the obligations of Section 3.2. The notice must be conspicuously included in any notice in an
Executable version, related documentation or collateral in which You describe recipients' rights relating to
the Covered Code. You may distribute the Executable version of Covered Code under a license of Your
choice, which may contain terms different from this License, provided that You are in compliance with the
terms of this License and that the license for the Executable version does not attempt to limit or alter the
recipient's rights in the Source Code version from the rights set forth in this License. If You distribute the
Executable version under a different license You must make it absolutely clear that any terms which differ
from this License are offered by You alone, not by the Initial Developer or any Contributor. You hereby
agree to indemnify the Initial Developer and every Contributor for any liability incurred by the Initial
Developer or such Contributor as a result of any such terms You offer.

3.7. Larger Works.

You may create a Larger Work by combining Covered Code with other code not governed by the terms of
this License and distribute the Larger Work as a single product. In such a case, You must make sure the
requirements of this License are fulfilled for the Covered Code.

4. Inability to Comply Due to Statute or Regulation.

If it is impossible for You to comply with any of the terms of this License with respect to some or all of the
Covered Code due to statute or regulation then You must: (a) comply with the terms of this License to the
maximum extent possible; and (b) describe the limitations and the code they affect. Such description must
be included in the LEGAL file described in Section 3.4 and must be included with all distributions of the
Source Code. Except to the extent prohibited by statute or regulation, such description must be sufficiently
detailed for a recipient of ordinary skill to be able to understand it.

5. Application of this License.

This License applies to code to which the Initial Developer has attached the notice in Exhibit A, and to
related Covered Code.
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6. Versions of the License.

6.1. New Versions.

Floris van den Berg may publish revised and/or new versions of the License from time to time. Each
version will be given a distinguishing version number.

6.2. Effect of New Versions.

Once Covered Code has been published under a particular version of the License, You may always continue
to use it under the terms of that version. You may also choose to use such Covered Code under the terms
of any subsequent version of the License published by Floris van den Berg

No one other than Floris van den Berg has the right to modify the terms applicable to Covered Code
created under this License.

6.3. Derivative Works.

If you create or use a modified version of this License (which you may only do in order to apply it to code
which is not already Covered Code governed by this License), you must (a) rename Your license so that
the phrases "FreeImage", `FreeImage Public License", "FIPL", or any confusingly similar phrase do not
appear anywhere in your license and (b) otherwise make it clear that your version of the license contains
terms which differ from the FreeImage Public License. (Filling in the name of the Initial Developer, Original
Code or Contributor in the notice described in Exhibit A shall not of themselves be deemed to be
modifications of this License.)

7. DISCLAIMER OF WARRANTY.

COVERED CODE IS PROVIDED UNDER THIS LICENSE ON AN "AS IS" BASIS, WITHOUT WARRANTY OF ANY
KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, WITHOUT LIMITATION, WARRANTIES THAT THE
COVERED CODE IS FREE OF DEFECTS, MERCHANTABLE, FIT FOR A PARTICULAR PURPOSE OR NON-
INFRINGING. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE COVERED CODE IS WITH
YOU. SHOULD ANY COVERED CODE PROVE DEFECTIVE IN ANY RESPECT, YOU (NOT THE INITIAL
DEVELOPER OR ANY OTHER CONTRIBUTOR) ASSUME THE COST OF ANY NECESSARY SERVICING, REPAIR
OR CORRECTION. THIS DISCLAIMER OF WARRANTY CONSTITUTES AN ESSENTIAL PART OF THIS LICENSE.
NO USE OF ANY COVERED CODE IS AUTHORIZED HEREUNDER EXCEPT UNDER THIS DISCLAIMER.

8. TERMINATION.

This License and the rights granted hereunder will terminate automatically if You fail to comply with terms
herein and fail to cure such breach within 30 days of becoming aware of the breach. All sublicenses to the
Covered Code which are properly granted shall survive any termination of this License. Provisions which,
by their nature, must remain in effect beyond the termination of this License shall survive.

9. LIMITATION OF LIABILITY.

UNDER NO CIRCUMSTANCES AND UNDER NO LEGAL THEORY, WHETHER TORT (INCLUDING NEGLIGENCE),
CONTRACT, OR OTHERWISE, SHALL THE INITIAL DEVELOPER, ANY OTHER CONTRIBUTOR, OR ANY
DISTRIBUTOR OF COVERED CODE, OR ANY SUPPLIER OF ANY OF SUCH PARTIES, BE LIABLE TO YOU OR
ANY OTHER PERSON FOR ANY INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES OF ANY
CHARACTER INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF GOODWILL, WORK STOPPAGE,
COMPUTER FAILURE OR MALFUNCTION, OR ANY AND ALL OTHER COMMERCIAL DAMAGES OR LOSSES,
EVEN IF SUCH PARTY SHALL HAVE BEEN INFORMED OF THE POSSIBILITY OF SUCH DAMAGES. THIS
LIMITATION OF LIABILITY SHALL NOT APPLY TO LIABILITY FOR DEATH OR PERSONAL INJURY RESULTING
FROM SUCH PARTY'S NEGLIGENCE TO THE EXTENT APPLICABLE LAW PROHIBITS SUCH LIMITATION. SOME
JURISDICTIONS DO NOT ALLOW THE

EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THAT EXCLUSION AND
LIMITATION MAY NOT APPLY TO YOU.
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10. U.S. GOVERNMENT END USERS.

The Covered Code is a "commercial item," as that term is defined in 48 C.F.R. 2.101 (Oct. 1995),
consisting of "commercial computer software" and "commercial computer software documentation," as
such terms are used in 48 C.F.R. 12.212 (Sept. 1995). Consistent with 48 C.F.R. 12.212 and 48 C.F.R.
227.7202-1 through 227.7202-4 (June 1995), all U.S. Government End Users acquire Covered Code with
only those rights set forth herein.

11. MISCELLANEOUS.

This License represents the complete agreement concerning subject matter hereof. If any provision of this
License is held to be unenforceable, such provision shall be reformed only to the extent necessary to make
it enforceable. This License shall be governed by Dutch law provisions (except to the extent applicable
law, if any, provides otherwise), excluding its conflict-of-law provisions. With respect to disputes in which
at least one party is a citizen of, or an entity chartered or registered to do business in, the The
Netherlands: (a) unless otherwise agreed in writing, all disputes relating to this License (excepting any
dispute relating to intellectual property rights) shall be subject to final and binding arbitration, with the
losing party paying all costs of arbitration; (b) any arbitration relating to this Agreement shall be held in
Almelo, The Netherlands; and (c) any litigation relating to this Agreement shall be subject to the
jurisdiction of the court of Almelo, The Netherlands with the losing party responsible for costs, including
without limitation, court costs and reasonable attorneys fees and expenses. Any law or regulation which
provides that the language of a contract shall be construed against the drafter shall not apply to this
License.

12. RESPONSIBILITY FOR CLAIMS.

Except in cases where another Contributor has failed to comply with Section 3.4, You are responsible for
damages arising, directly or indirectly, out of Your utilization of rights under this License, based on the
number of copies of Covered Code you made available, the revenues you received from utilizing such
rights, and other relevant factors. You agree to work with affected parties to distribute responsibility on an
equitable basis.

EXHIBIT A.

"The contents of this file are subject to the FreeImage Public License Version 1.0 (the "License"); you may
not use this file except in compliance with the License. You may obtain a copy of the License at
http://home.wxs.nl/~flvdberg/freeimage-license.txt

Software distributed under the License is distributed on an "AS IS" basis, WITHOUT WARRANTY OF ANY
KIND, either express or implied. See the License for the specific language governing rights and limitations
under the License.
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FreeType License

XPression Maps uses software covered by one or both of the licenses described below:

FreeType Project License

FreeType Font Engine License

FreeType Project License

2006-Jan-27   Copyright 1996-2002, 2006 by David Turner, Robert Wilhelm, and Werner Lemberg

Introduction

The FreeType Project is distributed in several archive packages; some of them may contain, in addition to
the FreeType font engine, various tools and contributions which rely on, or relate to, the FreeType Project.

This license applies to all files found in such packages, and which do not fall under their own explicit
license. The license affects thus the FreeType font  engine, the test programs, documentation and
makefiles, at the very least.

This license was inspired by the BSD, Artistic, and  IJG (Independent JPEG  Group) licenses, which all
encourage inclusion and use of free software in commercial and freeware products alike. As a
consequence, its main points are that:

• We don't promise that this software works. However, we will be interested in any kind of bug reports.
(`as is' distribution)

• You can use this software for whatever you  want, in parts or full form, without having to pay us.
(`royalty-free' usage)

• You may not pretend that you wrote this software.  If you use it, or only parts of it, in a program, you
must acknowledge somewhere in your documentation that you have used the FreeType code (`credits').

  We specifically permit and encourage the inclusion of this software, with  or without modifications, in
commercial products.

  We disclaim all warranties covering The FreeType Project and assume no liability related to The FreeType
Project.

  Finally, many people asked us for a preferred form for a credit/disclaimer to use in compliance with this
license. We thus encourage you to use the following text:

  "Portions of this software are copyright © <year> The FreeType Project (www.freetype.org).  All rights
reserved."

  Please replace <year> with the value from the FreeType version you actually use.

Legal Terms

0. Definitions

Throughout this license, the terms `package', `FreeType Project', and `FreeType archive' refer to the set
of files originally distributed by the authors (David Turner, Robert Wilhelm, and Werner Lemberg) as the
`FreeType Project', be they named as alpha, beta or final release.

`You' refers to the licensee, or person using the project, where `using' is a generic term including
compiling the project's source code as well as linking it to form a `program' or `executable'. This program
is referred to as  `a program using the FreeType engine'.

423

425
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This license applies to all files distributed in the original FreeType Project, including all source code,
binaries and documentation, unless otherwise stated in the file in its original, unmodified form as
distributed in the original archive. If you are unsure whether or not a particular file is covered by this
license, you must contact us to verify this.

The FreeType Project is copyright (C) 1996-2000 by David Turner, Robert Wilhelm, and Werner Lemberg.
All rights reserved except as specified below.

1. No Warranty

THE FREETYPE PROJECT IS PROVIDED `AS IS' WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, WARRANTIES OF MERCHANTABILITY AND FITNESS
FOR A PARTICULAR PURPOSE. IN NO EVENT WILL ANY OF THE AUTHORS OR COPYRIGHT HOLDERS BE
LIABLE FOR ANY DAMAGES CAUSED BY THE USE OR THE INABILITY TO USE, OF THE FREETYPE
PROJECT.

2. Redistribution

This license grants a worldwide, royalty-free, perpetual and irrevocable right and license to use,
execute, perform, compile, display, copy, create derivative works of, distribute and sublicense the
FreeType Project (in both source and object code forms) and derivative works thereof for any purpose;
and to authorize others to exercise some or all of the rights granted herein, subject to the following
conditions:

• Redistribution of source code must retain this license file (`FTL.TXT') unaltered; any additions,
deletions or changes to the original files must be clearly indicated in accompanying documentation. The
 copyright notices of the unaltered, original  files must be preserved in all copies of source files.

• Redistribution in binary form must provide a disclaimer that states that the software is based in part
of the work of the FreeType Team, in the distribution documentation. We also encourage you to put an
URL to the FreeType web page in your documentation, though this isn't mandatory.

These conditions apply to any software derived from or based on the FreeType Project, not just the
unmodified files. If you use our work, you must acknowledge us. However, no fee need be paid to us.

3. Advertising

Neither the FreeType authors and contributors nor you shall use the name of the other for commercial,
advertising, or promotional purposes without specific prior written permission.

We suggest, but do not require, that you use one or more of the following phrases to refer to this
software in your documentation or advertising materials: `FreeType Project',  `FreeType Engine',
`FreeType library', or `FreeType Distribution'.

As you have not signed this license, you are not required to accept  it. However, as the FreeType
Project is copyrighted material, only this license, or another one contracted with the authors, grants
you  the right to use, distribute, and modify it. Therefore, by using, distributing, or modifying the 
FreeType Project, you indicate that you understand and accept all the terms of this license.

4. Contacts

There are two mailing lists related to FreeType:

· freetype@nongnu.org

Discusses general use and applications of FreeType, as well as future and wanted additions to the
library and distribution. If you are looking for support, start in this list if you haven't found anything to
help you in the documentation.

· freetype-devel@nongnu.org

Discusses bugs, as well as engine internals, design issues, specific licenses, porting, etc.

Our home page can be found at  http://www.freetype.org.

mailto:freetype@nongnu.org
mailto:freetype-devel@nongnu.org
http://www.freetype.org
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FreeType Font Engine License

This means that *you* must choose *one* of the two licenses described below, then obey all its terms and
conditions when using FreeType 2 in any of your projects or products.

· The FreeType License, found in the file `FTL.TXT', which is similar to the original BSD license *with* an
advertising clause that forces you to explicitly cite the FreeType project in your product's documentation.
All details are in the license file. This license is suited to products which don't use the GNU General
Public License.

Note that this license is compatible to the GNU General Public License version 3, but not version 2.

· The GNU General Public License version 2, found in `GPLv2.TXT' (any later version can be used also), for
programs which already use the GPL. Note that the FTL is incompatible with GPLv2 due to its
advertisement clause.

The contributed BDF and PCF drivers come with a license similar to that of the X Window System. It is
compatible to the above two licenses (see file src/bdf/README and src/pcf/README).

The gzip module uses the zlib license (see src/gzip/zlib.h) which too is compatible to the above two
licenses.



426 • Appendix C: Third Party Licenses XPression Maps User Guide (v4.0)

GDAL/OGR License

This file attempts to include all licenses that apply within the GDAL/OGR source tree, in particular any that
are supposed to be exposed to the end user for credit requirements for instance. The contents of this file
can be displayed from GDAL commandline utilities using the --license commandline switch. 

GDAL/OGR General

In general GDAL/OGR is licensed under an MIT/X style license with the following terms:

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated documentation files (the "Software"), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies
of the Software, and to permit persons to whom the Software is furnished to do so, subject to the
following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions
of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED,
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR
PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE
LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT
OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR
OTHER DEALINGS IN THE SOFTWARE.

gdal/frmts/gtiff/tif_float.c

Copyright (c) 2002, Industrial Light & Magic, a division of Lucas Digital Ltd. LLC All rights reserved.

• Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

• Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

• Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

• Neither the name of Industrial Light & Magic nor the names of its contributors may be used to endorse or
promote products derived from this software without specific prior written permission. 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL
THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT
OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

gdal/frmts/hdf4/hdf-eos/*

Copyright (C) 1996 Hughes and Applied Research Corporation

Permission to use, modify, and distribute this software and its documentation for any purpose without fee
is hereby granted, provided that the above copyright notice appear in all copies and that both that
copyright notice and this permission notice appear in supporting documentation.

gdal/frmts/pcraster/libcsf
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Copyright (c) 1997-2003, Utrecht University All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

· Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

· Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

· Neither the name of Utrecht University nor the names of its contributors may be used to endorse or
promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL
THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT
OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

gdal/frmts/grib/degrib/*

The degrib and g2clib source code are modified versions of code produced by NOAA NWS and are in the
public domain subject to the following restrictions:

http://www.weather.gov/im/softa.htm

DISCLAIMER The United States Government makes no warranty, expressed or implied, as to the
usefulness of the software and documentation for any purpose. The U.S. Government, its instrumentalities,
officers, employees, and agents assumes no responsibility (1) for the use of the software and
documentation listed below, or (2) to provide technical support to users. 

http://www.weather.gov/disclaimer.php

The information on government servers are in the public domain, unless specifically annotated otherwise,
and may be used freely by the public so long as you do not 1) claim it is your own (e.g. by claiming
copyright for NWS information -- see below), 2) use it in a manner that implies an endorsement or
affiliation with NOAA/NWS, or 3) modify it in content and then present it as official government material.
You also cannot present information of your own in a way that makes it appear to be official government
information.

The user assumes the entire risk related to its use of this data. NWS is providing this data "as is," and
NWS disclaims any and all warranties, whether express or implied, including (without limitation) any
implied warranties of merchantability or fitness for a particular purpose. In no event will NWS be liable to
you or to any third party for any direct, indirect, incidental, consequential, special or exemplary damages
or lost profit resulting from any use or misuse of this data.

As required by 17 U.S.C. 403, third parties producing copyrighted works consisting predominantly of the
material appearing in NWS Web pages must provide notice with such work(s) identifying the NWS material
incorporated and stating that such material is not subject to copyright protection.

port/cpl_minizip*

This is version 2005-Feb-10 of the Info-ZIP copyright and license. The definitive version of this document
should be available at ftp://ftp.info-zip.org/pub/infozip/license.html indefinitely.

Copyright (c) 1990-2005 Info-ZIP.  All rights reserved.

http://www.weather.gov/im/softa.htm
http://www.weather.gov/disclaimer.php
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For the purposes of this copyright and license, "Info-ZIP" is defined as the following set of individuals:

Mark Adler, John Bush, Karl Davis, Harald Denker, Jean-Michel Dubois, Jean-loup Gailly, Hunter Goatley,
Ed Gordon, Ian Gorman, Chris Herborth, Dirk Haase, Greg Hartwig, Robert Heath, Jonathan Hudson, Paul
Kienitz, David Kirschbaum, Johnny Lee, Onno van der Linden, Igor Mandrichenko, Steve P. Miller, Sergio
Monesi, Keith Owens, George Petrov, Greg Roelofs, Kai Uwe Rommel, Steve Salisbury, Dave Smith, Steven
M. Schweda, Christian Spieler, Cosmin Truta, Antoine Verheijen, Paul von Behren, Rich Wales, Mike White

This software is provided "as is," without warranty of any kind, express or implied.  In no event shall Info-
ZIP or its contributors be held liable for any direct, indirect, incidental, special or consequential damages
arising out of the use of or inability to use this software.

Permission is granted to anyone to use this software for any purpose, including commercial applications,
and to alter it and redistribute it freely, subject to the following restrictions:

1. Redistributions of source code must retain the above copyright notice, definition, disclaimer, and this
list of conditions.

2. Redistributions in binary form (compiled executables) must reproduce the above copyright notice,
definition, disclaimer, and this list of conditions in documentation and/or other materials provided with
the distribution.  The sole exception to this condition is redistribution of a standard UnZipSFX binary
(including SFXWiz) as part of a self-extracting archive; that is permitted without inclusion of this
license, as long as the normal SFX banner has not been removed from the binary or disabled.

3. Altered versions--including, but not limited to, ports to new operating systems, existing ports with new
graphical interfaces, and dynamic, shared, or static library versions--must be plainly marked as such
and must not be misrepresented as being the original source.  Such altered versions also must not be
misrepresented as being Info-ZIP releases--including, but not limited to, labeling of the altered
versions with the names "Info-ZIP" (or any variation thereof, including but not limited to, different
capitalizations), "Pocket UnZip," "WiZ" or "MacZip" without the explicit permission of Info-ZIP.  Such
altered versions are further prohibited from misrepresentative use of the Zip-Bugs or Info-ZIP e-mail
addresses or of the Info-ZIP URL(s).

4. Info-ZIP retains the right to use the names "Info-ZIP," "Zip," "UnZip," "UnZipSFX," "WiZ," "Pocket
UnZip," "Pocket Zip," and "MacZip" for its own source and binary releases.

gdal/ogr/ogrsf_frmts/dxf/intronurbs.cpp

This code is derived from the code associated with the book "An Introduction to NURBS" by David F.
Rogers.  More information on the book and the code is available at:

http://www.nar-associates.com/nurbs/

Copyright (c) 2009, David F. Rogers. All rights reserved.

· Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

· Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

· Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

· Neither the name of the David F. Rogers nor the names of its contributors may be used to endorse or
promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL
THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT
OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)

http://www.nar-associates.com/nurbs/
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HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN ARISING IN ANY WAY OUT OF THE
USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 

gdal/alg/thinplatespline.cpp

IEEE754 log() code derived from: @(#)e_log.c 1.3 95/01/18

Copyright (C) 1993 by Sun Microsystems, Inc. All rights reserved.

Developed at SunSoft, a Sun Microsystems, Inc. business.

Permission to use, copy, modify, and distribute this software is freely granted, provided that this notice is
preserved.
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GStreamer License

GNU LIBRARY GENERAL PUBLIC LICENSE

Version 2, June 1991

Copyright (C) 1991 Free Software Foundation, Inc., 51 Franklin St, Fifth Floor, Boston, MA 02110-1301,
USA

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is
not allowed.

[This is the first released version of the library GPL.  It is numbered 2 because it goes with version 2 of
the ordinary GPL.]

Preamble

The licenses for most software are designed to take away your freedom to share and change it.  By
contrast, the GNU General Public Licenses are intended to guarantee your freedom to share and change
free software--to make sure the software is free for all its users.

This license, the Library General Public License, applies to some specially designated Free Software
Foundation software, and to any other libraries whose authors decide to use it.  You can use it for your
libraries, too.

When we speak of free software, we are referring to freedom, not price.  Our General Public Licenses are
designed to make sure that you have the freedom to distribute copies of free software (and charge for this
service if you wish), that you receive source code or can get it if you want it, that you can change the
software or use pieces of it in new free programs; and that you know you can do these things.

To protect your rights, we need to make restrictions that forbid anyone to deny you these rights or to ask
you to surrender the rights. These restrictions translate to certain responsibilities for you if you distribute
copies of the library, or if you modify it.

For example, if you distribute copies of the library, whether gratis or for a fee, you must give the
recipients all the rights that we gave you.  You must make sure that they, too, receive or can get the
source code.  If you link a program with the library, you must provide complete object files to the
recipients so that they can relink them with the library, after making changes to the library and
recompiling it.  And you must show them these terms so they know their rights.

Our method of protecting your rights has two steps: (1) copyright the library, and (2) offer you this
license which gives you legal permission to copy, distribute and/or modify the library.

Also, for each distributor's protection, we want to make certain that everyone understands that there is no
warranty for this free library.  If the library is modified by someone else and passed on, we want its
recipients to know that what they have is not the original version, so that any problems introduced by
others will not reflect on the original authors' reputations.

Finally, any free program is threatened constantly by software patents.  We wish to avoid the danger that
companies distributing free software will individually obtain patent licenses, thus in effect transforming the
program into proprietary software.  To prevent this, we have made it clear that any patent must be
licensed for everyone's free use or not licensed at all.

Most GNU software, including some libraries, is covered by the ordinary GNU General Public License, which
was designed for utility programs.  This license, the GNU Library General Public License, applies to certain
designated libraries.  This license is quite different from the ordinary one; be sure to read it in full, and
don't assume that anything in it is the same as in the ordinary license.

The reason we have a separate public license for some libraries is that they blur the distinction we usually
make between modifying or adding to a program and simply using it.  Linking a program with a library,
without changing the library, is in some sense simply using the library, and is analogous to running a
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utility program or application program.  However, in a textual and legal sense, the linked executable is a
combined work, a derivative of the original library, and the ordinary General Public License treats it as
such.

Because of this blurred distinction, using the ordinary General Public License for libraries did not
effectively promote software sharing, because most developers did not use the libraries.  We concluded
that weaker conditions might promote sharing better.

However, unrestricted linking of non-free programs would deprive the users of those programs of all
benefit from the free status of the libraries themselves.  This Library General Public License is intended to
permit developers of non-free programs to use free libraries, while preserving your freedom as a user of
such programs to change the free libraries that are incorporated in them.  (We have not seen how to
achieve this as regards changes in header files, but we have achieved it as regards changes in the actual
functions of the Library.)  The hope is that this will lead to faster development of free libraries.

The precise terms and conditions for copying, distribution and modification follow.  Pay close attention to
the difference between a "work based on the library" and a "work that uses the library".  The former
contains code derived from the library, while the latter only works together with the library.

Note that it is possible for a library to be covered by the ordinary General Public License rather than by
this special one.

GNU LIBRARY GENERAL PUBLIC LICENSE

TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION

0. This License Agreement applies to any software library which contains a notice placed by the copyright
holder or other authorized party saying it may be distributed under the terms of this Library General
Public License (also called "this License"). Each licensee is  addressed as "you".  

A "library" means a collection of software functions and/or data prepared so as to be conveniently
linked with application programs (which use some of those functions and data) to form executables.

The "Library", below, refers to any such software library or work which has been distributed under
these terms.  A "work based on the Library" means either the Library or any derivative work under
copyright law: that is to say, a work containing the Library or a portion of it, either verbatim or with
modifications and/or translated straightforwardly into another language.  (Hereinafter, translation is
included without limitation in the term "modification".)

"Source code" for a work means the preferred form of the work for making modifications to it.  For a
library, complete source code means all the source code for all modules it contains, plus any associated
interface definition files, plus the scripts used to control compilation and installation of the library.

Activities other than copying, distribution and modification are not covered by this License; they are
outside its scope.  The act of running a program using the Library is not restricted, and output from
such a program is covered only if its contents constitute a work based on the Library (independent of
the use of the Library in a tool for writing it).  Whether that is true depends on what the Library does
and what the program that uses the Library does.

1. You may copy and distribute verbatim copies of the Library's complete source code as you receive it, in
any medium, provided that you conspicuously and appropriately publish on each copy an appropriate
copyright notice and disclaimer of warranty; keep intact all the notices that refer to this License and to
the absence of any warranty; and distribute a copy of this License along with the Library.

You may charge a fee for the physical act of transferring a copy, and you may at your option offer
warranty protection in exchange for a fee.

2. You may modify your copy or copies of the Library or any portion of it, thus forming a work based on
the Library, and copy and distribute such modifications or work under the terms of Section 1 above,
provided that you also meet all of these conditions:

a) The modified work must itself be a software library.
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b) You must cause the files modified to carry prominent notices stating that you changed the files and
the date of any change.

c) You must cause the whole of the work to be licensed at no charge to all third parties under the terms
of this License.

d) If a facility in the modified Library refers to a function or a table of data to be supplied by an
application program that uses the facility, other than as an argument passed when the facility is
invoked, then you must make a good faith effort to ensure that in the event an application does not
supply such function or table, the facility still operates, and performs whatever part of its purpose
remains meaningful.

(For example, a function in a library to compute square roots has a purpose that is entirely well-defined
independent of the application. herefore, Subsection 2d requires that any application-supplied function
or table used by this function must be optional: if the application does not supply it, the square root
function must still compute square roots.)

These requirements apply to the modified work as a whole.  If identifiable sections of that work are not
derived from the Library, and can be reasonably considered independent and separate works in
themselves, then this License, and its terms, do not apply to those sections when you distribute them
as separate works.  But when you distribute the same sections as part of a whole which is a work based
on the Library, the distribution of the whole must be on the terms of this License, whose permissions
for other licensees extend to the entire whole, and thus to each and every part regardless of who wrote
it.

Thus, it is not the intent of this section to claim rights or contest your rights to work written entirely by
you; rather, the intent is to exercise the right to control the distribution of derivative or collective
works based on the Library.

In addition, mere aggregation of another work not based on the Library with the Library (or with a work
based on the Library) on a volume of a storage or distribution medium does not bring the other work
under the scope of this License.

3. You may opt to apply the terms of the ordinary GNU General Public License instead of this License to a
given copy of the Library. To do this, you must alter all the notices that refer to this License, so that
they refer to the ordinary GNU General Public License, version 2,  nstead of to this License.  (If a newer
version than version 2 of the ordinary GNU General Public License has appeared, then you can specify
that version      instead if you wish.) Do not make any other change in these notices.

Once this change is made in a given copy, it is irreversible for that copy, so the ordinary GNU General
Public License applies to all subsequent copies and derivative works made from that copy.

This option is useful when you wish to copy part of the code of the Library into a program that is not a
library.

4. You may copy and distribute the Library (or a portion or derivative of it, under Section 2) in object code
or executable form under the terms of Sections 1 and 2 above provided that you accompany it with the
complete corresponding machine-readable source code, which must be distributed under the terms of
Sections 1 and 2 above on a medium customarily used for software interchange.

If distribution of object code is made by offering access to copy from a designated place, then offering
equivalent access to copy the source code from the same place satisfies the requirement to distribute
the source code, even though third parties are not compelled to copy the source along with the object
code.

5. A program that contains no derivative of any portion of the Library, but is designed to work with the
Library by being compiled or linked with it, is called a "work that uses the Library".  Such a work, in
isolation, is not a derivative work of the Library, and therefore falls outside the scope of this License.

However, linking a "work that uses the Library" with the Library creates an executable that is a
derivative of the Library (because it contains portions of the Library), rather than a "work that uses the
library".  The executable is therefore covered by this License. Section 6 states terms for distribution of
such executables.

When a "work that uses the Library" uses material from a header file that is part of the Library, the
object code for the work may be a derivative work of the Library even though the source code is not.
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Whether this is true is especially significant if the work can be linked without the Library, or if the work
is itself a library.  The threshold for this to be true is not precisely defined by law.

If such an object file uses only numerical parameters, data structure layouts and accessors, and small
macros and small inline functions (ten lines or less in length), then the use of the object file is
unrestricted, regardless of whether it is legally a derivative work.  (Executables containing this object
code plus portions of the Library will still fall under Section 6.)

Otherwise, if the work is a derivative of the Library, you may distribute the object code for the work
under the terms of Section 6. Any executables containing that work also fall under Section 6, whether
or not they are linked directly with the Library itself.

6. As an exception to the Sections above, you may also compile or link a "work that uses the Library" with
the Library to produce a work containing portions of the Library, and distribute that work under terms
of your choice, provided that the terms permit modification of the work for the customer's own use and
reverse engineering for debugging such modifications.

You must give prominent notice with each copy of the work that the Library is used in it and that the
Library and its use are covered by this License. You must supply a copy of this License. If the work
during execution displays copyright notices, you must include the copyright notice for the Library
among them, as well as a reference directing the user to the copy of this License. Also, you must do
one of these things:

a) Accompany the work with the complete corresponding machine-readable source code for the Library
including whatever changes were used in the work (which must be distributed under Sections 1 and 2
above); and, if the work is an executable linked with the Library, with the complete machine-readable
"work that uses the Library", as object code and/or source code, so that the user can modify the Library
and then relink to produce a modified executable containing the modified Library.  (It is understood
that the user who changes the contents of definitions files in the Library will not necessarily be able to
recompile the application to use the modified definitions.)

b) Accompany the work with a written offer, valid for at least three years, to give the same user the
materials specified in Subsection 6a, above, for a charge no more than the cost of performing this
distribution.

c) If distribution of the work is made by offering access to copy from a designated place, offer
equivalent access to copy the above specified materials from the same place.

d) Verify that the user has already received a copy of these materials or that you have already sent this
user a copy.

For an executable, the required form of the "work that uses the Library" must include any data and
utility programs needed for reproducing the executable from it.  However, as a special exception, the
source code distributed need not include anything that is normally distributed (in either source or
binary form) with the major components (compiler, kernel, and so on) of the operating system on
which the executable runs, unless that component itself accompanies the executable.

It may happen that this requirement contradicts the license restrictions of other proprietary libraries
that do not normally accompany the operating system.  Such a contradiction means you cannot use
both them and the Library together in an executable that you distribute.

7. You may place library facilities that are a work based on the Library side-by-side in a single library
together with other library facilities not covered by this License, and distribute such a combined library,
provided that the separate distribution of the work based on the Library and of the other library
facilities is otherwise permitted, and provided that you do these two things:

a) Accompany the combined library with a copy of the same work based on the Library, uncombined
with any other library facilities.  This must be distributed under the terms of the Sections above.

b) Give prominent notice with the combined library of the fact that part of it is a work based on the
Library, and explaining where to find the accompanying uncombined form of the same work.

8. You may not copy, modify, sublicense, link with, or distribute the Library except as expressly provided
under this License.  Any attempt otherwise to copy, modify, sublicense, link with, or distribute the
Library is void, and will automatically terminate your rights under this License.  However, parties who
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have received copies, or rights, from you under this License will not have their licensesterminated so
long as such parties remain in full compliance.

9. You are not required to accept this License, since you have not signed it.  However, nothing else grants
you permission to modify or distribute the Library or its derivative works.  These actions are prohibited
by law if you do not accept this License.  Therefore, by modifying or distributing the Library (or any
work based on the Library), you indicate your acceptance of this License to do so, and all its terms and
conditions for copying, distributing or modifying the Library or works based on it.

10.Each time you redistribute the Library (or any work based on the Library), the recipient automatically
receives a license from the original licensor to copy, distribute, link with or modify the Library subject
to these terms and conditions.  You may not impose any further restrictions on the recipients' exercise
of the rights granted herein. You are not responsible for enforcing compliance by third parties to this
License.

11.If, as a consequence of a court judgment or allegation of patent infringement or for any other reason
(not limited to patent issues), conditions are imposed on you (whether by court order, agreement or
otherwise) that contradict the conditions of this License, they do not excuse you from the conditions of
this License. If you cannot distribute so as to satisfy simultaneously your obligations under this License
and any other pertinent obligations, then as a consequence you may not distribute the Library at all. 
For example, if a patent license would not permit royalty-free redistribution of the Library by all those
who receive copies directly or indirectly through you, then the only way you could satisfy both it and
this License would be to refrain entirely from distribution of the Library.

If any portion of this section is held invalid or unenforceable under any particular circumstance, the
balance of the section is intended to apply, and the section as a whole is intended to apply in other
circumstances.

It is not the purpose of this section to induce you to infringe any patents or other property right claims
or to contest validity of any such claims; this section has the sole purpose of protecting the integrity of
the free software distribution system which is implemented by public license practices.  Many people
have made generous contributions to the wide range of software distributed through that system in
reliance on consistent application of that system; it is up to the author/donor to decide if he or she is
willing to distribute software through any other system and a licensee cannot impose that choice.

This section is intended to make thoroughly clear what is believed to be a consequence of the rest of
this License.

12.If the distribution and/or use of the Library is restricted in certain countries either by patents or by
copyrighted interfaces, the original copyright holder who places the Library under this License may add
an explicit geographical distribution limitation excluding those countries, so that distribution is
permitted only in or among countries not thus excluded.  In such case, this License incorporates the
limitation as if written in the body of this License.

13.The Free Software Foundation may publish revised and/or new versions of the Library General Public
License from time to time. Such new versions will be similar in spirit to the present version, but may
differ in detail to address new problems or concerns.

Each version is given a distinguishing version number.  If the Library specifies a version number of this
License which applies to it and "any later version", you have the option of following the terms and
conditions either of that version or of any later version published by the Free Software Foundation.  If
the Library does not specify a license version number, you may choose any version ever published by
the Free Software Foundation.

14.If you wish to incorporate parts of the Library into other free programs whose distribution conditions
are incompatible with these, write to the author to ask for permission.  For software which is
copyrighted by the Free Software Foundation, write to the Free Software Foundation; we sometimes
make exceptions for this.  Our decision will be guided by the two goals of preserving the free status of
all derivatives of our free software and of promoting the sharing and reuse of software generally.

NO WARRANTY

15.BECAUSE THE LIBRARY IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR THE LIBRARY,
TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTHERWISE STATED IN WRITING THE
COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE LIBRARY "AS IS" WITHOUT WARRANTY
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OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.  THE ENTIRE RISK AS
TO THE QUALITY AND PERFORMANCE OF THE LIBRARY IS WITH YOU.  SHOULD THE LIBRARY PROVE
DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION. 

16.IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY
COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR REDISTRIBUTE THE LIBRARY
AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL,
INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE
LIBRARY (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE
OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A FAILURE OF THE LIBRARY TO OPERATE WITH
ANY OTHER SOFTWARE), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES.

END OF TERMS AND CONDITIONS

Appendix: How to Apply These Terms to Your New Libraries

If you develop a new library, and you want it to be of the greatest possible use to the public, we
recommend making it free software that everyone can redistribute and change.  You can do so by
permitting redistribution under these terms (or, alternatively, under the terms of the ordinary General
Public License).

To apply these terms, attach the following notices to the library.  It is safest to attach them to the start of
each source file to most effectively convey the exclusion of warranty; and each file should have at least
the "copyright" line and a pointer to where the full notice is found.

<one line to give the library's name and a brief idea of what it does.> Copyright (C) <year> <name of
author>

This library is free software; you can redistribute it and/or modify it under the terms of the GNU Library
General Public License as published by the Free Software Foundation; either version 2 of the License, or
(at your option) any later version.

This library is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY; without even
the implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE.  See the GNU
Library General Public License for more details.

You should have received a copy of the GNU Library General Public License along with this library; if not,
write to the Free Software Foundation, Inc., 51 Franklin St, Fifth Floor, Boston, MA 02110-1301, USA.

Also add information on how to contact you by electronic and paper mail.

You should also get your employer (if you work as a programmer) or your school, if any, to sign a
"copyright disclaimer" for the library, if necessary. Here is a sample; alter the names:

Yoyodyne, Inc., hereby disclaims all copyright interest in the library `Frob' (a library for tweaking knobs)
written by James Random Hacker.

<signature of Ty Coon>, 1 April 1990

Ty Coon, President of Vice

That's all there is to it!
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GTS License

GNU LIBRARY GENERAL PUBLIC LICENSE

Version 2, June 1991

Copyright (C) 1991 Free Software Foundation, Inc., 51 Franklin St, Fifth Floor, Boston, MA 02110-1301,
USA

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is
not allowed.

[This is the first released version of the library GPL.  It is numbered 2 because it goes with version 2 of
the ordinary GPL.]

Preamble

The licenses for most software are designed to take away your freedom to share and change it.  By
contrast, the GNU General Public Licenses are intended to guarantee your freedom to share and change
free software--to make sure the software is free for all its users.

This license, the Library General Public License, applies to some specially designated Free Software
Foundation software, and to any other libraries whose authors decide to use it.  You can use it for your
libraries, too.

When we speak of free software, we are referring to freedom, not price.  Our General Public Licenses are
designed to make sure that you have the freedom to distribute copies of free software (and charge for this
service if you wish), that you receive source code or can get it if you want it, that you can change the
software or use pieces of it in new free programs; and that you know you can do these things.

To protect your rights, we need to make restrictions that forbid anyone to deny you these rights or to ask
you to surrender the rights. These restrictions translate to certain responsibilities for you if you distribute
copies of the library, or if you modify it.

For example, if you distribute copies of the library, whether gratis or for a fee, you must give the
recipients all the rights that we gave you.  You must make sure that they, too, receive or can get the
source code.  If you link a program with the library, you must provide complete object files to the
recipients so that they can relink them with the library, after making changes to the library and
recompiling it.  And you must show them these terms so they know their rights.

Our method of protecting your rights has two steps: (1) copyright the library, and (2) offer you this
license which gives you legal permission to copy, distribute and/or modify the library.

Also, for each distributor's protection, we want to make certain that everyone understands that there is no
warranty for this free library.  If the library is modified by someone else and passed on, we want its
recipients to know that what they have is not the original version, so that any problems introduced by
others will not reflect on the original authors' reputations.

Finally, any free program is threatened constantly by software patents.  We wish to avoid the danger that
companies distributing free software will individually obtain patent licenses, thus in effect transforming the
program into proprietary software.  To prevent this, we have made it clear that any patent must be
licensed for everyone's free use or not licensed at all.

Most GNU software, including some libraries, is covered by the ordinary GNU General Public License, which
was designed for utility programs.  This license, the GNU Library General Public License, applies to certain
designated libraries.  This license is quite different from the ordinary one; be sure to read it in full, and
don't assume that anything in it is the same as in the ordinary license.

The reason we have a separate public license for some libraries is that they blur the distinction we usually
make between modifying or adding to a program and simply using it.  Linking a program with a library,
without changing the library, is in some sense simply using the library, and is analogous to running a
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utility program or application program.  However, in a textual and legal sense, the linked executable is a
combined work, a derivative of the original library, and the ordinary General Public License treats it as
such.

Because of this blurred distinction, using the ordinary General Public License for libraries did not
effectively promote software sharing, because most developers did not use the libraries.  We concluded
that weaker conditions might promote sharing better.

However, unrestricted linking of non-free programs would deprive the users of those programs of all
benefit from the free status of the libraries themselves.  This Library General Public License is intended to
permit developers of non-free programs to use free libraries, while preserving your freedom as a user of
such programs to change the free libraries that are incorporated in them.  (We have not seen how to
achieve this as regards changes in header files, but we have achieved it as regards changes in the actual
functions of the Library.)  The hope is that this will lead to faster development of free libraries.

The precise terms and conditions for copying, distribution and modification follow.  Pay close attention to
the difference between a "work based on the library" and a "work that uses the library".  The former
contains code derived from the library, while the latter only works together with the library.

Note that it is possible for a library to be covered by the ordinary General Public License rather than by
this special one.

GNU LIBRARY GENERAL PUBLIC LICENSE

TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION

0. This License Agreement applies to any software library which contains a notice placed by the copyright
holder or other authorized party saying it may be distributed under the terms of this Library General
Public License (also called "this License"). Each licensee is  addressed as "you".  

A "library" means a collection of software functions and/or data prepared so as to be conveniently
linked with application programs (which use some of those functions and data) to form executables.

The "Library", below, refers to any such software library or work which has been distributed under
these terms.  A "work based on the Library" means either the Library or any derivative work under
copyright law: that is to say, a work containing the Library or a portion of it, either verbatim or with
modifications and/or translated straightforwardly into another language.  (Hereinafter, translation is
included without limitation in the term "modification".)

"Source code" for a work means the preferred form of the work for making modifications to it.  For a
library, complete source code means all the source code for all modules it contains, plus any associated
interface definition files, plus the scripts used to control compilation and installation of the library.

Activities other than copying, distribution and modification are not covered by this License; they are
outside its scope.  The act of running a program using the Library is not restricted, and output from
such a program is covered only if its contents constitute a work based on the Library (independent of
the use of the Library in a tool for writing it).  Whether that is true depends on what the Library does
and what the program that uses the Library does.

1. You may copy and distribute verbatim copies of the Library's complete source code as you receive it, in
any medium, provided that you conspicuously and appropriately publish on each copy an appropriate
copyright notice and disclaimer of warranty; keep intact all the notices that refer to this License and to
the absence of any warranty; and distribute a copy of this License along with the Library.

You may charge a fee for the physical act of transferring a copy, and you may at your option offer
warranty protection in exchange for a fee.

2. You may modify your copy or copies of the Library or any portion of it, thus forming a work based on
the Library, and copy and distribute such modifications or work under the terms of Section 1 above,
provided that you also meet all of these conditions:

a) The modified work must itself be a software library.
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b) You must cause the files modified to carry prominent notices stating that you changed the files and
the date of any change.

c) You must cause the whole of the work to be licensed at no charge to all third parties under the terms
of this License.

d) If a facility in the modified Library refers to a function or a table of data to be supplied by an
application program that uses the facility, other than as an argument passed when the facility is
invoked, then you must make a good faith effort to ensure that in the event an application does not
supply such function or table, the facility still operates, and performs whatever part of its purpose
remains meaningful.

(For example, a function in a library to compute square roots has a purpose that is entirely well-defined
independent of the application. herefore, Subsection 2d requires that any application-supplied function
or table used by this function must be optional: if the application does not supply it, the square root
function must still compute square roots.)

These requirements apply to the modified work as a whole.  If identifiable sections of that work are not
derived from the Library, and can be reasonably considered independent and separate works in
themselves, then this License, and its terms, do not apply to those sections when you distribute them
as separate works.  But when you distribute the same sections as part of a whole which is a work based
on the Library, the distribution of the whole must be on the terms of this License, whose permissions
for other licensees extend to the entire whole, and thus to each and every part regardless of who wrote
it.

Thus, it is not the intent of this section to claim rights or contest your rights to work written entirely by
you; rather, the intent is to exercise the right to control the distribution of derivative or collective
works based on the Library.

In addition, mere aggregation of another work not based on the Library with the Library (or with a work
based on the Library) on a volume of a storage or distribution medium does not bring the other work
under the scope of this License.

3. You may opt to apply the terms of the ordinary GNU General Public License instead of this License to a
given copy of the Library. To do this, you must alter all the notices that refer to this License, so that
they refer to the ordinary GNU General Public License, version 2,  nstead of to this License.  (If a newer
version than version 2 of the ordinary GNU General Public License has appeared, then you can specify
that version      instead if you wish.) Do not make any other change in these notices.

Once this change is made in a given copy, it is irreversible for that copy, so the ordinary GNU General
Public License applies to all subsequent copies and derivative works made from that copy.

This option is useful when you wish to copy part of the code of the Library into a program that is not a
library.

4. You may copy and distribute the Library (or a portion or derivative of it, under Section 2) in object code
or executable form under the terms of Sections 1 and 2 above provided that you accompany it with the
complete corresponding machine-readable source code, which must be distributed under the terms of
Sections 1 and 2 above on a medium customarily used for software interchange.

If distribution of object code is made by offering access to copy from a designated place, then offering
equivalent access to copy the source code from the same place satisfies the requirement to distribute
the source code, even though third parties are not compelled to copy the source along with the object
code.

5. A program that contains no derivative of any portion of the Library, but is designed to work with the
Library by being compiled or linked with it, is called a "work that uses the Library".  Such a work, in
isolation, is not a derivative work of the Library, and therefore falls outside the scope of this License.

However, linking a "work that uses the Library" with the Library creates an executable that is a
derivative of the Library (because it contains portions of the Library), rather than a "work that uses the
library".  The executable is therefore covered by this License. Section 6 states terms for distribution of
such executables.

When a "work that uses the Library" uses material from a header file that is part of the Library, the
object code for the work may be a derivative work of the Library even though the source code is not.
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Whether this is true is especially significant if the work can be linked without the Library, or if the work
is itself a library.  The threshold for this to be true is not precisely defined by law.

If such an object file uses only numerical parameters, data structure layouts and accessors, and small
macros and small inline functions (ten lines or less in length), then the use of the object file is
unrestricted, regardless of whether it is legally a derivative work.  (Executables containing this object
code plus portions of the Library will still fall under Section 6.)

Otherwise, if the work is a derivative of the Library, you may distribute the object code for the work
under the terms of Section 6. Any executables containing that work also fall under Section 6, whether
or not they are linked directly with the Library itself.

6. As an exception to the Sections above, you may also compile or link a "work that uses the Library" with
the Library to produce a work containing portions of the Library, and distribute that work under terms
of your choice, provided that the terms permit modification of the work for the customer's own use and
reverse engineering for debugging such modifications.

You must give prominent notice with each copy of the work that the Library is used in it and that the
Library and its use are covered by this License. You must supply a copy of this License. If the work
during execution displays copyright notices, you must include the copyright notice for the Library
among them, as well as a reference directing the user to the copy of this License. Also, you must do
one of these things:

a) Accompany the work with the complete corresponding machine-readable source code for the Library
including whatever changes were used in the work (which must be distributed under Sections 1 and 2
above); and, if the work is an executable linked with the Library, with the complete machine-readable
"work that uses the Library", as object code and/or source code, so that the user can modify the Library
and then relink to produce a modified executable containing the modified Library.  (It is understood
that the user who changes the contents of definitions files in the Library will not necessarily be able to
recompile the application to use the modified definitions.)

b) Accompany the work with a written offer, valid for at least three years, to give the same user the
materials specified in Subsection 6a, above, for a charge no more than the cost of performing this
distribution.

c) If distribution of the work is made by offering access to copy from a designated place, offer
equivalent access to copy the above specified materials from the same place.

d) Verify that the user has already received a copy of these materials or that you have already sent this
user a copy.

For an executable, the required form of the "work that uses the Library" must include any data and
utility programs needed for reproducing the executable from it.  However, as a special exception, the
source code distributed need not include anything that is normally distributed (in either source or
binary form) with the major components (compiler, kernel, and so on) of the operating system on
which the executable runs, unless that component itself accompanies the executable.

It may happen that this requirement contradicts the license restrictions of other proprietary libraries
that do not normally accompany the operating system.  Such a contradiction means you cannot use
both them and the Library together in an executable that you distribute.

7. You may place library facilities that are a work based on the Library side-by-side in a single library
together with other library facilities not covered by this License, and distribute such a combined library,
provided that the separate distribution of the work based on the Library and of the other library
facilities is otherwise permitted, and provided that you do these two things:

a) Accompany the combined library with a copy of the same work based on the Library, uncombined
with any other library facilities.  This must be distributed under the terms of the Sections above.

b) Give prominent notice with the combined library of the fact that part of it is a work based on the
Library, and explaining where to find the accompanying uncombined form of the same work.

8. You may not copy, modify, sublicense, link with, or distribute the Library except as expressly provided
under this License.  Any attempt otherwise to copy, modify, sublicense, link with, or distribute the
Library is void, and will automatically terminate your rights under this License.  However, parties who
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have received copies, or rights, from you under this License will not have their licenses terminated so
long as such parties remain in full compliance.

9. You are not required to accept this License, since you have not signed it.  However, nothing else grants
you permission to modify or distribute the Library or its derivative works.  These actions are prohibited
by law if you do not accept this License.  Therefore, by modifying or distributing the Library (or any
work based on the Library), you indicate your acceptance of this License to do so, and all its terms and
conditions for copying, distributing or modifying the Library or works based on it.

10.Each time you redistribute the Library (or any work based on the Library), the recipient automatically
receives a license from the original licensor to copy, distribute, link with or modify the Library subject
to these terms and conditions.  You may not impose any further restrictions on the recipients' exercise
of the rights granted herein. You are not responsible for enforcing compliance by third parties to this
License.

11.If, as a consequence of a court judgment or allegation of patent infringement or for any other reason
(not limited to patent issues), conditions are imposed on you (whether by court order, agreement or
otherwise) that contradict the conditions of this License, they do not excuse you from the conditions of
this License. If you cannot distribute so as to satisfy simultaneously your obligations under this License
and any other pertinent obligations, then as a consequence you may not distribute the Library at all. 
For example, if a patent license would not permit royalty-free redistribution of the Library by all those
who receive copies directly or indirectly through you, then the only way you could satisfy both it and
this License would be to refrain entirely from distribution of the Library.

If any portion of this section is held invalid or unenforceable under any particular circumstance, the
balance of the section is intended to apply, and the section as a whole is intended to apply in other
circumstances.

It is not the purpose of this section to induce you to infringe any patents or other property right claims
or to contest validity of any such claims; this section has the sole purpose of protecting the integrity of
the free software distribution system which is implemented by public license practices.  Many people
have made generous contributions to the wide range of software distributed through that system in
reliance on consistent application of that system; it is up to the author/donor to decide if he or she is
willing to distribute software through any other system and a licensee cannot impose that choice.

This section is intended to make thoroughly clear what is believed to be a consequence of the rest of
this License.

12.If the distribution and/or use of the Library is restricted in certain countries either by patents or by
copyrighted interfaces, the original copyright holder who places the Library under this License may add
an explicit geographical distribution limitation excluding those countries, so that distribution is
permitted only in or among countries not thus excluded.  In such case, this License incorporates the
limitation as if written in the body of this License.

13.The Free Software Foundation may publish revised and/or new versions of the Library General Public
License from time to time. Such new versions will be similar in spirit to the present version, but may
differ in detail to address new problems or concerns.

Each version is given a distinguishing version number.  If the Library specifies a version number of this
License which applies to it and "any later version", you have the option of following the terms and
conditions either of that version or of any later version published by the Free Software Foundation.  If
the Library does not specify a license version number, you may choose any version ever published by
the Free Software Foundation.

14.If you wish to incorporate parts of the Library into other free programs whose distribution conditions
are incompatible with these, write to the author to ask for permission.  For software which is
copyrighted by the Free Software Foundation, write to the Free Software Foundation; we sometimes
make exceptions for this.  Our decision will be guided by the two goals of preserving the free status of
all derivatives of our free software and of promoting the sharing and reuse of software generally.

NO WARRANTY

15.BECAUSE THE LIBRARY IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR THE LIBRARY,
TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTHERWISE STATED IN WRITING THE
COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE LIBRARY "AS IS" WITHOUT WARRANTY
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OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.  THE ENTIRE RISK AS
TO THE QUALITY AND PERFORMANCE OF THE LIBRARY IS WITH YOU.  SHOULD THE LIBRARY PROVE
DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION. 

16.IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY
COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR REDISTRIBUTE THE LIBRARY
AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL,
INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE
LIBRARY (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE
OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A FAILURE OF THE LIBRARY TO OPERATE WITH
ANY OTHER SOFTWARE), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES.

END OF TERMS AND CONDITIONS

Appendix: How to Apply These Terms to Your New Libraries

If you develop a new library, and you want it to be of the greatest possible use to the public, we
recommend making it free software that everyone can redistribute and change.  You can do so by
permitting redistribution under these terms (or, alternatively, under the terms of the ordinary General
Public License).

To apply these terms, attach the following notices to the library.  It is safest to attach them to the start of
each source file to most effectively convey the exclusion of warranty; and each file should have at least
the "copyright" line and a pointer to where the full notice is found.

<one line to give the library's name and a brief idea of what it does.> Copyright (C) <year> <name of
author>

This library is free software; you can redistribute it and/or modify it under the terms of the GNU Library
General Public License as published by the Free Software Foundation; either version 2 of the License, or
(at your option) any later version.

This library is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY; without even
the implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE.  See the GNU
Library General Public License for more details.

You should have received a copy of the GNU Library General Public License along with this library; if not,
write to the Free Software Foundation, Inc., 51 Franklin St, Fifth Floor, Boston, MA 02110-1301, USA.

Also add information on how to contact you by electronic and paper mail.

You should also get your employer (if you work as a programmer) or your school, if any, to sign a
"copyright disclaimer" for the library, if necessary. Here is a sample; alter the names:

Yoyodyne, Inc., hereby disclaims all copyright interest in the library `Frob' (a library for tweaking knobs)
written by James Random Hacker.

<signature of Ty Coon>, 1 April 1990

Ty Coon, President of Vice

That's all there is to it!
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ImageMagick License

Before we get to the text of the license, lets just review what the license says in simple terms:

It allows you to:

· freely download and use ImageMagick software, in whole or in part, for personal, company internal, or
commercial purposes;

· use ImageMagick software in packages or distributions that you create;

· link against a library under a different license;

· link code under a different license against a library under this license;

· merge code into a work under a different license;

· extend patent grants to any code using code under this license;

· and extend patent protection.

It forbids you to:

· redistribute any piece of ImageMagick-originated software without proper attribution;

· use any marks owned by ImageMagick Studio LLC in any way that might state or imply that
ImageMagick Studio LLC endorses your distribution;

· use any marks owned by ImageMagick Studio LLC in any way that might state or imply that you created
the ImageMagick software in question.

It requires you to:

· include a copy of the license in any redistribution you may make that includes ImageMagick software;

· provide clear attribution to ImageMagick Studio LLC for any distributions that include ImageMagick
software.

It does not require you to:

· include the source of the ImageMagick software itself, or of any modifications you may have made to it,
in any redistribution you may assemble that includes it;

· submit changes that you make to the software back to the ImageMagick Studio LLC (though such
feedback is encouraged).

A few other clarifications include:

· ImageMagick is freely available without charge;

· you may include ImageMagick on a DVD as long as you comply with the terms of the license;

· you can give modified code away for free or sell it under the terms of the ImageMagick license or
distribute the result under a different license, but you need to acknowledge the use of the ImageMagick
software;

· the license is compatible with the GPL V3.

· when exporting the ImageMagick software, review its export classification.

Terms and Conditions for Use, Reproduction, and Distribution
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The legally binding and authoritative terms and conditions for use, reproduction, and distribution of
ImageMagick follow:

Copyright 1999-2015 ImageMagick Studio LLC, a non-profit organization dedicated to making software
imaging solutions freely available.

1. Definitions.

License shall mean the terms and conditions for use, reproduction, and distribution as defined by
Sections 1 through 9 of this document.

Licensor shall mean the copyright owner or entity authorized by the copyright owner that is granting
the License.

Legal Entity shall mean the union of the acting entity and all other entities that control, are controlled
by, or are under common control with that entity. For the purposes of this definition, control means (i)
the power, direct or indirect, to cause the direction or management of such entity, whether by contract
or otherwise, or (ii) ownership of fifty percent (50%) or more of the outstanding shares, or (iii)
beneficial ownership of such entity.

You (or Your) shall mean an individual or Legal Entity exercising permissions granted by this License.

Source form shall mean the preferred form for making modifications, including but not limited to
software source code, documentation source, and configuration files.

Object form shall mean any form resulting from mechanical transformation or translation of a Source
form, including but not limited to compiled object code, generated documentation, and conversions to
other media types.

Work shall mean the work of authorship, whether in Source or Object form, made available under the
License, as indicated by a copyright notice that is included in or attached to the work (an example is
provided in the Appendix below).

Derivative Works shall mean any work, whether in Source or Object form, that is based on (or derived
from) the Work and for which the editorial revisions, annotations, elaborations, or other modifications
represent, as a whole, an original work of authorship. For the purposes of this License, Derivative
Works shall not include works that remain separable from, or merely link (or bind by name) to the
interfaces of, the Work and Derivative Works thereof.

Contribution shall mean any work of authorship, including the original version of the Work and any
modifications or additions to that Work or Derivative Works thereof, that is intentionally submitted to
Licensor for inclusion in the Work by the copyright owner or by an individual or Legal Entity authorized
to submit on behalf of the copyright owner. For the purposes of this definition, "submitted" means any
form of electronic, verbal, or written communication sent to the Licensor or its representatives,
including but not limited to communication on electronic mailing lists, source code control systems, and
issue tracking systems that are managed by, or on behalf of, the Licensor for the purpose of discussing
and improving the Work, but excluding communication that is conspicuously marked or otherwise
designated in writing by the copyright owner as Not a Contribution.

Contributor shall mean Licensor and any individual or Legal Entity on behalf of whom a Contribution has
been received by Licensor and subsequently incorporated within the Work.

2. Grant of Copyright License. Subject to the terms and conditions of this License, each Contributor
hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable
copyright license to reproduce, prepare Derivative Works of, publicly display, publicly perform,
sublicense, and distribute the Work and such Derivative Works in Source or Object form.

3. Grant of Patent License. Subject to the terms and conditions of this License, each Contributor hereby
grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable patent license
to make, have made, use, offer to sell, sell, import, and otherwise transfer the Work, where such
license applies only to those patent claims licensable by such Contributor that are necessarily infringed
by their Contribution(s) alone or by combination of their Contribution(s) with the Work to which such
Contribution(s) was submitted. If You institute patent litigation against any entity (including a cross-
claim or counterclaim in a lawsuit) alleging that the Work or a Contribution incorporated within the
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Work constitutes direct or contributory patent infringement, then any patent licenses granted to You
under this License for that Work shall terminate as of the date such litigation is filed.

4. Redistribution. You may reproduce and distribute copies of the Work or Derivative Works thereof in
any medium, with or without modifications, and in Source or Object form, provided that You meet the
following conditions:

· You must give any other recipients of the Work or Derivative Works a copy of this License; and

· You must cause any modified files to carry prominent notices stating that You changed the files; and

· You must retain, in the Source form of any Derivative Works that You distribute, all copyright, patent,
trademark, and attribution notices from the Source form of the Work, excluding those notices that do
not pertain to any part of the Derivative Works; and

· If the Work includes a "NOTICE" text file as part of its distribution, then any Derivative Works that
You distribute must include a readable copy of the attribution notices contained within such NOTICE
file, excluding those notices that do not pertain to any part of the Derivative Works, in at least one of
the following places: within a NOTICE text file distributed as part of the Derivative Works; within the
Source form or documentation, if provided along with the Derivative Works; or, within a display
generated by the Derivative Works, if and wherever such third-party notices normally appear. The
contents of the NOTICE file are for informational purposes only and do not modify the License. You
may add Your own attribution notices within Derivative Works that You distribute, alongside or as an
addendum to the NOTICE text from the Work, provided that such additional attribution notices cannot
be construed as modifying the License. You may add Your own copyright statement to Your
modifications and may provide additional or different license terms and conditions for use,
reproduction, or distribution of Your modifications, or for any such Derivative Works as a whole,
provided Your use, reproduction, and distribution of the Work otherwise complies with the conditions
stated in this License.

5. Submission of Contributions. Unless You explicitly state otherwise, any Contribution intentionally
submitted for inclusion in the Work by You to the Licensor shall be under the terms and conditions of
this License, without any additional terms or conditions. Notwithstanding the above, nothing herein
shall supersede or modify the terms of any separate license agreement you may have executed with
Licensor regarding such Contributions.

6. Trademarks. This License does not grant permission to use the trade names, trademarks, service
marks, or product names of the Licensor, except as required for reasonable and customary use in
describing the origin of the Work and reproducing the content of the NOTICE file.

7. Disclaimer of Warranty. Unless required by applicable law or agreed to in writing, Licensor provides
the Work (and each Contributor provides its Contributions) on an AS IS BASIS, WITHOUT WARRANTIES
OR CONDITIONS OF ANY KIND, either express or implied, including, without limitation, any warranties
or conditions of TITLE, NON-INFRINGEMENT, MERCHANTABILITY, or FITNESS FOR A PARTICULAR
PURPOSE. You are solely responsible for determining the appropriateness of using or redistributing the
Work and assume any risks associated with Your exercise of permissions under this License.

8. Limitation of Liability. In no event and under no legal theory, whether in tort (including negligence),
contract, or otherwise, unless required by applicable law (such as deliberate and grossly negligent
acts) or agreed to in writing, shall any Contributor be liable to You for damages, including any direct,
indirect, special, incidental, or consequential damages of any character arising as a result of this
License or out of the use or inability to use the Work (including but not limited to damages for loss of
goodwill, work stoppage, computer failure or malfunction, or any and all other commercial damages or
losses), even if such Contributor has been advised of the possibility of such damages.

9. Accepting Warranty or Additional Liability. While redistributing the Work or Derivative Works
thereof, You may choose to offer, and charge a fee for, acceptance of support, warranty, indemnity, or
other liability obligations and/or rights consistent with this License. However, in accepting such
obligations, You may act only on Your own behalf and on Your sole responsibility, not on behalf of any
other Contributor, and only if You agree to indemnify, defend, and hold each Contributor harmless for
any liability incurred by, or claims asserted against, such Contributor by reason of your accepting any
such warranty or additional liability.

How to Apply the License to your Work
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To apply the ImageMagick License to your work, attach the following boilerplate notice, with the fields
enclosed by brackets "[]" replaced with your own identifying information (don't include the brackets). The
text should be enclosed in the appropriate comment syntax for the file format. We also recommend that a
file or class name and description of purpose be included on the same "printed page" as the copyright
notice for easier identification within third-party archives.

Copyright [yyyy] [name of copyright owner]

Licensed under the ImageMagick License (the "License"); you may not use this file except in compliance
with the License.  You may obtain a copy of the License at:

http://www.imagemagick.org/script/license.php

Unless required by applicable law or agreed to in writing, software distributed under the License is
distributed on an "AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or
implied.  See the License for the specific language governing permissions and limitations under the
License.

http://www.imagemagick.org/script/license.php
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Libav License

Most files in Libav are under the GNU Lesser General Public License version 2.1 or later (LGPL v2.1+).
Read the file COPYING.LGPLv2.1 for details. Some other files have MIT/X11/BSD-style licenses. In
combination the LGPL v2.1+ applies to Libav.

Some optional parts of Libav are licensed under the GNU General Public License version 2 or later (GPL
v2+). See the file COPYING.GPLv2 for details. None of these parts are used by default, you have to
explicitly pass --enable-gpl to configure to activate them. In this case, Libav's license changes to GPL v2+.

Specifically, the GPL parts of Libav are

· the X11 grabber in libavdevice/x11grab.c 

· the texi2pod.pl tool

· the following filters in libavfilter:

Ø    vf_blackframe.c

Ø    vf_boxblur.c

Ø    vf_cropdetect.c

Ø    vf_delogo.c

Ø    vf_hqdn3d.c

Ø    vf_interlace.c

Should you, for whatever reason, prefer to use version 3 of the (L)GPL, then the configure parameter --
enable-version3 will activate this licensing option for you. Read the file COPYING.LGPLv3 or, if you have
enabled GPL parts, COPYING.GPLv3 to learn the exact legal terms that apply in this case.

There are a handful of files under other licensing terms, namely:

· The files libavcodec/jfdctfst.c, libavcodec/jfdctint_template.c and libavcodec/jrevdct.c are taken from
libjpeg, see the top of the files for licensing details. Specifically note that you must credit the IJG in the
documentation accompanying your program if you only distribute executables. You must also indicate
any changes including additions and deletions to those three files in the documentation.

external libraries

Libav can be combined with a number of external libraries, which sometimes affect the licensing of
binaries resulting from the combination.

compatible libraries

The libcdio, libx264, libx265, libxavs and libxvid libraries are under GPL. When combining them with Libav,
Libav needs to be licensed as GPL as well by passing --enable-gpl to configure.

The OpenCORE and VisualOn libraries are under the Apache License 2.0. That license is incompatible with
the LGPL v2.1 and the GPL v2, but not with version 3 of those licenses. So to combine these libraries with
Libav, the license version needs to be upgraded by passing --enable-version3 to configure.

incompatible libraries

The Fraunhofer AAC library, FAAC and OpenSSL are under licenses incompatible with all (L)GPL versions.
Thus, unfortunately, since both licenses cannot be satisfied simultaneously, binaries resulting from the
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combination of Libav with these libraries are nonfree and unredistributable. If you wish to enable any of
these libraries nonetheless, pass --enable-nonfree to configure.

GNU LESSER GENERAL PUBLIC LICENSE

Version 2.1, February 1999

Copyright (C) 1991, 1999 Free Software Foundation, Inc., 51 Franklin St, Fifth Floor, Boston, MA 02110-
1301, USA

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is
not allowed.

[This is the first released version of the Lesser GPL.  It also counts as the successor of the GNU Library
Public License, version 2, hence the version number 2.1.]

Preamble

The licenses for most software are designed to take away your freedom to share and change it. By
contrast, the GNU General Public Licenses are intended to guarantee your freedom to share and change
free software--to make sure the software is free for all its users.

This license, the Lesser General Public License, applies to some specially software packages--typically
libraries--of the Free Software Foundation and other authors who decide to use it. You can use it too, but
we suggest you first think carefully about whether this license or the ordinary General Public License is the
better strategy to use in any particular case, based on the explanations below.

When we speak of free software, we are referring to freedom of use, not price.  Our General Public
Licenses are designed to make sure that you have the freedom to distribute copies of free software (and
charge for this service if you wish), that you receive source code or can get it if you want it, that you can
change the software or use pieces of it in new free programs; and that you are informed that you can do
these things.

To protect your rights, we need to make restrictions that forbid anyone to deny you these rights or to ask
you to surrender the rights. These restrictions translate to certain responsibilities for you if you distribute
copies of the library or if you modify it.

For example, if you distribute copies of the library, whether gratis or for a fee, you must give the
recipients all the rights that we gave you.  You must make sure that they, too, receive or can get the
source code.  If you link other code with the library, you must provide complete object files to the
recipients so that they can relink them with the library after making changes to the library and recompiling
it.  And you must show them these terms so they know their rights.

We protect your rights with a two-step method: (1) we copyright the library, and (2) we offer you this
license, which gives you legal permission to copy, distribute and/or modify the library.

To protect each distributor, we want to make it very clear that there is no warranty for the free library.
Also, if the library is modified by someone else and passed on, recipients should know that what they have
is not the original version, so that the original author's reputation will not be affected by problems that
might be introduced by others.

Finally, software patents pose a constant threat to the existence of any free program. We wish to make
sure that a company cannot effectively restrict the users of a free program by obtaining restrictive licenses
from a patent holder. Therefore, we insist that any patent license obtained for a version of the library must
be consistent with the full freedom of use specified in this license.

Most GNU software, including some libraries, is covered by the ordinary GNU General Public License. This
license, the GNU Lesser General Public License, applies to certain designated libraries, and is quite
different from the ordinary General Public License. We use this license for certain libraries in order to
permit linking those libraries into non-free programs.
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When a program is linked with a library, whether statically or using a shared library, the combination of
the two is legally speaking a combined work, a derivative of the original library.  The ordinary General
Public License therefore permits such linking only if the entire combination fits its criteria of freedom.  The
Lesser General Public License permits more lax criteria for linking other code with the library.

We call this license the "Lesser" General Public License because it does Less to protect the user's freedom
than the ordinary General Public License.  It also provides other free software developers Less of an
advantage over competing non-free programs.  These disadvantages are the reason we use the ordinary
General Public License for many libraries.  However, the Lesser license provides advantages in certain
special circumstances.

For example, on rare occasions, there may be a special need to encourage the widest possible use of a
certain library, so that it becomes a de-facto standard.  To achieve this, non-free programs must be
allowed to use the library.  A more frequent case is that a free library does the same job as widely used
non-free libraries.  In this case, there is little to gain by limiting the free library to free software only, so
we use the Lesser General Public License.

In other cases, permission to use a particular library in non-free programs enables a greater number of
people to use a large body of free software.  For example, permission to use the GNU C Library in non-free
programs enables many more people to use the whole GNU operating system, as well as its variant, the
GNU/Linux operating system.

Although the Lesser General Public License is Less protective of the users' freedom, it does ensure that the
user of a program that is linked with the Library has the freedom and the wherewithal to run that program
using a modified version of the Library.

The precise terms and conditions for copying, distribution and modification follow.  Pay close attention to
the difference between a "work based on the library" and a "work that uses the library".  The former
contains code derived from the library, while the latter must be combined with the library in order to run.

GNU LESSER GENERAL PUBLIC LICENSE

TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION

0. This License Agreement applies to any software library or other program which contains a notice placed
by the copyright holder or other authorized party saying it may be distributed under the terms of this
Lesser General Public License (also called "this License"). Each licensee is addressed as "you".  

A "library" means a collection of software functions and/or data prepared so as to be conveniently
linked with application programs (which use some of those functions and data) to form executables.

The "Library", below, refers to any such software library or work which has been distributed under
these terms.  A "work based on the Library" means either the Library or any derivative work under
copyright law: that is to say, a work containing the Library or a portion of it, either verbatim or with
modifications and/or translated straightforwardly into another language. (Hereinafter, translation is
included without limitation in the term "modification".)

"Source code" for a work means the preferred form of the work for making modifications to it. For a
library, complete source code means all the source code for all modules it contains, plus any associated
interface definition files, plus the scripts used to control compilation and installation of the library.

Activities other than copying, distribution and modification are not covered by this License; they are
outside its scope. The act of running a program using the Library is not restricted, and output from
such a program is covered only if its contents constitute a work based on the Library (independent of
the use of the Library in a tool for writing it). Whether that is true depends on what the Library does
and what the program that uses the Library does.

1. You may copy and distribute verbatim copies of the Library's complete source code as you receive it, in
any medium, provided that you conspicuously and appropriately publish on each copy an appropriate
copyright notice and disclaimer of warranty; keep intact all the notices that refer to this License and to
the absence of any warranty; and distribute a copy of this License along with the Library.
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You may charge a fee for the physical act of transferring a copy, and you may at your option offer
warranty protection in exchange for a fee.

2. You may modify your copy or copies of the Library or any portion of it, thus forming a work based on
the Library, and copy and distribute such modifications or work under the terms of Section 1 above,
provided that you also meet all of these conditions:

a) The modified work must itself be a software library.

b) You must cause the files modified to carry prominent notices stating that you changed the files and
the date of any change.

c) You must cause the whole of the work to be licensed at no charge to all third parties under the terms
of this License.

d) If a facility in the modified Library refers to a function or a table of data to be supplied by an
application program that uses the facility, other than as an argument passed when the facility is
invoked, then you must make a good faith effort to ensure that in the event an application does not
supply such function or table, the facility still operates, and performs whatever part of its purpose
remains meaningful.

(For example, a function in a library to compute square roots has a purpose that is entirely well-defined
independent of the application. Therefore, Subsection 2d requires that any application-supplied function
or table used by this function must be optional: if the application does not supply it, the square root
function must still compute square roots.)

These requirements apply to the modified work as a whole.  If identifiable sections of that work are not
derived from the Library, and can be reasonably considered independent and separate works in
themselves, then this License, and its terms, do not apply to those sections when you distribute them
as separate works.  But when you distribute the same sections as part of a whole which is a work based
on the Library, the distribution of the whole must be on the terms of this License, whose permissions
for other licensees extend to the entire whole, and thus to each and every part regardless of who wrote
it.

Thus, it is not the intent of this section to claim rights or contest your rights to work written entirely by
you; rather, the intent is to exercise the right to control the distribution of derivative or collective
works based on the Library.

In addition, mere aggregation of another work not based on the Library with the Library (or with a work
based on the Library) on a volume of a storage or distribution medium does not bring the other work
under the scope of this License.

3. You may opt to apply the terms of the ordinary GNU General Public License instead of this License to a
given copy of the Library. To do this, you must alter all the notices that refer to this License, so that
they refer to the ordinary GNU General Public License, version 2, instead of to this License.  (If a newer
version than version 2 of the ordinary GNU General Public License has appeared, then you can specify
that version instead if you wish.) Do not make any other change in these notices.

Once this change is made in a given copy, it is irreversible for that copy, so the ordinary GNU General
Public License applies to all subsequent copies and derivative works made from that copy.

This option is useful when you wish to copy part of the code of the Library into a program that is not a
library.

4. You may copy and distribute the Library (or a portion or derivative of it, under Section 2) in object code
or executable form under the terms of Sections 1 and 2 above provided that you accompany it with the
complete corresponding machine-readable source code, which must be distributed under the terms of
Sections 1 and 2 above on a medium customarily used for software interchange.

If distribution of object code is made by offering access to copy from a designated place, then offering
equivalent access to copy the source code from the same place satisfies the requirement to distribute
the source code, even though third parties are not compelled to copy the source along with the object
code.
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5. A program that contains no derivative of any portion of the Library, but is designed to work with the
Library by being compiled or linked with it, is called a "work that uses the Library".  Such a work, in
isolation, is not a derivative work of the Library, and therefore falls outside the scope of this License.

However, linking a "work that uses the Library" with the Library creates an executable that is a
derivative of the Library (because it contains portions of the Library), rather than a "work that uses the
library".  The executable is therefore covered by this License. Section 6 states terms for distribution of
such executables.

When a "work that uses the Library" uses material from a header file that is part of the Library, the
object code for the work may be a derivative work of the Library even though the source code is not.
Whether this is true is especially significant if the work can be linked without the Library, or if the work
is itself a library. The threshold for this to be true is not precisely defined by law.

If such an object file uses only numerical parameters, data structure layouts and accessors, and small
macros and small inline functions (ten lines or less in length), then the use of the object file is
unrestricted, regardless of whether it is legally a derivative work. (Executables containing this object
code plus portions of the Library will still fall under Section 6.)

Otherwise, if the work is a derivative of the Library, you may distribute the object code for the work
under the terms of Section 6. Any executables containing that work also fall under Section 6, whether
or not they are linked directly with the Library itself.

6. As an exception to the Sections above, you may also combine or link a "work that uses the Library"
with the Library to produce a work containing portions of the Library, and distribute that work under
terms of your choice, provided that the terms permit modification of the work for the customer's own
use and reverse engineering for debugging such modifications.

You must give prominent notice with each copy of the work that the Library is used in it and that the
Library and its use are covered by this License. You must supply a copy of this License. If the work
during execution displays copyright notices, you must include the copyright notice for the Library
among them, as well as a reference directing the user to the copy of this License. Also, you must do
one of these things:

a) Accompany the work with the complete corresponding machine-readable source code for the Library
including whatever changes were used in the work (which must be distributed under Sections 1 and
2 above); and, if the work is an executable linked with the Library, with the complete machine-
readable "work that uses the Library", as object code and/or source code, so that the user can
modify the Library and then relink to produce a modified executable containing the modified Library.
 (It is understood that the user who changes the contents of definitions files in the Library will not
necessarily be able to recompile the application to use the modified definitions.)

b) Use a suitable shared library mechanism for linking with the Library. A suitable mechanism is one
that (1) uses at run time a copy of the library already present on the user's computer system, rather
than copying library functions into the executable, and (2) will operate properly with a modified
version of the library, if the user installs one, as long as the modified version is interface-compatible
with the version that the work was made with.

c) Accompany the work with a written offer, valid for at least three years, to give the same user the
materials specified in Subsection 6a, above, for a charge no more than the cost of performing this
distribution.

d) If distribution of the work is made by offering access to copy from a designated place, offer
equivalent access to copy the above specified materials from the same place.

e) Verify that the user has already received a copy of these materials or that you have already sent
this user a copy.

For an executable, the required form of the "work that uses the Library" must include any data and
utility programs needed for reproducing the executable from it. However, as a special exception, the
materials to be distributed need not include anything that is normally distributed (in either source or
binary form) with the major components (compiler, kernel, and so on) of the operating system on
which the executable runs, unless that component itself accompanies the executable.
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It may happen that this requirement contradicts the license restrictions of other proprietary libraries
that do not normally accompany the operating system. Such a contradiction means you cannot use both
them and the Library together in an executable that you distribute.

7. You may place library facilities that are a work based on the Library side-by-side in a single library
together with other library facilities not covered by this License, and distribute such a combined library,
provided that the separate distribution of the work based on the Library and of the other library
facilities is otherwise permitted, and provided that you do these two things:

a) Accompany the combined library with a copy of the same work based on the Library, uncombined
with any other library facilities. This must be distributed under the terms of the Sections above.

b) Give prominent notice with the combined library of the fact that part of it is a work based on the
Library, and explaining where to find the accompanying uncombined form of the same work.

8. You may not copy, modify, sublicense, link with, or distribute the Library except as expressly provided
under this License. Any attempt otherwise to copy, modify, sublicense, link with, or distribute the
Library is void, and will automatically terminate your rights under this License. However, parties who
have received copies, or rights, from you under this License will not have their licenses terminated so
long as such parties remain in full compliance.

9. You are not required to accept this License, since you have not signed it. However, nothing else grants
you permission to modify or distribute the Library or its derivative works. These actions are prohibited
by law if you do not accept this License. Therefore, by modifying or distributing the Library (or any
work based on the Library), you indicate your acceptance of this License to do so, and all its terms and
conditions for copying, distributing or modifying the Library or works based on it.

10.Each time you redistribute the Library (or any work based on the Library), the recipient automatically
receives a license from the original licensor to copy, distribute, link with or modify the Library subject
to these terms and conditions. You may not impose any further restrictions on the recipients' exercise
of the rights granted herein. You are not responsible for enforcing compliance by third parties to this
License.

11.If, as a consequence of a court judgment or allegation of patent infringement of for any other reason
(not limited to patent issues),conditions are imposed on you (whether by court order, agreement or
otherwise) that contradict the conditions of this License, they do not excuse you from the conditions of
this License. If you cannot distribute so as to satisfy simultaneously your obligations under this License
and any other pertinent obligations, then as a consequence you may not distribute the Library at all.
For example, if a patent license would not permit royalty-free redistribution of the Library by all those
who receive copies directly or indirectly through you, then the only way you could satisfy both it and
this License would be to refrain entirely from distribution of the Library.

If any portion of this section is held invalid or unenforceable under any particular circumstance, the
balance of the section is intended to apply, and the section as a whole is intended to apply in other
circumstances.

It is not the purpose of this section to induce you to infringe any patents or other property right claims
or to contest validity of any such claims; this section has the sole purpose of protecting the integrity of
the free software distribution system which is implemented by public license practices. Many people
have made generous contributions to the wide range of software distributed through that system in
reliance on consistent application of that system; it is up to the author/donor to decide if he or she is
willing to distribute software through any other system and a licensee cannot impose that choice.

This section is intended to make thoroughly clear what is believed to be a consequence of the rest of
this License.

12.If the distribution and/or use of the Library is restricted in certain countries either by patents or by
copyrighted interfaces, the original copyright holder who places the Library under this License may add
an explicit geographical distribution limitation excluding those countries, so that distribution is
permitted only in or among countries not thus excluded. In such case, this License incorporates the
limitation as if written in the body of this License.

13.The Free Software Foundation may publish revised and/or new versions of the Lesser General Public
License from time to time. Such new versions will be similar in spirit to the present version, but may
differ in detail to address new problems or concerns.



452 • Appendix C: Third Party Licenses XPression Maps User Guide (v4.0)

Each version is given a distinguishing version number. If the Library specifies a version number of this
License which applies to it and "any later version", you have the option of following the terms and
conditions either of that version or of any later version published by the Free Software Foundation. If
the Library does not specify a license version number, you may choose any version ever published by
the Free Software Foundation.

14.If you wish to incorporate parts of the Library into other free programs whose distribution conditions
are incompatible with these, write to the author to ask for permission. For software which is
copyrighted by the Free Software Foundation, write to the Free Software Foundation; we sometimes
make exceptions for this. Our decision will be guided by the two goals of preserving the free status of
all derivatives of our free software and of promoting the sharing and reuse of software generally.

 NO WARRANTY

15.BECAUSE THE LIBRARY IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR THE LIBRARY,
TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTHERWISE STATED IN WRITING THE
COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE LIBRARY "AS IS" WITHOUT WARRANTY
OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS
TO THE QUALITY AND PERFORMANCE OF THE LIBRARY IS WITH YOU. SHOULD THE LIBRARY PROVE
DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION. 

16.IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY
COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR REDISTRIBUTE THE LIBRARY
AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL,
INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE
LIBRARY (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE
OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A FAILURE OF THE LIBRARY TO OPERATE WITH
ANY OTHER SOFTWARE), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES.

END OF TERMS AND CONDITIONS

Appendix: How to Apply These Terms to Your New Libraries

If you develop a new library, and you want it to be of the greatest possible use to the public, we
recommend making it free software that everyone can redistribute and change. You can do so by
permitting redistribution under these terms (or, alternatively, under the terms of the ordinary General
Public License).

To apply these terms, attach the following notices to the library. It is safest to attach them to the start of
each source file to most effectively convey the exclusion of warranty; and each file should have at least
the "copyright" line and a pointer to where the full notice is found.

<one line to give the library's name and a brief idea of what it does.> Copyright (C) <year> <name of
author>

This library is free software; you can redistribute it and/or modify it under the terms of the GNU Lesser
General Public License as published by the Free Software Foundation; either version 2.1 of the License, or
(at your option) any later version.

This library is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY; without even
the implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE.  See the GNU Lesser
General Public License for more details.

You should have received a copy of the GNU Lesser General Public License along with this library; if not,
write to the Free Software Foundation, Inc., 51 Franklin St, Fifth Floor, Boston, MA 02110-1301, USA.

Also add information on how to contact you by electronic and paper mail.

You should also get your employer (if you work as a programmer) or your school, if any, to sign a
"copyright disclaimer" for the library, if necessary. Here is a sample; alter the names:
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Yoyodyne, Inc., hereby disclaims all copyright interest in the library `Frob' (a library for tweaking knobs)
written by James Random Hacker.

<signature of Ty Coon>, 1 April 1990

Ty Coon, President of Vice

That's all there is to it!
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Noto-emoji License

Apache License

Version 2.0, January 2004

http://www.apache.org/licenses/

TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION

1. Definitions.

"License" shall mean the terms and conditions for use, reproduction, and distribution as defined by
Sections 1 through 9 of this document.

"Licensor" shall mean the copyright owner or entity authorized by the copyright owner that is granting
the License.

"Legal Entity" shall mean the union of the acting entity and all other entities that control, are controlled
by, or are under common control with that entity. For the purposes of this definition, "control" means
(i) the power, direct or indirect, to cause the direction or management of such entity, whether by
contract or otherwise, or (ii) ownership of fifty percent (50%) or more of the outstanding shares, or (iii)
beneficial ownership of such entity.

"You" (or "Your") shall mean an individual or Legal Entity exercising permissions granted by this
License.

"Source" form shall mean the preferred form for making modifications, including but not limited to
software source code, documentation source, and configuration files.

"Object" form shall mean any form resulting from mechanical transformation or translation of a Source
form, including but not limited to compiled object code, generated documentation, and conversions to
other media types.

"Work" shall mean the work of authorship, whether in Source or Object form, made available under the
License, as indicated by a copyright notice that is included in or attached to the work (an example is
provided in the Appendix below).

"Derivative Works" shall mean any work, whether in Source or Object form, that is based on (or derived
from) the Work and for which the editorial revisions, annotations, elaborations, or other modifications
represent, as a whole, an original work of authorship. For the purposes of this License, Derivative
Works shall not include works that remain separable from, or merely link (or bind by name) to the
interfaces of, the Work and Derivative Works thereof.

"Contribution" shall mean any work of authorship, including the original version of the Work and any
modifications or additions to that Work or Derivative Works thereof, that is intentionally submitted to
Licensor for inclusion in the Work by the copyright owner or by an individual or Legal Entity authorized
to submit on behalf of the copyright owner. For the purposes of this definition, "submitted"means any
form of electronic, verbal, or written communication sent to the Licensor or its representatives,
including but not limited to communication on electronic mailing lists, source code control systems, and
issue tracking systems that are managed by, or on behalf of, the Licensor for the purpose of discussing
and improving the Work, but excluding communication that is conspicuously marked or otherwise
designated in writing by the copyright owner as "Not a Contribution."

"Contributor" shall mean Licensor and any individual or Legal Entity on behalf of whom a Contribution
has been received by Licensor and subsequently incorporated within the Work.

2. Grant of Copyright License. Subject to the terms and conditions of this License, each Contributor
hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable
copyright license to reproduce, prepare Derivative Works of, publicly display, publicly perform,
sublicense, and distribute the Work and such Derivative Works in Source or Object form.

3. Grant of Patent License. Subject to the terms and conditions of this License, each Contributor hereby
grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable (except as
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stated in this section) patent license to make, have made, use, offer to sell, sell, import, and otherwise
transfer the Work where such license applies only to those patent claims licensable by such Contributor
that are necessarily infringed by their Contribution(s) alone or by combination of their Contribution(s)
with the Work to which such Contribution(s) was submitted. If You institute patent litigation against
any entity (including a cross-claim or counterclaim in a lawsuit) alleging that the Work or a
Contribution incorporated within the Work constitutes direct or contributory patent infringement, then
any patent licenses granted to You under this License for that Work shall terminate as of the date such
litigation is filed.

4. Redistribution. You may reproduce and distribute copies of the Work or Derivative Works thereof in
any medium, with or without modifications, and in Source or Object form, provided that You meet the
following conditions:

a) You must give any other recipients of the Work or Derivative Works a copy of this License; and

b) You must cause any modified files to carry prominent notices stating that You changed the files; and

c) You must retain, in the Source form of any Derivative Works that You distribute, all copyright,
patent, trademark, and attribution notices from the Source form of the Work, excluding those
notices that do not pertain to any part of the Derivative Works; and

d) If the Work includes a "NOTICE" text file as part of its distribution, then any Derivative Works that
You distribute must include a readable copy of the attribution notices contained within such NOTICE
file, excluding those notices that do not pertain to any part of the Derivative Works, in at least one
of the following places: within a NOTICE text file distributed as part of the Derivative Works; within
the Source form or documentation, if provided along with the Derivative Works; or within a display
generated by the Derivative Works, if and wherever such third-party notices normally appear. The
contents of the NOTICE file are for informational purposes only and do not modify the License. You
may add Your own attribution notices within Derivative Works that You distribute, alongside or as an
addendum to the NOTICE text from the Work, provided that such additional attribution notices
cannot be construed as modifying the License.

You may add Your own copyright statement to Your modifications and may provide additional or
different license terms and conditions for use, reproduction, or distribution of Your modifications, or for
any such Derivative Works as a whole, provided Your use, reproduction, and distribution of the Work
otherwise complies with the conditions stated in this License.

5. Submission of Contributions. Unless You explicitly state otherwise, any Contribution intentionally
submitted for inclusion in the Work by You to the Licensor shall be under the terms and conditions of
this License, without any additional terms or conditions. Notwithstanding the above, nothing herein
shall supersede or modify the terms of any separate license agreement you may have executed with
Licensor regarding such Contributions.

6. Trademarks. This License does not grant permission to use the tradenames, trademarks, service
marks, or product names of the Licensor, except as required for reasonable and customary use in
describing the origin of the Work and reproducing the content of the NOTICE file.

7. Disclaimer of Warranty. Unless required by applicable law or agreed to in writing, Licensor provides
the Work (and each Contributor provides its Contributions) on an "AS IS" BASIS, WITHOUT
WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied, including, without limitation,
any warranties or conditions of TITLE, NON-INFRINGEMENT, MERCHANTABILITY, or FITNESS FOR A
PARTICULAR PURPOSE. You are solely responsible for determining the appropriateness of using or
redistributing the Work and assume any risks associated with Your exercise of permissions under this
License.

8. Limitation of Liability. In no event and under no legal theory, whether in tort (including negligence),
contract, or otherwise, unless required by applicable law (such as deliberate and grossly negligent
acts) or agreed to in writing, shall any Contributor be liable to You for damages, including any direct,
indirect, special, incidental, or consequential damages of any character arising as a result of this
License or out of the use or inability to use the Work (including but not limited to damages for loss of
goodwill, work stoppage, computer failure or malfunction, or any and all other commercial damages or
losses), even if such Contributor has been advised of the possibility of such damages.

9. Accepting Warranty or Additional Liability. While redistributing the Work or Derivative Works
thereof, You may choose to offer and charge a fee for, acceptance of support, warranty, indemnity,or
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other liability obligations and/or rights consistent with this License. However, in accepting such
obligations, You may act only on Your own behalf and on Your sole responsibility, not on behalf of any
other Contributor, and only if You agree to indemnify, defend, and hold each Contributor harmless for
any liability incurred by, or claims asserted against, such Contributor by reason of your accepting any
such warranty or additional liability

END OF TERMS AND CONDITIONS

APPENDIX: How to apply the Apache License to your work.

To apply the Apache License to your work, attach the following boilerplate notice, with the fields enclosed
by brackets "[]" replaced with your own identifying information. (Don't include the brackets!) The text
should be enclosed in the appropriate comment syntax for the file format. We also recommend that a file
or class name and description of purpose be included on the same "printed page" as the copyright notice
for easier identification within third-party archives.

Copyright [yyyy] [name of copyright owner]

Licensed under the Apache License, Version 2.0 (the "License"); you may not use this file except in
compliance with the License.

You may obtain a copy of the License at:

http://www.apache.org/licenses/LICENSE-2.0

Unless required by applicable law or agreed to in writing, software distributed under the License is
distributed on an "AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or
implied. See the License for the specific language governing permissions and limitations under the
License.

http://www.apache.org/licenses/LICENSE-2.0
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Poly2Tri

Copyright (c) 2009-2010, PolyTri Contributors 

http://code.google.com/p/poly2tri/

All rights reserved.

Redistribution and use in source and binary form, with or without modification, are permitted provided that
the following conditions are met:

· Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer. 

· Redistrubtions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution. 

· Neither the name of Poly2Tri nor the names of its contributors may be used to endorse or promote
products derived from this software without specific prior written permission. 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY
EXPRESS OR IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT
NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
SUCH DAMAGE. 

http://code.google.com/p/poly2tri/
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ProtoZero License

ProtoZero Copyright

Apache License

Version 2.0, January 2004

http://www.apache.org/licenses/

TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION

1. Definitions.

"License" shall mean the terms and conditions for use, reproduction, and distribution as defined by
Sections 1 through 9 of this document.

"Licensor" shall mean the copyright owner or entity authorized by the copyright owner that is granting
the License.

"Legal Entity" shall mean the union of the acting entity and all other entities that control, are controlled
by, or are under common control with that entity. For the purposes of this definition, "control" means
(i) the power, direct or indirect, to cause the direction or management of such entity, whether by
contract or otherwise, or (ii) ownership of fifty percent (50%) or more of the outstanding shares, or (iii)
beneficial ownership of such entity.

"You" (or "Your") shall mean an individual or Legal Entity exercising permissions granted by this
License.

"Source" form shall mean the preferred form for making modifications, including but not limited to
software source code, documentation source, and configuration files.

"Object" form shall mean any form resulting from mechanical transformation or translation of a Source
form, including but not limited to compiled object code, generated documentation, and conversions to
other media types.

"Work" shall mean the work of authorship, whether in Source or Object form, made available under the
License, as indicated by a copyright notice that is included in or attached to the work (an example is
provided in the Appendix below).

"Derivative Works" shall mean any work, whether in Source or Object form, that is based on (or derived
from) the Work and for which the editorial revisions, annotations, elaborations, or other modifications
represent, as a whole, an original work of authorship. For the purposes of this License, Derivative
Works shall not include works that remain separable from, or merely link (or bind by name) to the
interfaces of, the Work and Derivative Works thereof.

"Contribution" shall mean any work of authorship, including the original version of the Work and any
modifications or additions to that Work or Derivative Works thereof, that is intentionally submitted to
Licensor for inclusion in the Work by the copyright owner or by an individual or Legal Entity authorized
to submit on behalf of the copyright owner. For the purposes of this definition, "submitted"means any
form of electronic, verbal, or written communication sent to the Licensor or its representatives,
including but not limited to communication on electronic mailing lists, source code control systems, and
issue tracking systems that are managed by, or on behalf of, the Licensor for the purpose of discussing
and improving the Work, but excluding communication that is conspicuously marked or otherwise
designated in writing by the copyright owner as "Not a Contribution."

"Contributor" shall mean Licensor and any individual or Legal Entity on behalf of whom a Contribution
has been received by Licensor and subsequently incorporated within the Work.

461
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2. Grant of Copyright License. Subject to the terms and conditions of this License, each Contributor
hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable
copyright license to reproduce, prepare Derivative Works of, publicly display, publicly perform,
sublicense, and distribute the Work and such Derivative Works in Source or Object form.

3. Grant of Patent License. Subject to the terms and conditions of this License, each Contributor hereby
grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable (except as
stated in this section) patent license to make, have made, use, offer to sell, sell, import, and otherwise
transfer the Work where such license applies only to those patent claims licensable by such Contributor
that are necessarily infringed by their Contribution(s) alone or by combination of their Contribution(s)
with the Work to which such Contribution(s) was submitted. If You institute patent litigation against
any entity (including a cross-claim or counterclaim in a lawsuit) alleging that the Work or a
Contribution incorporated within the Work constitutes direct or contributory patent infringement, then
any patent licenses granted to You under this License for that Work shall terminate as of the date such
litigation is filed.

4. Redistribution. You may reproduce and distribute copies of the Work or Derivative Works thereof in
any medium, with or without modifications, and in Source or Object form, provided that You meet the
following conditions:

a) You must give any other recipients of the Work or Derivative Works a copy of this License; and

b) You must cause any modified files to carry prominent notices stating that You changed the files; and

c) You must retain, in the Source form of any Derivative Works that You distribute, all copyright,
patent, trademark, and attribution notices from the Source form of the Work, excluding those
notices that do not pertain to any part of the Derivative Works; and

d) If the Work includes a "NOTICE" text file as part of its distribution, then any Derivative Works that
You distribute must include a readable copy of the attribution notices contained within such NOTICE
file, excluding those notices that do not pertain to any part of the Derivative Works, in at least one
of the following places: within a NOTICE text file distributed as part of the Derivative Works; within
the Source form or documentation, if provided along with the Derivative Works; or within a display
generated by the Derivative Works, if and wherever such third-party notices normally appear. The
contents of the NOTICE file are for informational purposes only and do not modify the License. You
may add Your own attribution notices within Derivative Works that You distribute, alongside or as an
addendum to the NOTICE text from the Work, provided that such additional attribution notices
cannot be construed as modifying the License.

You may add Your own copyright statement to Your modifications and may provide additional or
different license terms and conditions for use, reproduction, or distribution of Your modifications, or for
any such Derivative Works as a whole, provided Your use, reproduction, and distribution of the Work
otherwise complies with the conditions stated in this License.

5. Submission of Contributions. Unless You explicitly state otherwise, any Contribution intentionally
submitted for inclusion in the Work by You to the Licensor shall be under the terms and conditions of
this License, without any additional terms or conditions. Notwithstanding the above, nothing herein
shall supersede or modify the terms of any separate license agreement you may have executed with
Licensor regarding such Contributions.

6. Trademarks. This License does not grant permission to use the tradenames, trademarks, service
marks, or product names of the Licensor, except as required for reasonable and customary use in
describing the origin of the Work and reproducing the content of the NOTICE file.

7. Disclaimer of Warranty. Unless required by applicable law or agreed to in writing, Licensor provides
the Work (and each Contributor provides its Contributions) on an "AS IS" BASIS, WITHOUT
WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied, including, without limitation,
any warranties or conditions of TITLE, NON-INFRINGEMENT, MERCHANTABILITY, or FITNESS FOR A
PARTICULAR PURPOSE. You are solely responsible for determining the appropriateness of using or
redistributing the Work and assume any risks associated with Your exercise of permissions under this
License.
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8. Limitation of Liability. In no event and under no legal theory, whether in tort (including negligence),
contract, or otherwise, unless required by applicable law (such as deliberate and grossly negligent
acts) or agreed to in writing, shall any Contributor be liable to You for damages, including any direct,
indirect, special, incidental, or consequential damages of any character arising as a result of this
License or out of the use or inability to use the Work (including but not limited to damages for loss of
goodwill, work stoppage, computer failure or malfunction, or any and all other commercial damages or
losses), even if such Contributor has been advised of the possibility of such damages.

9. Accepting Warranty or Additional Liability. While redistributing the Work or Derivative Works
thereof, You may choose to offer and charge a fee for, acceptance of support, warranty, indemnity,or
other liability obligations and/or rights consistent with this License. However, in accepting such
obligations, You may act only on Your own behalf and on Your sole responsibility, not on behalf of any
other Contributor, and only if You agree to indemnify, defend, and hold each Contributor harmless for
any liability incurred by, or claims asserted against, such Contributor by reason of your accepting any
such warranty or additional liability

END OF TERMS AND CONDITIONS

APPENDIX: How to apply the Apache License to your work.

To apply the Apache License to your work, attach the following boilerplate notice, with the fields enclosed
by brackets "[]" replaced with your own identifying information. (Don't include the brackets!) The text
should be enclosed in the appropriate comment syntax for the file format. We also recommend that a file
or class name and description of purpose be included on the same "printed page" as the copyright notice
for easier identification within third-party archives.

Copyright [yyyy] [name of copyright owner]

Licensed under the Apache License, Version 2.0 (the "License"); you may not use this file except in
compliance with the License.

You may obtain a copy of the License at:

http://www.apache.org/licenses/LICENSE-2.0

Unless required by applicable law or agreed to in writing, software distributed under the License is
distributed on an "AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or
implied. See the License for the specific language governing permissions and limitations under the
License.

http://www.apache.org/licenses/LICENSE-2.0
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ProtoZero Copyright

protozero copyright (c) Mapbox.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

· Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

· Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL
THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT
OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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Vector Tile License

Copyright (c) 2016, Mapbox

Permission to use, copy, modify, and/or distribute this software for any purpose with or without fee is
hereby granted, provided that the above copyright notice and this permission notice appear in all copies.

THE SOFTWARE IS PROVIDED "AS IS" AND THE AUTHOR DISCLAIMS ALL WARRANTIES WITH REGARD TO
THIS SOFTWARE INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS. IN NO
EVENT SHALL THE AUTHOR BE LIABLE FOR ANY SPECIAL, DIRECT, INDIRECT, OR CONSEQUENTIAL
DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS,
WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR
IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.
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Appendix D: Datasets and Map Sources
Data layers and external map styles, not libraries.

· Blue Marble (NASA) —  The Blue Marble map style comes from 'NASA Earth Observatory'. Add the
following credit line to your closing credits or web page: "Blue Marble: Next Generation by NASA's Earth
Observatory."

· Natural Earth Data —  The shape database "Natural Earth" used in this software comes out of the
public domain. For details visit http://www.naturalearthdata.com/about/terms-of-use/.

· Microsoft Bing Maps — Users must comply with the Mapbox® terms of use:
https://www.mapbox.com/legal/product-terms, in particular the mandatory Attribution and Logo
requirements. The Microsoft® Bing™ Maps Broadcast, Media and Entertainment Terms of Use are an
extension of the Microsoft® Bing™ Maps Platform APIs Terms of Use.

· Bing Maps APIs — Subject to Bing Maps Platform APIs Terms of Use. The Microsoft® Bing™ Maps
Broadcast, Media and Entertainment Terms of Use are an extension of the Microsoft® Bing™ Maps
Platform APIs Terms of Use.

· Microsoft Azure — Users must comply with the Microsoft Azure’s® Terms of Use:
https://azure.microsoft.com/en-us/support/legal/® Bing™ Maps Broadcast, Media and Entertainment
Terms of Use, in particular, the Content Attribution Requirements. Mapbox® maps come from Mapbox,
Inc.  Mapbox® is a registered trademark of Mapbox, Inc. in the United States and other countries. 

· Mapbox Maps — Subject Mapbox Terms of Service. Attribution and logo requirements apply. Users
must comply with the Mapbox® terms of use: https://www.mapbox.com/legal/product-terms, in
particular the mandatory Attribution and Logo requirements.

http://www.naturalearthdata.com/about/terms-of-use/
https://www.mapbox.com/legal/product-terms
https://azure.microsoft.com/en-us/products/azure-maps/
https://azure.microsoft.com/en-us/products/azure-maps/
https://azure.microsoft.com/en-us/products/azure-maps/
https://azure.microsoft.com/en-us/support/legal/
https://azure.microsoft.com/en-us/products/azure-maps/
https://azure.microsoft.com/en-us/products/azure-maps/
https://www.mapbox.com/legal/product-terms
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Appendix E: Patent-Licensed
Technologies
Codec patent pools — these are not open-source software (OSS), but they require notice of license
coverage

The encoding of the video media in combination with FFmpeg or libav is licensed under the following
patent portfolio licenses from MPEG LA, LLC, 6312 S. Fiddlers Green Circle, Suite 400E, Greenwood Village,
Colorado 80111 U.S.A. 

· The MPEG-2 PATENT PORTFOLIO

· The MPEG-4 VISUAL PATENT PORTFOLIO

· The VC-1 PATENT PORTFOLIO

· The AVC PATENT PORTFOLIO
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Appendix F: LDAP and XPression Maps
Lightweight directory access protocol (LDAP) is an open and cross-platform protocol that will help secure
and authenticate the XPression Maps Web Client application's user information (user names, passwords,
email addresses, account IDs, etc.)

« Before you start configuring LDAP, consult with your IT department to get the information designated

with the « symbol.

To access and enable the Maps LDAP configuration file:

1. Navigate to the MapsLDAPConfig.exe file on your computer. 

Typically this file is located in C:\Program Files\XPression Maps
Gateway\bin64\MapsLDAPConfig.exe.

2. Double-click the MapsLDAPConfig.exe file to open the configuration dialog.

MapsLDAP Configuration File

3. Select the LDAP checkbox to enable XPression Maps to use LDAP user authentication for user login.
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To configure the LDAP server parameters:

1. In the Server section, in the Domain field, enter the domain name that is appended to all users in
your company, e.g., rossvideo.com.

Server Properties

2. If you are using the Secure Sockets Layer (SSL) protocol, select the SSL checkbox and in the Port
field, enter 636.

OR

If you are not using the SSL protocol, leave the SSL checkbox clear and in the Port field, enter 389.

« These are the standard LDAP ports. A different port may be used if necessary. Consult with your IT

department.

To configure the Bind User parameters:

1. In the User DN field, enter the name of the administrative account which will be responsible for
retrieving information from the LDAP server.

This is a Read-Only account.

Bind User Properties

2. In the Password field, enter the password for this account.

«Ask your IT department for the name of the administrative account and the password.

3. Then select Connect.

If the Bind User credentials are correct, you will see a message at the bottom of the window, saying
"BindUser Connected!"
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To configure the User Search parameters:

1. In the Query field, select the Browse (...) button to open the CN Search Filter Setup window.

2. Select the attribute to determine the username for HTML5 plugin users. 

CN Search Filter Setup

«Consult with your IT department to determine which attributes should be used.

3. In the Attributes field, select the Browse (...) button to open the Attribute Filter Setup window.

4. Select the attributes to be retrieved from the LDAP server. 

This should only include the cn, displayName, and description fields. 

5. In the Membership Attr. field, enter the group membership attribute that defines how groups are
assigned to a user (e.g., memberOf).

«Consult with your IT department to determine what attribute to use.

«This attribute must be one of the attributes selected in the Attributes field.

Selecting the Reset button restores the field to its default value.

6. In the Base DN field, enter the Base Distinguished Name of your LDAP directory. 

The Base Distinguished Name (also known as the search base) identifies the root LDAP node in the
directory, from which user searches are initiated.

e.g., DC=companyname, DC=com (where "DC" stands for "Domain Component") and OU=Canada
and OU=IT (where "OU" stands for "Organizational Unit")

«Ask your IT department for this information.

Base DN Properties
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To configure the Miscellaneous section:

1. In the Display Name field, enter the attribute you want to see displayed when the user logs in to the
application.

e.g., displayname, givenName, mail 

«This attribute must be one of the attributes selected in the Attributes field.

Selecting the Reset button restores the field to its default value.

Misc Properties

2. The Description field is optional and doesn't impact any function.

Selecting the Reset button restores the field to its default value.

To configure the Test Login section:

1. In the Username field, enter your username, as defined in the Username attributes in the User
Search section.

e.g., If you selected (givenName=%1) in the Username attributes, you would enter your full name
here.

Test Login Properties

2. In the Password field, enter your usual company login password.
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3. Select the Test button to check that the credentials you entered work.

If you have everything configured correctly, you will get a Results window indicating that the Login
Test was successful and returning all the data you requested in the Attributes field.

Successful Login Results

If you have configured something incorrectly, you will get a Login Test Failed message.  Review your
configuration to make sure it is correct and re-test.

4. When you have achieved a successful login test, select Save and close the Maps LDAP Configuration
dialog.
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